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1.1 INEIGHT CONTROL OVERVIEW
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1.2 INEIGHT CONTROL OVERVIEW

As one of the applications within the InEight portfolio of products, InEight Control is a project
management tool used for:

» Managing account codes
e Measuring progress

e Forecasting final man-hours and costs

Managing revenue

Managing budget/contract changes

1.2.1 ACCOUNT CODE MANAGEMENT

Within InEight Control, you can define and assign account codes to your cost items. This association
can be synced to your ERP, and can also be used to benchmark data with other projects.

Control
Account Code
Management
ACS Register .
CBS Register

Define Qty Account
Contribution Codes

1.2.2 PROGRESS MEASUREMENT

InEight Control is the application where your Cost Breakdown Structure and budget are established
and where you can monitor project progress. You can:

¢ Import your conformed estimate and structure from InEight Estimate

Create and manage cost items

Import approved quantities from InEight Plan

Import final hours and costs from your ERP system
e Track your actuals and compare them against your Current Budget and earned values

The following workflow illustrates how these functions relate and pass information between systems.
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Estimate

+ x
= Conform Estimate / Control

WBS Structure

Estimate

Progress
Measurement

Final Hours and Costs

CBS Register

WBS Structure / Budgeted

Quantities & Hours Create & Manage

Cost Items

Analyze Planned

Earned and Actual Budget/Forecasts
Quantities

Plan

You can utilize this information to analyze trends, track productivity factors, and measure progress.

CBS Pos.. Description % Complete C B-Total C.. C B-Earned Total .. Total Cost (To Date) C B-Total Cost G/L(T..
Infrastructure | 514,193.548.20 5E50,054.65 53.000.00
Mobilization 0.00 510,794.00 5000 50.00 5000

(%] West Screen Demolition 038 54,605.59 $3.000.00
a 121 West - Removal-Cenduit 034 53 33 $3,000.00 (81,827.12)

1.2.3 FORECASTING

InEight Control provides options for forecasting final costs, man-hours, and productivity for your
project.

Task details { seee > E Forecast | Created from Live forec.. ~ = L eee >

CBS position Description Resource Forecast (T/0) UoM Forecast final Forecast final Forecast final Forecast final
(5] quantity cost MHrs man productivity
hours/Unit factor

=] _ Earthwork 5 10,000.00 CY $ 400,000.00 £,000.00 0.80 1.00
(] _ Concrete 6 10,00000 CY $1,500,000.00 30,000.00 300 1.00
=] _ Structural Steel 1,000.00 Ton $1,000,035.71 20,000.71 20.00 1.00
(] 4.1 Erect Steel - Heavy 5 80000 Ton $ 800,000.00 16,000.00 20.00 1.00
5] 42 Erect Steel - Light 5 20000 Ton $200,000.00 4,000.00 2000 1.00
(] 43 Bolted Connections 8 2,00000 Ea $3571 07 0.00 1.00
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You can forecast your remaining work based on any of the following Forecast Methods:

e Current Budget

Current Estimate

» Average performance

Committed Cost

Manual Entry

You can save private forecasts, share them with others, and push them to a “live” forecast which can

be reviewed by all and used for official reporting. You can also compare the Live Forecast to other

forecasts created, for example to compare to the previous month’s forecast.

The workflow diagram below illustrates how forecasting functions relate to the rest of InEight Control

and other systems.

Control

Forecasting

CBS Register Final Hours and Costs

Forecast Method
Setup

Live
Forecast Budget/
Forecasts

Forecasts

Quantities

1.2.4 REVENUE MANAGEMENT

Within InEight Control, you can create and manage pay items for tracking pay quantities, actual and

forecasted revenue, and how much has been billed to the client.

Page 22 of 528
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Control

Forecasting

CBS Register

Forecast Method
Setup

Live
Forecast

Forecasts

Revenue Management

Change Management

Change Register Pay Item Register

Budget Move Create/Manage
Pay ltems

Budget

Qty/MH
et Analyzed Planned & Forecast Revenue

Contract
Adjustment

Track Billed Revenue

1.2.5 CHANGE MANAGEMENT

InEight Control allows you to manage changes to quantities, man-hours, and costs in each cost item as
needed during the execution of the project. You can make three different kinds of changes within the
Change Management register:

¢ Budget move — Movement of costs between cost items where the total dollars moved must
balance to zero. There is no revenue associated with this type of change

¢ Budget quantity and man-hour adjustment — change to quantities or man-hours within the
project without changing costs

¢ Contract adjustment — both the budget and the revenue either increase or decrease and are not
required to be a net zero transaction. You will associate pay items with the change order to
reflect the revenue change

Approved changes update your Current Budget within the CBS register.
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The below workflow shows the relationship of Change Management to the rest of InEight Control.

Control

CBS Register

— Approved changes Control
update Current Budget

Change Management

Change Register

Budget Qty/MH Contract Qty

Budget Move Adjustment Adjustment

Pay Items

. Pay ltems
Register

Below is an example of what the Change Register looks like in InEight Control.

Change Register

D cCco lssue # Description Type Discipline Total Budget § adjust
200 aol oo Increase budget in the code for Plan and Progress Contract adjustment 1 34,800.00

210 Increase budget quantity for proper production factor Budget Oty&MH adjustment 1 5000

1.2.6 INEIGHT CONTROL WORKFLOW

The following workflow illustrates how all the functions of InEight Control work together.
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Estimate

+x
%z8

Historical Benchmarking

Estimate

Control

Conform Estimate / WBS Structure

Progress

Account Code Measurement
Management

Forecasting

CBS Register

ACS Register Create & Manage Final Hours and Costs

Cost Items
Define Qty Account
Contribution Codes

Analyze Planned
Earned and Actual

Forecast Method

Setu
P Budget/Forecasts

X Quantities
Live

Forecasts
_ Forecast

— Approved changes
update Current Budget

WBS Structure /Budgeted
Quantities & Hours

Change Management

Change Register

Budget Qty/MH Contract Qty

Plan

Pay Items
) Pay Items
Register
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REVIEW

1. Which InEight application do you use for capturing time and quantities in the field?
a. InEight Control
b. InEight Plan
C. InEight Progress
d. InEight Inspect

2. What key data is imported from the ERP system into InEight Control? (Select all that
apply.)
a. Costs
b. Quantities
C. Hours
d

. Notes

3. Which of the following is NOT a function of InEight Control?
a. Budget Management
b. Daily Planning
C. Change Management
d. Progress Measurement

€. Forecasting

SUMMARY

As a result of this lesson, you can:

e Describe the InEight cloud platform and how it relates to your project management process

¢ Define InEight Control and its purpose
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2.1 GENERAL NAVIGATION
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2.2 PAGE NAVIGATION

You can access Control within the InEight Cloud Suite using the link provided by your manager or
facilitator. To access Control, you must open a project by selecting Main menu > All projects &
organizations.

= X  Welcome Gabriela Truijillo

INEIGHT &

GT Gabriela Trujillo
Main menu

FAVORITES
C-XYZ

Road & Bridge Project | 106000

Steel Structure Training Job 2 | 105...
st select a pro

SETTINGS Please selec

All projects & organizations
it Master data libraries

Suite administration

Praofile

The All projects & organizations page opens to the Projects tab that shows all projects you are
associated with.

! Al projects & organizations

PROJECTS ORGANIZATIONS
® ® Q
D Name Stat... Organization Created by Created on Forecast duration Original contract ... Contract n [[|

[ 105091 Steel Structure Training Job Active C-XYZ Jeremy cheek 08/31/2018 1:40:48 PM
[ 105002 Steel Structure Training_Job 2 Active C-XYZ Jeremy cheek 08/31/2018 1:44:12 PM
a 105093 Steel Structure Training Job 3 Active C-XYZ Jeremy cheek 08/31/2018 1:44:46 PM
[ 105094 Steel Structure Partner Job Active C-XYZ Jeremy cheek 08/31/2018 1:45:25 PM
O | 183850 Wards Island WWTP Active C-XYZ Jeremy cheek 11/07/2018 8:02:08 AM
] BMS Test BMS Test New C-XYZ Brenda Steven 10/20/2020 1:55:15 PM
[]  Heavy PM Estimate Heavy PM Estimate Active C-XYZ Jeremy cheek 01/08/20191:33:34 PM
O | Training Job Training Job Active C-XYZ Sterling yazzie 09/11/201810:28:37

You can search projects by clicking the Search icon at the top right of the page. This search function
searches all columns in the page.
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All projects & organizations

2.2 Page Navigation

1]
105091
105092
105093
105094
183850
BMS Test

Heavy PM Estimate

O/00/o0oo0ooo

Training Job

Name
Steel Structure Training_Job

Steel Structure Training Job 2

Steel Structure Training_Job 3

Steel Structure Partner Job
Wards Island WWTP

BMS Test

Heavy PM Estimate

Training Job

Stat...

Active

Active

Active

Active

Active

New

Active

Active

PROJECTS

Organization

C-XYZ

C-XYZ

C-XYZ

C-XYZ

C-XYZ

C-XYZ

C-XYZ

C-XYZ

ORGANIZATIONS

Created by
Jeremy cheek
Jeremy cheek
Jeremy cheek
Jeremy cheek
Jeremy cheek
Brenda Steven
Jeremy cheek

Sterling yazzie

Created on

08/31/2018 1:40:49 PM
08/31/201831:44:12 PM
08/31/2018 1:44:46 PM
08/31/20181:45:25 PM
11/07/2018 8:02:08 AM
10/20/2020 1:55:15 PM
01/08/2019 1:33:34 PM

09/11/201810:28:37 ...

Fol

Search.

Click a project name to open it. The project opens to the Project home landing page. In the Project

home landing page, you can access Control from the left menu.

= {r Steel Structure Training Job 2 | 105092 / Project home

CA

Add project image

Minimum of 540px x 360px

Steel Structure Training Job 2 | 105092

I

)] Model
Document

Schedule

Control

@l@lelo

Waorkspaces

Project library

@ Plan

Quantity tracking

& Links

Organization
Learn.InEight

InEight University

Project

®

2.2.1 NAVIGATE THE INEIGHT CONTROL
WORKSPACES PAGE

In the Project home landing page, under Control, click Workspaces to open the Workspaces module.

InEight Inc. | Release 25.7
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Control User Guide

E {2t Steel Structure Training Job 2| 105092 / Project ho

CA

Add project image

Minimum of 540px x 360px

Steel Structure Training Job 2 | 105092 @

Model
L

Control

a

| Workspaces

Project library

Plan

Quantity tracking

Description

@ @ (©
6
cBS ACS PAY ITEMS CHANGE T a View : | CE+Cl -
Q= > s m o = q
H REECEES Ceosn > : [l Current estimate
WBS Resources Forecast UoM CE total MHrs CE total cost
phase (T10) qty
code
1002 1 100 LumpSum 1 0.00 $31250 *
1069 Is 1000000 CY 1 8,000.00 $400,000.0C
0 Is 1000000  CY H 30,000.00 $1,500,000.00

Overview - Control Workspaces Page

1 Left Navigation
Menu

2 Home Menu

3 Help Menu

4 User Profile

Page 30 of 528

Opens a side panel where you can quickly access pages across the
InEight Suite, such as settings, favorite projects, and other InEight
applications.

Returns to the Organization or Project home landing page.

Opens a window where you can quickly access elLearning courses,
Knowledge Library topics, and training videos.

Access your User Profile and update preferences such as language
and number formats.

InEight Inc. | Release 25.7



Control User Guide 2.2 Page Navigation

Overview - Control Workspaces Page (continued)

5 Right Navigation Opens a side panel where you can quickly access project-specific
Menu pages and applications.
6 Tabs Navigate to the CBS (Cost Breakdown Structure), ACS (Account
Code Structure), Pay items, Change Register and Audit Log pages.
7 Viewset Menu Display different preset views and manage custom viewsets.
8 Actions Menu Select available actions for the current register tab you are viewing.
9 Left Toolbar Contains commonly-used buttons to make changes in the register. In

this case, Add is used to add cost items, Edit to edit cost items, and
Delete to remove a cost item from the project.

10 Right Toolbar Contains functions for the register page you are currently viewing.
(Additional information shown below).

11 Side Toolbar Contains options for filtering the register and indicators for filtering
and sorting.
12 Register Displays page content in rows and columns, grouped together in
content customizable data blocks.

2.2.2 RIGHT TOOLBAR OVERVIEW

The right toolbar allows you to use functions for the register page. The toolbar options change
depending on which tab you select (CBS, ACS, Pay Items, Change Register, or Audit Log). The right
toolbar is commonly used for the CBS register page. The following image and table show the right
toolbar functions:

06 View : CE+CB i

m O B = Q

5 $
000060600
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Overview - Workspaces Page CBS Tab - Right Toolbar

1 Group Columns  Group rows of the cost breakdown structure by like information from
selected columns.

2 Undo Access a list of entries from the current day and select specific entries
to undo.
3 Display Display currency in the CBS as entered or as the project default
Currency currency.

4 Add Data Block Open a panel where you can manage data blocks and add data blocks

to your view.
5 Import Import cost item data from an Excel File.
6 Export Export your register view to an Excel file. Only the data blocks

currently displayed on the page will be exported to the file.

7 Row Density Adjust the line height at which the register content is displayed.
Choose between Relaxed, Narrow, or Tight.

8 Find Find value in register content by selecting a data block column,
selecting either the Begins with or Contains criteria, then entering the
value to search for.

2.3 COLUMNS/GROUPING/SORTING

InEight Control allows you to customize columns in your data blocks according to your preferences.
Changes made to the placement of your columns will be retained the next time you access any page
you have customized.

2.3.1 MOVE COLUMNS

You can move a column from one place to another to customize your view using drag and drop.
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MOVE COLUMNS

1. On the Pay Items tab, click and hold any column.

Actions ¥ @ ®
Pay items
Line number Row number Total price Unit price Pay quantity |
|
(] 001 Eart... 1 1 $759,887.01 $759,887.01 1.00
] 002 Con.. 2 2 $2,919,020.71 $2,919,020.71 1.00
%4 003 Ste.. 3 3 $1,821,092.28 $1,821,002.28 1.00

2. Drag it to the left of right of another column.

u|_

Row number Total price Pay guanti
g Total pme o e

ik,
1 5759,887.01 $759,887.01 1.00

» Two black arrows appear to guide you to the location the column will be dropped

2.3.2 SORT COLUMNS

You can sort columns in ascending or descending order for both for alpha and numeric fields on any
column by clicking once on the column header.
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SORT COLUMNS

1. On the CBS tab, select any column header.

¢ Avyellow arrow appears, facing downward, indicating that you are sorting that column
alphabetically from A-Z or numerically.

2. Torevert the sort, select the column header again.
¢ The yellow arrow faces upward indicating the reverse sort.

3. Select the column header once more to return the column to the original sort.

2.3.3 FILTER COLUMNS

You can filter your column data to show only specific, pertinent information that you need. There are
two ways to set a filter:

2.3.3.1 METHOD 1: FILTER FROM COLUMN HEADER

You can set a filter for a column by clicking on the filter icon on any column header. This brings up a
drop down list of items that you can filter by to apply to that specific column.

RAdsdunce Forecast (TIO) ol
guantity
10RKN RS Show ivems with value that:
1.00000  PE-Laki-0 B
Equal -
1000000 K5
1 45000000  O&_Tes1-07 Select walue ':'\ﬂ:'l -
1 I00000O0] | FWAME™ .
AN -
1 10000000 | K5
1000000 K5 Equal -
1 popoD] | Lk
Gelect value -
1.00000 | PLS
1.00000 | PLS T
Claar | Apphy
10000 PLS —
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Jelg=0 If you wanted to remove a single filter, locate the column you filtered, click the filter icon,
and select the Clear button.

On the resulting filter, you can hover over the filter icon on the right icon selection to view which filters
are applied.

-
*
+ UaM squal PLS
.._Il'l' + Foeecast method egual Current
Ll stimat

Selecting the filter icon will remove all the filters applied to the columns.

2.3.3.2 METHOD 2: FILTER FROM RIGHT TOOLBAR

You can also set a filter by selecting the Filter icon from the right toolbar and selecting Query.

» ﬁ
w
» Query...

70

Mo saved queries

L 1 Job Overhead
2 Earthwork

This option is helpful when you:

¢ Need to search for the column you need to filter
¢ Need to apply filters to more than one column

Selecting the Filter icon from the right toolbar opens the Query builder slide out panel, where you can
set the filter value.

2.3.3.3 FILTER SLIDE OUT PANEL

The Filter slide out panel contains three key settings:
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Filter Settings

T ™

1 Columns Drop-down list to select the column to filter.
2 Operator Determines what kind of filter to apply. Includes the following:
e Equal

» Greater than

» Greater than or equal
 Is not null

e Isnull

» Lessthan

e Lessthan orequal

e Not equal

3 Query Name Name of query.

Query builder

Columns Operator. o Value: 9

@ Forecast (T/0) quantity Equal v ®

The following steps walk you through how to set a filter using the filter icon on the right toolbar.
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FILTER COLUMNS

1. From the CBS tab of the Control Workspaces page, click on the View drop-down arrow.

Wiew - | Project controls -
+ L J F f—
D S & Y B OO @ 1= Q

ecast | Created from Live forec.. * (= { eas )
cast Forecast Forecast Forecast Fored
cost final MHrs final mani fimal final

houwrs Unit productiert. .. cost
& BN NN N fnn i fin finn -

2. Select the Project controls viewset.

View Forecasts -
% Progress
CE+CB

Cost categories

— Project controls i

3. Select the Filter, then Query icon from the left toolbar.
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Actions = @

E Tasks
it

Y CBS
| position

e The Query builder slide out panel appears

Query builder
New guery name

Columns

®

4. Click on the Columns drop-down arrow to select a column.
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Lolumins
| -
~ Tasks
Row sele
CBS posi
Descripd
WEBS pha
w  Tash details
s Actuals
-

E\JI' TITres T

¢ Notice that the column titles are grouped by the data block in which they are housed
5. Select the Forecast Method column.
¢ This can also be typed into the text box to search for the column you need

6. Click on the Operator drop-down arrow and select Equal.

Query builder
-
Columns Operataor: Value:
@ Forecast method - Equal - Current budget - ®
Equal
Is not null
Is null
Mot equal

7. Click on the Value drop-down arrow and select Rollup.
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¢ Note that you can add additional filter criteria by clicking the plus icon

Query builder «

Columns Operator: Value:

@ Forecast method - Equal - Rollup E ®

Current budget
Current estimate
Average performance
Manual (EAC)

None

Rollup

Manual (ETC)
=3

¢ Note that you can click Save to add the filter to the My saved filter section for future use

8. Click Apply to apply the filter.

2.3.4 PAY ITEM GROUPING

Pay item grouping allows you to group your data in the most efficient way that makes sense to you.
This is useful if you want the option to group certain columns, and subtotal pay items.
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< PAY ITEMS CHANGE REGISTER AUDIT LOG >

Actions ¥ @ Y IE Q

Pay item D¢ Line Row Total Unit Pay Forecat UoM Is Billing Chan...

number l numbe! numbe! price price quantit gtlyo) billed methoc order
* Billing methods:|

P1 Test 2 2 $40.0000000  $ 40.0000000 1.0000000 0.0000000 AU D Cost Plus

asdf fawd. 3 3 $3,630.000.. $30.0000000 121.0000000 120.0000000 AU D Cost Plus @ 3)
 Billing methods: Fixed Final Price

333 4 4 §24,032.00 $400.0000. 60.0800000 90.0000000 Bag Fixed Final

P_1 P_Test 7 7 $250.0000.. § 220000000 11.3636364 150.0000000 K$ D Fixed Final @ )

$24,282.000...

The following steps walk you through how to set a pay item group by using drag and drop.

PAY ITEM GROUPING

1. From the Pay Items tab of the Control Workspaces page, click and drag the Billing methods
column header, and drop it in the space above.

cBs Acs PAY ITEMS CHANGE REGISTER AUDIT LOG
Actions v ® Y
s===————p Drag a column header and drop it here to group by that column | Billing methods

Pay item D¢ Line number Row number Total price Unit price Pay quantity Forecast UoM = s ml;\ Billing Change
number (T/0) Qty methods
Pl Test 2 2 $40.0000000 $40.0000000 1.0000000 0.0000000 AU m] Cost Plus
asdf fawd 3 3 $3,630.0000000 $30.0000000 121.0000000 120.0000000 AU m] Cost Plus &)
333 4 4 $24,032.0000000 $400.0000000 60.0800000 90.0000000 Bag Fixed Final Price
dsvsdy 5 5 $10.0000000 $10.0000000 1.0000000 00000000 1'Acre m] Unit Price &)
P P_Test 7 7 $250.0000000 $22.0000000 11.3636364 150.0000000 K$ m] Fixed Final Price (&
sa23 123 ] 8 $10.0000000 $10.0000000 1.0000000 100000000 !Acre m] Unit Price &)
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¢ Your Pay Items are now grouped by Billing methods

Actions v ®

1 Billing methods < IR SS=====y

Pay item D Line number
number

~ Billing methods: Cost Plus
P1 Test 2

asdf fawd 3

~ Billing methods: Fixed Final Price
333 4

P_1 P_Test 7

~ Billing methods: Unit Price
dsvsdv 5

s.123 123 8

cBs ACS
Row number Total price

2 $40.0000000
3 $3,630.0000000
$3,670.0000000

4 $24,032.0000000
7 $250.0000000
$24,282.0000000

5 $10.0000000
8 $10.0000000

PAY ITEMS

Unit price

$40.0000000

$30.0000000

$ 400.0000000

$22.0000000

$10.0000000

$10.0000000

CHANGE REGISTER

Pay quantity

1.0000000

121.0000000

60.0800000

11.3636364

1.0000000

1.0000000

Forecast
(T/0) aty

0.0000000

120.0000000

90.0000000

150.0000000

0.0000000

10.0000000

Control User Guide

AUDITLOG
-
; [

UoM Is billed Billing

methods
AU O Cost Plus
AU O Cost Plus
Bag Fixed Final Price
K$ O Fixed Final Price
1Acre O Unit Price
1Acre O Unit Price

2. Click on the sort arrow to the left of Billing methods column header to reverse the order of the

sort grouping.

Actions = @

1 Billing methods

Pay item ]
number

¢ Your Billing methods are now sorted, and the Unit Price displays as the first Billing

Methods grouping

Page 42 of 528

InEight Inc. | Release 25.7



Control User Guide

Forecast
(T/0) aty

0.0000000

10.0000000

90.0000000

150.0000000

0.0000000

120.0000000

UoM

11Acre

Acre

Bag

K$

AU

AU

Is billed

O

2.3.5 SUBTOTAL GROUPING

Billing
methods

Unit Price

Unit Price

Fixed Final Price

Fixed Final Price

Cost Plus

Cost Plus

2.3 Columns/Grouping/Sorting

Change order

Subtotal grouping lets you group your data based on the subtotals in the CBS. This is useful if you want
the option to group certain columns. You can group the following columns:

e Forecasting columns

Current Estimate

Current Budget

Actual columns

e Cost columns

¢ Man Hour columns

The following steps walk you through how to group by subtotals using drag and drop.

InEight Inc. | Release 25.7
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SUBTOTAL GROUPING

1. From the CBS tab of the Control Workspaces page, click the Group By icon.

cBS ACS PAY ITEMS CHANGE REGISTER AUDIT LOG View : | CE+CB -

aios v @ (]2 s @ @ B 1 a

T
[
I
3 CBS position Dascription ri:f phase CE final MHrs. CE final cost CE MHrs/unit CE units/MHr CE unit cost a:c':ndmr :I.Iﬁ‘:lll:; c
‘*‘ v Financial Results 1000 110,486 46 $ 46505058 T 110,486 46 000 § 46,505,085 71 100
v 1764 4548950 $8836.564 50 45,489 50 000 8,836,564 50 100
YRR 1765 4325943 $5934542.10 4325943 000 §593454210 1.00
' ERRE] 138 3033.36 §1429.379 44 303336 0.00 §1.420379.44 1.00
v Civil Demolitions ni’ 2019.36 $ 1,350,460 54 201936 000 § 1,350,460 54 1.00

2. Click and drag the Unit of Measure column header, and drop it in the space above.

¢ Your columns are now sorted by Unit of Measure.

c8s ACS PAY ITEMS. CHANGE REGISTER AUDIT LOG W CE+CB -

2 s m PP EQ

Task details LTS £ J§ Current estimate Coon >

Description B Resources Forecast (T/0) UoM CE final MHrs CE final cost CE MHrs/unit CE units/MHr CEunite
aty

1 100 Acte 000 $17.500.00 000 000
035  Acre 0.00 §7.500.00 0.00 0.00
100 Acre 110,00 $6.50000 11000 on
000 §26000.00
Stairs & Misc Met 6 2160000  BGSF 000 $113863.00 000 000
C 12283 Cathodic Protect 1609 1 2160000  BGSF 000 4954634 000 000
( 12254 cetv 1608 1 2160000  BGSF 000 §655.750.00 000 000
12255 1610 1 2160000  BGSF 000 §17.20000 000 000
12256 1813 1 2160000  BGSF 0,00 § 140951 86 000 000
1226 1514 1000000  BGSF 0,00 §5,066,072.00 000 000
12261 1615 2160000  BGSF 000 $1.206586.00 000 000
12262 Building Sub - LR 1817 2 2160000  BGSF 000 $2,691,878.00 000 000 ]
Subtotals 967 110631 46 § 4652845571

2.3.6 PAY ITEM MOVE OPTION

The move to feature is the only way to adjust the pay item order. This feature is similar to the adjust
CBS position feature in the CBS register. For a pay item to become a parent, billed revenue, billed
guantity, and current price must be zero, and no cost items can be assigned to it.

Selecting one or many pay items activates the Move to icon.
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= it  Steel Structure Training Job | 105091 / Control / Workspac

CBS
Actions ¥ ® ® |3 Moveto
- =< Pay item position Pay item Description
] number
O 1 00 Earthwork - Lab...
O 2 002 Concrete - Lab._..
3 003 Steel - Labor & ..

Selecting the move to icon opens the move-to field, where you can select the pay item you want to
move your selected pay item to.

Steel Structure Training Job | 105091 / Control / Workspaces

CBS ACS

Actions ©) X 2 - 002 - Concrete - Labor & Material -p @

After selecting the move to pay item and then clicking on the Move to icon, you have the option to
move the pay item as a child or a sibling.

CBS ACS

Actions = ® ®  Moveto2as: “= Child = Sibling %)
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2.3.7 PAY ITEM VIEWS

After your page view is arranged to your preference in the Pay Items page, you can create and save pay
item views.

The pay item view feature lets you select which columns to display in the current Pay item view, with
the Price and Revenue views as the default views.

PAY ITEMS CHANGE REGISTER AUDIT LOG

Save view as -
Unsaved (Price)
Y
Revenue
Revenue snapshot: Current revenue forecast Billed date: 07 Price
oM Current Price Change Original Original Qriginal Original Original
billing lock order price unit pay aty forecast billing i
method status price (T/0) method Rename current view
L5 Cost plus 6 Delete this view
New view
LS Unit price G

You can click the pay item column selection icon to choose which fields to include in your view.
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Sales order Billed gty

Pay item position /

Pay item number
Description
Current price
Current unit price
(] Current pay gty
(] Current forecast (T/0) gty
Uah
(] Current billing method
Change order
Sales order
Billed gty
(] Original price

Original unit price

ry

[ Original pay gty

Y

4 Original billing method
Original forecast (T/0) gty
Price lock status

[ Actual cost (to date) h

Like the view feature in the CBS, you can create, save, rename, and delete views.

View : | Unsaved (Revenue) -
Revenue
Price

07 .
ate billed gty and revenue

ugin Save view as

100.00¢
100.00 5 Iy

Hew view
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2.4 DATA BLOCKS

Each data block is a set of columns grouped together based on categories of information. Using data
blocks helps you organize and manage all the columns on a page.

Data blocks are customizable, and you can view them side by side and move them around in the
register. The information in each data block displays in a grid like format, maintaining a spreadsheet
look and feel.

CBS ACS PAY ITEMS CHANGE REGISTER AUDIT LOG
Forecasts -
w + =
Actions ® 0 $ P » m B P 1= Q
Tasks £ || Task details Ceose > t [l Forecast | created from Live forec.. ¥ = Cooe )

CBS position Description WBS Resource Forecast (T/0) UoM Forecast final Forecast final Forecast final Forecast final Forecast final
phase quantity man Frodlll:tivity unit cost
code hours/Unit factor

1 Job Overhead 1002 16 1.00 Lump Sum $695.00 11.00 11.00 0.00

2 Earthwork 1069 5 1000000 CY $ 400,000.00 8,000.00 0.80 1.00

3 Concrete 107 6 10,000.00 CY $1,500,000.00 30,000.00 3.00 1.00
~4 Structural Steel 1073 1,000.00 Ton $1,000,035.71 20,000.71 20.00 1.05 $
41 Erect Steel - Heavy 1074 5 800.00 Ton $ 800,000.00 16,000.00 20.00 1.00 $
42 Erect Steel - Light 1005 5 200.00 Ton $ 200,000.00 4,000.00 20.00 1.00 $

43 Bolted Connections 1006 8 200000 Ea $3571 07 0.00 1,400.00
A5 Materials 1084 1.00 Each $1,750,000.00 0.00 0.00 0.00 $1.75

5.1 Earthwork - Materials 1085 1 10,000.00 CY $ 250,000.00 0.00 0.00 0.00

52 Concrete - Materials 1086 1 10,000.00 CY $1,000,000.00 0.00 0.00 0.00

53 Structure Steel - Mat. 1087 1,000.00 Ton $ 500,000.00 0.00 0.00 0.00

54 | ona Trailer 1088 100 PIS 4000 000 000 000

Subtotals 13 $4,650,730.71 58,011.71

Each type of data block has its own unique default settings such as date range selectors and date
preset options (for financial periods). You can choose the total number of columns and panels for each
data block.

2.4.1 RESIZE COLUMN WIDTH

Data blocks can be customized based on your viewing preferences.. You can resize the columns widths
within a data block, so you are able to see all the data within a column.

In the below example, the Tasks Data block contains a column called Description. There are values in
the Description column which have the capability of being expanded for better visibility. The shortened
descriptions to be expanded are denoted by a ‘..." after the shortened description name.
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Tasks H
CBS position Descripl . *WBS phase code
43 Bolted Con. 1006
3 Concrete 10m
5.2 Concrete - _ M 1086
2 Earthwork 1069
51 Earthwork - 1085
41 Erect Steel ... 1074
42 Erect Steel 1005

If you want to resize and move the Description column to the right, select the Description column
border, and drag it to the right. Stop dragging the column when you’re satisfied with the column width.

Tasks
CBS position Description BS
¢|>phase
ode
5.4 Materials -
1 Job Overhead 1002
42 Erect Steel - Light 1005

43 Bolted Connections 1006
2 Earthwork 1069
3 Concrete 10m
4 Structural Steel 1073

41 Erect Steel - Heavy 1074

2.4.2 DATA BLOCK CATEGORIES

There are three categories of data blocks: Standard, Cost Category and Custom data blocks.

2.4.2.1 STANDARD DATA BLOCK

These include the following default data blocks:
e Task Details
e Actuals
e Current Budget & Estimate
e Forecast
¢ Forecast Delta
e Live Forecast

e Schedule

InEight Inc. | Release 25.7 Page 49 of 528



2.4 Data Blocks Control User Guide

You can customize the columns grouped within each of these data blocks.

2.4.2.2 COST CATEGORY DATA BLOCK

These data blocks organize key project progress information by cost category, and include the
following:

¢ Cost categories: Actuals

e Cost categories: Current Budget
¢ Cost categories: Current Estimate
¢ Cost categories: Forecast

You can change the columns in Cost Category data blocks.

2.4.2.3 CUSTOM DATA BLOCK

There are nine types of custom data blocks, each with their own unique characteristics:

@ Steel Structure Training Job (105091) - Control ~ Workspaces @ Q ®

CBS > Create new data block

o Define title and type @ Choose and customize columns

+ Data block title Preview

e pere Title here Con > H

=+ Data block type

® General
Forecast
Live forecast
Forecast delta
Actuals
Schedule
Revenue

Cost category

Tasks

You have the freedom to choose the type that best meets your needs. You will then select which
columns go into the custom data block.
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2.4.3 ADD A DATA BLOCK

The following step by step walks you through adding a standard or cost category data block to the CBS
tab of the Workspaces page.

ADD A STANDARD DATA BLOCK

1. On the CBS tab of the Workspaces page, click on the Add data block button on the right toolbar
to open the Data block slide out panel.

E O s o B B 1= Q

2. Onthe slide out panel on the left, drag and drop the Cost categories: CB data block into the
register page on the right.

ey g= Each view holds a maximum of five data blocks.

e This will drop the data block at the very far right side and you can then move it via

drag and drop in the register

r—— ®
X

CBS position Diescription WES Pay em CBS Tty complese MHrs/Unit (10
assignme camnlribut (1o date) date]
C » uantity

i

Standard data blocks
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TIP You can view currently active project data blocks by either a thumbnail or list.

Add data block

Standard data blocks

Cost category data blocks

X

Add data block

Click to add a data block from the list

Task details
Actuals

Current budget

Current estimate

Forecast
Forecast delta
Live forecast
Schedule

Cost categories

Cost categories -

Cost categories :

Cost categories

- Actuals
CB
CE

: Forecast

X

2.4.4 CREATE A CUSTOM DATA BLOCK

The following steps walk you through creating a custom data block from scratch.

CREATE A CUSTOM DATA BLOCK

1. On the CBS register page, click on the Add data block button, to open the data block slide out

panel.

E ©9 §s |m & ¢

1=

Q

2. At the bottom of the Data Block menu, select Create custom data blocks.
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v X

Add data block

;z} Standard data blocks

Cost category data blocks

Create custom data blocks

Select Data Block Type: General.
In the Data block title, enter in [your initials] Training — Unit Cost.

Select Next.

o g bk~ w

Using one of the methods above, add the following columns to the data block on the right:
¢ Unit Cost (To Date)
e CE Unit Cost (To Date)
¢ Forecast Remaining Unit Cost
* Forecast Final Unit Cost
e CE Forecast Unit Cost G/L

7. Once your data block is finalized, click Save at the bottom right of the slide out panel.

(\[e3g2 On the Add data blocks slide out panel, you will only see the Custom data blocks
you create. Custom data blocks created by other users will only show up under

their respective logins.

2.4.5 FORECAST DATA BLOCK

When you open the Forecasts view, you can select existing private forecasts or choose to create a new
private or shared forecast. This helps to create a more manageable list of private and shared forecasts.
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Aetions - ® = 9 s m o o i Q
T
_ Forecast
i
position
Create new Create new
L] 1 \
P () MNew private forecast (F) New private forecast
(¥) Mew shared forecast (#) Mew shared forecast
Recent Recent
w22
Hame Last Viewed Hame Last Viewed
,  Created from Live forecast 02/223/2024 12403 - .  Created from Live forecast 02/22/2024 1203
v 23 Q22272024 12:03:34 M 0222024 120334 P
., Created from Live fonecast 02/22/2024 12103 .,  Created from Live Sorecast 02/22/2024 1203
w 2310 O2F337I024 12:03:34 PM 02220334 P
~ ., Created from Live fonecast 02/22/2024 11:58 .,  Created from Live Sorecast 02/22/2024 11-58
0272272024 11:58.47 AM O2/2272024 11 5047 Al

Load More Load More

Subictals 143

2.4.6 DATA BLOCK CONTEXT MENU

The data block Context Menu allows you to perform different operations specific to the data block you

select.
Task details < eeee > haiaalo SR t0
Resource Forecast UoM Choose columns MHrs=
(T/0) _ date)
guantity Filter
100 Lump Sum Save data block as...
10,000.00 @ CY
Remove data block
1 1.00  Each

5 10,000.00 @ C¥Y 0.00

The following table provides an overview of Context Menu options:
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Data Block Context Menu

Title Description

Choose columns Open the column chooser menu and move, add, and remove
columns from the data block.

Filter Filter data within a data block.
Save data block as Create a copy of the existing data block and save it.
Remove data block Remove the data block from the current view.

Color coded terminal ~ Add colors to terminal items of your current data block.
items
(Tasks data block

only)

Color-coded CBS Adds colors to all CBS lines.
position
(Tasks data block only)

Show/Hide WBS Display or remove the WBS Phase Code column within the Tasks
Phase Code data block.

(Tasks data block

only)

In the following step by step, you will learn how to modify a custom or an existing data block using the
Context Menu.

EDIT A DATA BLOCK

1. In the CBS register, select the Context Menu icon of the custom data block you created.
2. Select Choose columns from the context menu.

3. Add a new column to your custom data block.
4

. Remove a column from your custom data block by selecting the header and clicking the left-
facing arrow to return it to the left column.
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CBS > Editdata block
@ Define title and type o Choose and customize columns

ALPHABETICAL BY CATEGORY RECENT

Actuals - Panel 1
 wene >

Actuals I to I
/Unit (to date]

Qty complete (to MHrs
date)

—

CE cost burnrate €B MHrs G/L (todate) Total cost (to date) ﬁB m;ml cost G/L (to
late)

CE cost earned (to date)

e €
CE cost expended %

CE CPI

5. To close the slide out panel, click the APPLY button on the bottom right of the slide out.

2.4.7 FILTER DATA BLOCK DATA

You can filter the columns in your data blocks to see relevant information pertaining to your specific
needs.

The following Step by Step walks you through filtering data block columns.

FILTER DATA IN A DATA BLOCK COLUMN

From any tab, on any column header, select the yellow arrow icon.
Select your desired operator from the first drop-down list.

Enter the value in the next field.

Select the next fields for filters logic and additional operator.
Select Apply. The pyramid turns yellow.

To clear the filter, select the same column header and yellow arrow.

N o g b~ w D=

Select Clear.

2.5 VIEWSETS

Once you have all desired data blocks organized to your liking, you can create a saved view of your
page so that you can always revert to it. This saved view is called a Viewset. The viewset can also be
shared with other users.
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CREATE AND SAVE A VIEWSET

1. From the CBS register page, click on the View drop-down arrow.

AUDIT LOG View Unsaved (Project controls) -

O $§ & VY B O B = Q

2. From the Viewset drop-down list, select Save view as.

|
View - | Unsaved (Project controls)
% Progress
CE +CB

Cost categories
Project controls

Forecasts

Save view as

New view

3. Name your view [your initials] — Saved view.
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Save view as:

JP- Saved view

Cancel Save

4. Click Save.

2.5.1 SENDING VIEWS AND DATA BLOCKS

J[egg= Certain permissions are needed to send views and data blocks to roles.

You can send views to all users that have a certain role. You can also send it to specific projects or full
organizations. To send to a project, you have to be a user on that project or in that organization.

SEND A VIEWSET

1. With the Viewset selected and shown, from the Viewset drop-down list, select Send view.

2. Inthe Search for a User field, type an employee's name and select their name from the list.
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Send view (test danielle) ta

(IS -

s&nd 1o

Users

D

Mo users sslected
Raoles
N roles sebected

Projects

._I___?

1

Ho projects sclecked

Organizations

i
==

Wo organizations s=lecbed

Y Reditdi
=) Remave a

» To send to a project, you have to be a user on that project or organization. Then
select the Send View to drop down list and select the option you want.
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3. Click Send.

Send view (test danielle) to

R

Users

Ugers who have atceas 10 the organizatan

Ugers who have atceas o specalic role
Projecis

Users who have access o project
Oripan s

Usgers whio have aCcess (o an onganization o ".-.Iqﬁui.lé MIZATIAN

&

o projects selecten
DOrganizations

Mo arganizations selected

N Bhainin
:_' SMAavE i

Cancel

4. The selected Viewset will send a notification to the selected employee, and will be available in
their drop-down list with sender’s name and when the Viewset was sent.
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Wiew . fest daniele -

View sent by Sunilbabu G5

View sent one 08971 &/ 2020 ",

Budget Surnmanyy{1) &L
3 - -'I'.
|'I|I-III'||:I1.'I' |:'r Bul.-ll:IE| Elil-llll.lll-: lf_ I Lt
contrazts B
Budget Summang 1 | 10
Budget Summany{1) (i)

Y iEW miare k

el =0 If the user does not have the proper permissions to view all the columns in the view that
was sent to them, then the employee will only be able to view the columns for which
they have permissions.

2.6 ROW DENSITY

The row density feature allows you to change the spacing between rows within the various pages and
slide out panels in Control, allowing you to view your data with the amount of spacing you prefer.

There are three options available:
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¢ Relaxed

Tasks

e Narrow

CBS position

Tasks

e Tight

CBS position

Tasks

CBS position

Description

Job Overhead

Earthwork

Earthwork Review

Earthwork

Description

Job Overhead
Earthwaork
Earthwork Review
Earthwork

Concrete

Description

SJUL UVELNNSOU
Earthwork
Earthwork Review
Earthwork
Concrete

Structural Steel

Task details < eeee >

Resource

Forecast
(T/0)
guantity

1.00

10,000.00

1.00

10,000.00

Task details < eeee >

Rezource

Forecast
(1/0)
guantity
1.00

10,000.00
1.00
10,000.00

10,000.00

Task details < eese

Resource

Forecast
(T/0)
quantity

10,000.00
1.00
10,000.00
10,000.00
1,000.00

Control User Guide

UoM

Lump Sum

;Y

Each

CY

UoM

Lump Sum
cY

Each

cY

cY

UoM

Curnp sunn
cY

Each

CcY

CcY

Ton

The Row density icon is available on the CBS, ACS, Pay Items, Change Register, and Audit Log tabs.
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E O $ o B § (1] Q

When you select the Row density icon, a drop-down menu appears, where you can select the row
density (space between rows) you prefer.

Row density
Relaxed
Marrow

® Tight

The row density you select applies to all registers within Control, including all tabs and slide out panels
on the Workspaces and Project Library pages.

Row density is user-specific, so different users can apply different row densities within Control, and the
row density option you select will remain the next time you log in.

[\[sJp 2 Row density is independent from the Viewsets you create. The row density you select is
therefore not saved as part of your viewsets.

2.7 AUDIT LOG

The Audit Log tab within the CBS register is used to capture changes that were made within InEight
Control and is broken down into five sub-tabs located on a left sidebar menu. Each log is designed to
capture the changes that happened within each of the different registers and during synchronization.

All five audit logs can be accessed by selecting the Audit log tab on the menu bar, then selecting each
individual audit log on the far left.
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Actions =

CBS

ACS

Pay items

Integration

Import history

Audit
1D

4871359
4871358
4871357

4871356

2.7.1 CBS

Data
type

CBS

CBS

CBS

CBS

Item
type

Cost ltem

Cost ltem

Cost ltem

Cost ltem

Desc

Concrete

Earthwork

Job Overh.

Structural...

WBS

1o

1069

1002

1073

ACS

Attrik

Schedule

Schedule

Schedule

Scheduled

Chan

by
Michael M
Michael M
Michael M

Michael M

PAY ITEMS

Chan
date

07/23/20

07/23/20

07/23/20

07/23/20

Value
befor

False

False

False

False

Control User Guide

CHANGE REGISTER AUDIT LOG

Value
after

True

True

True

True

Actuz
comp

You can access the CBS audit log by selecting CBS from the left side menu.

Forec
total
co...

Forec
total
co...

The CBS audit Log captures changes in the CBS register and utilizes an attribute field to identify what

type of change was made. Other columns include:

¢ Changed By (who made the change)

¢ Change Date (the date and time the change was made)

¢ The attribute value before and after

e Forecast cost before and after

¢ Forecast man-hours before and after

¢ Posting date before and after

CBs

ACS

Pay items

Integration

Import history

2.7.2 ACS

You can access the ACS Audit Log by selecting ACS from the left side menu.

Audit
ID

4871359

4871358

4871357

4871356

Data
type

CBS

CBS

CBS

CBS

Item
type

Cost Item

Cost Item

Cost Item

Cost Item

Desci wBS

Concrete 107

Earthwork 1069

Job Qverh.. 1002

Structural 1073

Attrik

Schedule ..

Schedule ..

Schedule

Scheduled

Chan

by

Michael M...

Michael M...

Michael M

Michael M

Chan
date

07/23/20..

07/23/20..

07/23/20

07/23/20

Value
befor

False

False

False

False

Value
after

True

True

True

True

The ACS Audit Log functions similarly to the CBS Audit Log, but contains the changes that were made
within the ACS (Account Code Structure) tab. The fields utilized to capture what changes were made

are:
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Change attribute

2.7.3 PAY ITEMS

Changed By (who made the change)

Attribute value before and after

.

[ vtn

Changed Date (the date and time the change was made)

.......

You can access the Pay Item Audit Log by selecting Pay Items from the left side menu.

Audit ID
CBS
ACS 4873330
Integration 4872028
Import history 4872027

Data type

Pay Item

Pay Item

Pay Item

Pay Item

Item type

Pay Item

Pay Item

Pay Item

Pay Item

Description

Pay Iltem 1

Pay item Attribute
No.

001

1

1

1

Billing Method

Pay item tag 8

Pay item tag 6

Pay item tag 4

Changed
by

Renee Japp
Renee Japp
Renee Japp

Renee Japp

Changed Value
date before

07/26/2019 01 Cost Plus
07/24/2019 02:
07/24/2019 02

07/24/2019 02:

Value after

Fixed Final Price

2.7 Audit Log

The Pay Item Log again functions similarly but contains changes that were made to the pay items. The
fields utilized to capture what changes were made are:

o Attribute

.
¢ Value before and Value after
e Total price before and after

Audit ID Description Attribute

1333638 Testing 07/31 Description

1333637 Testing 07/31 Sales Order

Changed By (who made the change)

Changed Date (the date and time the change was made)

Changed Changed Value Value after
by date before

paul trippi 07/31/2019 08: Test Testing 07/31
paul trippi 07/31/2019 08: S1

2.7.4 INTEGRATION

Total price
before

$1040.0000000...

$40.000000000...

You can access the Integration/Sync Audit Log by selecting Integration from the left side menu.
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Audit ID Interface Status Processing details Start Finish User name Log Handle
cBS
ACS 65639 ActualQty Succeeded 4ofa 07/29/2019 03:23 PM 07/29/2019 03:24 PM pavithra baskaran1 4a229816-€aa6-431b-811
Pay items 65638 LiveForecast Succeeded 4ofd 07/29/2019 03:23 PM 07/29/2019 03:24 PM pavithra baskaran1 ce90c8df-1916-4a50-847
65637 Budget Succeeded 4ofa 07/29/2019 03:23 PM 07/29/2019 03:24 PM pavithra baskaran1 43b8dc1c-6825-413a-9c
Import history 65636 cBS Succeeded 4ofd 07/29/2019 03:23 PM 07/29/2019 03:24 PM pavithra baskaran1 0985605a-745¢-4127-88

The Sync Audit Log is different from the other three. This log is used to capture:

¢ Whether the syncronization process between InEight Control and the ERP system was completed
successfully

¢ How long the sync process took to complete and who requested the sync
It keeps track of the functions performed under the Actions > Sync menu.
The syncing process will be discussed further in thel1.4 Audit Log Integration on page 466.
To help troubleshoot sync issues, you can click the link under the Processing details column to get

more information on which steps succeeded, are suspended, or failed.

2 Last updated: 08/29/2018 01:03 PM
2 Use shortcut key F5 to refresh status

Completed details - - Plan quantities pull: 31570

Step Status
Step 1: Recieving data Complete
Step 2: Populating data Complete
£ 2018 InEight Inc. Privacy and Terms | v 18.3 INEIGHT

If a sync error should occur, you can click on the Log Handle link to obtain troubleshooting information.

Log Handle

4a229816-€aa6-431b-811

ce90c8df-1916-4a50-847.
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This brings you into the InEight Suite App Logs screen, where you can see information relating to the
error including Level, Time, Domain, Area, Exception Message, Exception Type and Correlation Id,
which can help you determine the cause of the sync error.

2.7.5 IMPORT HISTORY

You can access the Import history audit log by selecting Import history from the left side menu.

The Import history log contains status information for all imports coming into all InEight products. For
example, cost item and actuals import processes can both be viewed in the Import history log for
status, then you can eventually make corrections and reprocess.

File name Status Processi Total Errors Total Added Added Created Created Last Last
cBs Details line imported estimate pay by date edited edited
items " resource items by date

ACS Market_St_9_8_17_GMP_Baseline.xer (Mark.. € Failed Step3 1842 0 0 0 0 Renee Japp 07/24/20191... Renee Japp 07/24/20191
Pay items Market_St_9_8_17_GMP_Baseline.xer (Mark... € Failed Step3 1842 i 0 0 0 Renee Japp 07/23/20191... Renee Japp 07/23/20191

Integration Book1.xlsx Pe.. Q@ 2 2 0 0 0 Renee Japp 07/12/20190.. paul trippi 07/30/2019 0.,

Import history Market_St_9_8_17_GMP_Baseline xer (Mark Cancelled  Step5 i i 0 0 0 Renee Japp 07/10/20190.. Renee Japp 07/23/20191

The Import history audit log allows you to take action on import and sync failures, based on error
messages. Error messages are contained within the error file for those imports that have failed import.

You can view progress in sync longs, view error messages, and then resolve issues in effort to continue

with your import.

Control — Audit Log

e | SR

1 File name The name of the actual import file being used to import data.

2 Status The current status of the import file. There are six import status that
can define the current state of an import process.

3 Processing This column describes the processing state in which the file is being
Details processed. This column is not applicable for all statuses.

4 Total line This is the total line items that are included within the Excel import file.
items

5 Errors This is a count of the number of errors during import.

6 Total import This is the total amount of records that were successfully imported

from the Excel import file.

7 Added This is the total amount of added estimate resources that were added in
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Control — Audit Log (continued)

T T S

estimate the CBS.
resources

8 Added pay This is the total amount of pay items successfully imported from the
items Excel import file.

9 Created by This is user responsible for importing the Excel upload file.

10 Created date  This is the actual date the Excel upload file was imported.
11 Last edited by This is the last user to edit the Excel upload file.

12 Last edited This is the last date the Excel upload file was edited.

File name Status Processing Total line Errors Total Added Added pay Created by Created Last Last
Details items imported, estimate items date edited by edited
® @ resouces @) @ m date
NEWPRO.ser (D. Pend . PP Q@ Step5 18 0 0 0 0 paul trippi 08/02/2019 12:1. paul trippi 08/02/2019 121
NEWPRO.xer (D. Cancelled  Step5s 0 0 0 0 0 paul trippi 08/02/201912:1... paul trippi 08/02/201912:1
NEWPRO.er (D. Cancelled  Step5 0 0 0 0 0 paul trippi 08/02/201912:0... paul trippi 08/02/2019 12:1
NEWPRO.ser (D. Cancelled  Step5 0 0 0 0 0 paul trippi 08/02/2019 12:0... paul trippi 08/02/2019 120

If you hover over one of these Status symbols below, it provides you with a brief explanation of the
selected status.

Here are some examples:

Database update failed o Failed C

Import Cancelled
0 of 0 items contains errors Cancelled
d the import

Import complete
842 items imported successfully

@ Complete
B
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Pending
0 of 111 line items contain errors
PP Continue Import
Q@ cancel

EE
¥y 3
o o

@ Complete

There are six possible import statuses listed below.

Failed
Failed with

errors

Pending

Cancelled

Processing

Complete

€ Failed

© railedwi..

Cancelled

O Processng

@ Complete

Import history Statuses

Definition

Import failed due to a duplicate row within the
Excel file.

Import failed with an attachment to download
with further information.

The Excel import file is pending, further action
is needed. The double blue arrows will open a
new window where you can correct and re-
process the Excel import file. The blue circle
with the line through it will cancel the import
completely.

The Excel import file has been cancelled.

The Excel import is still processing. Once this
is complete, the status will move into one of
the other five statuses.

Processing of the Excel import files is
complete.

2.7.5.1 PENDING STATUS

2.7 Audit Log

When an import is in a Pending status, this means that further action is needed to complete the Excel

file import.

Pending Pp @

There are two options:
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OPTION 1

Control User Guide

1. By selecting the double blue errors, you will be taken to another window to continue processing

the faulty records.

File name Status

CBS Import.csv

Pendin

s[mle

As an example, in the below screenshot, there are 3 existing errors. If you hover over one of the

errors, it will tell you what needs to be corrected.

In this case, there is an issue with the account code assignment, as the pop-up hover suggests.

Auditlog > Importhistory > CBS Import.csv

Status Details (& wBs phase code)

Import status CBS match status

Pending + 101002 [1] [Job Overhead]
Pending + 101069 [2] [Earthwork]
Pending + 101071 (3] [Concrete]
Pending + 101073 [4] [Structural Steell
Pending + 101074[4.1] [Erect Steel - H
Pending + 101005 [4.2] [Erect Steel - Li
Pending + 101006 [4.3] [Bolted Connec.
Pending ' 101084(5] [Materials]

Error 101085 [5.1] [Earthwork - M.
Error + 101086 (5.2] [Concrete - Mat
Error V' 101087 [4.4] [Module 01 - Er

|3 errors remaini | [ Find next error ]

Import Columns A

Import method CBS position Description

Update existing items o... | 1 Job Overhead

Update existing items o... 2 Earthwork
Update existing items 0. 3 Concrete
Update existing items o... 4 Structural Steel
Update existing items o... 4.1 Erect Steel - Heavy
Update existing items o... 4.2 Erect Steel - Light
Update existing items .. 4.3 Bolted Connections
Update existing items 0.. 5 Materials
Update existing items o.. | 5.1 Earthwork - Materials
Update existing items o... 5.2 Concrete - Materials

Update existing items .. 4.4 Module 01 - Erect Steel

WBS phase code

1002

1069

107

1073

1074

1005

1006

1084

1085

1086

1087

Cancel

Account code

20
5

6

62.03.02.004.06

62.03.02.004.02

62.03.02.006
1112233

1112234 (<}
1112235 Value must match an existing account code €
1112236 [<]

2. When you double click into one of the 3 errors, it will take you directly into an account code

assignment screen where you can make the correction.

From here you can select an account code and click on Assign.
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Assign account code
Search
Select Account code
00
00.03

00.03.02

Description

Overhead.6233 EDIT

OH - Get Work

OH - Estimating

D) 00.03.02.002

00.03.02.006

00.03.02.008

00.03.02.010

00.03.02.014

00.03.02.016

00.03.02.018

OH - Estimating - Research & Qu_..

OH - Estimating - Prepare Estima...

OH - Estimating - Review (Pre-Bid)

OH - Estimating - Post Bid

OH - Estimating - Management

OH - Estimating - 2nd Estimates

OH - Estimating - Engineering (Pr...

UoM

PLS

MWk

MWk

MWk

MWk

MWk

MWk

MWk

MWk

MWk

Cancel

2.7 Audit Log

3. After all corrections have been made to the existing errors, you can select the Import button on

the top right on the screen.

Description

Job Overhead
Earthwork
Concrete

Structural Steel

InEight Inc. | Release 25.7

'WBS phase code

1002

1069

107

1073

Account code

20

51

61

Cancel
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4. A warning message appears stating that changes will be made, and this project will be disabled
until completion.

Importing cost items will update the CBS for all connected users, Notify all
users that changes need to be saved prior to continuing with import. Upon
commitment of import, this project will be disabled until completion
Please note this may take several mins,

Active Users -

bridgette quintero v

5. Once processing has finished, you will receive an Import complete message.

X

Import complete

The project has updated and is now enabled.

Close

6. The Import history page now shows that the imported file is now successfully imported and
updates the Last edited date.

File name Status Total line Errors Total Added Added pay Created by Created date Last edited Last edited
items imported estimate items by date
rrrrrrrrr

CBS Import.csv @ Complete n 0 0 0 0 Keith Anderson 06/19/201906:30 .. paul trippi 07/31/201910:32
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OPTION 2

1. Selecting cancel, the blue circle with the line through it, will cancel the import completely.

File name Status

CBS Import.csv Pending @

2.7.5.2 FAILED WITH ERRORS STATUS

When an import is in a Failed with errors status, the system will generate a Word error report. The
document displays detected errors while attempting to import the Excel file values. Errors will need to
be reviewed within the Word document

e Failed with errors 4

An example of the Failed with errors Word error file provides direction on how to proceed with
correcting the Excel import errors, and a course of action to run the import again
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Import actuals CBS data: CBS impeort.xls

File Import attempted on: 7/31/201% 3:45:03 BM

The fellowing errcrs were detected while attempting to import actual
values intoc control.

Review the errors below, cnce all the errors hawve been resoclwed,
reattempt the import to Centrol.

Errer l: Posting date in external system must be walid (this error
affects 10 WBS/CBS items cut of 10 total attempted imported WES/CBS items
and 10 rows cut of 10 total attempted imported rows)
WBS: 2804
CBS: 10
Row: 7
WBS: 2505
CES: 11
Row: 8
WES: 280§
CBES: 12
Row: 9
WBS: 2807

CES: 13
Row: 10

The only option with a Failed with errors status is to review the errors, resolve them within the initial
Excel file import, and then re-import the file.

2.8 PROJECT INTRODUCTION

You will be using the project titled “Steel Structure Training Job” for the InEight Control training.
Within this Control training, you will create cost items and other data that will be utilized in trainings
covering the other InEight products (Plan, Progress, etc.)

The project consists of the construction of multiple steel support platforms in a greenfield site. The
project scope ranges from site preparations, concrete foundation and footing pours, steel erection,
and bolted connections.
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by

Bb % y.d
.biy/q /—\
=7/ AW/A\

= >\ _._;__f_f

A — ___/_..
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North Area

0103105 |07 105 11113 [15] 17 |19 2123 25 |27 29

| 02 0406 |08 |10 112 |14 1618 |20 22|24 2628 | 30]

South Area

v
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REVIEW

1. Match each term to its correct definition:

Term Definition

Home Select available actions for the current register tab
Menu you are viewing.
Actions Navigate to the CBS, ACS, Pay Items, Change
Menu Register and Audit Log register pages.

Select what application you want to use (Control,
Tabs . .

Plan, etc.), as well as other project settings.
Right Contains functions for the register page you are
Toolbar currently viewing.
Second . : .
Level Returns to the Organization or Project home landing
Menu Page

2. Which two of the following are not a data block category?
a. Standard
b. Unique
C. Cost category
d. Custom

e. Audit

3. How are filtered columns in InEight Control indicated in the content register’s data
blocks?

a. Column header is highlighted green

b. Column will shade red
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C. Sort/Filter button in column header is yellow

d. No indication is given

4. How do you change the spacing of your rows in Control?
a. Select the Row density icon from the right toolbar
b. Select Row density from the Actions menu

C. Change Row density in the Project settings

SUMMARY

As a result of this lesson, you can:
¢ Navigate the InEight Control Workspaces page
e Manage data blocks
e Group Pay Items
e Manage columns
e Create viewsets

¢ Change row density
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3.1 COST ITEM SETUP

InEight Inc. | Release 25.7 Page 79 of 528



3.2 InEight Control Workflow - Cost Item Setup Control User Guide

3.2 INEIGHT CONTROL WORKFLOW - COST
ITEM SETUP

Estimate

Historical Benchmarking

Control
Conform Estimate / WBS Structure

Progress .
Measurement Forecasting

Account Code

Management Final Hours and Costs

CBS Register

Forecast Method Budget/Forecasts
Setup Quantities

ACS Register Create & Manage

Cost Items
Define Qty, Account
Analyze Planned
Earned and Actual

Live
Forecasts
Forecast

WBS Structure / Budgeted
Quantities & Hours

roved changes
ﬂgﬂafe Currentgﬂudgef Revenue Management

Billed Revenue

Change Management Ll
Change Register Pay Item Register

Budget Move

Create/Manage
Items
Budget
Plan Qty/MH Analyzed Planned & Forecast Revenue

Contract
Adjustment Track Billed Revenue

InEight Control is the application used to create and manage cost items. The cost breakdown structure
developed and maintained in Control is utilized by other InEight applications which inherently share
the same data set to eliminate duplicate data entry.
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Estimate

Control

InEi g ht WBS Structure

Estimate

WBS Structure Create & Manage
Cost ltems

InEight Plan

\I
-
1

Plan

3.3 COST ITEM OVERVIEW

3.3.1 COST BREAKDOWN STRUCTURE

The CBS (Cost Breakdown Structure) is the main tab of the Workspaces page in Control and is the tab
where you typically spend most of your time. Each row in the CBS represents a work activity and is

called a cost item.

InEight Inc. | Release 25.7
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Actions v ®
Y
Tasks

(m] v :);Egmm
[w] 1

& w] 2
[w] 3
=] v 4
[w] 41
=] 42
[w] 43
=] V5
[w] 51
=] 52
[w] 53
=] 6

Description

H RERCGEES

phase
code
Job Overhead 1002 H
Earthwork 1069 }}5
Concrete 107 }}5
Structural Steel 1073
Erect Steel - Heavy 1074 }}5
Erect Steel - Light 1005 }}5
Bolted Connections 1006 }}5
Materials 1084
Earthwork - Materials 1085 H]
Concrete - Materials 1086 H]
Structure Steel - Materials 1087 H
Merrill Iron & Steel - Steel Material 1088 1

PAY ITEMS
< eo00 >
Forecast UoM
(T/0) aty
100 Lump Sum
10,00000  CY
10,00000  CY
1,000.00  Ton
90000  Ton
20000  Ton
200000  Ea
100  Each
10,000.00  Ton
10,00000  CY
1,000.00  Ton
10000 Ton

CHANGE REGISTER

¢ B Current estimate

AUDIT LOG

CE total MHrs

0.00
8,000.00
30,000.00
23,000.00
18,000.00
4,000.00

1,000.00

View : | ce+cB -
O s m L B B Q
< eoo >
CE total cost CE MHrs/unit CE units/MHr
$250,000.00 000 000
$400,000.00 080 1.25
$1,500,000.00 300 033
$1,150,000.00 23.00 004
$900,000.00 20.00 005
$200,000.00 20.00 005
$50,000.00 050 2,00
$1,750,000.00 000 000
$250,000.00 000 000
$1,000,000.00 000 000
$500,000.00 000 000
$50,000.00 000 000

The CBS is organized in a hierarchy of superior and subordinate cost items. A cost item is superior

and/or subordinate based on its relationship to other cost items. This is similar to a parent and a child
relationship where an individual can be both a parent and a child at the same time. The CBS is color

coded to identify which level of the hierarchy a specific cost item is located.

O000o0o0o0odg

O 00O
o
W R
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Description

Job Overhead
Earthwork

Concrete

Structural Steel

Erect Steel - Heavy
Erect Stesl - Light
Bolted Connections
Materials

Earthwork - Materials
Concrete - Materials

Structure Steel - Matenals

1005

1006

1084

1085

10886
1087

Superior
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3.3 Cost Item Overview

Tasks :
¥ ngm Deseription m
code

O IS sob Overhead 1002 Subordinate
O R oo 1069

O _ Concrete 107

O _ Structural Steel

O 41 Erect Steel - Heavy T

O 437 Erect Steel - Light 1

O 43 Bolted Connections 1

O _ Materials 10

] 51 Earthwork - Materials 1085

O 52 Concrete - Materials 1086

O 53 Structure Steel - Materials 1087

If a cost item has no subordinates it is considered a terminal cost item. Terminal cost items are where

cost is tracked. All superior items are a roll up of the budget, manhours, and cost of the cost items
below. Terminal items are identified with a special symbol located at the first column of each data

block.

position

0O0O0oo0o0ooou

H RERGCEES

Description WBS Resources )
phase
code y

Job Overhead 1002

Earthwork 1069

Concrete 107

Structural Steel 1073

Erect Steel - Heavy 1074

Erect Steel - Light 1005

Bolted Connections 1006

Materials 1084

This terminology and associated graphics provide a way to communicate and understand the hierarchy
of the Cost Breakdown Structure. The following table provides definitions for each of these terms.

Superior
Subordinate

Terminal

InEight Inc. | Release 25.7

Cost item that has subordinate subcost items that roll up under it.
Cost item that is a child to a superior cost item.

Cost item that has no subordinate beneath it. Costs and hours are
defined at the terminal level.
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As accurate as estimators try to build the estimate, changes occur during the project’s execution that
affect the CBS register in Control. To learn how to maintain, improve, and use the CBS register
properly, this topic focuses on the fundamentals of the Cost Breakdown Structure.

3.3.2 CBS TREE

The CBS tree provides a way to navigate up and down your Cost Breakdown Structure and a way to
filter down to a subset of the structure.

You open the CBS tree slide out panel by clicking on the CBS Tree icon on the Side Toolbar.

Actions )

Y
Tasks

= CBS Descrniption
[] position
[] ] Job Overhead
FI?. [] 2 Earthwork
[] ] Concrete
] v 4 Structural Steel

When selected, the CBS tree icon turns yellow and the slide out panel appears.
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X

w
- CBS tree

Expand all Collapse all

1 Job Overhead
2 Earthwork
3 Concrete
4 4 Structural Steel
& 5 Materials
G
7 Equipment

Select Expand all to expand the entire Cost Breakdown Structure

Select Collapse all to collapse the entire Cost Breakdown Structure

Click on the arrow icons to expand a cost item to view its subordinates

Select a cost item and then click Apply to filter your view to that cost item and its subordinates

To clear the CBS filter, click the CBS tree icon and then click Disable

Actions b @

w

% CBS position

}

|

Edit CBS tree view...

Disable

TIP You can select more than one cost item on the tree to create a customized view.

3.3.3 COST ITEM MENU

You can access a variety of cost item details and actions from the Cost Item menu.
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J 41 Erect s1eel - Heavy 14 i
O 492 Erect Steel - Light Copy >
43 Bolted Connections
O _ Materials o
O 5.1 Earthwork - Materials Insert copied cost items  »
O 59 Concrete - Materials
()] 53 Structure Steel - Materials @ New costitem
O _ Merrill Iron & Steel - Steel Mat @ New subordinate cost item
O _ Site & Demolition
O 7.1 Selective Demolition ® Delete cost items(s)
a 7.2 Site Demolition - Mobilization Ly Adjust CBS position
O Tl Site Demolition - Building KL
O 7.4 Site Demolition - Footings & F [4 Update Forecast (T/0) q..
O 75 Site Demolition - Hard - Buildi @ Cost item details
O 76 Site Demolition - Hard - Buildi
O 77 Site Demolition - Hard - Buildi Actuals details
dJ 78 Site Demolition - Driveway Ap
Change summary

Subtotals 32 (1 rows selected)

k. ] —
© 2025 InEight Inc. | Privacy Statement | Terms & Conditions | Costitem dashboard

You can open the Cost Item menu in one of two ways:

¢ Right-click the cost item

¢ Click the three vertical dots in the Description column

O 42 Erect Steel - Light 1005

J 43 Bolted Connections 1006

The following table provides details for the options in the Cost Item menu.

Copy cost item Copy the selected cost item with its associated resources.
Copy selection Copy the value from a specific cell.
Paste Paste the copied content.
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3.3 Cost Item Overview

Insert copied cost items

New cost item

New subordinate cost item

Delete cost item(s)

Adjust CBS position

Update Forecast (T/O) gty with
Plan component total qty

Cost item details

Actuals details

Change summary

Contract details

Cost item dashboard

Insert the copied cost item in a CBS position that is above,
below, or subordinate to the selected cost item.

Create a new cost item.

Create a new cost item that is subordinate to the selected
cost item.

Delete the selected cost item.
Move the selected cost item to a new position in the CBS.

Copy the total quantity of the associated component in
InEight Plan to the Forecast (T/O) quantity of the selected
cost item.

Open the Cost Item Details slide-out panel, where you can
manage the cost item.

Open the Actuals Details slide-out panel, where you can
input claimed quantities and view actuals history and
commitments.

Open the Change Order Details slide-out panel, where you
can view associated change orders, the budget change
summary, and the change order summary.

Open the Contract Details slide-out panel, where you can
view associated contract details from InEight Contract.

Open the Cost Iltem Dashboard slide-out panel.

3.3.4 COST ITEM DASHBOARD

The Cost Item Dashboard slide-out panel shows multiple cost item affiliated graphs. These graphs let

you further analyze cost item past and current performance trends related to time-phased distribution,

current budget changes, value over time, completion progress indicators, and a CBS audit history log.

InEight Inc. | Release 25.7
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1074
Erect Steel - Heavy
Time phased distribution Current budget changes
$8K $14,000
.-.C
$6.4K .ot $11,200
OO.’
‘0
54.8K +* 8,400
l.‘
§3.2K $5,600
$1.6K ,.-O' $2,800

Aug-2021 Sep-2021 Oct-2021 Nov - 2021
tly Time phased budget Actuals Earned budget
1l; Time phased forecast «O» Time phased budget Actuals
Earned budget «Om Time phaszed forecast

Value change over time CBS audit log history

5900K 900
Ju' _

5720K 720
§540K 540 Jun
$360K 360
May
$180K 180
Apr
50 0

Cost
Apuenty

Oct-2020 Dec-2020 Jan-2021 Feb-2021 Mar-2021
CBqty Mar
Completion progress Feb
50% 1.00

. 6 8 10
0% 100% 0
0% -
castRemainingManH
% complete CBCPI - _built lock
1.00 1.00 B CBS - Forecast method

BS - Estimate Tag 2

A
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3.4 COST ITEM SETUP

While most of your project structure typically imports from your estimating system, you may need to
adjust the Cost Breakdown Structure (CBS) to better reflect how the work will be executed in the field.
Additionally, contract changes or newly added scope may require updates. To accommodate these
needs, you can add, edit, and rearrange cost items as necessary.

If you need to build additional structure from the ground up, you can create new cost items manually.
This flexibility allows you to construct an entirely new project structure within Control — even starting
from a blank project if needed.

3.4.1 COST ITEM CREATION

Within InEight Control, you can create a new cost item in two ways:

* New Cost Item: Creates a new cost item at the same hierarchy level as the selected item, using
the next available number. For example, if you select 1.6, the new item will be 1.7 (if available).

¢ New Subordinate Cost Item: Creates a new cost item one level below the selected item, using
the next available number at that level. For example, if you select 1.6, the new item will be 1.6.x,
where x is the next available number.

When creating a new cost item, there are multiple fields available for populating the cost item details.
Not all fields are required; you can edit these details after the cost item has been created. The
following table provides more information on the available options.

T T T

Description Optional Text field for the name or description of the cost
item.
Forecast T/O qty Required The Forecast Takeoff Quantity is the amount

of work or materials expected to be completed
for the cost item. This value can be updated as
project details progress.

UoM Required The Unit of Measure is the standard
measurement used to quantify the Forecast
T/O qty, such as linear feet, cubic yards, or
labor hours.

Cost source Required Indicates how the cost item’s value is derived -
either as a Plug (a lump-sum amount) or as
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T T T

Current Estimate
fields

Cost segment

Pay item assignment

Account code

Live forecast method

Allow as-built

Page 90 of 528

Optional

Required

Optional

Optional

Optional

Required

Detail (built from associated quantities, rates,
or resources).

If available, input costs, unit rates, man-hours,
and/or equipment hours. Many of these values
are linked, and changes to these values will
update related values as well as the Current
Estimate total cost. Fields include CE total
cost, CE total MHrs, CE total equipment Hrs,
CE unit cost, CE MHr/Unit, CE Units/MHrs,
and CE labor cost/MHrs.

Categorizes whether the cost item is a direct or
indirect cost.

» Direct Cost - Costs that directly pertain
to the deliverables (pay items) of the job

» Job Overhead - Overhead costs
associated with running and managing
the job (e.g., management, jobsite
facilities)

» Business Overhead - Overhead costs
associated with running the business
(not directly related to running the job)

» Subcontract - Subcontract associated
costs

Select an existing pay item to associate to this
cost item.

Select an organizational account code for this
cost item.

Select how the live forecast is calculated for
this cost item. Forecast Method applies to
individual cost items and can be changed at
any time.

Determines whether you can enter actual
costs and quantities for a cost item.
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I T T

* None - Cost item does not accept cost or
quantities. This is typically seen in
Superior cost items

« All - Allows a cost item to accept both
direct costs and quantities

» Quantities - Cost item only accepts
quantities

» Cost - Cost item only accepts costs, man
hours, and equipment hours

Quantity driver Required Defines how a cost item’s Forecast T/O qty is
controlled.
 Superior Cl - Automatically updates the
quantity based on changes to a parent
cost item using a proportional multiplier
» Fixed - Keeps the quantity constant
regardless of changes to related cost

items
Currency Required Select a currency unit for this cost item.
As-built lock Optional Select the checkbox to lock the ERP status for

this cost item. Once you lock the ERP status,
your ERP does not allow the cost item to be

progressed.
Hide in Plan, Optional Select the checkbox to make this cost item
Progress, and unavailable for claiming in InEight Plan,
Design Progress, or Design.
CBS contribute gty Optional Select the checkbox to add the Forecast (T/O)

gty of this cost item with any other selected
siblings to the superior (parent) cost item. Note
that the UoM must be the same for all cost
items.
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CREATE A NEW COST ITEM

1. From the CBS tab of Control > Workspaces, click the Add Cost Item icon on the top left toolbar.

CBS
Actions = @
Y
Tasks

% CBS Description WB!
position pha
cod
O 1 Job Overhead 100
f:'i O 2 Earthwork 106

2. Select Create a new blank cost item, and then click Yes.

Are you sure you want to add a new cost item?

Inherit data from parent cost item

@ Create new blank cost item

¢ To specify the CBS position of the new cost item, first select an existing cost item from the
CBS, and then click Add Cost Item > New cost item.

3. The New cost item dialog box opens to the Details tab. Enter the cost item details as needed.
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New cost item

New cost item

(® Add new costitem

Forecast T/0 qty

1.00

DETAILS

ATTRIBUTES

CE unit cost

$0.00

CE total cost

$0.00

3.4 Cost Item Setup

Description * Forecast T/0 qty *UoM WBS phase code
1.00 PLS -
« Cost source CE total cost CE total MHrs CE total equipment Hrs
Plug A $0.00 0.00 0.00
CE unit cost CE MHr/Unit CE Units/MHrs CE labor cost/MHrs
$0.00 0.00 0.00 $0.00

Cancel

4. When finished, click Save.

CREATE A NEW SUBORDINATE COST ITEM

1. From the CBS tab of Control > Workspaces, select the superior cost item.

CBS ACS
Actions = @ I_ﬁ ®
]
Tasks :
% CBS Description WBS
position phase
code
O 1 Job Overhead 1002
f:'i (] 2 Earthwork 1069
O g Concrete 107
~v 4 Structural Steel 1073
O 41 Erect Steel - Heavy 1074
(] 42 Erect Steel - Light 1005

2. On the top left toolbar, click Add cost item > New subordinate cost item.
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CBS

Actions W @' D& ®

Y New cost item

New subordinate cost item

— O v cp:EsSitinn

O Job Overhead
f:'i - Earthwork

O Concrete
J. 2 Structural Steel

)

FCennt C4aal Ilamina

3. Select Inherit data from parent cost item, and then click Yes.

Are you sure you want to add a new cost item?

@ Inherit data from parent cost item I

O Create new blank cost item

¢ Note that the fields in the New cost item window are populated with the existing data
from the selected cost item.

4. Modify the cost item details as needed.
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Structural Steel

Structural Steel

® Add new cost item

Forecast T/0 qty

1,000.00

Description

Structural Steel

* Cost source

Plug -

CE unit cost

$0.00

* Cost segment

Job Overhead -

DETAILS

« Forecast T/0 qty

1,000.00

CE total cost

$0.00

CE MHr/Unit

Pay item assignment

ATTRIBUTES

CE unit cost

$0.00

*UoM

Ton

CE total MHrs

CE Units/MHrs.

Account code

CE total cost

$0.00

WBS phase code
CE total equipment Hrs

CE labor cost/MHrs

None

Cancel

$0.00

5. When finished, click Save.

3.4.1.1 CREATE MULTIPLE COST ITEMS

When you need to create multiple cost items, you can save time by including additional cost items in
the New cost item window. From the left panel, click Add new cost item to add another cost item

record.

Precast Concrete

New cost item

(®) Add new cost item

DETAILS

Forecast T/O gty UoM

1.00 PLS

To copy the details of a new cost item record, click the Copy cost item icon.
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Precast Concrete - Wall 20"x20"

Precast Concrete

Precast Concrete - .

(+) Add new cost item

When you’re finished, click Save

4.4 Precast Concrete Wall -
45 Precast Concrete Wall -
46 Precast Concrete Wall -
4.7 Precast Concrete Wall

3.4.2 REQUIRED COST ITEMS

Forecast T/O qty

1.00

Control User Guide

. The new cost items will appear in sequence in the CBS.

20"

- 20°X20”

1089

1090

1091

1092

69.00

71.00

1.00

29.00

Ea

Ea

Ea

Ea

The Required cost items feature lets you create standardized or commonly used cost items at the

organization level, and then add them at the project CBS level. Changing any of the required cost items
at the organization level, such as the account code or UOM, also updates the cost items at the project

level.

When required cost items are added in Settings > Control > Others > Required cost items, the feature

provides standardization across all projects for those cost items that are commonly used.
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{at 5100000 - I Seitings

» PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE OTHERS
@)
® Required cost items @
® ©

n O Description = UoM Account code Allow as-built
& ] Foundation footers concreate 65656 EA None -
ij" m} Steel wire 5inch 9958925 EA None

JE? ] Synthetic wood rafters 98265 EA None

] Test_Copylnsert] 001 Bag None
= ] Test_Copylnsert2 022 Acre None -
4 >

This feature can be a substitute for copying and pasting cost items from one project into another and
ensures the same WBS phase code is being used regardless of the project a team member is working
on.

fat 103961 | Ten Mile Slide - Phase 2 (Carrying) / Control / Workspaces

CBS

Actions O]

el Torecasi me ription WES phase code Number of
contracts
Claim multiple CBS quantities
icial Results 1000
‘_:1 Budget move and contract adjustment »
Rev Internal 1103
Lock/unlock budget b
| Add required cost items Rev Internal 1104
sync > ation/Caontin... 1701
= | weneral Project Ri.. 1102
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3.4.3 COST ITEM ARRANGEMENT

As the project progresses, you may need to rearrange cost items in the CBS to accommodate project
changes.

MOVE A COST ITEM

1. Select the cost item(s) that you want to move.

2. Right-click the cost item(s) to open the cost item menu, and then select Adjust CBS position.

v 5 Structural Steel

O Copy »
(] 51 Erect Steel - Heavy

] 52 Erect Steel - Light

] 53 Bolted Connections

O v 6B Materials

6.1 Precast Concrete Wall - 8

6.2 Precast Concrete Wall - 9”

6.3 Precast Concrete Wall - 20" ® Delete cost items(s)

6.4 Precast Concrete Wall - 20"X20" I_) Adjust CBS position

] 65 Earthwork - Materials

] 6.6 Concrete - Materials m Update Forecast (T/0) at..

3. In the Adjust CBS Position window, drag and drop the selected cost item(s) into a new position in
the CBS.
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e This icon indicates that the cost item is moved into a subordinate position.

CBS ,  AdjustCBS Position

Move to
o ¥ CBS position Description 'WBS phase code
o I o:overhead 1002
O I certhwork 1069
[m] _ Concrete 1071
O _ Precast Concrete * 4items selected| = 1093
O _ Structural Steel 1073
[} 541 Erect Steel - Heavy 1074
[} 52 Erect Steel - Light 1005
O 53 Bolted Connections 1006
[m] _ Materials 1084
6.1 Precast Concrete Wall - 8" 1089
6.2 Precast Concrete Wall - 9" 1090
6.3 Precast Concrete Wall - 20" 1001
6.4 Precast Concrete Wall - 20"X20" 1092

e This icon indicates that the cost item is moved into an equal position.

Precast Concrete 1093
e o se.m,

(m] 51 Erect Steel - Heavy 1074
a 52 Erect Steel - Light 1005
[m] 53 Bolted Connections 1006
6.1 Precast Concrete Wall - 8" 1089
62 Precast Concrete Wall - 9" 1090
63 Precast Concrete Wall - 20" 1091
6.4 Precast Concrete Wall - 20"X20" 1092

¢ If you prefer not to use drag and drop, click the Move to icon. Input the applicable CBS
position, and then click Move to again. Select Child to move the cost item(s) into a
subordinate position, or Sibling to move the cost item(s) to an equal position.

1
CBS , AdjustCBS Position CBS >  AdjustCBS Position
Move to — | 4[1093] Precast Concrete (ag | 7))
¥ CBS position Description ¥ CBS position Description

4. Confirm the new position in the Adjust CBS Position window. When finished with the changes,
click Save.
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3.4.4 VIEWING THE CBS GROUPED BY COLUMN

Navigating the CBS can be challenging when searching for specific information, as data is often
distributed across multiple levels. Projects may contain large volumes of diverse data, making it
difficult to locate and view relevant details- especially in a flat list format. The CBS Group By feature
helps simplify this by allowing users to organize the CBS into logical groupings based on shared
attributes. You can drag and drop column headers to group cost items by the criteria most relevant to
your workflow.

CBS GROUP BY COLUMN

1. On the CBS register tab, select the Group Columns icon on the right toolbar.

AUDIT LOG View : CE+CB b

B9 s m O B = Q

- Current estimate { o0 )

2. Drag the column header of a column and drop it into the grey grouping area.

* Note that this feature can only be used with columns with a predefined set of discrete
values, such as UoM or Allow as-built.

=+ Change status Drag a column header and drop it here to group by that column

Task details < sove > ¢ B Current estimate

‘WBS Change status Allow as-built As-built lock CE total MHrs CEt
HE

1002 i Al 0 i 0.00

1069 ! Al 0 i 8,000.00

1071 i - Al 0 i 30,000.00

1073 None =} 21,000.00

1074 i Al O I 18,000.00

1005 i ) Al O i 2,000.00

1006 ! Al O ! 1,000.00
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Actions ¥ ®

v ==

cBs Description WBS Change status Allow as-built As-built lock
[J  position phase
& code
Change status: (Count:2)
(=] 3 Concrete 1071 H . Al (m]
(@] 52 Concrete - Materials 1086 ' - Al (@]
Count:2

Change status: (Count:4)

(=] a1 Erect Steel - Heavy 1074 ' 2 Al =]
(m] 42 Erect Steel - Light 1005 ' e Al (@]
(=] 43 Bolted Connections 1006 ' 2 Al (=]
(@] 6 Merrill Iron & Steel - Steel Material 1088 ' e None (@]

3.4 Cost Item Setup

¢ | Current estimat

CE total MHrs

30,000.00
0.00

30,000.00

18,000.00
2,000.00
1,000.00

0.00

3. To add subgroupings, drag and drop additional column headers into the grouping area. You can
rearrange these headers in the grouping area to modify the subgroups.

Actions ¥ ®

I N

0

$

m o B = Q

Tasks t | Task details < es0e > ¢ § Current estimate

cBs Description WBS WBS phase Pay item CBS contribute CE total MHrs
[J  position phase code assignment qty
code
& Change status: (Count:2)
Pay item assignment: 002 (Count:2)
O |3 Concrete 107 fion 002 ' 30,000.00
o 2 Concrete - Materials 1086 1oss 002 [u] ' 0.00
Count:2 30,000.00
Change status: (Count:4)
Pay item assignment: (Count:1)
(=] 6 Merrill Iron & Steel - Steel Material 1088 Hmsa H 0.00
Count:1 0.00
Pay item assignment: 003 (Count:3)
o Erect Steel - Heavy 1074 fio7a 003 (@] ' 18,000.00
o 42 Erect Steel - Light 1005 f1005 003 (=] ' 2,000.00
O a3 Bolted Connections 1006 11006 003 (@] ' 1,000.00
Count:3 21,000.00

4. To return to the standard CBS, click the Group columns icon again.

3.4.5 COST ITEM DELETION

CE total cost

$1,500,000.00
$1.,000,000.00
$2,500,000.00

$80,000.00
$80,000.00

$979,.272.00
$100,000.00
$50,000.00
$1,129,272.00

CE MHrs/unit

3.0
0.0

20.00
20.00

You can delete one cost item or multiple cost items by selecting the cost items, right clicking, and then

selecting Delete Cost Item.

When deleting cost items from the CBS, deleting the forecast, clearing out the account code, or

changing attributes to delete a cost item is not necessary.
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4]
(X

v o4

v 5

0000000 o0ooagao

4.1
4.2
4.3

5.1
52
5.3
5.4
55

Earthwork
Concrete
Structur:
Erect Ste
Erect Ste
Bolted Ci
Materiale

Earthwor

Copy

Mew cost item

Control User Guide

1069

New subordinate cost item

Concrete

Structure

Delete cost items(s)

Material:

Materialt

Subtotals 14 (1 rows selected)

R [ |®]|® ®

< [

[~]

Adjust CBS position

Cost item details

Actuals details

Change summary

Cost item dashboard

You can also select a cost item and click the Delete icon on the left toolbar.

© B e

Actions w

CBS position
[
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MeJ =0 A cost item must meet the following conditions to be deleted:

¢ Total Cost (To Date) =0, MH (To Date) = 0, Eqp Hours (To Date) = 0, Qty Complete
(To Date)=0

e CB-Total Cost =0, C B-Total MH = 0, CB-Total Quantity = 0, C B-Qty Remaining =0

o If the cost item is a parent item, all the subordinate cost items will also need to be
checked to see if they can be deleted

If you are deleting multiple cost items and do not meet the following conditions for deletion, a
downloadable file appears that lists all of the validations and why they failed.

3.4.6 COPYING COST ITEMS WITH RESOURCES

You can copy and paste entire cost items with resources from the CBS tab to any cost item you select.

el = When you copy a cost item, you cannot copy the current budget because the current
budget must be approved in a contract adjustment or budget move.

Follow the step by step to copy a cost item.

COPY AND PASTE COST ITEMS

1. From the CBS tab, select one or more cost items that you want to copy that contain a resource.

o) g= This can be checked in the Resources column. If the cost item has a 1 or higher,
then a resource is attached to that cost item.

2. Right-click your selected cost items.

3. Hover over the Copy selection and select Copy cost item.
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(<< I <

O 00000oo0oooono

O

Subtotals 96 (3 rows selected)

| InEight Inc.

31
3.2
Vo4
41
42
v 43
431
432
v 5
5.1
52
v 6
6.1
6.2
6.3

Excavation Copy
Embankm

Aggregate

Furnish &

Finegrade

Install Agc

Flace Agg

Blue Top £

Asphalt Ce @ Delete cost items(s)
Furnish &

Install Hot

36 Inch RC r_,t? Cost item details
Furnish R(

Excavate |

Install RCI Change summary

Privacy Statement Temr I?

4. Right-click on another cost item in the CBS tab.

Control User Guide

2 Copy cost item

WZGsy

5. Hover over the option Insert copied cost items. You have three options as to where to place the

copied cost items:

¢ |Insert above

¢ |nsert below
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¢ |nsert as a subordinate

Tasks

% CBS

position
]

O w2
(] 21
] v 22
(] 2.2
v 23
O v 231
(] v 237,
(] 23.
d 23.
(] 23.

Description

Financial Results Analysis

Misc. Rev Internal

Misc. Rev Internal

Escalation/Contingency

General Project Risk

Directs
Direct Labour
Grading Work
I

Resurface Existing Accet

Maintain Access Road

Clear & Grub Bench B &\

 RERGEENS

Resources

Copy

Insert copied cost items

MNew cost item

New subordinate cost item

Delete cost items(s)

»

3.4 Cost Item Setup

£ osee > ]
Forecast (T/0) UoM
aty
1.00  PLS
1.00 PLS
1.00  PLS
1.00 Each
5245 K$
1.00 PLS

1.00  PLS

LS
T Insert above

z
‘L Insert below

k
— Insert as subordinate

050 HA

You can also view the pasted cost items in the Resources tab of the Cost item details slide-out panel.

3.4.7 DESIGN TOTAL QTY AND MAN-HOURS COLUMNS

IN CBS

Control displays the sum of the Forecast T/O quantity from the associated InEight Design items against
the attributed cost items. You can compare the Design total quantity and Design total man-hours to
the Forecast (T/O) quantity and Forecast hours columns, to make sure the values match up with what

is in Design.
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Control User Guide

Design total gty

Forecast T/O gty as determined
and pulled from the Design
application (Quantity item -

Design total MHrs

Current estimate man hours as
determined and pulled from the
Design application (Quantity

Forecast TO qty) item - CE MHrs)
i Forecast Design total Design total ¥ Forecast
remaining cost qty MHrs method
55259890046 53,898 000 0993  Rollup
5 5,760,886.07 370.000 0651  Rollup

3.4.8 CREATE COST ITEMS IN INEIGHT CHANGE

You can also create cost items with resources in Change, and then have them created in Control upon
the approval of a contract adjustment. This reduces the amount of extra steps needed for creating cost

items in multiple areas.

Creating cost items in Change is performed by first creating an issue with your newly created cost

items, then executing your change order.

= fnr 683 Art Museum - Addition

/ Change

Change management >  CCO-Demo 22.2-New scope

Executed Change order sent to Control

Executed .. Cost Billing mark.. Markup  Margin
$6,116.00 $5,560.00 $0.00 $556.00 10.00%
] Actions - DETAILS PRICING

»

Pricing summary ROM

Deductions MNet va... CCO status Pricing status Proposal status
$0.00 $6,116... . None . None -
SUPPORTING WORKFLOW
= + = 3
DOCUMENTS ASSIGNMENTS Z — 1= D
Estimate Proposal Agreed

~ Direct cost total

# Labor

A 153U8 75 - New scope <

Labor cost item pricing
Labor subtotal

. Materials

~ 1ssue 75 - New scope «

Materials cost item pricing
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In Control, go into the Change Register and click on the change order to review the new cost items that
originated from Change.

cBs ACS PAY ITEMS CHANGE REGISTER AUDITLOG
Actions [ 4 B 3 = Q
1D Description cco Crea... Issue
Ch. date # 28.0 % X
New scope
6. 280 New scope Demo222  0/28/2022 75
Type Status Originated on Originated by
6. 270 Buciget Move: WO/ 11/29/2021 Contract adjustment (Cost ite (@) cCo-Approved 02/28/2022 Morgan Smith
16.. | 26.0 Budget Allowance h /2972021 Last changed on Last changed by Approved on Approved by Approval probability
02/28/2022 Morgan Smith 02/28/2022 Morgan Smith 10000%
6. 250 Buyout Gain: PVS; M. 11/23/2021
6. 240 Budget Move: Temp 11/04/2021 Pay item details
Payitem Description Current billing Adjusted Adjusted Adjusted Locked date
16. 230 Budget Move: Temp 11/04/2021 number method current price current unit current pay qty
rice
6. 21 Budget Move: Moro 11/04/2021 2 Amendment #2 Fixed final price $6116.00 $0.00 6116.00
S
6. 220 Budget Move: Moo 11/02/2021
$6,116.00 $0.00
6. 210 Budget Move: Adjust 11/01/2021
Cost item details
16.. | 200 Budget Move: BTAm 1/01/2021 CBS position Description WBS Adjusted CB Adjusted CB Adjusted CB Locked date
phase ‘total cost total MHrs total Qty
code
16.. 19.0 Budget Move: Distrib... 10/29/2021
436 New scope - Plug values 1353 $5150.00 50.00 100 | 02282022
6. 180 Temp Entrance: Lab 09/30/2021 02
137 New scope - Resources 1354 $410.00 0.00 100 | 02282022
16. 172 Buyout Adjustment 09/23/2021 . .
6. 171 Buyout Adjustment 09/23/2021

Review Revise

Revise the change order to make any further adjustments, such as associating pay items to your cost
items. Notice how the cost category assignments have all come over to Control that originated from
the change document.

Change register > 28,0 - Contract adju.
€COtotalbudget  CCOunassigned budget  Net budget change  Net quantity change  Net man hour change | Makup Fes | Net contract change G0 agreed price CCOunassigned price  Approval probability
$5560.00 $000 $556000 Yes 5000 5000 3000 |$000 $6116.00 $6116.00 100.007% - Executed Change Order ¥
o Costitems =
@ 8 Assigncostto ¥ x
CBS position Description wes €8 total cost Adjusted CB Markup Marku  New scope - Plug values
() phase total cost %
— 0B total cost Pending budget cost CBtotal MHrs B total quantity
A Unassigned costitems 5000 $000 000 000
5515000
a \ $410.00
Cost category CB total cost Pending
A Total

0.00
000
5000
Undefined $000

Totals 5000 $515000

Subtotals 2 5000 $ 556000 suwy suvw v o suww

{ Cancel ‘ [omar ] ‘ Back ] m

Approving the change order creates the new cost items with the resources specified in Change, and
places them within the hierarchy specified in the contract adjustment, and if none is specified, then
they are placed at the bottom of the CBS.
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CBS ACS PAY [TEMS CHANGE REGISTER
Actions  w
e o U i L e
by on tag 1 tag 2 tag 3
280 New scope 02/28/2022 02/28/2022 £ fj CCO-Pending
270 Budget Move: IWO/ 11/29/202) (D Detals 11/29/2021 B (¥) Approved
260 Budget Allowance M... 11/29/2021 2 Reiia 11/29/2021 % (_ Approved
250 Buyout Gain: PVS; M. 11/23/2020 ar N 11/23/2021 B (%) Approved
240 Budget Move: Temp . | 11/04/2021 npplltg-.'e 1/04/2021 = (@ Approved
230 Budget Move: Temp ... 11/04/2021 /0472021 % |’., Approved
221 Budget Move: Morol crrrprey RO R Ji by e = 2 Draft
o #: CBS position Description :\;&it
code
J b 413 Visqueen Material - Available 1229
] 414 LICENSES, PERMITS, & BONDS 1039
] 415 Security Personnel IWO - Available 1320
[} 416 Available 1169
] 417 Available nn
0 418 Available nr2
(]} 419 Available 1183
] 420 Available 1158
] 421 Available 1349
(]} 422 Available 1143
] 423 Available 1147
]} 424 Available 1150
J 425 Available 1126
] 426 Available 127
(] 427 Available nn
] 428 Available 132
(]} 429 Available 1136
[} 430 Available 107
[} 43 Available 110
] 432 Available 1339
() v 433 Construction Equipment 1070
L v 434 FINISH CARPENTRY 1188
O i 435 SHEAR CORE WALLS nan
] 436 New scope - Plug values 1353
O 437 New scope - Resources 1354
Subtotals 41

3.5 COST ITEM EXCEL IMPORT

When you need to add multiple cost items to your project, adding them manually can be tedious and
time consuming. To save time, if you can export your cost items to Microsoft Excel (e.g., export to Excel
from your estimating software), you can import them into Control, allowing you to update your
estimate in bulk, without needing to manually enter data into individual cells.
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Click the Import icon on the right toolbar of the Control > Workspaces page to go access the Excel
import feature.

= O $ m ||l B = Q

The table below indicates the data you can import into Control from Excel.

Data Type CBS Columns

Tasks CBS position, Description, UoM, code-related fields, user-defined fields, other
settings found in the Task details data block in Control.

Schedule Schedule ID, schedule dates, Scheduled, Schedule plug days, Plug days,
Cost curve, Roll up schedule

Current CE final MHrs, final costs, total equipment hours, MHr/Unit, units/MHr,

Estimate equipment hour/unit, labor cost/MHr, equipment cost/MHr, Secondary Qty,
Scales 1, 2, and 3.

Cost Total and unit costs.

Categories

When you click on the Import icon on the CBS tab of the Workspaces page, you have three import type
options. You can import cost items, actuals, or a schedule.
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Cost items

Actuals

00.00 %

Commitment
99 .02 % 1,

After you make a selection, the Import CBS data window opens.

Overview - Import CBS Dialog box

1 Import from You can either drag and drop or browse to the file to import. Microsoft
Excel Excel files (.xlIsx,, .xIs) and Comma Separated Value (.csv) files can be

Page 110 of 528 InEight Inc. | Release 25.7



Control User Guide 3.5 Cost Item Excel Import

Overview - Import CBS Dialog box (continued)

imported.

2 Options You can add new cost items and update cost items that already exist in
the project, choose to only update existing cost items, or only add new.

3 Costitem When adding and updating cost items, the structure in the spreadsheet
matching you are importing from may be in a different order than the structure in
criteria Control. By specifying a code for matching your cost items, the import

routine will know which cost items in the spreadsheet are new when
adding new items, and which cost items to update with data from the
spreadsheet when updating cost items.

4 Information This information provides a description of available functionality and
message instructions for proceeding to the next step.
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Import CBS data

Import from Excel (xlsx, xls) or Comma separated value (_csv) o

Drag and drop the file here

or browse

Browse

Options
e o

* Import type @ Once the import file is read, Cost item match
options and field mapping can be specified.

Cost items and cost item attributes v Mapping uses row 1 headers from the source
document. New cost items are inserted to the
(® Update existing and new items bottom of the CBS.

Cost item matching criteria

WBS phase code -

3

() Update existing items

() New items

Clicking Next opens the Map columns dialog box, where you can map your Excel columns to the
appropriate column in Control.

Overview - Map Columns Window

1 Template  After you map the import file columns to the CBS columns in Control, you
can save your settings as a template for future use. This is helpful when you
need to make scope changes or updates on a regular basis.

2 Control The names of the column headers in Control that you can map your data to.
field

3 Mapped A green checkmark indicates the column in your import file is mapped
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Overview - Map Columns Window (continued)

correctly to the CBS column. The Green key indicates the matching code
you specified is locked.

4 File The names of the column headers in your import file that you can map to the
columns CBS columns in Control.

1)

Template ‘ Unsaved template - ‘ Ej
Control field 9 Mapped e File columns o
oo oo R
Description v Description
Optional code Blank-do not import
WBS phase code Blank-do not import
Allow as-built Blank-do not import
CBS position (V.4 CBS Position
UoM Blank-do not import

* Required fields

[ Cancel ] [ Back ] Next

3.5.1 FORECAST EXCEL IMPORT

When manually importing cost items by either updating existing cost items or importing new cost
items, you can also import forecast values via Excel. How the fields are mapped in Excel determines
which CBS forecast columns are populated.

Examples of some forecast columns that can be mapped via the Excel CBS import cost item process
include, Forecast total cost, Forecast total MHrs, and Forecast total unit cost. Cost categories can also
be selected for importing into Control.
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Import CBS data- ALL PERMISSION LC_12102021054633 xlsx

Map columns

Template  Unsaved template -

Control field Mapped File columns

Live Forecast -
Forecast method Blank-do not import

Forecast total Cost Blank-do not import

Forecast total Mhrs Blank-do not import

Forecast total Mhr/Unit Blank-do not import

Forecast total productivity Blank-do not import

Forecast total unit cost Blank-do not import

Forecast remaining cost Blank-do not import

Forecast remaining Mhrs Blank-do not import

= - — — - . -

* Required fields

(ewa ) (o)

3.5.2 SPREADSHEET RULES

For the import process to work correctly, the items in your Excel spreadsheet must be formatted in a
certain way so that Control can recognize the items. The following table indicates important
spreadsheet rules to follow to make sure your data imports successfully.

Import Reads the first worksheet within the referenced workbook.
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N T S

function

Firstrowof Considered to be the header row of the data. This imports as titles which are
data referenced during the mapping process.
The import stops reading headers if it encounters a blank header cell.

Numbers Needs to be the actual number, and not the summation of cells.
Values cannot contain the $ symbol or other currency symbols.

Second row Considered the first row of data to be imported.
of data

Meyg= If you make changes in the spreadsheet, you must save the spreadsheet before importing
(only saved data will be imported).

Below is a list of items to be aware of during the population of the import template.

1. The Excel file should not be open while simultaneously using the import wizard.

a. If there are any edits made to the spreadsheet, it must be saved and closed prior to
importing.

2. CBS positions cannot be duplicates. They must be unique to each cost item.
a. The system will show an error if there are any duplicates.

3. The WBS phase codes are not required during the import but must also be unique per cost item.
4. Cost categories are spelling and case sensitive, and must match directly to the cost categories
spelling.

a. The cost categories list can be exported from the import wizard.

5. The Excel sheet cannot contain any blank cells during the import. Blank cells show an error and
cause the import to stall.

6. Make sure any blank columns from an export file are removed before importing again.

7. Date formats must match spreadsheet date formats. The Import Wizard will prompt you to
chose a date format used in the spreadsheet.

a. The Import wizard will prompt you to chose adate format prior to initiating the import.
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3.5.3 BEST PRACTICES AND RECOMMENDATIONS

1. Use WBS phase code as the matching criteria for updating existing items.

a.

WBS phase code are tied 1:1 for each cost item. The CBS position can be changed,
but the WBS phase code remains the same regardless of CBS position.

2. Set up the views for exporting of data to match the import template created. Views are

customizable for flexibility in what is being imported/exported.

3. Import template mapping is unique to each individual user. Master mapping cannot be set at a

global level. It is recommended to provide users with a step-by-step import mapping document
to set up data mapping initially during the on-boarding of InEight.

4. When exporting data in Control, current system drops trailing zeros on CBS positions. Example:
1.10 exports as 1.1.

a.

One way to get around this is opening data as a CSV file in Excel.

5. Once you have downloaded the export file, proceed to the following steps.

Open blank Excel sheet

Navigate to Data tab

Click Get Data > From File > From Text/CSV
Choose downloaded export file

Click Import

Click Load

Your data will now be imported into the sheet where updates are made. Once you have completed

your updates, you may save and re-import the same file.

3.5.4 CBS HIERARCHY

If you select CBS position as the matching criteria for the import, the import routine recognizes the
hierarchy of your structure by the numbering of the codes.
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3.5 Cost Item Excel Import

A2 : B || 1115
A B C

1 CBS position Description Forecast T/O gty
2 11.1.1.5 Parent 1
3 |1.1.1.5.1 Child 1 10
4 11.1.1.5.2 Child 2 1
5 |1.1.1.5.2.1 Child 2.1 15
6 [1.1.1.5.2.2 Child 2.2 20
7 11.1.1.5.3 Child 3 1

After the import is complete, if the CBS position for the new cost items match existing cost items in the
CBS, your new CBS cost items will import as you have defined them. The existing CBS cost items will
shift down and be relabeled to match the next corresponding number.

When adding new cost items to an existing CBS position, a warning message displays informing you the
CBS positions you have picked already exist. The message then asks you to confirm if you would like to
continue with this import.

3.5.4.1 CBS PREDICTIVE HIERARCHY

New cost items created via the import process automatically adjust the CBS structure hierarchy to
match your import as needed and predict the movements in the current hierarchy, and the hierarchy
that is being added via the Excel import.

Tasks

7~ CBS Description WBS phase
] position code
O v A - Road materials 1000
O v 1. B - Rock 1001
O 1.1.1 C - Mix 1002
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For example, you have three cost items that you want to import, as shown below. Positions 1 and 1.1
already exist in the CBS, and position 2.1.2 is new.

A | B
CBS position Description

1 D - Maintenance
1.1 E - EQuipment
|2.1.2 F - Subcontracts

R S

The import process imports Excel CBS positions 1 and 1.1, and places 2.1.2 at the bottom of the

hierarchy.
Tasks :
w7 CBS Description WBS phase

position code
(] v o1 D - Maintenance 1003
] 1.1 E - Equipment 1004
] v o2 A - Road materials 1000
] v 2.1 B - Rock 1001
) 211 C - Mix 1002
] 21.2 F - Subcontracts 1005

The following steps walk you through the import process.

Page 118 of 528 InEight Inc. | Release 25.7



Control User Guide 3.5 Cost Item Excel Import
Jleli= The following steps are only applicable when importing new cost items.

Options

*Impaort type

Cost items and cost item attributes b

() Update existing and new items
() Update existing items

(@ New items

IMPORT CBS DATA

1. From the Control > Workspaces page, on the CBS tab, click on the Import icon on the right
toolbar.

= O $§ m Tl B = Q

2. Select Cost Items when the Import CBS data window appears.

3. Click on the Browse button to select a file to import.
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Import CBS data

Import from Excel {.xlsx, .xls) or Comma separated value (.csv)

Drag and drop the file here or browse

Browse...

4. Browse to the Excel file you wish to import.

e The file and its location should be indicated by your instructor if you’re in a classroom
setting, otherwise you can select one of your own

5. Select the import file and click Open.

[4 Open x
4 Il » ThisPC » Desktop v O Search Desktop
(el MNarme Date modified Type Size
3+ Quick access
=) CBS Import File.csv 8/9/2018 11:30 AM Microsoft Excel Com...
[ Desktop - - P - - = = - -
] Copy of MES EndPoints for Suite.xlsx 7/11/2018 2:59 PM Microsoft Excel Work...
¥ Downloads  # = WalkMe £/20/2018 3:56 PM Shortcut
@ Documents o
=/ Pictures -
Control
KSU Materials De ¥ € 4
File name: | CBS Import File.csv v| All Files w

e The import file is now selected
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Import CBS data ICBS Import File csv I

Import from Excel (xlsx, xls) or Comma separated value (_csv)

Drag and drop the file here or browse

Browse...

6. Under Options, select New Items (if not already selected).

7. For the Cost item matching criteria, select Cost items and cost item attributes from the drop-

down list.
Options
* Import type Update existing and new items
Cost items and cost item attributes v Update existing items
® New items
8. Click Next.

* This takes you to the Map columns window
¢ Note that the File columns fields are set to Blank-do not import by default

9. Under File columns, click in the field on the same row as the UoM CBS column, then click
again to expand the drop-down list for that field.
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Map columns

Template | Unsaved template -
Control field Mapped File columns
WBS phase code Blank-do not import
Allow as-built Blank-do not import
CBS position Blank-do not import
UoM Blank-do not import %
Account code | Q\

Blank-do not import
Pay item assignment

CBS Position
Description

CE materials total cost

CE subcontract total cost
Cancel
uom

10. Select UOM from the drop-down list to map the UOM column in the Excel file to the UoM CBS
column.

11. Repeat the selection process to select the appropriate File columns to map to the following CBS
columns:

e CBS position

e Description

e WBS Phase Code

e Forecast (T/0O) quantity
e CE Final MHrs

¢ CE final cost
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e A green check mark indicates successful mapping of your file columns

Import CBS data - costitem import xlsx

Map columns

Template | Unsaved template - ‘ B]
Gontrol field Mapped File columns
CE equipment cost/Hr Blank-do not import a
CE equipment-Hrs/Unit Blank-do not import
CE final cost Blank-do not import
CE final MHrs v CE Final MHrs
CE final unit cost v CE final cost
CE labor cost/MHr Blank-do not import
CE Mhrs/Unit Blank-do not import

[ Cancel } [ Back ] Next

12. To save these settings for future use, click in the Template field and type Steel Structure

Template.
Map columns \
Steel Structure Template = @
Order Data type CBS columns Mapped File columns

13. Click the Save icon to save the template.

ure Template \@ @

i File columns

14. Click Next.
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e A progress bar appears informing you the import is in progress

Import CBS data - CBS Import File.xlsx

Import in progress...

e A prompt appears, indicating the project will be disabled from use during the importing
process

X

You are about to update the CBS structure. Upon commitment of import,

this project will be disabled until completion. Please note this may take
several mins.

15. Click Import now.

e A prompt appears informing you that the project is currently locked for the importing

process
This project is currently locked due to an import in
process
Upon completion, this project will enable automatically. Flease note, this may
take several minutes.
& Redirect me to the projects menu page
Page 124 of 528
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¢ Once completed, you will receive the following prompt, informing you the data imported
successfully

X

Import complete
The project has updated and is now enabled.

3.5.5 RESOLVING IMPORT ERRORS

When conducting the import, you may run into errors. This will be indicated when you attend to run
the import routine by the following prompt:

1 of 112 records contain errors

Would you like to resolve errors now or Close and continue later?

The prompt window includes a Review errors and items for import link, which you can click on to
resolve any issues prior to final import. An error resolution page opens where you can identify and
resolve your errors.
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Auditlog >

Import histery > CBS Import File.xlsx

Status Details (% CBS position)

Import status

CBS match status

1 errors remaini.

Import Columns 4

Import method

CBS position

Description

Cancel import

WBS phase code

Control User Guide

CE final
MHrs

Pending No match found, new item Add new items and upd... Bolted Connections 1000

Pending No match found, new item Add new items and upd... Module 01 - Erect Steel... 16000

Pending No match found, new item Add new items and upd... Structural Steel 0

Pending No match found, new item Add new items and upd... Structural Steel 0

Pending No match found, new item Add new items and upd... Module 001 - Erect Ste... 0

Error No match found, new item Add new items and upd.. Structural Steel [x] |
Pending No match found, new item Add new items and upd Materials 0

Pending Mo match found, new item &dd new items and nnd Frninment n

There can be situations where the cost item Excel import process will successfully process
some cost items, but fail to import other cost items. In this situation the process will
show as failed. For example, you imported 100 cost items, and 90 of the cost items
import successfully. There are 10 cost items that did not import successfully. In this
scenario you would need to resolve the import errors.

3.5.6 EXCEL IMPORT FOR COMMITTED COST

Importing committed cost mainly helps to keep track of subcontract cost items where you would have
a purchase order that would drive all of your cost.

You can import two types of committed cost:

¢ Open/Remaining Committed Cost
o Total committed cost

Open/Remaining Committed Cost is the cost you still have left to pay on the purchase order. Total
committed cost is the total purchase order amount for the purchase order.

Committed cost were previously located in different areas of Control. You can have Open and Total
committed cost columns in your CBS. The same columns are also in the Commitments tab of the Actual
Details Slideout where you can make manual edits to the committed costs. Columns in CBS for Open
and Total committed costs only reflects the manual edits you made in the Actual Details Slideout. Open
and Total committed costs are also shown in cost item details slideout cost categories tab.

You can import committed costs using the import icon on the CBS and selecting Commitment.
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s W B

Import:
precast .
Cost items
Actuals
% 36,500.00 400,
§ 25,000.00 IEﬂrr'lrnitm\erfﬂ1 300

& k0NN NN Lj M

3.5.6.2 GENERATING THE COMMITMENT COST EXCEL
SPREADSHEET

To bring in committed cost from the excel import, you first need an existing value in your CBS that
matches the Excel Spreadsheet value. This can be one of two options:

 WBS phase code
e CBS position

You will also need the Type of committed cost you want to import, either Open/Remaining Committed
Cost or Total commitment.

El - Jx Type

A B & D E F
1 |WBS phase code  Cost Category Type
2 1003 100 Undefined Open commitment
3 1003 100 Undefined Total commitment
4 1004 450 Undefined labor Open commitment
5 1004 750 Undefined labor Total commitment

Me3pa0 Open/Remaining Committed Cost and Total commitment types need to be spelled exactly
word for word as it is written in the screenshot. If you shorten any of the wording in the

Type column, the system will not accept the import and you will receive an error.
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Each Type of committed cost has to be its own line item on the Excel spreadsheet. You can do multiple
transactions for one cost item, but only one commitment type per line item. if they are different types,
you need to separate them out into different line items.

D3 =

A B
1 |WBS phase code
2 1003
3 1003
4 1003
5 1004
6 1004

C
Cost

Ir Undefined

Category
100 Undefined

100|Undefined

P

100 Undefined labor
450 Undefined labor
750 Undefined labor

E F
Type
Open commitment
Total commitment
Total commitment
Open commitment
Total commitment

Each column needs to be created and defined if you are to do a Commitment Excel Import. You must

include a Cost column and a Category column as shown in the above image.

o320 Open/Remaining Committed Cost should never be greater than your total.
Open/Remaining Committed Cost cost should either be equal or less than the Total
commitment cost.

3.5.6.3 IMPORTING COMMITMENT DATA

Follow the step by step to Import commitment data.
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IMPORT COMMITMENT COSTS

1. From Control's CBS tab, select the import icon. Then select Commitment.

s m B [

Import:

precast .
: Cost items

Actuals
$ 36,500.00 400,
¢ 25,000.00 Cnmmitmerj]_l 300

& R 0nn NN \j i

2. After you have created your Excel spreadsheet with your commitment costs, select Browse from
the Import from Excel window. Then select the Excel file name you saved.

3. After you return to the Import commitment data window, under the Options section, select the
Import type drop down arrow. If it is not already selected, select the Commitment values
option.

Options

*Import type

Commitment values v
Select one
Cost items and cost item attributes
Actuals values

Commitment values
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4. Select the Cost item matching criteria drop down and choose either WBS phase code or CBS
position.
Cost item matching criteria

WBS phase code -

WRBS phase code

CBS position @

5. After selecting the drop down options, select Next in the bottom right corner.

6. From the Map columns screen, select the columns you are importing from your Excel
spreadsheet.

Import commitment data - cBSDataBlock - 2020-12-08T121215.813.csv

Map columns

Template Unsaved template hd

Control field Mapped File columns

Tasks

CBS position nly used if
WBS phase code -
Commitments b

| SN

* Commitment type

Cost Blank-do not import
Cost categories

WBS phase code
Cost

Category

Type

7. The Control field should match the File columns. For example, Commitment type in Control field
should match Type in File columns as shown below. Once done, select Next.
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Map columns

Template Unsaved template - Ef_'l
Control field Mapped File columns
Tasks
CBS position only used if matching
WBS phase code Q¢ WBS phase code
Commitments
* Commitment type v Type
Cost v 4 Cost
Cost categories v

8. If there are no errors in the mapping stage, you should see a green check mark on the next
screen, indicating everything is ready to be imported.

Document contains no errors
5 record(s) ready for import

Select next to continue with import steps.

If you receive any errors in the mapping stage, you will receive an error with a download option
to download a word document that shows you all the errors.
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10.

Control User Guide

Import commitments CBS data: CBSDataBlock - 2020-12-08T121215.813.csv
File Import attempted on: 12/8/2020 9:04:55 PM

The following errors were detected while attempting to import commitment
values into controel.

Review the errors below, once all the errors have been resolved,
reattempt the import to Control.

Error 1: ﬂbvalid commitment type. (this error affects 2 WBS/CBS items cut
of 2 total attempted imported WBS/CBS items and 4 rows out of 4 total
attempted imported rows)

WBS: 1003
CBS: 1.3
Row: 1, 2
WBS: 1004
CBS: 1.4
Row: 3, 4

Click Next and then select Import now. This will create a line item in the Import history section
of the Audit Log tab.

From Control, go to the Audit Log tab. Then select Import history. Hover over the yellow triangle
to view the information on the pending import item.

Actions -

' ! Stat
CBES Pending .

0 of 5 line items contain errors Pe_ » @

ACS M Cont | 1 Iékl
ontnue Impor re. »@

Import history
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CBSDataBloc..

Commitment

. |
Fay items @ cance 9 Failed .. 4
) CBSDataBloc.. Commitment e Failed .. 4
Integration -
CBSDataBloc.. Commitment 9 Failed i
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\[e) 2 After the pending import is Complete, the committed costs populate in the Cost
Categories Details tab, as well as the CBS. It the costs also appear in the

Commitments tab from the Actuals Details Slideout and populates into the new
Open and Total cost committed columns.

If the imported commitment costs fail to import, the Aduit Log Import history would show that the
import failed completely.
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REVIEW

1. Which of the following is how can you identify a terminal cost item on the CBS register
page? (Select all that apply.)

a. The row is highlighted a different color
b. A symbol displays on certain cost item fields
C. The row is indented

d. The ‘Is Terminal’ column is checked

2. When moving a cost item to be above another cost item at the same level, which icon
should display when you drag and drop the cost item?

a. The one with a subordinate bar
b. The one with three equal bars

C. The one with an equal sign
d

. The one with a plus sign

3. If you make changes to your spreadsheet, you must the spreadsheet prior to
importing it into Control.

a. close
b. copy
C. save
d

. refresh

SUMMARY

As a result of this lesson, you can:

e Explain the Cost Breakdown Structure and its purpose
¢ Create, arrange and delete cost items

¢ Import cost items

Page 134 of 528 InEight Inc. | Release 25.7



Control User Guide 4.1 Cost Item Management

4.1 COST ITEM MANAGEMENT
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4.2 INEIGHT CONTROL WORKFLOW - COST
ITEM MANAGEMENT

Estimate

Historical Benchmarking

Control

Canform Estimate / WBS Structure

Progress ; .
orecastin
Account Code Measurement g

Management CBS Register

Final Hours and Costs

ACS Register Create & Manage Forecast Method Budget/Forecasts
. Cost Items Setup Quantities
Define Qty Account
Contribution Codes
Live

Analyze Planned Forecasts

Earned and Actual Forecast

WS Structure / Budgeted
Quantities & Hours

Approved changes

update Current Budget Revenue Management

I
I
Billed Revenue

Change Management r |
Change Register Pay item Register
Budget Move Create/Manage
Pay ltems
Budget
Qty/MH Analyzed Planned & Forecast Revenue
Adjustment

Contract
Adjustment Track Billed Revenue

4.3 ESTIMATE RESOURCES

InEight Control refers to labor, equipment, material, installed equipment, and supplies as resources.
You will use these resources as the basic building blocks for detailing the estimated costs which creates

your budget.

The Project library contains all resources used to estimate costs for the cost items within the CBS.

TIP Most of your CBS cost detail will import directly from InEight Estimate, but you may need
to create additional cost item detail for conforming your budget and creating change
orders.

Estimate resources in the Project library are organized into seven resource types:
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Resource Description

4.3 Estimate Resources

Labor

Construction
Equipment

Rented
Construction
Equipment

Installed
Material

Installed
Equipment

Supplies

Unique

The human resources that do the work, classified by trade (e.g., pipefitters,
electricians, iron workers).

Owned construction equipment.

Construction equipment rented from a third party.

Materials that will remain installed on site after the project is completed,
(e.g., concrete, piping, aggregate).

Equipment that will remain installed on site after the project is completed,
(e.g., boilers, heat exchangers, vessels, cooling towers).

Expendable items that will not be permanently installed (e.g., small tools,
consumables).

Resources that are of a “unique” nature and do not fit well into the other types
(e.g., dump fees, hauling charges and equipment rented by the month, and
subcontracted work).

TIP Estimate resources are the equivalent of the Resource Rate Register in InEight Estimate.

You can access the Estimate resources page from the home page slide-out menu:

1. From Menu > Control > Workspaces > Project Library and then selecting the Estimate Resources

tab.
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— {f Welcome Paul trippi

INEIGHT®

Pt Paul trippi

< Back

Training Job | Training Job

Model
Document
Schedule
Design
Estimate
Control

Workspaces
Project library

Page 1 Plan

Control User Guide
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= {3  Training Job | Training Job / Control / Project library

ESTIMATE RESOURCES REVENUE
Resource Description Default Unit Utiliza... [H]
Labor code Quanti... of count co
m... (S
BT G T O Lc1 Carpenter Apprentice 1.00  Hour 594.37
O Lc2 Carpenter Journeyman 1.00  Hour 1,188.73
Rented construction
equipment ] LC3 Carpenter Foreman 1.00  Hour 594 37

2. Another way to access Estimate Resources is from the CBS page. Highlight a line item and
hovering over the number in the Resource column for that cost item, as shown below.

« Steel Structure Training Job

Actions ¥ CBS ACS
Tasks = : B Task Details <«
CBS Description Resource Foreca
Position (TQ)
Quanti
1 Job Overhead
2 Earthwork 1 10,00
3 Concrete 1 10,00

¢ As aresult, the Resource Summary window appears, where you can select Resource
Library to open the Project library

0 3 Concrete 1 anannnn | ey annnnan s180n00n 0 ann nag
Resource Summary
O V4 Structural Steel Row # Code Description Quantity uoM Work Hrs GE-UnitCost  CF - Total Cost
O 41 Erect Steel - Heavy ]}
1 Loo1 General Labor 1 Hour 14000 50 700000
O 42 Erect Steel - Light 1
| Resource Library | (#) Assign Resource  View More.
O 43 Bolted C:
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Overview - Estimate Resources

. Resource Description

1 Resource Type The seven resource categories for organizing your resources.

2 Resource Alphanumeric label to quickly identify resources.
Code

3 Description Additional label to provide more resource detail.

4 Default The quantity the resource will have by default when it is assigned to a
Quantity cost item.

5 Unit of The unit the resource is measured by.
Measure

6 Utilization
Count

The number of units of that resource being used in the project.

7 C E-Unit Cost
(Scale 1)

The resource’s rate per unit.

8 Cost Driver Tells you what drives the cost for that resource when it is assigned to a

cost item (cost, quantity, or fixed).

9  AccountCode Code assigned to resources for accounting and benchmarking

purposes.

ESTIMATE RESOURCES REVENUE
Search
Resource Description . Default Unit Utilizati C E-unit Cost Account
code 3 =7 quantity of... on co... cost (Sca... T driver code
Labor 1
1.€.01.1.05 Laborer 0 || Hour 12381 $30.00 || €1 Duration
Construction equipment 1.C.01.1.06 Crane Operator 0 ||Hour 5100 $65.00 || CI Duration
1.C.01.1.07 Civil Operator 0 ||Hour 145454545 $65.00 || Cl Duration
Rented construction
equipment 1.C.04.1.02 [Concrete Foreman 0 ||Hour 3000 $65.00 || CI Duration
Installed material 1.C.04.1.03 Concrete Journeyman 0 ||Hour 9000 $55.00 || €l Duration
1.C.041.04 (Concrete Apprentice 0 J|Hour 9000 $45.00 || €1 Duration
Installed equipment
1.C.05.1.02 ironworker Foreman 0 ||Hour 2100 $65.00 || €I Duration
Supplies 1.C.05.1.03 Ironworker Journeyman 0 ||Hour 6300 §55.00 )} CI Duration
1.C.05.1.04 Ironworker Apprentice 0 ||Hour 6300 $45.00 || 1 Duration
Unigque
4 1.C.05.1.08 Civil Foreman 0 ||Hour 104727272 $65.00 || Cl Duration
1.C.05.1.09 Civil Journeyman 0 ||Hour 1454 54545 § 57.50 || Cl Duration
1.€.05.1.23 Civil Apprentice 0 [|Hour 218181818 $45.00 || I Duration
LO01 General Labor 0 ||Hour 0 $50.00 || €I Duration

You can add additional estimate resources to the library by selecting the Add estimate resource icon.
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®

Labor

4.3 Estimate Resources

Tag1

User defined 1

User defined 4

User defined 7

User defined 10

Cl Duration

Tag2

User defined 2

User defined 5

User defined 8

* Productivity Factor

1

Employed Cost Item

Tag 3

User defined 3

User defined 6

User defined 9

= Default Quantity

0

Cancel

ESTIMATE RESOURCES REVENUE
i Resou Description Non-hourly
rce charg...
code
¢ The Add labor estimate resource screen opens.
-
= X
Add labor estimate resource
= Code + Description 1000
SETUP RESOURCE RATES

Account code * Cost driver = Cost curve a

To add a resource to the correct resource type, make sure you are on the appropriate resource type
tab (Labor, Construction Equipment, etc.) before clicking on the Add icon.
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Labor

Construction equipment

Rented construction
equipment

Installed matenal

Installed equipment

supplies

Unique

4.3.1 RESOURCE BILLABLE RATES

Within the Resource Rates tab, you can import, modify and add billable rates to estimate resources.
This is particularly helpful on time and material or cost plus contracts to drive accurate invoicing.

Resource billing rates are also used for Forecast final revenue, as it will rely on the billing rates of the
resources on the cost items that are assigned to pay items. These values generate revenue forecast for
cost items that are associated to a cost plus or time & material (billing method) pay item.

Page 142 of 528 InEight Inc. | Release 25.7



Control User Guide 4.3 Estimate Resources

Add labor estimate resource

* Code » Description 99:
I
Lab001-PB Welder
SETUP RESOURCE RATES
Allowance $0.00 $0.00 $000 a
G&A $0.00 $0.00 $0.00
Undefined $0.00 $0.00 $0.00
Billing rate $50.00 $0.00 $0.00
Billing rate markup $0.00 $0.00 $0.00
Billing rate markup % 0.00% 0.00% 0.00%

CREATE A LABOR RESOURCE

1. In the Steel Structure Training Job, select Menu > Control > Workspaces and make sure you are
on the CBS tab.

2. Hover over the number under the Resource column of the Task Details data block for a
subordinate cost item.

3. Select Resource Library from the Resource summary window.
4. With the Labor resource type selected, click on the Addestimate resource icon.
Fill in the blanks with the following:
e Code: Lab001-XX (XX your initials)
e Description: Welder
Scroll down to Default Quantity and change the value from 0 to 1.
Select the Resource Rates tab.

Select the Labor cost category and type 50.00 in the Scale 1 unit cost.

© o N o

Scroll down to the Resource Rates and enter in values for the following Billing Rates:
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e Scalel
e Scale 2
e Scale 3

1. Click Add to add the new resource to the register of estimated resources.

Now that you have created a resource, you will add this resource to the Erect Steel — Heavy cost item
in your Project.

ADD RESOURCE TO JOB

From the Steel Structural Training Job, make sure you are in the CBS.
Right click on your subordinate cost item.

Select Cost item details.

Select the Resources tab.

Select Add estimate resource.

Click Add.

S o

4.4 COST ITEM DETAILS

The cost item detail slide out panel contains many different fields to edit and enter cost item-related
information. To access this screen, select the cost item and right-click to open the menu. Select Cost
item details. There are four tabs to select from:

e Details tab

Attributes tab

Cost Categories tab

Current Estimate Resources

Forecast Resources tab

CURRENT ESTIMATE

DETAILS ATTRIBUTES COST CATEGORIES RESOURCES

FORECAST RESOURCES
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4.4 Cost Item Details

Al = All editable cells in the cost item detail slide-out panel are single click.

4.4.1 DETAILS TAB

The Details tab contains the values and settings related to the cost detail of the item.

COST CATEGORIES

1069
Earthwork

DETAILS ATTRIBUTES
Forecast T/0 qty UoM CE unit cost
10,000.00 cY 5 40.00
Last changed on Last changed by

06/08/2022 09:53 AM

Description

Earthwork

* Forecast T/0 gty

CE total cost

CE total MHrs

CE MHr/Unit

« Allow as-built

All

+ Quantity driver

Service Account

10,000.00

Pay item contribute gty

Below is an explanation of some of the key settings on the Details tab.

InEight Inc. | Release 25.7

Account code

51

*UoM
cY

CE unit cost

CE total equipment Hrs

CE Units/MHrs

Pay item assignment

001

CBS contribute gty

CE total cost

$400,000.00

CURRENT ESTIMATE

| Hide in plan/Progress

RESOURCES FORECAST RESOURCES
CBS position
2
* Cost source
Detail -
| As-built lock
2 Live forecast method
Current estimate -
CE labor cost/MHrs
* Cost segment
Direct Cost -
* Currency
w
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Cost source

Live
Forecast
method

Cost
segment

Allow as-
built

Quantity
driver

Cost item
contribute

quantity

Pay item
contribute

Page 146 of 528

Indicates how costs are entered on the cost item.

¢ Detail - Resources and duration defined to determine costs
 Plug - Unit and total costs entered at the cost category level

Determines the Forecast Method for the cost item. (See Lesson 9 - Forecasting
for more Forecast Method details).

Categorizes whether the cost item is a direct or indirect cost.

» Direct Cost - costs that directly pertain to the deliverables (pay items) of
the job

» Job Overhead - Overhead costs associated with running and managing
the job (e.g., management, jobsite facilities)

» Business Overhead - Overhead costs associated with running the
business (not directly related to running the job)

» Subcontract - subcontract associated costs

Determines whether you can enter actual costs and quantities for a cost item.

* None - Cost item does not accept cost or quantities. This is typically seen
in Superior cost items

» All - Allows a cost item to accept both direct costs and quantities

» Quantities - Cost item only accepts quantities

» Cost - Cost item only accepts costs, man hours, and equipment hours.

Superior cost item will have the Forecast T/O qty update when the superior cost
item (parent cost item) receives an update. The change to the qty will be the
original value multiplied by the same multiplier that was applied to the superior
cost item.

For example: if the superior cost item qty doubles, the item with Superior CI will
double as well. Cost items with Fixed as the selection will not be affected by
changes to the parent cost item.

Checked cost items will have the Forecast T/O qty roll-up to the parent cost
item if the UoM on both of the items are the same.

Checking this box lets you choose which cost items contribute to the Pay item's
forecast (T/O) quantity and can affect earnings rules for the associated pay
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quantity item. This field is only visible if you have the Enable Pay item Forecast (T/O)
quantity rollups setting turned on in Settings > Control > Revenue.

4.4.1.1 PAY ITEM CONTRIBUTE QUANTITY

The Pay item contribute gty function works only when the Pay item Forecast (T/O) gty rollups toggle is
set to On in Settings > Control > Revenue. If you have a unit price pay item, its forecast (T/O) quantity
is the sum of all the contributing cost items forecast (T/O) quantities.

This function lets you define which cost items roll up their quantities to a pay ite

PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENLIE
- Unit price
Earnings amounts based on:
(® Forecast (T/0Q) gty
e ) CE total cost
Pay item Forecast (T/0) qty rollups
= Enahle pay item Forecast {T,-"D} qty mllups @ Urit price pay rtem Forecast (T/0) quantriies wall
e rollup based on contributing cost items’ Forecast
@ (T/0) quantities

In the CBS, you can quickly modify the pay item contribute quantity either in bulk or by selecting a
single cost item.
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Multiple cost items selected
Tasks P
O

< CBS De.. = ITES £ e CURRENT ESTIMATE
= " R y E E
position DETAILS ATTRIBUTES COST CATEGORIES RESOURCES

v 3 Mige | Last changed on Last changed by

05/23/2022 11:49 PM rakesh gunda-ptri@inei.
v 3 Misc. |
v 316 B/C 8€

Description Account code + Cost source
O 3161 8888( (Varies) Detail
O 3162 B888C  «Forecast T/Oqty *UoM
— 1.00000000000 PLS - | As-built lock
L 3163 8888C Ll
0O 3164 Bowar  CEtotalcost CE unit eost 2 Live foreca
- Rollup
Ll 3165

CE total MHrs CE total equipment Hrs CE labor cost/MHrs

CE MHr/Unit CE Units/MHrs * Cost segment

(Varies)
+ Allow as-built Pay rtem assignment + Currency
- 2 CAD
* Quantity driver
Superior CI - || cBS contribute qty | Hide in plan/Progress

7 F'é‘vy item contribute qry

Selecting the Pay item contribute qty check box updates both the Current forecast (T/O) and the
Update earning rules, only if Earnings rules are set to calculate based on Forecast (T/O) qty value in Pay
items.
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Payitem B Bescrgtion
z 2
Ealculats saming amaunts ky:

) Farecast (T/0) gty
{_) CE iofal cost

£BE Pasition Bescript_. Py item Enaming %
contrib. ..
e
3 Misc. Rev Exte. -] 500000000000 %
a Misc. Rev Exte 000000000000 %
RN B/C 0208 Dzle. 000000000000 %
3165 0.00000000000 %
RN B3BE OslerLa.. :| 15.00000000000 %
3164 Bowen Island .. 000000000000 %
3162 BEHE Osler Eq. o DO00U0GI0000 %
3163 B888 Osler 3rd m] 000000000000 %

20.00000000000 &

] Default Earming Aules

Deselecting the Pay item contribute gty check box in the CBS also updates both the Current forecast
(T/0) and the Update earning rules.

Py itemn 1Dy Deacrption
2 2

Cabeulite pnrmang mmointa by
@ Forecast (T/0) gty

() CE total cost
C83 Position Descript.. Py item Eaming %

conlad...

quandity
1 Mize. e Exte i} 500000000000 %
11 Mise. Few Exte. a 000000000000 %
116 B/C 8680 Dle.. | 000000000000 %
ERE 000000000000 %
3161 BG36 Daler La.. o 1500000000000 %
3164 Bawen Island . 000060000000 %
ERE 4556 Dsler Eq. a 0.00IC0000000 %
3163 B850 Osler 3nd O 0000CA00H000 %

2000000000000 %

[ Default Eaming Rules

4.4.2 ATTRIBUTES TAB

The Attributes tab allows you to tag the new cost item with user-defined entries.
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1. User-Defined Fields —free text fields that you can type values into manually

2. Tags — Many of these fields are validated fields (known as tags), meaning you can choose from
options in a drop-down list

1074
Erect Steel - Heavy

CBStag 16

CBStag 19

CBS tag 22

CBS tag 25

CB

@

user defined 3

DETAILS

CB

©

user defined 6

ATTRIBUTES

GBS user defined 9

CB

@

user defined 12

CB

©

user defined 15

CBS tag 17

CBS tag 20

CBS tag 23

CBS user defined 1

CBS user defined 4

CBS user defined 7

CBS user defined 10

CBS user defined 13

COST CATEGORIES

RESOURCES

C8s tag 18

Hand Place
Machine Finish

Other

Cut Off Pile

Splice Pile

Shoulder Barrier - Walls

@ R

Clear

CBS user defined 8

CBS user defined 11

CBS user defined 14

Some of these tags and their drop-down values are defined at the organizational level and others are

customizable via the Project Settings under the Configure tag list value.

4.4.3 COST CATEGORIES TAB

The Cost Categories tab allows you to view your current budget, actuals, live forecast and forecast

remaining cost, broken down into more detailed cost categories (e.g., labor, construction equipment,
supplies, materials, etc.).

The header in the Cost Categories tab shows the % Complete, Live forecast method, and the Latest

actuals in forecast values.
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DETAILS

% Complete * Live forecast method

297777777778 % Committed cost

TOTAL PER UNIT

Cost category Current budget Total cost (to date) Current estimate * Live forecas % Forecast remaini
~ Total $100.00000 $30,565.15556 $100.00000 $ 3156515556

v Labor $0.00000 $ 44,111.00000 § 0.00000 $ 45,111.00000

~ Construction $0.4477 $0.02304 S0.40477 $0.02304

~ FOM Rented $0.04148 $0.00230 $0.04148 $0.00230

v Supplies $0.00000 ($ 14,000.00000) $ 0.00000 ($ 14,000.00000)

~ Materials $0.00000 ($ 51.40000) $ 0.00000 ($ 51.40000)

~ Subcontract $0.00000 $ 0.00000 $ 0.00000 $ 0.00000

v Fees $99.54376 $5.53021 $99.54376 $5.53021

ATTRIBUTES COST CATEGORIES

Latest actuals in forecast
values

O 08/21/2020

4.4 Cost Item Details

RESOURCES

$1,000,00000
$1,000,00000
$0.00000
$0.00000
$0.00000
$0.00000
$0.00000
$0.00000

If you have the correct permissions, you can change the Live forecast method. You can also change the

view of the Cost Categories values to show either Total or Per Unit cost.

1004
Peimilsss
DETAILS ATTHIBUTES COST CATEGORIES
% Complete ' Lailesl seluals i Morecast
valuas
20T TITITITIR % Commifted cast - O 08/21/1020
Current budged
= TOTAL PER LINIT
Cusrent estimate
Cast catagary tal cost (1o data) Curnrant ectimats W Liv
AvVErage Fl:”%ﬂl'lﬂ'
# Tatal iz - 5 30 BAE 16554 £ 100 00000 % 31 B&E 185656
~ Labor S 117 DE0 5 00C EL MO
Labo Comemnitted cost 544117 0000 % 000000 5 45.111.00000
" Mnnchnieting & i AN & i A1H77 2 it 1S

This is also where you enter the estimated cost into the different cost categories for the plug cost

source.

You can expand the labor category and enter your cost at the appropriate level (e.g., Labor Base

wages). You need to enter the cost under the appropriate level of the category. For example, if you
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enter the cost at the Labor category level, the cost will appear in Undefined Labor level because you
did not enter it at a specific sub-category level.

DETAILS ATTRIBUTES COST CATEGORIES RESOURCES
Cost category Gurrent Budget Total Gost (To Date)  Gurrent Estimate
4 Total $800,000.00 $0.00 $800,000.00 $800,000.00 $800,000.00 A
4 Labor $800,000.00 $0.00 $800,000.00 $800,000.00 $800,000.00
Labor Base $800,000.00 $0.00 $800,000.00 $800,000.00 $800,000.00
¥ Labor Burden 50.00 50.00 §0.00 50.00 $0.00
Undefined Labor Undefined Labor $0.00 $0.00 $0.00 $0.00
¥ Construction Equipment $0.00 5$0.00 5000 $0.00 5000

The following Step by Step walks you through adding costs to the Cost Categories tab of the Cost item
details slide out panel.

ENTER COSTS IN COST CATEGORIES

Within the InEight Control main page, on the CBS tab, right click on the cost item you created.
Select Cost Item Details to open the Cost item details slide out panel.
Click on the Cost Categories sub tab.

Under the Current Estimate column, expand the Labor cost category.

a K~ w0 N o=

In the Current Estimate column, enter a value in the Current Estimate column for Labor Base,
then press the Tab key.

4.4.4 CURRENT ESTIMATE RESOURCES TAB

The Current Estimate Resources tab is where you can view and manage the CE resources for terminal
cost items.

From the Current Estimate Resources tab you can view and manage:

e Cost item details
e Current estimate resources

¢ Productivity and overall settings
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e Resource details

CURRENT ESTIMATE

4.4 Cost Item Details

DETAILS ATTRIBUTES COST CATEGORIES RESOURCES FORECAST RESOURCES
Cost item details ~
Forecast T/O gty UoM CE total cost CE remaining cost CBS position Cost source
10,000.00 cY $ 1,000,000.00 $ 1,000,000.00 52 Detail o
Current estimate resources A
Row # Code Description Quantity UoM Waoark CE unit
hours cost
1 C01.04 Concrete Bulk Commodities | 10000 CY 0 -
Productivity and overall settings ~
Remaining  Total
Remaining hours Remaining units/hour Remaining hours/unit
Remaining man hours Remaining units/man hour Remaining man hours/unit
Resource details ~
Rem:
C01.04
Concrete Bulk Commodities
‘When
@ Cost category Amount
O
~ Total $100.00
Billing rate $100.00
Billing rate markup 5000
Billing rate markup % 0.00 %
Charge rate $100.00
Markup amount $0.00
Markup % 0.00 %
[ 3
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1012 To see atotal sum of the resources in Current estimate resources, you must have the
Cost Source set to Detail.

- - c CURRENT ESTIMATE .

DETAILS ATTRIBUTES COST CATEGORIES HESOURCES FORECAST RESOURCES
Cost item details A

Forecast T/0 gty UoM CE total cost CE remaining cost CBS position Cost source
_ ‘ ‘ - i

200.00 on $800,000.00 $800,000.00 . Detail .
Current estimate resources Plug w
Productivity and overall settings ~
Resource details w~

o= When the cost item’s cost source is set to Plug, you will not use the Current Estimate
Resources tab. Instead, costs are “plugged” or entered directly into cost categories on the
Cost Categories tab of the cost item.

4.4.4.2 COST DRIVER

Each type of resource has a default cost driver. For example, Labor resources are duration driven so
their default cost driver is Cl Duration, meaning their costs are driven by the duration of the cost item.
If you want a resource to only be assigned to a specific cost item or work activity for half the time, you
can change its quantity to .5 and it will be driven by half of the cost item’s hours.
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X
1005
Erect Steel - Light
- CURRENT ESTIMATE -
DETAILS ATTRIBUTES COST CATEGORIES RESOURCES FORECAST RESOURCES
Cost item details A
Forecast T/0 gty UoM CE total cost CE remaining cost CBS position Cost source
200.00 Ton 5 155,000.00 $155,000.00 42 Detail o
Current estimate resources ~
Row # Code Description Quantity UoM Waork CE unit
hours cost
O 1 1.C.01.1.08 Laborer 2 Each 800
O 2 1.C051.04 Ironworker Appremice 0.5 |Each 200
O 3 1.C.01.1.06 Crane Operator 1 Each 400
O 4 1.C05103 Ironworker Journeyman 3 Each 1200
(] 5 1.C.05.1.02 Ironworker Foreman 1 Each 400
3

Jlelg 2 Updating the total quantity of a resource with Cl quantity as the cost driver will not auto-
update the hours.

To enter work hours manually for the employed resource, you can change the Cost Driver option to CI
Quantity or Fixed.
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DETAILS

Cost item details

Forecast T/O gty UoM
800.00 on

Current estimate resources

® ®

Row # Code

]

4]

1.C.05.1.04

ra

1.C.05.1.02

1.C.05.1.03

3%}

.

1.C.01.1.05

o

1.C.01.1.06

ATTRIBUTES

CE total cost

% 800,000.00

Description

Ironworker Apprentice
Ironworker Foreman
Ironworker Journeyman
Labarer

Crane Operator

COST CATEGORIES

CURRENT ESTIMATE
RESOURCES

Control User Guide

FORECAST RESOURCES

CE remaining cost CBS position Cost source
)0 41
$ 800,000.00 . Detail "
Fa%
CE total Cost Cost
cost driver curve
45.00 $ 216,000.00 Employed Cos.. |
65.00 $104,000.00 - Employed Cos...
55.00 $ 264,000.00 ™ Employed Cos..
35.00 $112,000.00 Cl Duration Employed Cos...
65.00 5104,000.00 - . Employed Cos...
Cl Quantity
Fixed
1 2

ey g= If you change the Cost Driver to Cl Quantity, the fields below will not be editable. It
causes the adjusted duration to become zero or read-only. However, it can be editable if

it does make a cost impact.

With CI Quantity as your cost driver for your resources, you can adjust the Work Hours manually,

where previously that column was read-only. For example, perhaps you want your Laborer to work
specifically 80 hours. The Forecast (T/O) Qty is very significant when it comes to quantity driven

resources. It determines how the cost is driven and what affects the cost of that specific line item.

For example, perhaps there is a scope change and you need to change the Forecast (T/O) Qty from 900

to 350.
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1074
Erect Steel - Heavy
DETAILS ATTRIBUTES

Forecast T/0 qty UoM CE unit cost
900.00 Ton $1,000.00
Last changed on Last changed by
07/02/2025 06:51 AM Toby Stow

Description Account code

Erect Steel - Heavy 62.03.02.0C
= Forecast T/0 gty = UoM
900.00 Ton

4.4 Cost Item Details

A dialog box shows to choose whether it will affect the CE unit cost or CE total cost. Typically, you keep

the unit cost constant and adjust the total cost.

Proportionally adjust CE unit cost or CE total cost

?

‘You can modify Forecast T/0 gty by propertionally adjusting CE unit cost or CE total

cost. Specify the value you would like to modify:

(O CE unit cost

(®) CE total cost

Note that the Welder’s work hours adjust because they are driven by the Forecast (T/O) quantity of the

cost item.

When the Cost Driver is set on Fixed, you can only update the resource’s hours by typing into the
resource itself and updating the work hours directly.

Many of the numbers are tied to equations under the Productivity resources below. If you edit the
numbers, it will have an impact on the resources depending on the cost driver.
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4.4.5 FORECAST RESOURCES TAB

The Forecast Resources tab is where you can view and manage estimate resources assigned to a cost

item.

From the Resources tab you can view and manage the:

e Forecast details live forecast method

¢ Add new resources and adjust duration-driven resources by changing their productivity

e View and adjust resource rates of assigned resources

DETAILS ATTRIBUTES

COST CATEGORIES

CURRENT ESTIMATE

f -
RESOURCES FORECAST RESOURCES

Forecast details

Forecast total cost Forecast remaining cost

Forecast total MHrs

Forecast remaining MHrs

i Live forecast method

$0.00 $0.00 0.00 0.00 Manual (ETC) ~
Resources ~
® ®
Row # Code Description Estim... Remaini... uoM Remaini..
O qty work hrs
1 1.C01.1.05 Laborer Labor 0.00 Hour
0O
Productivity and overall settings ~
Remaining hours Remaining units/hour Remaining hours/unit
0.00 0.00 0.00
Remaining man hours Remaining units/man hour Remaining man hours/unit
0.00 0.00 0.00
Remaining equipment hours Remaining units/equipment hour Remaining equipment hours/unit
0.00 oo oo
Resource details A
When 1
@r Cost category Scale 1 unit cost Scale 2 unit cost Scale 3 unit cost
~ Total $35.00 530,00 $40.00

Like the Details, Attributes, and Cost Categories tabs, you access the Forecast Resources tab from the

Cost Item Details slide out panel.
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Tasks
+ CBS Description WBS phase
m] position code
m} 1 Job Overhead 1002
O 2 Earthwark 1069
] 1071
Copy >
] 1073
iy 1074
=] 1005
] s 1006
[m] (®) New costitem 1084
] 1085
(¥) New subordinate cost item
] 1086
=] () Delete cost items(s) 1087
] 1088

L Adjust CBS position

[# Costitem details

Actuals details

[

1074
Erect Steel - Heavy

DETAILS

Forecast T/0 aty

80000

Last changed on

02/22/2022 0217 PM

Description

Erect Steel - Heavy

= Forecast T/0 gty

CE total cost

CE total MHrs

ATTRIBUTES COST CATEGORIES
UoM CE unit cast CE total cost
Ton $1,000.00 $800,000.00
Last changed by

Service Account

200.00

Account code

£2.03.02.004.06

=UoM

Ton

CE unit cost

CE total equipment Hrs

4.4 Cost Item Details

X

FORECAST RESOURCES

CURRENT ESTIMATE
RESQURCES

CBS position

41

* Cost source

Detail hd

7| As-built lock

ecast method

Manual (ETC) -

CE labor cost/MHrs

The Forecast Resources tab shows as an accordion menu where you can select a specific drop down

menu you want to view.

CURRENT ESTIMATE

DETAILS ATTRIBUTES COST CATEGORIES RESOURCES FORECAST RESOURCES
Forecast details ~
Resources A
Row # Code Description Estim... Remaini... uom Remaini...
O work hrs
1 1.C01.1.05 Laborer Labor 0.00 Hour
(] 2 1.C.01.1.06 Crane Operator Labaor 0.00 Haour
3
Productivity and overall settings v
Resource details v

4.4.5.3 PRODUCTIVITY AND OVERALL SETTINGS

If the resource’s cost driver is set to Cl Duration, you can change any of the values on the Productivity

tab under Adjusting duration driven resources below, and it will change the work hours of your

resources without you having to do the math yourself.
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CURRENT ESTIMATE

COST CATEGORIES RESOURCES FORECAST RESOURCES
Cost item details v
Current estimate resources w
Productivity and overall settings ~
Remaining  Total
Remaining hours Remaining units/hour Remaining hours/unit
1,600.00 0.50 2.00
Remaining man hours Remaining units/man hour Remaining man hours/unit
16,000.00 0.05 20.00
Remaining equipment hours Remaining units/equipment hour Remaining equipment hours/unit
When updating the quantity of duration driven labor resources
@® Proportionally update Units\Man hours
O Proportionally update Hours
Resource details v

4.4.5.4 RESOURCE DE

TAILS

Resource Details shows the unit cost category breakdown of the selected resource listed above. The
Resource rates tab expands to a unit breakdown on a selected item under resources. It is fully editable
if you have the right permissions to do so.
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Resource details

~

1.C.05.1.04

Ironworker Apprentice

Cost category Scale 1 unit cost Scale 2 unit cost Scale 3 unit cost

~ Total $45.00 54500 $60.00
~  Labor 545.00 $45.00 $60.00
~  Construction Equipment $0.00 5000 50.00
*  FOM Rented Equipment $0.00 5000 50.00
~  Supplies $0.00 5000 50.00
~  Materials $0.00 5000 50.00
~  Subcontract $0.00 5000 50.00

~ORPHAN INDICATOR

If you change the resource rate of one of the assigned resources, then a triangle will appear. The

triangle is an orphan indicator. This means a value associated with this resource does not match the

resource’s value in the Estimated resources in the Project library. When you hover over the triangle, it

will give you a summary of all the differences between the library value and the orphaned value.

Attribute

Most recent change in this item

Library value

Total - Scalel 50.00
FOM Rented Equipm...  0.00

Undefined FOM Rent...  0.00

Orphan value

100.00

50.00

50.00

Last changed by

Susan Cappelloni
Susan Cappelloni

Susan Cappelloni

2 Lab0ol

Last changed on

09/25/2017 02:24 PM

09/25/2017 02:24 PM

09/25/2017 02:24 PM

Welder
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Row # Code Description Quantity uoM Work CE - Unit CE - Tota
Hours Cost Cost [

2 | lab1 lab1 1 Each we 60.00 10

% 3 lab1 lab1 1 Each 4167 $60.00 515

(*) Add estimate resource

PRODUCTIVITY 2
Unit cost charge rates

CHARGE RATE

Cost category Scale 1 unit cost Scale 2 unit cost Scale 3 unit cost

4 Total $70.00 & $0.00 $0.00

» Labor $0.00 $0.00 50.00

This is shown in case you want to change the values back to match the library. If you change the values
back to match the library, the triangle will disappear.

4.4.5.5 COST ITEM MAN-HOURS

Aside from on the Cost Estimate Resources tab, you can also define productivity on the CBS register
page. The following steps walk you through how to add the planned man-hours for a cost item from
the CBS register page.

DEFINE COST ITEM MAN-HOURS

1. On your CBS register tab, make sure the Current estimate data block is displayed on the page, by
selecting the CE + CB viewset.

View: [cevce | T O

Cost categories
Forecasts
Project controls

=2

- Live forecast

CE Units/MH rcondary UON
Unsaved (Progress)

2. Under the CE Total MHrs column, enter 16,000 for a cost item, then press the Tab key. Note — If
the cost item is a “detail” cost source you will not be able to manually adjust this field.
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~ Steel Structure Training Job

Actions v CBS

PAY ITEMS

CHANGE REGISTER

4.4 Cost Item Details

AUDITLOG

Task Details < ===+ > ¢ B Current estimate

CBS Description Resource
O Position

O 3 Concrete 1

O T4 Structural Steel

O 41 Erect Steel - Heavy 1

— in J

Forecast

(T9)

Quantity

10,000.00

1,000.00

800.00

CE total MHrs

30,000 00

20,000 00

16,000 00

4.4.6 ISSUE TAGGING IN THE CBS

CE total cost

$1,500,000.00

$1,050,000.00

$800,000.00

You can associate an issue to a cost item in the CBS. Issue Ids in Change have a hierarchy of issues and

subordinate issues. Associated an issue to a cost item applies to parent-level issues. Child issues take

on the cost item of the parent issue.

CBsS
Actions = @ I_‘_I'. ®
A 4
Tasks
% CBS position Description WBS phase
| code
L 30 1785
3 1790
‘_h 32 Cost item 1 up
33 Cost item 2
34 X
35 Detail - labor
| 36 Detail - CE
37 Detail - other
kl:} Detail - mix
39 Plug
40 plug2
4 Cost item 1 n
A2 Cost item 2 02
43 Costitem 3 03
L A4 Cost item 4 04
45

Subtotals 804 (1 rows selected)

Last estimated
actual man
hours reversal

04/06/2021 1:18:

PAY ITEMS CHANGE REGISTER
Formula description: Document
issue: N/A 1
s e
Last estimated Issue & ce
actual equip

hours reversal

03/29/2021 3:08:7

When you click in the Issue column, the Assign issue dialog box is shown. The list of issues originates

from the list of the issues in Change.
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Assign issue

Select  Issue
id

Issue name

newS_copy6 T

w5

Cancel

Control User Guide

X

el g= The Assign issue dialog box does not contain the full list of Issues that Change contains.
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i - Change +
sse
®
lssue ID PCOID Client CO 1D Issue name

U A 11 G Testing 2/1 02n17
Ll 122 G Testing 2/1 o2n7
O 121 G Testing 2/1.. | 0217
Ll 118 newt (B) 11/05
(| 114A newt (Qriginal). | 11/05
O A~ 10 news 11/05/
O 101 newé 11/05
L 9 newl newsc). 1/04
0 ~ B news 1/04

ISSUE LOG

4.5 Lock Budget

POTENTIAL CO
LOG

Issue start date

2021

2021

2020

2020

2020

2020

Issue stat._. Assig
Open
New
New
New
New
Open
New
F

Executed )

"

Open

If a parent issue in Change becomes a subordinate while you already have that issue assigned to a cost

item in the CBS, the cost item then changes Issue ID to match the parent item that the linked issue was

then relocated under. For example, if the parent issue ID was a 2 in Change and it was moved under
the parent issue ID 1, then the cost item previously linked to the parent 2 changes to the parent issue

1.

4.5 LOCK BUDGET

4.5.1 BUDGETS VS ESTIMATE

You can maintain an Original Budget, a Current Budget, and a Current Estimate, as is shown from the

CBS tab of the Control main page, using a custom data block.
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Tasks : [ TaskDet. < «eee> : [ BM Budget View <>
cas Descrition was Foreca uoM 0 5-Total Cost C B-Total Cost C E-Final Cost
Position Phase stTO
Code Gty

Job Overhead H 1002 100 Lump Su }} $250,000.00 $250,000.00 $250,000.00
Earthwiork H 1069  10000.0. C¥ u $400,000.00 $400,001.00 $400,000.00
Concrata 1071 10,000.0 cv¥ $0.00 $8000.00 $5,000.00
Cancrete Footings 1088 100000 CY $0.00 $8,000.00 $5,000.00
Place/Strip Footing Forms i 100 50000 SF i $0.00 $8000.00 $5,000.00
Pour Faotings o 000 cY ! $0.00 $0.00 5000

4.5.1.1 ORIGINAL BUDGET

The Original Budget (OB) is a snapshot of the project plan in its original state, prior to execution. Itis a
baseline used for comparison as the project progresses. You cannot edit your Original Budget values;
they are read-only in the CBS register, available for reference only.

Once set, the Original Budget never changes.

In the CBS register, you can find the OB values for man-hours, quantities, and costs.

TaskDet.. € ssss> i ll BM Budget View <o

cas Deseription S Foreca uoM 0B-Total Cost Descr. Original Budget C B-Total Cost C E-Final Cost
Position Phase stTO Total Cost Formula
Code aty
Job Overhaad H 1002 100 LumpSu H $250,000.00 $250,000.00 $250,000.00
Earthvrark i 10e2 1oooop.  ov i $400,000.00 $400,001.00 $400,000.00
Conerete 1071 100000, CY $0.00 $8,000.00 $5,000.00
Concrete Footings 1088 100000 CY $0.00 $2,000.00 $5,000.00

4.5.1.2 CURRENT BUDGET

The Current Budget (CB) is the project’s operational budget, including only project changes approved
through a controlled process. The Current Budget is therefore the sum of your Original Budget, plus or
minus any approved changes.

TIP See the Change Management section for more details on managing and approving

budget changes.

In the CBS register, you can find CB values for planned, earned and forecasted costs, hours and
productivity.
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cas Description wes Foreca =] 0 B-Total Cost € B-Total Cost Descr: Currant Budget C E-Final Cost
Position Phase SETO Total Cast Formula
Code aty Nis
Job Overhead i 10z 100 Lump Su 1 $250,000.00 §2R0000.00 $250,000.00
Earthwiark :} 1068 100000,  CY }: $400,000.00 S400,007.00 $400,000.00
Concrete 1071 100000 CY $0.00 $8,000.00 $5,000.00
Concrete Faotings 1083 100000 CY $0.00 $8000.00 $5,000.00
Place/Strip Footing Farms :} 1090 50000 SF }: 50,00 $8,000.00 $5,000.00
Pour Footings I qom ooo cY I $0.00 $0.00 S0.00

4.5.1.3 CURRENT ESTIMATE

The Current Estimate (CE) represents the most up to date estimate of your work. You can update your
Current Estimate quantities, hours, and costs at any time in the CBS register, with no required approval
process or work flow.

You can use the Current Estimate as a sand box to build out change orders and do what-if analysis to
plan for potential changes, without worrying about affecting the Current or Original Budgets.

8BS Descrintion Was Foreca UoM 0 B-Total Gost ¢ B-Total Gost CE-Final Cost _ Deser: Current
Pasition Phase StTO Estimat Final Cost
Coda aty Formula: /A
Job Cverhead i o0z 100 LumpSu i §250,000.00 §250,000.00 §250000.00
Earthwaork i 1083 0pooo.  cv ! §400,000.00 §400,001.00 8400,000.00
Concrete 1071 10,0000 [ $0.00 $8,000.00 $5,000.00
Concrete Footings 1089 100000 CY $0.00 $2,000.00 $5,000.00
Place/Strip Footing Farms H 1090 50000  SF u $0.00 $6,000.00 $5,000.00
Pour Footings H 1091 000 oy ! $0.00 $0.00 $0.00

Jleag = All editable cells in the Current Estimate CBS grid are single click.

4.5.2 LOCK BUDGET AND PRICE

When you first create your project, your cost breakdown structure is unlocked, meaning you can make
changes to your current estimate, but there is no locked down budget for tracking purposes. Your
Original Budget and Current Budget data blocks therefore contains no values.
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Steel Structure Job (Do not Use) (10509.. - Conliol ¥ Workspaces

ces - ACS PAY ITEMS CHANGE REGISTE View CEv+CB -

Actions ® 9 § &L ¥V g2 O ® 1= Q
The budget is unlocked and only Current estimate can be modified. Click to Lock budget Dismiss

__ CBS position Description Units/MHr CE final unit Secondary CB total CE total MHrs CB total cost C8 MHrs/Unit
Ll cost UoM quantsty
U 1 Job Overhead 000 $ 250.000.00 ~
0 2 Larthwork 125 54000
(m) 3 Concrete 033 $150.00
O 4 Stuctural Steel 01z $3M.14

Locking your budget creates an Original and Current Budget based on your Current Estimate values.
Keep in mind that:

¢ Your Original Budget cannot change

e Your Current Budget can only change via approved change orders (see Lesson 7 — Change
Management)

e During project execution, you can compare your actual costs and man-hours to your Original and
Current Budgets to track you progress

In the CBS you can lock the budget by selecting Actions > Lock/unlock budget > Lock Budget or Lock
project budget and price.

cBS - ACS PAY ITEMS CHANGE REGISTER AUDIT LOG View : | Forecasts

s~ @ [ ® O §$ & v o F P
The budget is unlocked and only Current estimate can be modified. Click tq Lock budget

Global forecast method.

Set forecast method Description
{ Task details I LT & [ Forecast | created from Live forec.. * = (o0 >

Time phased forecasting

: Resource Forecast (T/0) UoM Forecast final Forecast final Forecast final Forecast final
metal bracing quantity man Frodm:tlvlty
; Claim muttple CBS quantities hours/Unit actor
16 1.00 Lump Sum $695.00 11.00 11.00 0.00

Budget move and contract adjustment b

! Lock/unlock budget R 5 10,000.00 CY $ 400,000.00 8,000.00 0.80 0.00
Lock budget
syne N 6 10,000.00 CY $1,500,000.00 30,000.00 3.00 0.00

Unlock budget

Reverse estimated actuals

Lock project budget and price

The Budget Lock Status columns then changes to a locked symbol.
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Pay item Description Current Price

OJ number forecast lock
(T/0) qty status
O 001 Earthwork - Lab... 1.00 -
OJ 002 Concrete - Lab... 1.00 ™
OJ 003 Steel - Labor & 1.00 ™

In Pay Items, you can also lock your price and budget for pay items by selecting Actions > Lock/unlock
price>Lock Price or Lock project budget and price.

Actions ¥ @ @

Lock/unlock price b
Lock price
Lock/unlock price :
Sync 4 Curreni
Budget move and contract adjustment P
Lock project budget and price ¢
OJ 002 Concrete - Lab... — §:
OJ 003 Steel - Labor & ... 1.00 i 51

The Price Lock Status columns then changes to locked.

Pay item Description Current Price

J number forecast lock
(T/0) gty status
OJ 001 Earthwork - Lab... 1.00 a
U 002 Concrete - Lab.. 1.00 ™
O 003 Steel - Labor & ... 1.00 ™

4.5.3 UNLOCK BUDGET AND PRICE

After you lock your budget, in rare instances, it might be necessary to unlock your Original and Current
Budgets, though this is typically not recommended. For example, after initial import of your estimate
into Control, you might need to make further adjustments to your cost breakdown structure to
conform your estimate to the working plan for the project. Normally, unlocking your budget is the
exception, not the rule.
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Actions b @ |__1t3'-:’r

Global forecast method..
Set forecast method

Time phased forecasting

Claim multiple CBS gquantities

®

ription

svorhead

waork

Budget move and centract adjustment P rete

7 Lock/unlock budget

Sync

Reverse estimated actuals

»

Lock budget

Unlock budget

Lock project budget and price

I:I R1

Earthwark - Materials

WBS
code

1002
1069
1071
73
T4
05
06
b4

1085

Control User Guide

In Pay Items, like locking the budget for cost items, you unlock the price from the Actions menu.

Actions ¥ @ @

Lock/unlock price

ock/unlock price

sync

Budget move and contract adjustment P

Lock price

Unlock price

Lock project budget and price

002 Concrete - Lab...

(N nn3 Staal - 1 ahar 2
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REVIEW

1. When you first import or create your cost breakdown structure, by default your budget
is:

. Locked

a

b. Unlocked
C. Suspended
d

. Auto-filled

2. Under the Cost Details tab, what are the three types of cost segments that you can
choose from?

a. Direct Cost, Job Overhead, Business Overhead
b. Detail, Plug, Quote
C. Superior, Subordinate, Terminal

d. Fixed, Superior Cl

3. The Resources tab is where you can:
a. Adjust the unit rate of your project’s resources
b. Adjust Man-Hours
C. Adjust and add equipment costs
d. All of the above
e

. None of the above

SUMMARY

As a result of this lesson, you can:
¢ Manage estimate resources
¢ Gain visibility into resource billing rates
e Manage cost item details

e Lock the budget
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5.1 PROGRESS MEASUREMENT
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5.2 INEIGHT CONTROL WORKFLOW -
PROGRESS MEASUREMENT

Estimate

Historical Benchmarking

Control

Conform Estimate / WBS Structure

Progress .
Measurement Forecasting

CBS Register

Account Code
Management

Final Hours and Costs

ACS Register Create & Manage Forecast Method Budget/Forecasts
Cost ltems Setup Quantities
Define Qty Account
Contribution Codes
Live

Analyze Planned FerneEE
Earned and Actual Forecast

WBS Structure / Budgeted
Quantities & Hours

Approved changes

update Current Budget Revenue Management

I
Billed Revenue

Change Management v |
chaonge Register Pay Item Register

Create/Manage
Pay Items
Budget
Qty/MH Analyzed Planned & Forecast Revenue
Adjustment
Contract
Adjustment Track Billed Revenue

5.3 PROGRESS MEASUREMENT OVERVIEW

One of the standard forms of contract payment terms in the construction industry is based on the
value of specific contract deliverables. It is also based on the work completed during the previous
month towards those pay items. Throughout the life of a project, you will want to track the progress of
work completed.

It is important to identify and define a few key terms related to progress measuring, and to identify
how to utilize InEight Control as a tool for accessing and maintaining critical job factors.

5.3.1 BUDGETS VS ESTIMATE

Within InEight Control, you can maintain an Original Budget, a Current Budget, and a Current Estimate,
as is shown from the CBS tab of the Control main page by using a custom data block.
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cas Description was Foreca uoM 0 5-Total Cost C B-Total Cost G E-Final Cost
Position Phase stTO
Code ay
Job Cwerhead H 1002 100 Lump Su u $250,000.00 $250,000.00 $250,000.00
Earthwork i 10e2 1op000. e i $400,000.00 $400001.00 $400,000.00
Concrate 1071 10000.0. €Y $0.00 $8000.00 $5.000.00
Conerete Foatings 1083 100000 CY $0.00 $8,000.00 $5,000.00
Flace/strip Footing Forms H 1030 50000  SF u $0.00 $8,000.00 $5,000.00
Pour Footings o om oo Ccy I $0.00 $0.00 $0.00

5.3.1.1 ORIGINAL BUDGET

The Original Budget (OB) is a snapshot of the project plan in its original state, prior to execution. It is a
baseline used for comparison as the project progresses. You cannot edit your Original Budget values;
they are read-only in the CBS register, available for reference only.

Once set, the Original Budget never changes.

Within the CBS register of InEight Control, you will find the Original Budget (OB) values for man-hours,
guantities, and costs.

Tasks : TaskDet . € eeee> : |l BM Budget View o>

cBs bescription WS Foraca UoM 0B-Total Gost  Descr: Original Budget € B-Total Cost & E-Final Gost
Pasiticn Phase 5tTO Total Cost Formula
Code aty I
Jab Overhead i ooz 100 Lumpsu. SZ50000.00 $250,000.00 $250,000.00
Earthwork H 1068 100000,  CY H $400,000.00 $400,001.00 $400,000.00
Concrate 107 10,000.0 cy $0.00 £8,000.00 $5,000.00
Concrete Footings 108 100000 CY $0.00 $2,000.00 $5,000.00

5.3.1.2 CURRENT BUDGET

The Current Budget (CB) is the project’s operational budget, including only project changes approved
through a controlled process. The Current Budget is therefore the sum of your Original Budget, plus or
minus any approved changes.

TIP See the Change Management lesson for more details on managing and approving budget
changes.

Within the CBS register of InEight Control, you will find Current Budget (CB) values for planned, earned
and forecasted costs, hours and productivity.
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cas Deseription wes Foreca UoM 0 B-Total Cost € B-Total Gost  Deser: Gurrent Budget C E-Final Cost
Position Phase stTO Total Cost Formula
Code tity Ni&
Jioh Overhead :} 1002 100 Lump Su }: $250,000.00 $F80.000.00 $250,000.00
Earthvrark :} 1069 10000.0. CY }: $400,000.00 £400,001.00 £400,000.00
Concrete 1071 100000, CY $0.00 $2,000.00 $5,000.00
Concrate Footings 1088 100000 CY $0.00 $8,000.00 $5,000.00
Flace/Strip Footing Forms :} 1090 50000 SF }: $0.00 $2,000.00 $5,000.00
Four Footings Ioom 000 cy ! $0.00 $0.00 $0.00

FORECAST (T/O) - CB QTY DELTA COLUMN

The Forecast (T/O) - CB qty delta column shows you the difference between the Forecast (T/0O)
guantity and the current budget total quantity columns.

The calculation for this formula is [Forecast (T/0) qty] - [CB total qty].

CBS ACS
Actions w @
) 4 . y
Tasks s B Current estimat

% CBS Description WBS phase Forecast (T/0)

position code - CB qty delta
] 34221 STS - Direct MHR 1056 522.0
O 3523 SC Xaxlip Traffic Control Su... 1071 466.0
O 3.51.5 PM Soil Anchors 1067 101.5
O 34122 Drill / Install / Grout Anchors 1014 101.5
[ 3.41.23 Build & Move Anchors 1015 101.5

You can filter on non-zero CBS records, which makes you aware to update either the Forecast T/O
Quantity or CB Total Quantity.
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Forecast (T/0) @ Forecast © Fore
- CB gty delta method total co

751,86  Show items with value that:

Greater than v
5%

0
4¢

AND hd
1C

Equal v

: oy

5.3.1.3 CURRENT ESTIMATE

The Current Estimate (CE) represents the most up to date estimate of your work. You can update your
Current Estimate quantities, hours, and costs at any time in the CBS register, with no required approval
process or work flow.

You can use the Current Estimate as a “sand box” to build out change orders and do what-if analysis to
plan for potential changes, without worrying about affecting the Current or Original Budgets.

TaskDet.. € +sas > i [l BM Budget View <>

CBS Deseription was Foreca uonM 0 B-Total Cost C B-Total Cost € E-Final Cost Descr: Current
Paosition Phase stTO Estimate Final Cost
Code Oty Formula: M/A

Job Overhead I ooz 1.00  LumpSu I §250,000.00 $250,000.00 §250,000.00
Earthwark I 1080 toponn. Y ! $400,000.00 $400,001.00 $400,000.00
Concrete 1071 10,0000 [ $0.00 $8,000.00 $5,000.00
Concrete Footings 1088 100000 CY $0.00 $2,000.00 $5,000.00
Flace/Strip Footing Farms I 1000 50000  SF ! $0.00 $6,000.00 $5,000.00

Pour Footings I 001 000 C¥ I $0.00 $0.00 $0.00

Within the CBS register of InEight Control, you will find a wealth of columns for measuring and
analyzing your project progress. InEight Control uses its own terminology for these measurements that
match up well with common Earned Value Management terminology. Before comparing these terms,
the following section reviews some Earned Value Management basics.

5.3.1.4 UPDATING FORECAST (T/0) QUANTITY

The different ways to update the Forecast (T/O) quantity include:

InEight Inc. | Release 25.7 Page 177 of 528



5.3 Progress Measurement Overview Control User Guide

Direct entry into data block.

Direct entry into Cost item details slideout.

Excel import.

Undo.

Copy/paste into data block.

Rolldown from assigned pay item (need to have this setting enabled).
Cost item API.

Selective import.

Rolldown from parent (Qty driver is Superior Cl).

© © 0 N4 o a0 bk 0w DN =

—

Rollup from children ( Contribute qty is checked).

UPDATING CE UNIT COST FOR CE TOTAL COST

When you update the Forecast (T/O) on both the CE and the Forecast, you are prompted to update
either the CE unit cost for CE total cost. You can also choose to update either the CE labor cost/Mhr or
CE total MHrs, and either CE construction equipment cost/hr or CE total equipment hrs (if applicable).

This will then update the Forecast values because Forecast is based off Remaining qty * selected unit
cost, and your Remaining qty will update with a Forecast (T/O) qty change. This also affects your %
complete (Qty claimed / Forecast (T/O) qty) which impacts all the earned value columns. It will also
update the Forecasted revenue values as well (based on the % complete).

ENSURING TOTAL QUANTITY ALIGNMENT BETWEEN CONTROL
AND PLAN

You can easily filter the Forecast (T/O) - Plan component gty delta column. There is also a menu option
in the Actions menu to update the Forecast (T/O) gty to match the Plan qty - Update Forecast (T/O) qty
with Plan component total gty

5.3.2 PLANNED VALUE (PV)

Planned Value (PV) are the costs and hours you have estimated and scheduled for the project. Think of
PV as your approved budget of scheduled items. In Control, your PV includes the following columns:
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CE Total Cost

CE Total MHrs

CB Total Cost
CB Total MHrs

Actuals RakENE] to =

CE total cost CE total MHrs CB total cost CB total MHrs
S0.00 0.00 S50.00 0.00
5247458057 837048 5 2780589.58 8,088.50
S0.00 0.00 S50.00 0.00
55244900 0.00 55244900 0.00

5.3.3 EARNED VALUE (EV)

Earned Value (EV) Measures the amount of money you merit in return for the work performed up to
that point. You can use EV to measure how much of your planned costs and hours you should have
spent so far, according to the percent of work completed. It uses the below formula to calculate this:

Planned Value x % of work completed = Earned Value
In InEight Control, your EV includes the following columns:

¢ CE cost earned
e CE MHrs earned
e CB cost earned

e CB MHrs earned
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CBS

Forecast (T/0)
gty

1.00 /

1.00  PL

ol

PAY ITEMS

‘ Current estimate

CE cost earned CE MHrs
earned
5000 0.00
$2,469,579.10 8370.48
50.00 0.00

Control User Guide

CHANGE REGISTEP Lrimmnen

CB MHrs earned

Current budget man hours
eamed

Formula

[% complete] = [CB total MHrs]

CB cost earned CB MHrs —  CEtotal
earned -
50.00 0.00
$ 2,766,947 .48 8,088.50
5000 0.00

5.3.4 SCHEDULE PERFORMANCE INDEX

Schedule performance index (SPI) measures how close the work is being completed according to the
designated schedule. It is Earned value/Planned value, and is calculated as earned current budget
cost/CB planned value (to date)
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CB:

SPl

Task details

0.00
0.80
3.00
5.00
0.00
20.00
0.50
0.00
0.00
0.00

0.00

ACS
{ seen )
CB planned Forecast (T/0)
value (to date) gty
S 250,000.00 1.00
£ 40.00 10,000.00
$150.00 10,000.00
5151628 1,000.00
5 25,666.00 800.00
$1,000.00 200.00
52498 2,000.00
$1,750,000.00 1.00
$25.00 10,000.00
5 100.00 10,000.00
5 500.00 1,000.00
1.00

PAY ITEMS

The SPI calculation uses the time phased budget values as planned values. To accommodate the time
phased budget values, the planned value includes the cumulative time phased budget planned value to

date.

5.3.5 ACTUAL COST (AC)

Actual Cost (AC) refers to the costs you incur when you perform the work.

In InEight Control, AC is known as Total Cost (To Date). In addition, InEight Control refers to actual
man-hours as MH (To Date).
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cBs Bescription W8S Forasa UoM Gty Complete (To WHUnit (To ¢ B-MHG/L (To Total Gost (To
Position Phase stTO bate) Date) bate) Date)
Code aty

Job Overhead I 10z .00 Lump Su ! 0.00 0.00 0.00 $0.00 $0.00 0.00%

Desor Total Gost (Ta | ™ Comalete
Date) Formula: N/ |

Earthwark I 1oes  topono. oy i 0.00 0.00 0.00 $0.00 $0.00 0.00%
Concrete W71 100000, CY 0.00 0.00 0.00 $0.00 $0.00 000%
Concreta Footings 1083 1,000.00 cy¥ 0.00 0.00 0.00 $0.00 $0.00 000%
Place/Strip Footing Forms I om0 50000 SF I 0.00 0.00 0.00 $0.00 $0.00 0.00%

Four Footings o 000 oy ! 0.00 0.00 0.00 $0.00 $0.00 0.00%

5.3.6 VARIANCE

Variance is the difference between EV and AC, expressed in the following equation:
Earned Value - Actual Cost = Variance

It indicates if you are performing better or worse than planned up to that point. InEight Control uses
the term Gain/Loss (G/L) rather than variance, including the following columns:

e CE actual cost G/L (to date)

CE MHrs G/L (to date)

CB actual cost G/L (to date)

CB MHrs G/L (to date)

5.3.7 REMAINING

Remaining is a general finance term for money that is not yet used. InEight Control uses the following
terms:

e CE remaining cost
¢ CB remaining cost

These terms refer to a very specific relationship expressed in the equation:
Planned Value - Actual Cost = Remaining Value

In other words, it is the difference between what you originally planned and what you have spent so
far, to help you understand how much cost or how many man-hours you have left.
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> ] Actuals to m ses Descr: Current Budget
' UoM Qty Complete (To MH/Unit (To € B-MH G/L (To Total Cost (To C B-Total Cost TT‘;AEF?; ‘D‘Z't';}‘”

Date} Date) Date} Dete) oL Dete) Formula: C B-Eamed

Total Cost (To Date) -
00 Lump$ 0.00 0.00 0.00 $0.00 spy TotalCost(ToDate) §
oy 0.00 0.00 0.00 $0.00 50.00 0.00
00 PLS 0.00 0.00 0.00 50,00 $0.00 0.00
00 PLS 0.00 0.00 0.00 $0.00 $0.00 0.00
00 PLS 0.00 0.00 0.00 50,00 $0.00 0.00
00 PLS 0.00 0.00 0.00 $0.00 $0.00 0.00
00 PLS 0,00 0.00 0.00 $0.00 $0.00 0.00
00 PLS 0.00 0.00 0.00 $0.00 50.00 0.00

$1,000.00

The table below summarizes each EVM term with its equivalent term in InEight Control and what it
measures.

Planned Value CE total cost Budget of scheduled values
(PV) CE total MHrs

CB total cost

CB total MHrs

Earned Value CE cost earned Planned Value x Percent Complete
(EV) CE MHrs earned

CB cost earned

CB MHrs earned
Actual Cost (AC) Actual cost (to date) Actual/expended values

Actual MHrs (to date)

Variance CE actual cost G/L (to Difference between Earned Value and Actual
date) Cost
CE MHTrs G/L (to date)
CB actual cost G/L (to
date)
CB MHrs G/L (to date)

Remaining CE remaining cost Difference between Planned Value and Actual
CB remaining cost Cost
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The following displays Planned vs. Earned vs. Actual values within a custom data block of the CBS
register of InEight Control:

CBS Descrintion 0 B-Total Gost © B-Total Gost © E-Final Gost © B-Earned Total Total Gost (To © B-Remaining

Pasition Cost (To Date) Date) Cost
Job Overhead i $250,000.00 £250,000.00 £250,000.00 $0.00 $0.00 $250,000.00
Earthurork i $400,000.00 £400,007.00 £400,000.00 80.00 §0.00 $400,001 00
Conerata $0.00 $8,000.00 $5,000.00 s0.00 §0.00 800000
Conerete Footings $0.00 $8,000.00 $5,000.00 $0.00 $0.00 $8,000.00
PlacesStrip Footing Forms “ 40.00 §8,000.00 §5,000.00 £0.00 40.00 £&,000.00
Paur Faotings I $0.00 $0.00 50.00 50.00 $0.00 5000

5.3.8 PRODUCTIVITY

If you are the contractor building a project, you will need to monitor the performance of your crews,
including how productive they are and how much they are being paid.

Productivity is a measure of effectiveness. The rate of output per unit of input. An example would be if
you have estimated that you can install a light switch in 1 hour and it takes you 1.5 hours you are not
being very productive. In InEight CB-PF is productivity and can be measured with the following
equation:

Earmed MH

Prod I.,I[:'.'t”u"ll'ffr = m

1

0.667 = 5

Descr. Current Budget

cas Description wes Foreca uoM Units/MH {To MH (To Date} €B-PF  Productivity Factor  (To Labor Cost/MH CF (To Date}
Position Phase StTO Date) Farmula: G B-MH (To Bate}
Code Oy Earned (To Datg) /MH |
(To Date)
Job Overhead i 100z 100 Lump Sy ! i n.ni . $0.00 $0.00 000
Earthwark I 1oes 100000, cY i o 0.0 0.00 $0.00 $0.00 0.0
Concrete 1071 100000, CY 0.0 0.0 0.00 $0.00 §0.00 000
Concrete Footings 1088 100000 CY 0o 0.0 0.00 $0.00 $0.00 000
Place/Strip Footing Forms i 1000 500.00  SF ! 0.00 0.00 0.00 $0.00 $0.00 0.00
Pour Faotings I o 000 ¥ ! .00 0.0 0.00 $0.00 $0.00 000
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5.3.8.5 COMPENSATION FACTOR (CF)

Compensation is the amount of money paid to an employee for their hours worked. Compensation
Factor is a numerical value comparing the budgeted compensation to the actual compensation. An
example would be if you had budgeted using master electricians (making $35/hour) to install light
switches, but you actually used 2nd year apprentices (making $26/hour) where you would have a
compensation factor that is off. In InEight, Compensation Factor is displayed as CF (To Date). You can
calculate it as follows:

Budgeted MH Cost
Actual MH Cost

Compensation Factor =

$ 35
130 = ——
$ 26
e e o femmemme o
o)

Deser Compensa
¢bs Descripticn WS Foreca ] Units/MH (To MH (To bate) € B-pF Unit Eost (To Labor Cost/MH CF (Tobate} _ Factor (To Dats
Posifion Phase ST Balc} Dac) (To bate) Formula: G B-Labor
Code tiy Unit Cast / Labor Unit
Cost (Ta Date)

H

Job Overhead I qopz 1.00  LumpSu ! 0.00 0.00 0.00 $0.00 $0.00
Earthwork I 1063 100000, v ! 000 0.00 000 $0.00 $0.00 oon ) el
Concrete 1071 100000, o 0.00 0.00 000 80.00 $0.00 0.00

Concrete Footings 1089 1,000.00 cY 0.00 0.00 0.00 $0.00 $0.00 0.00

Placerstrip Footing Forms I qo00 50000 SF ! 0.00 0.00 0.00 $0.00 $0.00 0.00 H

Paur Footings I o0 0o oy ! 0.00 0.00 0.00 $0.00 s0.00 oon |l

5.3.8.6 LABOR EFFICIENCY INDEX (LEI)

Labor Efficiency Index (LEI) is a numerical value assigned to indicate the effectiveness of resource
utilization. You can calculate LEI using the following formula:

Labor Efficiency Index = Productivity x Compensation Factor

.90=.67x1.35

Meyg= If LEl is greater than 1, it means that you are using your resource effectively.

If LEl is lower than 1, it means your resources are being used poorly.

5.3.9 INEIGHT PLAN QUANTITY

The Plan component total gty column shows the sum of the component quantities from Plan and
Control and lets you update the Forecast (T/O) gty to match this value.
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CBS ACS

Actions  w ©)

Plan component total gty
Sum of component quantities
from Plan

Actuals i

Tasks

¥ CBS Description WES phase Actual qty (to Plan
position code date) component MHrs
total gty date)
J 26.28.2 Craft Labour Supp.. 1093 4,827.00 4,827.00
O 23122 Drill / Install / Gro... 1014 1,501.45 1,501.45
O 23123 Build & Move Anc.. 1015 1,501.45 1,501 .45

Using the Install conduit cost item as an example, it is assigned to WBS phase code 1139 in the CBS.

Actions w ® 4 )
A 4

Tasks :
= CBS Description WBS phase
position code
3 0 314 B/C CN Pier 11 1128
0 315 B/C Turcot 1129
B/C 8888 Osler Pi_. 1130
_/ o
e
- Forecas. (09
5 Install conduit 1139

In Plan, WBS phase code 1139 is assigned to components Conduit material with a quantity of 150 and
Install conduit with a quantity of 120.
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Component details
- Name Claiming scheme Quantity wBs
I - N - - -
] Road Subgrade Road Subgrade 293.60000 1008
% Conduit material Conduit 150.00000 1139
Install conduit Electrical 120.00000 1139

In the CBS, the Plan component total gty for the Install conduit is 270, which is a total of the two WBS

11/17/20

1139 components in Plan.

Tasks :

3 CBS Description WBS phase Plan
D position code component
total gty
O 314 B/C CN Pier 11 1128 1.00
' at, . 100"
O a. JOR . 1109
@ s Install conduit 1139 270.00

The Forecast (T/O) - Plan component gty column is the difference between the Forecast (T/O) and the
Plan component quantity.

= A 103961 | Ten Mile Slide - Phase 2 (Carrying) / Control / Workspaces

Forecast (T/0) - Plan component I
qty delta

Difference between Forecast M
(T/0) gty and Plan component
Actions  w @ total quantity columns

Formula

|Forecast (T/0) qty] - [Plan

cBs

component total gty
Tasks : B Actuals RRELLEY to PITEEEY F b
wCBS Description WES phase Forecast (T/0)
position code gty component
total gty
5 Install conduit 1139 100.00 270.00 -170.00
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5.3.9.7 UPDATE FORECAST (T/0) QUANTITY WITH PLAN
COMPONENTS

The Update Forecast (T/O) gty with Plan component total quantity option located under the Actions
drop-down, copies the Plan component total quantity over to the Forecast (T/O) quantity. You can also
right-click in the context menu to see this option.

Actions = ® 4 )
T
X
Update Forecast (T/0) gty with Plan compone.
) - - \\ Proportionally adjust CE total cost or CE unit cost
i_:,l Claim multiple CBSc{ Update Forecast (T/0) qty with P The Forecast T/0 qty can be modified by proportionally adjusting
) CE total cost or CE unit cost.Specify the value you would like to

Budget move and contract adjustment L modify, for all pasted values in Forecast T/0 gty
Lock/unlock budget L ) CE total cost
Add required cost items ® CE unit cost

r
Sync »

3 —_—
Take snapshots Cancel J n

5 L

B quantities
Forecast (T/0) Plan
aty component
total gty
Z70.00 270.00

5.4 DATE RANGE SETUP

InEight Control gives you flexibility in the form of a Date Range option. The following Step by Step
walks through how the Date Range setup feature works.
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DATE RANGE SETUP

1. Click the View drop-down to change your view.

View :| CE+cB T
D o BB 1= Q

2. Select the Progress viewset from the View drop-down list.

View : CE+CB -
O m PT view
Cost categories
{ sne > Unsaved (CE + CB)
fUnit CE Units/MHr CE

cos Live forecast

Revenue

11.00 0.09
Project controls
0.80 1.25
View more 4
Forecasts
Progress
view as
Progress
20.00 0.05
2000 005
0.00 2,800.00 Mew view
0.00 0.00

3. Inthe Actuals data block, select the left calendar field on the date range chooser and choose the
first day of this month.

InEight Inc. | Release 25.7 Page 189 of 528



5.4 Date Range Setup Control User Guide

Actuals o] 7/3/2018

Total cost (to

(todate) "o Mo Tu We Th Fr Sa |02 )

27 28 29 30 31 1 2 500 $0.00
3 4 5 & T 8 9

0.00 5000
10 71 12 13 14 15 16
17 18 19 20 21 22 23 0.00 % 0.00
24 25 26 27 28 29 30 0.00 $0.00
1 2 3

0.00 5000

Tuesday, July 03, 2018

0.00 0.00 0.00 5000

¢ To manually select your date range, click into the date cells along the header of the Actuals
data block and select your desired to and from dates

4. Select the right calendar field on the date range chooser and select the last day of this month.

5. Select the calendar icon.

B Cooe>

Oty complete MHrs/Unit (to CB MHrs G/L Total cost (to
(to date) date) (to date) date)

0.00 0.00 0.00 5 0.00

0.00 0.00 0.00 5000

6. Select Last month end from the calendar.
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K+ KT

To date

B MHrsfUnit (to T
date) d:
Current week
0.00 0.00
Last week end 12}
0.00 0.00
Last week (period)
0.00 0.00
— Last month end (2]
0.00 0.00 l

Last month (period)

e To select your date range from the pre-set list, click on the calendar icon within the
Actuals data block header and select the desired date option

I+ KT

To date

B MHrsfUnit (to T
date) d:
Current week
0.00 0.00
Last week end 12}
0.00 0.00
Last week (period)
0.00 0.00

Last manth end o
0.00 0.00 l
Last month (period)

TIP Both week and month end date rules are determined during project setup within
the Fiscal Calendar setting. (See lesson 12.2 Project Settings on page 477 for more
information.)
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5.5 MANAGE ACTUALS

In Control, you can choose from four methods for tracking actual values:
e Sync — Lets you connect directly with other systems to update data in real time.
¢ Import — Allows you to upload spreadsheet data.
e Manual entry — You can input data directly into the system.
¢ API - Allows you to connect data from external sources, such as an ERP.

These methods help ensure that project records are accurate and up to date. The following topics
provide more details on methods for managing actuals:

Actuals by Sync

Actuals by Import

Actuals by Manual Entry

Actuals by API

5.6 ACTUALS BY SYNC

Update Control data in real time by connecting with InEight applications and other external systems.

5.6.1 SYNC QUANTITIES

A quantities sync lets you to bring actuals from other InEight applications into Control. Quantities are
brought into Control through a Get Quantities sync. The Actual qty (to date) column is updated when
the sync is complete.
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Actuals ez to ™

Actual gty (to
date)

07
1.00
0.28
0.53
750.00
200.00
1.00
0.00

Sync operations are accessed from the Actions menu in the CBS.

InEight Inc. | Release 25.7

Actual
MHrs/unit (to
date)

12277
0.00
0.00
0.00
0.00
0.00
0.00
0.00

CB MHrs G/L
(to date)

0.00

0.00
0.00
0.00
0.00
0.00
0.00
0.00

5.6 Actuals by Sync
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PERFORMING A GET QUANTITIES SYNC

1. From the Actions menu, choose Sync > Get quantities.

Actions w @
Y
Time phased forecasting .
Update Forecast (T/0) gty with Plan compone Resources Fore
(T/0]
Claim multiple CBS quantities
f:? Budget move and contract adjustment » ent Permit ::
; I
Lock/unlock budget p Dance Permit i
n
8
| Sync »  Push CBS structure
Reverse estimated actuals »  PushCBS structure and Budget
Push CBS structure and Live forecast
] 17 Bacteria Testing
Push CBS structure and Actual quantities
O 18 Storm Drain Vid
O 19 sewer and Manl Push CBS structure, Budget, Live forecast, and ..
O ~ 110 Subcontractor N py o pay jtem
O 1101 CIP Concrete Su
Push Billed revenue
O 1.10.2 Landscaping Su
O 1103 Rotomill/Pulveri Fush Forecast revenue
U 1.10.4 Striping Sub Moy Get quantities »
O 1.105 Survey Sub Mol
Get Actual cost and MHrs
] 1.106 QC Testing Sub
O 1107 Traffic Control § Get Billed revenue
— A e e il

2. Choose the time period for the sync (Through previous pay period or Job to date).

J I.UU  Eacn

- Push Forecast revenue 100  Each

2 Get quantities » Through previous pay period
| Get Actual cost and MHrs Job to date

5 Get Billed revenue 100  Each

T — I'I R -

3. A status message notifies you that the sync has initiated.
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Get to-date quantities sync initiated

ACS PAY ITEMS CHANGE REGISTER

5.6.1.1 TYPES OF GET QUANTITIES SYNCS

Depending on your project configurations, the Get Quantities sync can bring in values from InEight
Design, InEight Plan, or InEight Contract. Each of these applications tracks quantities differently,
depending on its role in the project lifecycle.

InEight Design

In InEight Design, engineering deliverables are broken down and tracked as scope items. As work on
scope items is completed, team members can claim partial or total quantity values. Scope items are
linked to cost items through the WBS phase code. As a result of a Get Quantities sync, scope item
guantities update the actual quantity for their associated cost items.

DESIGN
Engineering

CONTROL
Workspaces

Scope items link to
—— costitemsviaWBS |——
phase code

WBS Phase
Code Roll-up

T

[ [ | Actual gty (to
date)

Scope Scope Scope
Items Items Items

InEight Plan

Quantities from InEight Plan represent completed progress in the field. Quantities can be captured
directly in the Quantity Tracking module, or they can be captured through approved daily plans from
InEight Progress. Components are linked to cost items through the WBS phase code. As a result of a
Get Quantities sync, component quantities update the actual quantity for their associated cost items.
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’

v

PLAN

CONTROL
Workspaces

Quantity Tracking

Components link
—— tocostitemsvia —>
WBS phase code

Actual qty (to

Components
date)

?

Approved daily plans update
component quantities

' PROGRESS

Daily Planning

Installed
quantities

InEight Contract

Quantities from InEight Contract represent completed progress associated with a third-party contract.
Contract line items can be broken down into schedule of value items to track field progress. These SOV
items can be claimed directly in InEight Contract, or they can be claimed as contract components in
InEight Plan. SOV items are linked to cost items through the WBS phase code. As a result of a Get
Quantities sync, SOV quantities update the percent complete and actual quantity for their associated
cost items.
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®

CONTRACT

CONTROL

SOV items link Workspaces
o — tocostitemsvia —
Line items WBS phase code
T % complete Actu;;tqet)y (to
| | ]
Sov Sov sov
items items items

t

Components link to SOV
items via WBS phase code
I

PLAN

Quantity Tracking

Contract
components

To update complete from InEight Contract, you must enable the settings for the project in Control >
Project Tracking > Actuals. Switch the Update % complete from Contract toggle to On.

= £  Road & Bridge Project| 106000 / Settings

» PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE SYNC INTEGRATIONS
®
Actuals

®
@ Calculate percent complete for individual cost items as a percentage of Cap percent complete at 100%
® Forecast (T/0) aty - ™ .‘
®

g Calculate percent complete for roll-up items such as superior costitems and  Roll-up percent complete weighted by
® account code by:

Cost - Current Budget -

Calculate man hours earned at the parent level by (7)

@ The summation of man hours earned from direct child items

O The total man hours multiplied by percent complete

Get actual cost from Contract (i) ©@ Update % complete from Contract (i) @)

Drive committed cost values from Contract (1) @ Caloulate percent complete for individual cost items as a percentage of

After the Update % complete from Contract setting is enabled, select from the Calculate percent
complete for individual cost items as a percentage of drop-down list to define how you want to
calculate the percent complete for cost items.
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Update % complete from Contract @ @

Calculate percent complete for individual cost items as a percentage of

Current budget total cost v

Current budget total cost
_ | Committed total cost
Forecast total cost

Current estimate total cost

o= The calculation for this option is: (updated % complete on the cost item) = (SOV unit
price) x (Claimed qty in Contract or Plan) + (Denominator in settings). Actual qty (to date)

=% complete * Forecast (T/O) gty OR CB total qty (depending on settings).

5.6.2 SYNC HOURS AND COSTS

If your project uses external systems to capture man-hours and costs, those values can be brought into
Control through a sync. If your project uses an ERP system, you can bring in man-hours and costs by
performing a Get Actual Cost and MHrs sync. If you have values tracked through contracts, you can
enable project settings to bring those values in from InEight Contract. Hours and costs brought into
Control through a sync update which updates the Actual cost (to date) and Actual MHrs (to date)
columns.
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Actuals to R

Actual cost (to Actual MHrs
date) (to date)
¢ 583.998.84 1.935.50
4 524,328.84 1.824.00
” $0.00 0.00
” $ 104.100.00 0.00
” $12.800.00 0.00
” $ 62.375.00 1.800.00
ERP

5.6 Actuals by Sync

After man-hours and costs are verified in your ERP system, you can initiate a sync to bring those values
into Control. Similar to the Get Quantities sync, the Get Actual Cost and MHrs sync is accessed from

the Actions menu.
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@

Actions A4

Time phased forecasting
Update Forecast (T/0) gty with Plan compone...
Claim multiple CBS quantities

Budget move and contract adjustment »

Lock/unlock budget »
q
! Sync »
Reverse estimated actuals »

- Task details

Rescurces Fores

(o

ations

ape and Clean

Push CBS structure

Push CBS structure and Budget

Push CBS structure and Live forecast

Push CBS structure and Actual quantities

Push CBS structure, Budget, Live forecast, and ..
Push Pay Item

Push Billed revenue

Push Forecast revenue

Get quantities

Pour Concrete

Get Actual cost and MHrs

Demob

O 117 Building K&L - §
O 118 Concrete - Build
O 119 Building N&O - ¢
a 1.1.10 Concrete Found
O CFA Piling

O Building X

a Finegrade

O Formwork

O

O

O

Get Billed revenue

If your project captures work hours through InEight Progress, those hours and their associated costs

are approved in Progress before being

$24
PROGRESS

Daily Planning

Daily Plans

sent to the ERP.

CONTROL
Workspaces

Weekly Time Sheet

Weekly Time Sheets

Hours

Actual MHrs
(to date)

Actual cost

Costs (to date)

Time Cards
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InEight Contract

InEight Contract can record actual costs in the form of goods receipts, accruals, invoice receipts, or
payment forms. You can configure your project settings to pull these actual costs into Control through
a batch process.

In project settings, under Control > Project Tracking > Actuals, switch the Get actual cost from
Contract toggle to On.

bl PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE SYNC INTEGRATIONS OTHERS
D

o Actuals

")

o Calculate percent complete for individual cost items as a percentage of Cap percent complete at 100%

)

Forecast (T/Q) gty - Yes -|

Calculate percent complete for rell-up items such as superior costitems and  Roll-up percent complete weighted by
account code by:

Cost - Current Budget -
Calculate man hours earned at the parent level by @

(@ The summation of man hours earned from direct child items

(O The total man hours multiplied by percent complete

Get actual cost from Contract @ @ Update % complete fram Contract @ @

Drive committed cost values from Contract (§) &)

After you enable this setting, Contract values update the actual cost for the associated cost items. Note
that it may take up to 15 minutes for the background batch process to complete.

®

CONTRACT CONTROL

Workspaces

Background
batch process

Goods Actual cost
receipts (to date)

Accruals

Invoice
receipts

Payment
forms
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5.6.3 AUDIT LOG

You can check the status of a sync in the Audit Log on the Integration tab.

CBS ACS PAY ITEMS CHANGE REGISTER AUDIT LOG
Actions v Y
LT Interface Status Processing details Start Finish Log Handle
c8s
O 2150 Quantities - Job to date Succeeded 202 10/16/202412:15 PM 10/16/2024 12:15 PM 3041926-52ed-461¢-he23-1148056(41ch
08 0O o Budget Failed Failed at1 03/10/202312:33 PM 03/10/202312:48 PM ef916a4f-5edb-4563-8ed7-Tfelfa37bi3a
Reyemn O 109 c8s Succeeded 4ofd 03/10/202312:33PM 03/20/2023 05:30 AM 60200491-75h8-413(-8908-a1bfbb 1bfid4
O 10s Quantities - Job to date Succeeded 2012 02/23/202312:26 PM 02/23/202312:26 PM 3073197(-189a-deeb-had5-a1 dee8 765432
O 1os Quantities - Job to date Succeeded 202 02/23/202312:04 PM 02/23/202312:04PM 43c1d5ec-0321-4357-b70-90ed(B37501
|mport history O o4 Quantities - Job to date Succeeded 202 02/23/2023 11:49 AM 02/23/202311:49 AM 5805be3-8d61-45¢1-a269-283a6143742¢
O 1661 ActualMHCost InProcess 0of3 12/07/2022 0326 PM delffe?1-8ae0-4111-8399-¢93c29a86h56

5.7 ACTUALS BY IMPORT

You can import actual costs, man-hours and quantities by using an Excel or CSV file.

An actuals import is similar to claiming actuals in Control. After you upload a spreadsheet containing
actuals, those values are added to any existing actuals for the specified cost items. Your spreadsheet
values should represent new claiming on a cost item rather than the total sum to date.

From the CBS tab in Control Workspaces, you can access the Import function by clicking the Import
icon, and then selecting Actuals.

VIEW | Progress -
O s$ m T B = Q

Import:

I =0 02/24/2022 BT

e Cost items Ral qiy (i Actuz

te) ) MHr=
date)

Actuals
S0.00 0.00

50.00 Commitment 0.00
% 0.00 0.00
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After you add the import file, you can select the matching criteria in the Map columns dialog box. The
Map columns dialog box has a select number of Control fields which pertain to actuals. The table
below shows details of the available fields.

WBS phase code The unique WBS phase code. Can be used as the cost item matching
criteria. Required to select this or CBS position as the cost item
matching criteria.

CBS position The position in the CBS hierarchy. Can be used as the cost item
matching criteria. Required to select this or WBS phase code as the
cost item matching criteria.

Posting date Required field. Control will prompt you to specify the date format used
in your import file.

Notes Text field for any notes that pertain to this specific claiming update.

Claimed quantities Quantities in this field will be added to the Actual gty (to date) field for
the specified cost items.

Number of man Values in this field will be added to the Actual MHrs (to date) field for
hours the specified cost items.

Number of equipment Values in this field will be added to the Actual egp hrs (to date) field for
hours the specified cost items.

Cost Values in this field will be added to the Actual cost (to date) field for the
specified cost items.

Cost categories You can download a list of your project’s cost categories from the
Import actuals data dialog box. The values in the import file must match
the Control values exactly.

Actuals user defined Use these fields to enter dates based on customized field labels set up
1-2 in Platform > Suite Administration > Custom labels.

Actuals user defined Use these free text fields to enter any variable attribute based on
3-6 customized field labels set up in Platform > Suite Administration >
Custom labels.

Estimate Resource You can specify estimate resources to be included with this claiming
update. Use the resource code for the estimate resource as the value
for this field. This update will be visible from the Actuals Details tab in
Actuals History.
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Follow the steps below to import actuals.

Control User Guide

IMPORT ACTUALS

1. Prepare the import file.

2. From the CBS, click Import > Actuals.

r. 1A -
VIew : | Progress v

= O §$ m T B = Q

Import;

Cost items

cost ual gty (to Actue
te) ) MHrs
Actuals date)
S0.00 0.00
$0.00 Commitment 0.00
50.00 0.00

3. In the Import actuals data dialog box, add the import file, and then select the cost item matching

criteria.
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Road & Bridge Project (10600| ontral

Import actuals data - Actuals Import.csv

-
'
1
'
Drag and drop the file here {
or browse |
1
'
|
'
'
'
'
__________________________________________________________________________________________ a
Options
* Import type (@ Specify a Match key. Once import file header
- columns are verified, column fields can be mapped.
Actuals values Data from the matched items will be imported. If
match is not found, items will be ignored. If your
Cost item matching criteria document contains actual cost, then you will need to
specify which column contains your cost categories.
WBS Phase Code hd Cost category naming in you upload file must match
what is in Control. Download Control's cost category
list to ensure the use of correct naming.
i Cost categories list
Next
4. Map the Control fields to the file columns.
Import actuals data - Actuals Import csv
Map columns
Templaie Unsaved template - g
Control field Mapped File columns
Tasks
*WBS phase code Qt WBS phase code
CBS position only used if matching
Actuals
* Posting date " Date
Notes Blank-do not import
Claimed quantities v 4 Actual gty (to date)
Number of man hours v 4 MHrs
Number of equipment hours " Equipment
Cost " Cost
4 »
Next

5. Select the date format used in the import file.
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Select dat... Choose date format currently
displayed in file. Selected format
will be converted to match user
settings.

MM/DD/YYYY

el - |

6. The import file will be checked for errors. If the file contains no errors, click Next.
If the import contains errors, download the error file for more information.

7. Click Import now to complete the import.

You are about to import actuals. You may continue working in
your project while your import is occurring. Please note this may
take several minutes

Cancel Import now

Visit Cost Item Excel Import for more information on performing an import.

5.8 ACTUALS BY MANUAL ENTRY

In some situations, you may need to enter actuals directly in InEight Control. This can be helpful when
field data is delayed, incomplete, or needs correction. Manual entry also gives you greater flexibility
when tracking progress tied to lump sum or indirect costs, or when values include confidential or
sensitive data.

The steps below outline how to claim actuals by manual entry.
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CLAIM ACTU

BY MAN

L ENTRY

5.8 Actuals by Manual Entry

1.

41

8 cC

42

4.3
V5

51

52

5.3

71
7.2
73
74
75
76

Oo0oo0oooooooooooo

7T

O

78

Subtotals 32 (1 rows selected)

EIeCL Sleel - neavy

Erect Steel - Light

Bolted Connections

Materials

Earthwork - Materials

Concrete - Materials

Structure Steel - Materials
Merrill Iron & Steel - Steel Materiz
Site & Demolition

Selective Demolition

Site Demolition - Mobilization
Site Demolition - Building KL
Site Demoliticn - Footings & Foun
Site Demolition - Hard - Building |

Site Demolition - Hard - Building |

I ® @ ®

H

From the CBS, right-click a cost item, and then select Actuals details.

o4

Copy

New cost item

New subordinate cost item

Delete cost items(s)

Adjust CBS position

Update Forecast (T/0) gt...

Cost item details

Site Demolition - Hard - Building |

©

Actuals details

Site Demolition - Driveway Appro:

40—

© 2025 InEight Inc. Privacy Statement

Terms & Conditions v2

[<b

Change summary

Cost item dashboard

2. On the Claim Actuals tab of the slide-out panel, select the type of actuals from the tabs on the

left.

1005
4.2 ErectSteel - Light

CLAIM ACTUALS

ACTUALS HISTORY

QUANTITIES Forecast (T/0) gty
100.00
MAN HOURS
EQUIPMENT HOURS
Claimed quantity
cOsT

Actual qty (to date)

2155

Estimated actuals to be added on claiming:

Total cost

Labor

COMMITMENTS

3. Enter the quantity, hours, or cost to be claimed.
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e s e e

CLAIM ACTUALS ACTUALS HISTORY
QUANTITIES Forecast (T/0) qty Actual gty (to date)
100.00 21.55

MAN HOURS

EQUIPMENT HOURS
Claimed gquantity

COsT 15.00

Posted date

06/30/2025 =

4. Enter additional details as needed.

COMMITMENTS

Estimated actuals to be
Total cost
Labor

Construction Equipmen

ENK Rantad Faninmant
4 G

CLAIM ACTUALS ACTUALS HISTORY COMMITMENTS
Labor $000

el Construction Equipment $0.00

06/30/2025 ﬁ “ FNM Rantad Fnninmant <n ﬂﬂ. v
Start date Finish date

06/23/2025 = 06/27/2025 =
Area Actuals user defined 4

South
Actuals user defined 5 Actuals user defined 6
Estimate resource
Notes 4000

5. When finished, click Apply.

5.8.1 CLAIM QUANTITIES

Control User Guide

Track completed progress progress on a cost item by entering a claim on the Quantities tab in the

Actuals details slide-out panel.

Before claiming quantities for a cost item, make sure the Hide in Plan, Progress, and Design column is

checked. This option prevents conflicts by making the cost item unavailable for claiming outside of

Control.
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. .
Tasks * W Task details (o000 )
w CBS Description WBS Hide in Plan, |s terminal
position phase Progress, and
code Design
O ) Construction 1011 ()]
O v 21 Bridge Work 1012

See the table below for details on the available fields on the Quantities tab.

CLAIM ACTUALS ACTUALS HISTORY COMMITMENTS

QUANTITIES Forecas t (T/0) qty Actual gty (to date)
4,331.00 2,576.45
MAN HOURS
EQUIPMENT HOURS
Claimed quantity Posted date
cosT 07/01/2025 =
Actuals user defined 1 Actuals user defined 2
Actuals user defined 3 Actuals user defined 4
Actuals user defined 5 Actuals user defined 6
Estimate resource
Notes 4000

Forecast (T/O) qty Shows the forecast takeoff quantity for the cost item.

Actual gty (to date) Shows the actual quantity claimed to date for the cost item.
Claimed quantity Required field. Enter the quantity you wish to claim for this entry.
Posted date Select a posting date for this claiming entry.

Actuals user defined Use these fields to enter dates based on customized field labels set up
1-2 in Platform > Suite Administration > Custom labels.

Actuals user defined  Use these free text fields to enter any variable attribute based on
3-6 customized field labels set up in Platform > Suite Administration >
Custom labels.
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(continued)

Estimate resource You can select a resource from the Project library. You can only select
one resource per entry.

Notes Enter any notes pertinent to this claiming entry.

Mle = You can enter negative quantities when claiming in Control.

5.8.1.1 CLAIM QUANTITIES FOR MULTIPLE COST ITEMS

Select Claim quantities for multiple cost items to claim actuals for multiple cost items on the same
posting date. The Claim quantities for multiple cost items window shows the same fields that are found
on the Quantities claiming tab in a grid format.

Claim quantities for multiple cost items

O
D Load template Save as template

A Note: Cost items that cannot be claimed are not displayed in this list.

Posted date

07/01/2025 (]

Claim multiple actuals

Action CBS WBS Description CE Forecast CB- Actual Claimed Actt
position phase UoM (T/0) aty total (to amS“’ quantity defi
code quantity
@ 116 1007 Drainage - System LF 4,331.00 0.00 2576.45 0.00 :
Ll [
® Add cost item

Follow the steps below to complete a manual claim for multiple cost items.

CLAIM QUANTITIES FOR MULTIPLE COST ITEMS

1. From Claim Actuals > Quantities of the Actuals Details slide-out panel, click Claim quantities for
multiple cost items.
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Notes 4000

@ Add claimed quantity @ Claim quantities for multiple cost items

Cancel

2. Select the posting date for this claim.

Claim quantities for multiple cost items

1
D Load template Save as template

A Note: Cost items that cannot be claimed are not displayed in this lst.

Posted date

07/01/2025 i)

s Description cE Forecast cB- Actual
SU MO TU WE TH FR SA S iy oy et & “mﬂg"
e quantity
2 3 4 5 o
T Drainage - System LF 4,331.00 0.00 257645 *
6 7 8 9 M n 12 v

13 14 15 16 17 18 19

20 21 22 23 24 25 26

28 29 30 3
TUESDAY, JULY 1,2025

2

N

3. Click Add cost item to add additional cost items to claim on this posting date.

Claim quantities for multiple cost items

5
D Load template Save as template

A Note: Cost items that cannot be claimed are not displayed in this list

Posted date

07/01/2025 ]

Claim multiple actuals

Action cBS WBS Description CE Forecast CB- Actual Claimed Acti
position phase UoM (T/0) aty total (to date quantity defi
code quantity
S 116 1007 Drainage - System LF 4331.00 0.00 2,576.45 0.00 o
4 G »v

® Add costitem
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Control User Guide

4. Click the checkbox to select cost items. When you are finished, click Add.

Add CBS items

Tasks

cBS
(=] position
=] 111
[m] 112
=] 113
[m} 1.1.4
115
(@] 1.7
O 1.1.8
(@] 119
211

<

wBS
phase
code
1002
1003
1004
1005
1006
1008
1009
1010

1013

& Notes : Cost items that cannot be claimed are not displayed in this list

Descrip... CEUoM

Structural So. SF
Walls - SB Ra SF

Structural - S, SF

Traffic Model .. LF
Roadway-Ci..  LF
Landscape - Acre

D16 408 Permit | Each
Geo Report Each

Erect Structur..  Ton

Forecast

(T/0) aty

35.210.00
13,000.00
640.00
2,454.00
3,000.00
1.00
1.00
2.00

1,500.00

CB - total
quantity

0.00

0.00
0.00
0.00
0.00
0.00
0.00

Actual Claimed
qty (to quantity
date)
2915000 0
1300000 0
64000 0
220860 0
255000 0
100 0
1.00 0
200 0
000 0

2 items selected

5. Click inside the Claimed quantity field to enter a quantity for each cost item.

Posted date

07/01/2025

Claim multiple actuals:
Description

Drainage - System
Roadway - Civil Design

Erect Structural Steel for Bridges
<

Claim quantities for multiple cost items

O
D Load template Save as template

A Note: Cost items that cannot be claimed are not displayed in this list.

Forecast
(T/0) qty

4,331.00
3,000.00

1,500.00

CB-
total
quantity

(@ Add costitem

Actual
=
2,576.45
2,550.00
0.00

Claimed
quantity

1

Actuals user
defined 1

000.00
500.00

200

==y - |

Actu:
defin

»

<«

6. Enter additional details as necessary.
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5.8 Actuals by Manual Entry

Claim quantities for multiple cost items

.
) el Save as template

A Note: Cost items that cannot be claimed are not displayed in this list.

Posted date

07/01/2025 [l

Claim multiple actuals

Actuals user Actuals user Actuals user Actuals user Actuals user Estimate
defined 2 defined 3 defined 4 defined 5 defined 6 resource

Notes

Storm event on 6/30

T

(® Add cost item

7. When finished, click Claim.

Note that you can also claim quantities for multiple cost items by selecting the cost items in the CBS

register, and then opening the Actions menu and choosing Claim multiple CBS quantities.

Actions = D/ ®
h 4

Update Forecast (T/0) gty with Plan compone...

Claim multiple CBS guantities

Budget move and contract adjustment »
f:'i Lock/unlock budget » dBridge
Sync | Bound Ramp/Bri...
{ )/Bridge
‘ O 113 " Structural - SB Ramp/Bridge Misc ...
11.4 Traffic Model - Development/Anal...
115 Roadway - Civil Design
116 Drainage - System
d 197 Landscape - SB Ramp/Bridge
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phase
code

1000
1001
1002
1003
1004
1005
1006
1007
1008
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5.8.2 CLAIM MAN-HOURS

Control User Guide

Claim work hours for a specific employee or for a crew on the Man Hours tab in the Actuals details

slide-out panel.

To claim hours for a crew, enter the total number of hours worked in the Number of hours field and

leave the Employee name and Employee ID number fields blank.

See the table below for details on the available fields on the Man Hours tab.

CLAIM ACTUALS ACTUALS HISTORY

QUANTITIES CE total MHrs MHrs(to date)

12,000.00 0.00

MAN HOURS

EQUIPMENT HOURS

CosT

Number of hours

Employee name

Actuals user defined 1

Actuals user defined 3

Actuals user defined 5

Estimate resource

Notes

COMMITMENTS

Posted date

07/01/2025

Employee ID number

Actuals user defined 2

Actuals user defined 4

Actuals user defined 6

4000

CE total MHrs
MHrs (to date)
Number of hours
Posted date

Employee name

Employee ID

Page 214 of 528

Shows the Current Estimate total man-hours for the cost item.

Shows the actual man-hours claimed to date for the cost item.

Required field. Enter the hours you wish to claim for this entry.

Select a posting date for this claiming entry.

If entering hours for a single employee, enter the employee name.
Make sure that the entry matches the name in the employee record.

If entering hours for a single employee, enter the ID number. Make
sure that the entry matches the ID number in the employee record.
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T T

Actuals user defined Use these fields to enter dates based on customized field labels set up
1-2 in Platform > Suite Administration > Custom labels.

Actuals user defined Use these free text fields to enter any variable attribute based on
3-6 customized field labels set up in Platform > Suite Administration >
Custom labels.

Estimate resource You can select a resource from the Project library. You can only select
one resource per entry.

Notes Enter any notes pertinent to this claiming entry.

5.8.3 CLAIM EQUIPMENT HOURS

Claim hours for an equipment item on the Equipment Hours tab in the Actuals details slide-out panel.
See the table below for details on the available fields on the Equipment Hours tab.

CLAIM ACTUALS ACTUALS HISTORY COMMITMENTS

QUANTITIES CE total equipment Hrs Equipment Hrs (to date)

1,800.00 0.00
MAN HOURS

EQUIPMENT HOURS
Equipment ID # Posted date

cosT | 07/01/2025 B

Hours used Actuals user defined 1
Actuals user defined 2 Actuals user defined 3
Actuals user defined 4 Actuals user defined 5

Actuals user defined 6 Estimate resource

4000

T

CE total equipment ~ Shows the Current Estimate total man-hours for the cost item.
Hrs

Equipment Hrs (to Shows the actual equipment hours claimed to date for the cost item.
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date)

Equipment ID #

Posted date
Hours used

Actuals user defined
1-2

Actuals user defined
3-6

Estimate resource

Notes

You can enter the ID for the equipment item. Make sure that the entry
matches the ID number in the equipment record.

Select a posting date for this claiming entry.
Required field. Enter the hours you wish to claim for this entry.

Use these fields to enter dates based on customized field labels set up
in Platform > Suite Administration > Custom labels.

Use these free text fields to enter any variable attribute based on
customized field labels set up in Platform > Suite Administration >
Custom labels.

You can select a resource from the Project library. You can only select
one resource per entry.

Enter any notes pertinent to this claiming entry.

5.8.4 CLAIM COST

Claim cost for a cost item on the Cost tab in the Actuals details slide-out panel. See the table below for

details on the available fields on the Cost tab.

CLAIM ACTUALS ACTUALS HISTORY COMMITMENTS

QUANTITIES CE total cost

$50.000.00
MAN HOURS

EQUIPMENT HOURS

Claimed cost

CosT

Posted date

07/01/2025

Actual cost (to date)

$522175

Cost category

r4

Actuals user defined 1

Actuals user defined 2 Actuals user defined 3

Actuals user defined 4 Actuals user defined 5

Actuals user defined 6 Estimate resource

Notes

Page 216 of 528
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CE total cost Shows the Current Estimate total cost for the cost item.

Actual cost (todate)  Shows the actual cost claimed to date for the cost item.

Claimed cost Required field. Enter the cost you wish to claim for this entry.
Cost category Required field. Select the cost category for this entry.
Posted date Select a posting date for this claiming entry.

Actuals user defined Use these fields to enter dates based on customized field labels set up
1-2 in Platform > Suite Administration > Custom labels.

Actuals user defined Use these free text fields to enter any variable attribute based on
3-6 customized field labels set up in Platform > Suite Administration >
Custom labels.

Estimate resource You can select a resource from the Project library. You can only select
one resource per entry.

Notes Enter any notes pertinent to this claiming entry.

5.8.5 ADD ADDITIONAL CLAIMING ENTRIES

You can record separate claiming entries for a single cost item from the Actuals Details slide-out panel.
Click the Add icon from the bottom of the slide-out panel to add additional entry fields.

Notes 4000

@ Add claimed quantity @ Claim quantities for multiple cost items

Cancel
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5.8.6 USER-DEFINED FIELDS

There are 6 user-defined fields you can use when you claim actuals in Control. These field labels can be
customized to fit your business practices. Examples of custom labels include “Start Date”, “Area”, or
“Category”. An additional field is available to select a resource from the Project library.

Number of hours Posted date
07/01/2025 =
Employee name Employee ID number
Actuals user defined 1 Actuals user defined 2
Actuals user defined 3 Actuals user defined 4
Actuals user defined 5 Actuals user defined 6
Estimate resource
Notes 4000

Custom labels for the user-defined fields can be set up in Platform > Suite Administration > Custom
labels.

User-defined
field Type Description

Actuals user Date Use this field to enter dates, such as start and finish dates.
defined 1-2
Actuals user Free Use these fields to enter any variable attribute based on your
defined 3-6 text business processes.
Estimate Choice Select a resource from the Project library. You can only select
resource one resource per transaction.
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5.9 ACTUALS BY API

Your organization can set up APl integrations to synchronize actuals between InEight Control and an
ERP or other external system. Refer to the Control Integration Specification document for more details.

5.10 ESTIMATED ACTUALS

Estimated actuals lets you track costs, quantities, man-hours, and equipment hours on a cost item
before these values are validated through the ERP system. This provides more up-to-date visibility on
progress and increases forecast accuracy. Estimated actuals can be generated in Control through
guantity claims, or brought in from approved daily plans in Progress. After actuals are validated in the
ERP system, you can reverse the estimated actuals and maintain the confirmed actuals.

To view estimated actuals in Control, you must first enable the feature in Control’s project settings. To
enable, go to the Project Tracking tab in settings, and under Estimated actuals, switch the Turn on
estimated actuals toggle to ON, and then select the applicable cost categories under Control and
Progress.

Turn on estimated actuals: ©

Enable estimated actuals for:
Actual type
Control Progress

Labor cost @ @
Labor man hours @ @
Construction Equipment cost @ @
Construction equipment hours &) @)
FOM Rented Equipment cost @

Supplies cost @

Materials cost (&)

Subcontract cost @

Fees cost &)

Allowance cost @

G & A cost S

Undefined cost S)

When you enable estimated actuals, you can add relevant columns to a data block to view estimated
actuals.
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5.10 Estimated Actuals

Estimated Actuals
Confirmed Confirmed
actual

Confirmed Confirmed
actual cost tual may actual gty

ctu
equipment hours
I $000 000 0.00 000

$92,300.00 0.00 2,030.00 2,150.00

I 10350000 0.00 1.890.00 69500

$76,300.00 0.00 1,620.00 0.00

I $5130000 0.00 1.060.00 8000
$20500.00 0.00

! $450000 000

400.00 21.00

160.00 44.00

Estimated
actual cost

Control User Guide

<o)

Estimated E: ates Last estimated Last estimated

actual ] e
equipment man hours actual cosf
$0.00 0.00 0.00 0.00
$0.00 0.00 0.00 0.00
$0.00 0.00 0.00 0.00
$33,537.35 151.00 580.50 0.00
$26.761.60
$6,054.00

$721.75

120.00 500.00 0.00

11.00 0.00 055  05/14/2025 3. 05/14/2025 3:13:5...

20.00 80.50 000  05/06/20251

The following table shows columns related to estimated actuals.

Confirmed actual cost

Confirmed actual
equipment

Confirmed actual man hours
Confirmed actual qty

Estimated actual cost

Estimated actual
equipment

Estimated actual man hours
Estimated actual gty

Last estimated actual cost
reversal

Last estimated actual man

hours reversal

Last estimated actual eqp
hours reversal

Page 220 of 528

The expended cost verified through the ERP system.

The expended equipment cost verified through the ERP system.

The number of labor hours verified through the ERP system.
The cost item quantity verified through the ERP system.

Recorded actual cost that has not yet been confirmed through
the ERP system.

Recorded equipment cost that has not yet been confirmed
through the ERP system.

Recorded labor hours that have not yet been confirmed through
the ERP system.

Recorded cost item quantity that has not yet been confirmed
through the ERP system.

The date and time the last Reverse estimated actuals >
Reverse estimated actual cost action was performed.

The date and time the last Reverse estimated actuals >
Reverse estimated actual man-hours and labor cost action
was performed.

The date and time the last Reverse estimated actuals >
Reverse estimated actual equipment hours and construction
cost action was performed.
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5.10 Estimated Actuals

5.10.1 CLAIM ESTIMATED ACTUALS IN CONTROL

CLAIM ESTIMATED ACTUALS

1. From the CBS, right-click a cost item, and then select Actuals details.

New cost item

New subordinate cost item

Delete cost items(s)

Adjust CBS position

Update Forecast (T/0) qt...

Cost item details

Actuals details

J 4.1 CIECL DLEEl - medvy Ul g
a7 Erect Steel - Light Copy
O 413 Bolted Connections

O v 5 Materials

O 51 Earthwork - Materials

d 52 Concrete - Materials

O 53 Structure Steel - Materials @

0O 6 Merrill Iron & Steel - Steel Materig @

O v 7 Site & Demolition

O 71 Selective Demolition ®

O 72 Site Demolition - Mobilization L

O 7.3 Site Demolition - Building KL

a T4 Site Demolition - Footings & Foun Dﬂ

0O 75 Site Demolition - Hard - Building | D”

O 76 Site Demolition - Hard - Building |

a 77 Site Demalition - Hard - Building |

O 78 Site Demolition - Driveway Appro:

©

Subtotals 32 (1 rows selected)

4 —

© 2025 InEight Inc. Privacy Statement

2. From the Quantities tab, enter a claimed quantity.

Ce e ame e

CLAIM ACTUALS ACTUALS HISTORY

QUANTITIES Forecast (T/0) qty Actual gty (to date)
100.00 21.55
MAN HOURS
EQUIPMENT HOURS
Claimed quantity
COST 15.00

Posted date

06/30/2025 &=

Change summary

Terms & Conditions 2 Cost item dashboard

COMMITMENTS

Estimated actuals to be
Total cost
Labor

Construction Equipmen

ENM Rantad Fnninmant
4 G

3. When you select Estimated actuals to be added on claiming, cost category values automatically

populate based on the claimed quantity entered using Current Estimate unit rates.
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Claimed quantity

Posted date

07/01/2025

Control User Guide

15.00 Total cost $375.00 &~
Labor $375.00 ’
Construction Equipment $0.00
i ENM Rantad Faninmant annn ¥
4 »

Estimated actuals to be added on claiming:

4. Click Apply when you are done.

The estimated values for the cost item can now be viewed in the relevant columns.

Estimated Actuals

Confirmed
actual cost

$0.00
$92,300.00
I $103500.00
! $0.00
$ 76,300.00

I $51,300.00
" $20,500.00
$ 4,500.00

Confirmed
actual man
hours

0.00
2,030.00
1,890.00

0.00
1,620.00
1,060.00

400.00

160.00

Confirmed
actual gty

0.00
2,150.00
695.00
0.00
0.00
80.00
21.00

44.00

Estimated
actual cost

$0.00
$0.00
$0.00
$0.00
$28,703.85
$26,761.60
$1,220.50
§721.75

o>
Estimated

actual
equipment

0.00
0.00
0.00
0.00
140.00
120.00
0.00

20.00

Estimated
actual
man hours

6
5

0.00
0.00
0.00
0.00
10.50
00.00
30.00

80.50

Estin
actu:

5.10.2 ESTIMATED ACTUALS FROM PROGRESS

With the correct settings enabled, estimated actuals can be brought in from Progress based on
approved daily plans.

Note in the example below, prior to the creation of a new daily plan, the estimated actuals for this cost
item have a value of 0.

Actions ¥ ®
Y
Tasks

0 ostton
=] 1

o w] 2
[w] 3
w] 4
[w] V5
w] 51
52
w] 53
[w] V6
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“

®

Description

Job Overhead
Earthwork
Concrete

Bolted Connections
Structural Steel
Erect Steel - Heavy
Erect Steel - Light
Bolted Connections

Materials

WBS
phase
code

1002
1069
107
1110
1073
1074
1005
1006
1084

PAY ITEMS

Estimated Actuals

Confirmed Confirmed
actual cost actual

equipment
$0.00

$92,300.00
$103,500.00
$0.00
$76,300.00
$51,300.00
$20,500.00
$4,500.00
$604,400.00

CHANGE REGISTER AUDIT LOG View : | Unsaved (Progress) -
O s m O B = Q
<e>
Confirmed Confirmed Estimated Estimated Estimated Estimated Last
actual man actual gty actual cost actual actual actual gty estimated
hours equipment man hours actual cost
000 0.00 0.00 $0.00 0.00 0.00 0.00 4
000 2,030.00 2150.00 $0.00 0.00 0.00 0.00
000 1,890.00 695.00 $0.00 0.00 0.00 0.00
000 0.00 0.00 $0.00 0.00 0.00 0.00
000 1,620.00 0.00 $28703.85 140.00 610.50 0.00
000 1,060.00 80.00 $26,761.60 120.00 500.00 0.00
000 400.00 21.00 0.00 0.00 0.00 000 [05/14/2025 2
000 160.00 44.00 $721.75 20.00 80.50 000  05/06/20251
000 0.00 000 ($250,000.00) 0.00 0.00 0.00
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In Progress, labor hours and equipment hours are tracked on the Time Sheet tab of a daily plan.

= it  Steel Structure Training Job 2| 1.. / Progress / Daily planning
Daily Plans ; Erect Steel Module 12 - 05/14/2025 (Execution) - Plan ID 63

OVERVIEW DETAILS TIME SHEET QUANTITIES NOTES / ISSUES

B @
@ @ Add maintenance 1005 ®
Add tasks and . R
resources @ Clear hours o 132 &£ @ 11

© Alejandro Ramirez &
L Laborers - Laborer Journeyman
IN8-10023 ST 8

MH 8
© Maria Popova ®

Iron Worker - Iron Worker (Stru

IN8-10013 ST: 8

MH :8

R ®

Grove-RT880E Crane

4<= Mc-10000000 )
Operated: 8

MH -8

Quantities are tracked on the Quantities tab of a daily plan.

TIME SHEET QUANTITIES NOTES / ISSUES PRODUCTIVITY SIGN IN/SIGN OUT
>
T
4/ Module 12 - F22: Cross Brace Assembly Module 12 - F22: Cross Brace Assembly 7 El @ A
Complete Claim % Step Quantity UoM To date quantity Planned quantity Installed quantity
15 Shakeout/Transport 0.30000 Ton 0 0 0.30000
45  Erect/Bolt Up 0.30000 Ton 0 0 0.30000
30 Final Torque 0.30000 Ton 0 0 0.30000
(@] 10  QC Verification 0.30000 Ton 0 0 0
Component total 0.30000 Ton 0.00000 0.00000 0.27000
» 7' Module 12 - E24: Beam Assembly Module 12 - E24: Beam Assembly > El @
» ' Module 12 - E23: Cross Brace Assembly Module 12 - E23: Cross Brace Assembly ¥ El @

After the daily plan is submitted and approved in Progress, the estimated actuals values automatically

update in Control.
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CBS ACS PAY ITEMS CHANGE REGISTER AUDIT LOG View : | Unsaved (Progress) -
Actions v ® g ® D s m T B = Q
Y . .
Tasks ¢ | Estimated Actuals <e>
H
7 CBS Description WBS Confirmed Confirmed Confirmed Confirmed Estimated Estimated Estimated Estimated Last
a position phase actual cost actual actual man actual gty actual cost actual actual actual gty estimated
code equipment hours equipment man hours actual cost
m] 1 Job Overhead 1002 H $0.00 0.00 0.00 0.00 $0.00 0.00 0.00 0.00 A
o Earthwork 1069 ! $92,300.00 0.00 2,030.00 2,150.00 $0.00 0.00 0.00 0.00
2 i
Concrete 10N [ $103,500.00 0.00 1,890.00 695.00 $0.00 0.00 0.00 0.00
3 i
o 4 Bolted Connections 1110 H $0.00 0.00 0.00 0.00 $0.00 0.00 0.00 0.00
[m] v 5 Structural Steel 1073 $76,300.00 0.00 1,620.00 0.00 $34,24735 151.00 612.50 0.00
[m] 51 Erect Steel - Heavy 1074 H $51,300.00 0.00 1,060.00 80.00 $ 26,761.60 120.00 500.00 0.00
52 Erect Steel - Light 1005 H $20,500.00 0.00 400.00 21.00 $6,764.00 11.00 32.00 055 |05/14/2025 2:
o 53 Bolted Connections 1006 H $4,500.00 0.00 160.00 44.00 $721.75 20.00 80.50 000 05/06/20251
[m] v 6 Materials 1084 $604,400.00 0.00 0.00 0.00 ($ 250,000.00) 0.00 0.00 0.00

Estimated actuals values are only general estimates. They are not confirmed until synced with an ERP
or an external payroll system.

5.10.3 REVERSE ESTIMATED ACTUALS

After actuals are reviewed and confirmed in your ERP system, they are brought into Control through a
sync. These values are then reflected as “confirmed” actuals. Following this process, you can reverse

the estimated actuals, since the confirmed actuals now reflect the most up-to-date information.

REVERSE ESTIMATED ACTUALS

1. From the CBS, select the cost items which have recorded estimated actuals.

If you keep the estimated values without reversing after syncing with the ERP system,
those values are detected as double values.

2. From the Actions menu, select Reverse estimated actuals, and then select the appropriate type
of reversal.
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Actions = @ E ®

Update Forecast (T/0) gty with Plan compone... WES Confirmed
| phase actual cost
. . . code
Claim multiple CBS quantities I
1002 i !
f:'i Budget move and contract adjustment » 1069 H 5923
Il
Lock/unlock budget » 1o i $1035
4 s 1110 H !
3
| Syne ' 1073 $763
Reverse estimated actuals 14 3
Reverse estimated actual cost E
I.
Take snapshots
Reverse estimated actual MHrs and labor cost 5
o s Materials Reverse estimated actual equip hrs and constr... w
O 6.1 Earthwork - Mal 10

3. Click Yes to confirm the reversal.

This action will remove all estimated actual cost entries for the indicated cost items.
Are you sure you want to continue?

4. Inthe CBS, the estimated values are reset to 0.

5.11 ACTUALS HISTORY

Once progress is tracked against a cost item, you can view its actuals claim history. You can view
actuals history of a cost item by right clicking on a cost item and selecting Actuals details from the
menu. On the resulting slide out panel, you can view the history of when actual quantities, costs, and
man-hours were posted by clicking on the Actuals History tab of the cost item.
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The Actuals history tab displays and groups the actual claim history by posting date. Within in each

posting date folder you can view as-built progress details of quantity, cost, man-hours, and equipment
hours of the specific cost item selected in the CBS.

I CLAIM ACTUALS ACTUALS HISTORY
1al
Posting date Quantity Cost Man hours Equipment hours
[ 1/16/2018 0.00 5000 40.00 0.00 -

-
View more

In addition, by clicking on the posting date link, you can view more specific claim history details such as
actuals type, cost category, employee change by, and notes.

CLAIM ACTUALS ACTUALS HISTORY
Posting date A Actuals type Actuals Cost category Changed by Notes
il completed
= 11/16/2018 : Man Hours 40.00 Control - [Paul Bennion] :
View more

5.12 PROGRESS CONTROL SETTINGS

InEight Control integrates with several other programs. Within the tool, a few specific columns allow

you to manage the information that is sent to other InEight applications and to your ERP system. Below
is a table of the key columns and their functions.

Allow As-Built  Allows you to choose whether a cost item accepts actual cost, quantities,
both, or none.

Once this item receives actual costs, quantities, or man-hours, this setting
cannot be adjusted (changed from All to None).

As-built lock Once you lock the ERP status, your ERP does not allow the WBS to be
progressed.

Example use cases for locking ERP status:
» Work will not begin for two more years

» Foreman is not allowed to claim more quantity because work is 100%

Page 226 of 528 InEight Inc. | Release 25.7



Control User Guide 5.13 Vendor Work Hours from Progress

complete

» Work is complete and you do not want people mistakenly charging
cost to completed to cost items

Hide in Plan Allows the user to choose whether to have a cost item available to use in
and Progress InEight Plan and InEight Progress.
Example use case for Hiding in Plan and Progress:

¢ |Indirect staff cost codes should not be available for direct labor to
charge

The steps below walk you through the various columns and discuss options for changing the settings.

PROGRESS CONTROL SETTINGS

For this step you will need to have a subordinate available to use.
1. On the Control main page CBS tab, select the Progress view.
2. Navigate to the Task Details data block.
3. Select the second Data Panel in the Task Details data block.
4

. Double click in the Allow As-Built field of the subordinate cost item and select the drop-down
arrow.

5. Select All.
6. Navigate to the Third Panel of the Task Detail data block.

7. Select the Hide in Plan and Progress check box of the cost item.

5.13 VENDOR WORK HOURS FROM
PROGRESS

5.13.1 VENDOR MHRS FROM PROGRESS

You can see the subcontract man-hours in Control for cost items that derive from InEight Progress.
Subcontract performance can be tracked in Progress with data coming into Control for increased
transparency, improved monitoring, and analysis.
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In addition to assigning a vendor to a cost item, and viewing the assigned vendors from InEight
Contract, you can also see the claimed MHrs originating from Progress in Control > Workspaces, upon
approval in Progress.

After the claimed vendor hours are approved in Progress, the Actual vendor MHrs (to date) and Actual
columns populate with the claimed hours. This helps to find and focus on the true causes of any issues
and support the ongoing work in the best way possible.

= fr 103614 PATH Substation / Control / Workspaces
CBS ACS PAY ITEMS
Actions = ®
T -
Tasks : § Vendor

w7 CBS Description Assigned vendor Actual vendor Actual MHrs Hide in Plan
O postion MHrs (to date) (to date) and Progress
(] (7 Roofing Vendor Independent Roofing Co Inc 20.00000000000 0.00000000000 Ll

The Actuals Details slide-out panel shows the number of hours worked by the assigned vendor.

= & lossT) Solar75MW / Control / Workspaces ®
ces ACS PAY ITEMS CHANGE REGISTER AUDITLOG View - | nsavec
<
Actions  w ® @ ® 9 3 m [
Copy >
A 1020
1111102 CA- 51 - Soil Stabilization - 12° @ 6%
oY coca = TS fpast (T/0) ks CLAIM ACTUALS ACTUALS HISTORY COMMITMENTS
Posting date Confirmed Vendor man Total man Estimated Confirmed
v FinancialResults Analysis 1000 | @ wewcostiem | 1000 RS | 0 | menhous ours ours cquipment cauipment
il Results Analy 1000 @ Neweostitem 1000 PLS ! h h <t s
o v DIRECTLABOR oo (@ New subordinate costitem 1000 PLS 03 0610/2022 }Q/ 0.000 0.000 0.000 0.000
] v aviL 1002 ® Delete costitemsis) 1000 PLS Oos0y 0.000 33.000 0.000 0.000 0.000
[u] v 111, GRADING 1003 Ly Adjust CBS position 1000 FLs O 051032022 0.000 8.000 0.000 0.000 0.000
o © 1.  COUNTYROADS 1018 @ costitemdetaiis 03 08r08/2020 16.500 0.000 16.500 0.000 0.000
[m] v 1. COUNTYROADS, Take me 1023 Actuals details / 9885330  CY 03 08/04/2020 0.000 0.000 0.000 0.000 0.000
[u] 1., CR - 81 - Subgrade Prep 1024 Change summary 558330 Cv 30772012020 0.000 0.000 0.000 0.000 0000
Cost item dashboard

In Progress > Daily Plans > Timesheet, the new Vendor tab lets you choose which vendors to include on
your daily time sheet as selected vendors to claim hours.
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Daily Plans >  Daily Plan 1 - 05/20/2022 (Awaiting Approval) - Plan ID 1835891

OVERVIEW DETAILS TIME SHEET QUANTITIES NOTES / ISSUES

U

TASK EMPLOYEE EQUIPMENT VENDOR X

ADD TO DAILY PLAN
RECENT

% 0000001013-Kiewit Management Co.

ALL % 0000001125 Kiewit Industrial Canada Co
0000007 008-Midwest Aviation

0000001036-Kiewit Infrastructure West Co

Only those vendors that are assigned in Control > Workspaces can claim hours against a timesheet
Progress’s daily plan. In Progress, if a vendor is not assigned to a cost item in Control, the vendor hours
task block is disabled and hours cannot be claimed.
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= far 103614 - PATH Substation / Progress [ Daily pla
Daily Plans  »  Install Roof - 04/07/2022 (Awaiting Approval) - Plan ID 1835468
(]
2002
@ e Install Roof
Add tasks and Clear hours
resources e -
, ®
Construction Vendor not
Five 0000001042 <4— | assigned in
Z:0 Control
@. "
Independent Roofi... ST 10 agsei;?'gdl ?n
Fie 0010000758 oT —
T:20 Control
DT 5
Midwest Aviation Vendor not
Fie 0000001008 ¢ assigned in
Z:0
Control

If a vendor is assigned to a cost item in Control, the vendor can claim actual hours.
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Vendor hours

Task: 2002 - Install Roof

Vendor 758 Independent Roofing Co Inc

Time calculations Planned

ST

oT

oT

Number of employees

Clear Cancel m

5.13.2 ASSIGN VENDOR COLUMN IN THE CBS

You can assign a vendor to a cost item, and also view the assigned vendors from InEight Contract.

If a vendor is assigned via a contract, the vendor name is automatically assigned to a cost item and
cannot be removed.
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Tasks

2 CBS position

| 1

O w2

O 21

O v 22

O 221

O v 23

O v 231

O o231

O 23111
O 23112
O 23113
O 23114
O 23115

Description

Financial Results Analysis

Misc. Rev Internal

Misc. Rev Internal
Escalation/Contingency

General Project Risk

Directs

Direct Labour

Grading Work

Resurface Existing Access road
Maintain Access Road

Clear & Grub Bench B & West Layd...
Type D Excavation LD/PL/CP to E..

Road Subgrade Prep/Place/Finish...

Control User Guide

i l Assigned Vendors

Assigned vendor

Finance Group Inc.

Mining Grou... Midwest Aviation

Enterprises Inc

Power Cons... Engineering ...
Plaza Building Co... Finance Gro...

Mexico LLC

Canada Inc

Finance Gro...

Censtruction Kiewi... Infrastructur...

Clicking in an Assigned vendor field lets you add new vendors. Vendors originate from the master data
library for the entire organization.
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Vendor assignment

Vendor ID Vendor name

0000007003 Mining Group Inc.
0000007008 Aviation

0000001013 Management Co.
0000001014 Infrastructure Co.
0ooooo1022 Infrastructure Engineer...
0000001035 Engineering (NC) Co
0000007037 Power Constructors Co.
0000001039 Finance Group Inc.
0000007042 Construction Cie

0000001044 Infrastructure South Co.

0
O
O
O
O
O
a
a
a
O
O
O

0000007049 Building Company

Clear ‘ [ Cancel ]

5.14 TRACK OPEN/REMAINING AND TOTAL
COMMITTED COSTS

Additional information about purchase orders and contracts (for any particular task) can be viewed and
updated within CBS columns. This provides users with a more comprehensive data set in one location.

Committed costs are the purchase orders or subcontract commitments that a cost item may have
against it. To determine open and total commitments, look at the agreed or pending purchase order
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amounts that are associated to any particular cost item. This information is typically exported from
your ERP or accounting system.

Open/Remaining committed cost: Total committed cost - Actual cost (amount that still needs to be
paid for a cost item).

Total committed cost: The summation of all purchase order and/or contract obligation amounts
assigned to a cost item.

Open/Remaining committed cost adjustment: A debit or credit to the existing Open
committed/Remaining cost value.

New open committed cost: Open/Remaining committed cost + Open/Remaining committed cost
adjustment.

However, there is also the option to use a generic APl to push committed cost values into InEight
Control. If your organization does not have an ERP system, you can configure the endpoints in APIM
and push over your committed cost values.

VIEWING OPEN/REMAINING AND TOTAL COMMITTED COSTS

1. Onthe CBS register tab, select the Group Columns icon to the right of the page. The icon
will turn yellow when turned on.

PAY ITEMS > View - Forecasts

O s o B ¥

¢ Tasks, Task details and Commitments data block need to be present on this screen

e |f the Commitments data block has not been created, create a custom data block using the
Data Icon and include columns Remaining committed cost, and Total committed cost.
Insert this data block into your view.
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2. Drag the UOM column from the Task details data block, and drop it into the grey bar area

Drag a column header and drop it here to group by that column

Task details C esse > ¢ l| commi... <e> H
Descripti WBS Resource UoM Open Total
phase committed committed
code cost cost
=] _ Job Overhe.. 1002 Ie 100 Lump Sum f $0.00 $0.00
o _ Earthwork 1069 Is 1000 A CY i $0.00 $0.00
o I oo 1071 ls 10,000.00 ¥ I $0.00 $0.00
O A structwals. 1073 1,00000  Ton $0.00 $0.00
] 21 Erect Steel 1074 Is 40000 g4  Ton i $0.00 $0.00
(m] 42 Erect Steel .. 1005 is 200.00 | Ton i $0.00 $0.00
* Notice how UOM's are now are now visible by groups.
=
[ | cas position Deseripti wes_ Resource Forccs UoM Gpen Total
code quanti cost cost
UoM: €Y
O P earthwork 1068 is 1000 A | cv 4 $0.00 5000
O [ concrete 1071 Is 1000000 | cY i $0.00 $0.00
O 51 Heavy Steel 1085 h 10,000.00 | Y I $0.00 $0.00
(3] 52 Concrete - .. 1086 i 10,000.00 | CY 1 $0.00 $0.00
UoM: Ea
o 44 Bolted Con 1006 le 200000 | Ea 1 $0.00 $0.00
UoM: Each
o _ Materials 1084 100 | Each $000 $000
UoM: Lump Sum
O [ scboverhe. 1002 e 1.00 | Lump Sum i $0.00 $0.00
o [  cwvioment 1091 ! 1.00 | Lump Sum i $0.00 5000
O [  cwvioment mz i 1.00 | Lump Sum ' $0.00 50.00

3. To view a more granular level of information, navigate into the context menu for a cost item,
and select Actuals details.
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Cost type: Subcontracts

Ci 1.1.355 Water & Ice Distril T
Copy
1.1.356 Trash Remaoval
Paste
11322

Mew cost item

New subordinate cost item
X) Delete cost items(s)
L, Adjust CBS position

Cost item details

Actuals details

4. Once in the Actuals details, navigate to the Commitments tab.

» Here is a more concentrated view of the cost category breakdown of the Open and
Total commitments

* It's also possible to update information. For example: the below cost item for Water &
Ice Distribution, the New total committed cost is showing that a contract was signed
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for $1,267.87.

1069
1.1.3.5.5 Water & Ice Distribution

CLAIM ACTUALS ACTUALS HISTORY COMMITMENTS

Open committed cost Total committed cost
$ 700.00 $1,267.87
Cost category Open committed cost New open itted Total cost New total committed
adjustment cost adjustment cost
Total $0.00 $700.00 51,267 .87
Labor $0.00 $0.00 $0.00
Construction Equipment $0.00 $0.00 $0.00
FOM Rented Equipment $0.00 $0.00 $0.00
Supplies $0.00 $0.00 $0.00
Materials $0.00 $0.00 $0.00
Subcontract $0.00 $700.00 $0.00 $1,267.87

» There is $700.00 left remaining to pay the full $1,267.87 subcontract, as shown in
the New open committed costs column

1069
1.1.3.5.5 Water & Ice Distribution
CLAIM ACTUALS ACTUALS HISTORY COMMITMENTS
Open committed cost Total committed cost
$700.00 $1,267.87
Cost category Open committed cost New open itted Total itted cost New total committed
adjustment cost adjustment cost
Total $0.00 $700.00 $0.00 $1,267.87

Labor $0.00 $0.00 $0.00 $0.00
Construction Equipment $0.00 $0.00 $0.00 $0.00
FOM Rented Equipment $0.00 $0.00 $0.00 $0.00
Supplies $0.00 $0.00 $0.00 $0.00
Materials $0.00 $0.00 $0.00 $0.00
Subcontract $0.00 $700.00 $0.00 3126787

InEight Inc. | Release 25.7 Page 237 of 528



5.14 Track Open/Remaining and Total Committed Costs

Control User Guide

» Assuming a bill of $100.00 was just paid, it's possible to update the Open committed
cost adjustment field with this value. Notice how the New open/remaining committed
cost decreases to $600.00, after making an adjustment of $-100.00 to the Open

committed cost adjustment field.

1069
1.1.3.5.5 Water & lce Distribution

CLAIM ACTUALS

Open committed cost

ACTUALS HISTORY

Total committed cost

$700.00 $1,267.87

Cost category

Total
Labor
Construction Equipment
FOM Rented Equipment
Supplies
Materials

Subcontract

5. Select Apply to apply the above changes.

Tasks

CBS Description WBS phase
position code

Gost type: Subcontracts

11322 0SC - Third Party I... 1054
£ 11355 Water & Ice Distrib... 1069
11356 Trash Removal 1070

6. Back on the CBS, you can now see your new updated values for this cost item.

NOTE

Page 238 of 528

Open committed cost
adjustment

($100.00)

$0.00

$0.00

$0.00

$0.00

$0.00

COMMITMENTS

itted

$600.00

$0.00

$0.00

$0.00

$0.00

$0.00

— S 600.00

Task details

Forecast (T/0) UoM
quantity

13.00 Mwk
3,489.55 DMH

3,489.55 DMH

Subcentracts

Subcontracts

Subcontracts

itted cost New total committed
cost
5100.00 $1,367.87
$0.00 $0.00
$0.00 $0.00
$0.00 $0.00
$0.00 $0.00
$0.00 $0.00
$100.00 $1,367.87
Commi... <o> H
Total
committed committed
cost
$7,525.23 $13,000.00
$ 600.00 $1,367.87
$309.00 $873.24

Both the Open/Remaining committed cost and the Total committed cost values can be
edited in the Actuals details slideout > Commitments tab (with the right permissions).
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5.15 COMMITTED COST FROM CONTRACT

When the Drive committed cost values setting is on, your committed cost is then derived from
Contracts.

When the switch is off, your committed cost is driven from the ERP. Regardless of the state of the
switch, you can always manually enter your committed cost directly in the product or via a Microsoft
Excel import.

Forecast

With the setting on, all of your committed cost values initially zero out, and then pull over all of your
committed cost values that exist in InEight Contract.

For example, if you have a cost item that is associated with a contract, those values are pulled over
from Contract and populate the total committed cost and open/remaining committed cost columns.

The calculation is Forecast final cost = your Total committed cost; Forecast remaining cost = your
Open/Remaining Committed Cost.

In a contract on the Line items tab, change your view to Progress. Take note of the WBS phase code
and then view the Gross amount. The gross amount for the cost item is the exact amount for the total
committed cost, which includes your line item amount, plus tax.

Total gross amount is your line item amount plus tax. That is going to be your total committed cost
value. The calculation for that: Total committed cost = Line item amount + Tax (this is also called Gross
amount in Contract)

If you have a cost item that is associated with multiple line items in a single contract or across multiple
contracts, the total committed cost for that cost item is the gross amount for all the line items that
cost item is associated with.

If the WBS element is associated to three different line items, the sum of those three gross amounts is
the total committed cost value. A best practice is to associate a single cost item to a single line item.
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To get your Open/Remaining Committed Cost, calculate what you still have to pay for your remaining
commitments. It is your total committed costs minus what you have already paid. You track payments
in contract in three different ways:

e goods receipts
e accruals
¢ invoices
Invoices are generated in your payment forms.

The calculation is Open/Remaining Committed Cost= Total committed cost - Max(Goods receipt
amount, Invoice amount) - Accrual amount.
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EXERCISE 5.1 - PROGRESS MEASUREMENT

The purpose of this exercise is to give you more familiarity with the InEight Control progress

measurement terminology.

1. From the CBS register in InEight Control, create a new viewset with one or more custom
data blocks that contain the planned, earned, and actual measurements you would want

to see in your project.

2. Add additional productivity measurements (e.g., CF, LEI) as desired.

Congratulations, you have completed this exercise!
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REVIEW

1. How can you determine what your productivity is for a specific timeframe?
a. Excel Spreadsheet (Date Range Select)
b. Forecast Final MH (Date Range Select)
C. CB Total MH (Date Range Select)
d

. Actuals CB Productivity Factor (Date Range Select)

2. What term describes your Original Budget plus or minus approved changes?
a. Current Actuals
b. Current Budget
C. Current Estimate

d. Current Cost Changes

3. How can you view the actuals history of a cost item?

a. Select the Actuals History viewset

b. Right clicking on a cost item and selecting Cost item details
C. Right clicking on a cost item and selecting Actuals details
d

. Selecting Actuals History from the Actions menu

SUMMARY

As a result of this lesson, you can now:
¢ Define the measurements for analyzing the progress of a project
e Set up a Date Range for progress data
¢ Get Plan quantities, actual costs, and actual man-hours using the Sync feature
¢ Explain the settings used for managing progress data shared between applications
¢ Add and adjust actuals manually

¢ View actuals history
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6.1 FORECASTING
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6.2 INEIGHT CONTROL WORKFLOW -

FORECASTING

Estimate

Historical Benchmarking

Confrol

Conform Estimate / WBS Structure

Progress .
Measurement Forecasting

Account Code

(ELERE CBS Register

Create & Manage
Cost Items

ACS Register
Define Qty.
Contribution

WBS Structure / Budgeted
Quantities & Hours

Forecast Method

Setup
Account

Codes
Live

Forecast

Analyze Planned
Earned and Actual

Forecasts

Approved changes
update Current Budget

Change Management
Change Register

Budget Move

Budget
H
ent

Plan

M
Adjustm

Contract
Adjustment

Analyzed Planned & Forecast Revenue

Final Hours and Costs

Budget/Forecasts

Quantities

Revenue Management

Billed Revenue

Pay Item Register

Create/Manage
Pay ltems

o

Track Billed Revenue

Control

Forecasting

CBS Register

P Final Hours and Costs

Forecast Method
Setup

Live
Forecasts

Budget/
Forecasts

Forecast

Quantities
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6.3 FORECASTING OVERVIEW
6.3.1 FORECAST DATA BLOCK

All forecasting is done using the Forecast data block.

Forecast | InEight Control

Forecast Final Forecast Final Forecast Final Forecast Final PF Forecast Final Forecast Method

Cost MH Man Hour/Unit Unit Cost
$250,000.00 0.00 0.00 0.00 $250,000.00  Current estimate
$360,000.00 7,200.00 0.72 111 $36.00 | Current budget
$1,500,000.00 30,000.00 3.00 1.00 $150.00 Current estimate
$1,000,000.00 24,000.00 30.00 0.83 $1,250.00 Rollup
$800,000.00 20,000.00@ 25.00 0.80 $1,000.00 Manual (EAC)

The Forecast data block contains columns for determining the Forecast Final Unit Cost, Forecast Final
Cost, Forecast Final MHrs, and productivity, as well as the Forecast Method. Further in the lesson, you
will learn the details of how to input a forecast.

TIP The Control main page includes a default Forecasts viewset that contains the Forecast
data block.

6.3.2 PRIVATE FORECASTS

The Control application allows you to create multiple private forecasts as needed, giving you flexibility
to try out different forecasting methods and “what if” scenarios. The Manage Forecasts section of this
lesson walks you through how to save and share your forecasts with others on your project.

You can access all the forecasts you have access to via the drop-down on the Forecast data block
header.

This shows you all your forecasts, as well as any other forecasts that have been shared with you.

6.3.3 LIVE FORECAST

In Control, the Live Forecast is the official project forecast used for financial reporting and is shared
with all members of the project automatically. Data from other forecasts can be pushed to the Live
Forecast to keep it up to date. The Live Forecast is managed using its own data block.
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< seveee >

Forecast Forecast Forecast Forecast
final cost final MHrs final man final
hours/Unit productivit...
$1,500,000.00 30,000.00 3.00
$1,097,500.00 22,390.00 2239
$ 800,000.00 16,000.00 2000
$ 200,000.00 4,440.00 22.20
£Q7 /NN NN TaR0 NN nas

1.00

0.94

1.00

0.90

O 111572018

Forecast method

Current estimate
Rollup

Current estimate
Current estimate

Current actimata

Control User Guide

TIP The Control main page includes a default Forecasts viewset that contains the Forecast

data block.

Only users with the right permissions have access to update the Live Forecast. Updating the Live

Forecast is covered in greater detail further in the lesson.

6.3.3.1 LIVE FORECAST GRID NAVIGATION

You can access the cost categories slide-out panel quickly by clicking the Live Forecast View Cost

Categories icon.

Live forecast

I—.', For # Foreca
5 36,500.00
$25,000.00
L $ 5,000.00
$5,000.00
$1,500.00

400.00
300.00
0.00
100.00
0.00

400.00

Clicking the icon takes you directly to the cost categories slide-out panel in the cost item details.
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10019
Blue Top Aggregate Base
CURREMT ESTIMATE
DETAILS ATTRIBUTES COST CATEGORIES AESOURCES
% complete £ Live forecast method Latest actuals in forecast
values
0.00% Current estimate hd C 02/24/2022

Total  Perunit

Cost category Current budget Actual cost (to date)  Current estimate {3 Live forecast i Forecast
remaining cost
~ Total $24,106.42 50.00 $24,106.42 $24,106.42 $24,106.42
“ Labor 51687442 50.00 $1687442 51687442 51687442
~ Construction... $7,23200 50.00 $7,232.00 $7,232.00 $7,23200
“ FOM Rented ... 50.00 50.00 $0.00 50.00 50.00
~ Supplies 5000 5000 5000 5000 5000

6.4 FORECAST METHODS

The Forecast Method establishes the appropriate forecast unit cost, which is used to calculate the total
forecast cost. The Forecast Method applies to individual cost items and can be changed at any time.

You can use several forecast production methods to calculate the cost of the remaining work
associated with a cost item. This enables the control of forecasting on a cost item by cost item basis by
controlling the calculation of the cost of the remaining work. The different methods available for
forecasting are:

Forecast Methods

Current Budget Actual Total cost + (Current budget unit cost * Quantity Terminal or
(CB) remaining) superior
cost items

Current Estimate  Actual Total cost + (Current estimate unit cost * Quantity ~ Terminal or
(CE) remaining) superior
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Forecast Methods (continued)

costitems
Average Actual Total cost + (Actual unit cost * Quantity remaining) Terminal or
Performance superior
cost items
Manual Manually entered forecast value Terminal or
Superior
cost items
Rollup The sum of subordinate forecast values Superior
cost items
Committed Cost Actual Total cost + Open/Remaining committed cost Terminal or
superior
cost items
None The Forecast total cost will be 0 Terminal or
superior
cost items
Contract Line item gross amount + Draft vendor change order Terminal or
amount + Remaining to buy (value allocated to the first superior
line item in the contract) cost items
Detailed ETC Actual Total cost + sum (Forecast remaining cost) forall ~ Terminal
assigned forecast resources. cost items

Static manual time The sum of the manually distributed time phased forecast Terminal or

phased cost. superior

forecasting (TPF) cost items

Custom (customer Calculation specified by customer. Terminal or

specified) superior cost
items

6.4.1 FORECAST METHOD ASSIGNMENT

There are three different ways to assign a forecast method:
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¢ Globally to all cost items in the project
¢ Selection of multiple cost items

¢ Individual cost item

6.4.1.1 GLOBAL FORECAST METHOD

From the Actions menu, you can set the forecast method globally for all the cost items within the
project.

{le) = The Global forecast method only applies to the forecasted items of the user who
performs the function. It does not apply to other users in the project.

The following steps walk you through applying a global Forecast Method.

SET GLOBAL FORECAST METHOD

From the CBS tab register, select the View menu.
Select the Project Controls viewset.
Click on the Actions drop-down menu and select Global Forecast Method.

Select the Current Budget Forecast Method.

o k 0N~

Click Apply.

e =0 Only terminal cost items will adjust per the global Forecast Method selected. The
parent item Forecast Method will stay as Rollup.

6. Click Yes on the prompt that appears.

6.4.1.2 FORECAST METHOD FOR SELECTED ITEMS

You can also set the forecast method for selected cost items, as shown in the steps below.
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SET THE FORECAST METHOD FOR SELECTED ITEMS

1. In the Tasks data block, select the check box next to the desired tasks.

=IMENU Control & Q

75100000 - PKS Inc

~ Steel Structure Training Job View : | Forecasts v D 4 ® &

Actions v cBs Acs PAY ITEMS CHANGE REGISTER AUDITLOG Q
Tasks H Task Det.. < eses > H Forecast | Created from Live foreca. * = Cooed H Forecast | Created from Live foreca. ~ =
c8s Description wBs Foreca UM Forecast Final Forecast Final Forecast Final Forecast Final PF Forecast Final Forecast Method Forecast Final Forecast Final Forecast |
) Position Phase stT0 Cost MH Man Hour/Unit Unit Cost Cost MH Man Hour
Code aty
_ Job Overhead I 1000 100 Lump Su. 1 $250,000.00 0.00 0.00 0.00 $250,000.00  Current estimate i $250,000.00 0.00
I oo ! w002 1000000 ov ! sius000000 3000000 200 100 $15000  Cument estimate ! sius000000 3000000
) _ — s | raoon | Ton p— - o0 0300 | o p— —

“ Bolted Connections I 1005 200000 i $50,000.00 0.00 000 0.00 $2500  Current estimate I $50,000.00 0.00

o I oo 1007 100 | Each $1.750000.00 000 000 000 §175000000 | Rollup $1.750000.00 000

o BRI e vaterials ! o 1000000 cv ! szs000000 000 000 000 $2500  Current estimate ! s2s000000 000

o [ corcrete - Materiats ! 009 1000000 oY ! s100000000 000 000 000 10000 Curent estimate ! $1.00000000 000

o [EI swewesee-vaeris | 1010 100000 Ton | ssooo0000 000 000 000 $50000  Cument estimate | ssooo0000 000

Subtotals n $4,950,000.00 58,000.00 $4,950,000.00 58,000.00
‘ ,
©2017 InEight Inc Privacy and Terms | & €8 2.0.6352.34 INEIGHT )

2. Select the Actions drop-down menu and select Set Forecast Method.

@)  Steel Structure Job (105091)

Actions = G—) BT ®

Glohal forecast method..

I Set forecast method .

Claim multiple CBS guantities g

Budget move & contract adjustment »

Unlock budget co

Sync 4 St
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3. On the resulting slide out panel, select your desired Forecast Method and click Apply.

Actions = ® = )

Set forecast method I

This will apply a single forecast method to selected costitems
with an allow as-built selection for which this forecast method
is enabled in settings

(O Current budget
(O Current estimate
(O Average performance

(O Committed cost

Cancel

6.4.1.3 FORECAST METHOD FOR INDIVIDUAL ITEMS

You may need to change the forecast method for a single cost item. The following Step by Step walks
you through how to do so.

SET THE FORECAST METHOD FOR INDIVIDUAL ITEMS

1. In the Forecast data block, locate the Forecast Method column.

2. Double click on the Forecast Method field for the your desired cost item.
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¢ A dropdown menu appears where you can select your Forecast Method from a list

CBS Description inal Forecast Final Forecast Final Forecast Final Forecast Final Forecast Method Fu
Posi MH Man-Hours/Unit Productivity Unit Cost C
tion Factor

1 Job Qverhead 50,000.00 0.00 0.00 0.00 $250,000.00 Current budget 5t

2 Earthwork 00,000.00 8,000.00 0.80 1.00 $40.00 | Current budget v St

3 Concrete 100,000.00 30,000.00 3.00 1.00 5150.00 | o, 8t

Current budget
4 Structural Steel 83,768 50 19,977.80 1998 1.00 $108377 §C
Current estimate

Erect Steel - Heavy 34,158 50 15,985 60 1998 1.00 $1,167.70 Average performance S0

None
Module 01 - Erect Steel Heavy 00,000.00 0.00 0.00 0.00 $1,000.00 St

6.4.1.4 AVERAGE PERFORMANCE FORECAST METHOD

The average performance forecast method lets you use actuals for a specific time frame range to
determine the unit cost and rate for the remaining work when calculating the remaining forecast.
Forecasting using average performance lets you forecast the remainder of work based off completed
work.

When Average performance is selected as the forecast method in the CBS, you can click the value in
the Average performance settings column and select a date range to use for the actual rate of
completion for the remainder of work.

This feature lets you identify a length of time you want to utilize a cost item's hours and quantities to
determine the install rates for the remaining work.

Click an Average Performance Settings CBS record to access the Average Performance Settings
window.

T g T g s

Calculate average performance over all The average performance for the cost item
dates takes all the dates into account when
calculating its average performance.

Calculate average performance based on You can determine how many weeks or

most recent months to calculate the average performance
for a cost item. For example, you determine
that the last 2 weeks performance best
represents how to progress, then you would
calculate two weeks of average performance.
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Calculate average performance over a Selecting a date range uses only the specified

specified range time range for calculating the average
performance.

Calculate average performance from date You can select a specific date to calculate

average performance. After the learning period
for the selected cost item is complete, you can
use the average performance for a specific
date and onward.

Average performance settings

@ Calculate average performance over all dates
This will be up to date through the
O Calculate average performance based on most recent: (@ P g

most recent week ending date

-

O Calculate average performance over a specified range:
From (= To &=
O Calculate average performance from date:

&

The average performance settings can also be accessed in the cost item details slide-out panel.
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Tasks

3 CBS position Description

Subtotals 151 (1 rows selected)

e [ Actuals TS \
- il Resurface Existing Access road
Actual to
e DETAILS

Description (

Resurface Existing Access rog

CE total MHrs

2 103.20

CE MHr/Unit
0.0z

* Allow as-built

All

« Forecast T/0 qty 1
CE total cost
i $5803.84

As-built lock

[] Hidein Plan, Progress, aui/

O 1 Financial Results .
U W Misc. Rev Internal
o 2.1 Misc. Rev Internal
o V22 Escalation/Contin...
(W 2.2.1 General Project Ri..
O v 23 Directs

o ~ 231 Direct Labour

O v 2311 Grading work
23101 Resurface Existin...
o 23112 Maintain Access ..
(W 23113 Clear & Grub Benc..
o 23114 Type D Excavatio...
o 23115 Road Subgrade Pr...
o 23116 Culverts & Riprap ...
O 23117 Rock / Boulder Ex...
O 23118 Sump Excavation ...
(W v 2312 PreCast Blocks &
O 23.1.21 Set / Place Pre-C..
U 23122 Drill / Install / Gro._.
(W 23123 Build & Move Anc...
=] 23124 Test Anchors

o 23125 Relocate Existing ..
o 2.3.1.26 Anchor Re-Tensio...
(W 23127 Anchor Block Re-l...

Control User Guide

NT ESTIMATE

SOURCES FORECAST RESOURCES
* Cost source
Detail -

& Live forecast method

Average performance -

Average performance settings

(O Calculate average performance over all
dates

(O Calculate average performance based on
most recent: (@)

(@ Calculate average performance over a
specified range:

From |11/22/2018 [
To 01/10/2023 [

(O Calculate average performance from date:

[T}

To date v

As an example, if you choose to calculate the average performance based on the most recent three

weeks, the Forecast remaining cost and Forecast remaining MHrs change based off the cost item’s

performance from the last three weeks.

Actions = ® = (]

Tasks
% CBS position Description
O 1 Financial
O ~ 2111 Site .
21111 Site

The Forecast method and Average performance settings changes are also shown in the cost item

details slide-out panel.
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CHANGE REGISTER

/

AUDIT LOG

= O

$

{ ooen > C 12092022 §

& Forecast ) Forecast & Average £ Forecast £ Forecast
total cost remaining performance remaining cost method
rs
5000 0000 5000  Current estimate
$2,469,443.93 -2.409 ($101.66) Rollup
/ 2 | $2,452434.31 0000 Last3weeks | 5000 Average performan.. |

\
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O §$§ m T B 1 Q

X
1396
Site Maintenance Crew
CURRENT ESTIMATE
| F ASTR
DETAILS RESOURCES ORECAST RESOURCES
Forecast T/O qty UaM CBS position
75,181.000 MH 21.1.1.0
Last changed on Last
12/16/2022 09:54 AM
Description + Cost source
Site Maintenance Detail -
= Forecast T/0 gty ( & Live forecast method
Average performance -
CE total cost Average performance settings
Last 3 weeks -
CE total MHrs CE labor cost/MHrs

6.4.1.5 COMMITTED COST FORECAST METHOD

Committed Costs are obligations made for contract work or purchase orders that you have agreed to
pay for. The Committed Cost forecast method provides you with the ability to use committed cost
information to forecast your cost at completion.
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Forecast final

Forecast

Forecast

Control User Guide

unit cost remaining cost method
($120,539,221.43) ($122907,115.92) = Rollup
($142,040,228.20) (5142,445305.28)  Rollup
($12,535.89) (5129212.48)  Rollup
$118.05 $10,805.00 | Committed cost
54388 $8,676.00 Q,
918 S0.00 | cyrrent budget
($14,869.35) (5148,693.48) | Currentestimate
Average performance
$0.00 $0.00

None

$0.00 $0.00 5

Forecasting cost items can be done in the live or private forecast, and can be forecasted at the parent
or terminal levels. The Committed Cost Forecast method can only be used when cost items have an
Allow as-built of All or Costs. When the Allow as-built values are set to None or Quantities, this forecast
method cannot be used because cost and committed costs cannot be claimed.

The Committed Cost forecast is mostly utilized on cost items that are driven from purchase orders or
contracts. It is not used when you're claiming quantities. For example, this forecast method isn't
suitable for direct labor items where quantities are claimed to generate progress and crew
performance. This forecast method works well for cost items that are tied to a contract or PO.

When Open/Remaining Committed Cost values are being entered, these values will also update the
forecast values in the CBS. There is also an integration available that allows you to import committed
cost data from your ERP, instead of manually entering in the data. For more information on
Commitment Costs, visit subject Track Open/Remaining and Total Committed Costs within this topic3.4
Cost Item Setup on page 89

The following columns will help you view the Committed Cost forecast method:

Forecast total cost: Forecast cost at completion which is equal to the Open/Remaining committed cost
plus any Actual cost to date.

Forecast remaining cost: This is the amount of money that remaining to be paid out. This column is
equal to the Open/Remaining Committed Cost.

¥ CBS Description As-built lock Allow as-built
position

@‘ O oaroo/ze20  §
F
cost

‘orecast
method

1111 Permits All 1.00 $11,805.00 232300 00 $11805 $10,80500 Committed cost
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The Committed cost forecast method is most commonly used for costs that are associated to a
purchase order tracked through an ERP system. This method doesn't focus on quantities or percent
complete, but rather the progression of costs paid towards the final agreed upon PO value.”

6.4.1.6 CONTRACT FORECAST METHOD

Using this forecast method, you can forecast by Contract values. This forecast method is only available
in the forecast drop down for cost items that are assigned to a Contract.

e = Any modifications that you make in Contract automatically updates and comes into
Control.

L]

3 Forecast
method

Contract -

| N

Current estimate .
Average performan
Mone

Committed cost

Contract

When a cost item is assigned to a contract, you have the option of adding the read-only column
Number of contracts to your CBS. This column is an integer value that counts the number of contracts
a particular cost item is associated to. You have to go into Contracts to see which Contract your cost
item is associated to.
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Number of contracts
Number of associated contracts
in the Contract application

Number of Fc
contracts meth

36.00 1 Contr

If the Number of contracts column is set to zero, the Contract Forecast Method becomes unavailable
from the Live Forecast, Private Forecast, and the Cost Item Details slideout drop down for Live Forecast
Method on the Details tab.

Contract Forecast Method pulls the cost that is associated to a specific cost item from Contracts. Cost
items can be associated to the following if using Contract Forecast Method:

» Many different Contracts
» Many different line items across different Contracts

The cost item's Forecast Final Cost value sums up the line item amounts of all cost that is associated to
a cost item from Contract.

UNAPPROVED CONTRACT LINE ITEMS

The line item price is included in the associated cost item's Contract forecast method when creating
new line items in a Contract vendor change order.

After a new line item is saved, a batch process is initiated in the background that sends the line item’s
net price over to Control.
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Actions v @

Add existing line item |
] o Line item Il | Add new line item m = Cost:
D Ne Add new line item

Contracts > 7400007066 - contract1 >} [ Cancel J Save and new J 2%

Line item details / Quantity & pricing
Type = Quantity * UoM = Unit price * Per
Material 1000 | Each v $ 400.00 1.000 gach
Description
! Is taxable
Pricing Value §

The net price from Contract shows in Control’s forecast total cost column, which also includes the tax
from draft pending vendor change orders.

Contracts > T400007066 > 2-2 CADS contract
et Remaining amount to allocate / tesponsible party Vendor CO status Approval status
v Draft - Not applicable
$0.00 $0.00 /
e : @ = Clear all filters LU z [:J L<; _j @ Q
< e = Total revis:
1 = Costcenter =| WBScode = |GL account = =  Unitprice = [ MNetprice = fax == = s
Te 1102 - Gen 521320 - Supplies-C. ) $ 400,00 5 400.C $0.00 .
— $400.00 \ $0.00 $0.00
+

mieths

1
Description WBS phase code I
1000

Financial Results Analysis / Current estimate 50

New 1 1139 Rollup 50

New 2 1140 None $0

Misc. Rev Internal 1103 / 1 Rollup $2.402829

Misc. Rev Intemnal 104 ' Manual (EAC) Th

Escalation/Contingency nm Rollup <100 Forecast total cost

General Project Risk 102 / 52 Contract ‘ was pre\“ous[y
$600

6.4.1.7 CUSTOM FORECAST METHOD

The Custom forecast method lets you specify a calculation for a forecast cost and manhours. For more
information, refer to Project Control settings where Custom forecast methods can be configured.

InEight Inc. | Release 25.7 Page 259 of 528



6.5 Manual Forecasting Control User Guide

» Scheduling ’ Custom Forecast method calculations [’“’JE“ racking lorganization & project
= evel
~ Administration - P -
You can create custom forecast methods at both the project and organization levels by configuring your own calculations. Tasks
» Account Code Structure (ACS) Actusl
Actuals

* Control Settngs Estimated Actuals

Roles & Permissions - Enabling actusls for Progress

Project Settings ] Enabling actuals for Cantrol

Estimated actuals process overview
Reversing estimates

Custom forecast method calculations

Reversing Estimated Actuals

Time Phasing budget

Forecast (organization & project level)
Time Phasing

oo eate it Forecast
G CALG double check

Custom Forecast method
West 4 calculations

Enable Forecast methods based on
Allow as-built selections
Estimate Resources (organization &
To create a custom Forecast Method, click Add custom farecast method, and then enter the Farecast Method Mame, Forecast Total Cost and project level)
Forecast Total Mhrs calculations. You can create a maximum of 10 custom organization and project level forecast methods each at one time. Schedule (organization & project level)
Rev (project level)
Select the Formula icon to choose fields to include in your forecast formula. evenue project ey

Revenue and Cost Timing

Billing method default eamings
rules

New custom forecast method Pay item forecast takeoff quantity

o , rollups

Pay item forecast takeoff quantity
rall down

Markup
| Syne Integrations (project level)
Others (project lavel)

Required Cost Items

[ ]
ﬁ Decimal Precision
] "

Others {org level)

Dvrsiend Fock Bomme

6.5 MANUAL FORECASTING

Scenario

Assume you have a structural steel installation code being performed by a subcontractor. They
have notified the project team that the material cost of the steel has gone up due to a change of
thickness of some of the column base plates. You will need to forecast an increase in the total
subcontract cost of the code to reflect this change.

You also receive an update from the concrete superintendent that the code for a concrete
pouring operation will now be using journeymen instead of apprentice concrete finishers. He has
provided the total and you will update the total cost and the labor cost per man-hour.

6.5.1 EAC VS. ETC

You can manually enter forecast values for both your Estimate at Completion (EAC) and Estimate to
Completion (ETC) values.

Control uses different descriptions than EAC and ETC as indicated below.
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Control Term What it measures

Estimate at Completion Forecast Final Cost As-built + (Forecast Unit Cost x Quantity
(EAC) Forecast Final MHrs Remaining)
Estimate to Completion Forecast Remaining Forecast Unit Cost x Quantity Remaining
(ETC) Cost

Forecast Remaining

Man Hour

The image below illustrates what EAC and ETC measure:

Estimate at Completion (EAC)
Forecast Final Cost/MH

-
As-Built + (Forecast Unit x Remaining Quantity)
\ v
Estimate to Completion (ETC)
Forecast Remaining Cost/MH

6.5.2 MANUAL EAC (ESTIMATE AT COMPLETE)
FORECAST

You can use the Manual (Estimate at Completion) Forecast Method to make a simple, quick adjustment
to the calculated forecast numbers, or to forecast the cost of the work remaining, while ignoring actual
costs in the calculation of the forecast.

When you enter a forecast cost at the total level, you can have forecast costs:

¢ Distributed to the cost categories, or

e Back calculated if forecast man-hours are adjusted
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To set the forecast total or EAC forecast, type a value into one of the following cells within the
forecasting data block:

e Forecast final cost

¢ Forecast final MHrs
e Forecast Final Man-hours per Unit
e Forecast Productivity Factor

Forecast Final Cost per Unit

The next two Step by Steps walk you through how to define the Manual (EAC) forecast by adjusting the
Forecast Final Cost and the Forecast Final Man-Hours.

MANUALLY ADJUST FORECAST FINAL COST

1. In the Forecast data block, double click the Forecast Final Cost cell for a cost item.

¢ This will allow you to edit the dollar value manually

=IMENU Control Lo CY

¥5100000 - PKS Inc:

~ Steel Structure Training Job View : |Forecasts v D &K ® B
Actions v CcBS ACS PAY ITEMS CHANGE REGISTER AUDIT LOG Q
ces Description wes Foreca vom c:
Position Phase  stTO ost
Code ay
Job Overhead I too 100 wmpse |} 52000000 ) 000 000 525000 I 2000000 000
earthwor ! tom 100000 oy ! ss000000 800000 080 100 ! ss000000 800000
Conerete ! w0z 1000000 v 1 3000000 200 100 ] 2000000
Structural Steel 1003 100000  Ton 2000000 2000 1.00 2000000
rect seel - Heavy | oo+ soo0  Ton I sw000000 1600000 2000 100 1600000
rect Stee - Light I 1005 | 20000 Ton ! 520000000 400000 2000 100 400000
Bolted Comnections | oo 200000 e | s000 000 000 000 000
Materials 1007 100 Each 000 000 000 000
Earthwork - Materials ! o 10m000  ov ! 000000 000 ) 000 $2500  cure ! 000000 000
| 10w 100000 oy ! 000 000 000 $10000 | Curent est ! s100000000 000
L] | 100 100000 Ton 000 000 000 $50000  Current estimate 1 $500000.00 000
Subtotals n $4900,000.00 5800000 $4950000.00 5500000
©2017 InEight Inc Privacy and Terms INEIGHT (B

2. Change this value to 125,000.
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= | MENI

75100000 - PKS Inc

+ Steel Structure Training Job

Actions v cBS

Acs

sks

Description

c8s
Position
) Job Overhead

) Earthwork

) Concrete

] Structural Steel

] Erect Steel - Heavy

] Erect Steel - Light

] Bolted Connections

] Materials

] Earthwork - Materials
] Concrete - Materials

L] Structure Steel - Materials.

Subtotals. n

‘

©2017 Inight Inc Privacy and Terms

TIP

To revert to the original value

PAY ITEMS CHANGE REGISTER AUDITLOG
Task Det.. < 2 [ Forecast | Created from Live foreca.. ~
wBS Foreca  UOM Forecast Final Forecast Final
Phase stT0 Cost MH
Code ay
| oo 100 mpsu }  sas000000 000
| oo 00000 ov | 000000 800000
| 1002 1000000 cv | s1s0000000 3000000
1003 | 100000  Ton $1,000,000.00 2000000
| 1004 80000  Ton i $800,000.00 16,000.00
| 1005 20000 Ton ! $200,000.00 400000
| 1006 200000 Ea ! $0.00 000
1007 100 Each $1,750,000.00 0.00
| 1008 1000000 o ! $250000.00 000
I 1009 1000000 oY ! 100000000 000
I 1010 100000 Ton 000
$4900000.00 5800000

(Esc) key.

NOTE

adjusted.

InEight Inc. | Release 25.7

=3

Forecast Final
Man Hour/Unit

20,00

20,00

20,00

>

Forecast Final PF

View : | Forecasts

Forecast Final Forecast Method
Unit Co:

Current estimate

54000 Current budget
$150.00 | Current estimate
$100000 | Rollup
$1,00000 | Current budget
$1,00000 | Current budget
$0.00  Average performan
$1,750,000.00  Rollup
$2500  Current estimate
$10000  Curent estimate
$50000  Current estimate

6.5 Manual Forecasting

o s ® B8 ¢

Forecast | Created from Live foreca.

Forecast |

Forecast Final
Cost Man Hour

Forecast Final
MH

i $250,000.00 0.00
i $400,000.00 8000.00
i $1,500,000.00 30,000.00

$1,050,000.00 2000000
| seoo000 1600000
I $200,000.00 4,000.00
i $50,000.00 0.00

$1.750,000.00 0.00
i $250,000.00 0.00
I su00000000 000
i $500,000.00 000

$4,950,000.00 58,000.00

3

INEIGHT @

when manually typing into the cell, press the Escape

All other cost categories proportionally adjust automatically once the labor is
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Meyg= In the Forecast data block, blue dots indicate what the forecast driver is. A forecast
driver is the manually edited value that the Forecast Final Cost is based off.

Forecast | Created

Forecast Final
Cost

! $250,000.00
H $400,000.00
HH 31,500,000.00
$1,000,000.00
H $800,000.00
H $200,000.00
H $0.00
$1,375,000.00
H $250,000.00
== $1,000,000.00
I $125,000.00®

In the *Live forecast data block, orange triangles will appear in the top right-hand
corner of the cell. These indicate what the forecast driver is and give a detail of the
change when hovered over.
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Forecast Final Forecast Final Forecast Final PF Forecast Forecast Method
MH Man Hour/Unit Remaining Cost

Forecast Final
Cost

$250,000.00 0.00 0.00 0.00 $250,000.00  Current estimate

SHEEITEED Most recent change to this item
Previous Forecast  Forecast final cost  Previous Forec

§1,500,000.00
cBS Column Previous value New Value final cost new e
$1,000,000.00
2 - Earthwork ForecastMethod Current budget Current estimate $0.00 $360,000.00 0
$800,000.00
£200000 00 4000 00 7000 100 820000000 Current hudaet

3. Hover over the Forecast Final Cost cell of the value you entered and select the View cost

categories pop-up.

Forecast

Forecast Fina... Forecast Fina..

12000R ".F[Ili'ew cost categories I

¢ You can see the adjustments that were made by cost category

6.5.2.1 PROPORTIONAL ADJUSTMENT

As you make changes, you may receive a prompt asking you how you would like to adjust other values
affected by your change. For example, when you change your Forecast Final Cost, this will affect either:

¢ Forecast Final MH or

e Forecast Final $/MH
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Proportionally adjust Forecast Final MH or Forecast Final $/MH ?

The Forecast Final Cost can be medified by proportionally adjusting Forecast Final MH
or Forecast Final 5/MH. Specify the value you would like to modify:

Forecast Final MH

Forecast Final 5/MH

While one of those values will remain constant, the other will adjust as indicated in the table below:

Forecasting - Proportional Adjustment Example

Action Result

Original Forecasted Values Forecast Final Cost = $1000
Forecast Final MH = 100
Forecast Final $/MH =10

Manually adjust Forecast Forecast Final Cost changes from $1000 to $2000
Final Cost

Resulting adjustment Forecast Final Cost / Original Forecast Final $/MH = Adjusted
Option 1: Forecast Final MH

Adjust Forecast Final MH $2000/ 10 =200 MH

Resulting adjustment Forecast Final Cost / Original Forecast Final MH =

Option 2: Adjusted Forecast Final $/MH

Adjust Forecast Final $/MH  $2000/ 100 = 20/MH
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6.5.3 MANUAL ETC (ESTIMATE TO COMPLETION)
FORECAST

The Manual ETC (Estimate to Completion) forecast method can be used to make an adjustment to
forecast the unit cost of the work remaining and adding it to the as-built costs in the calculation of the
forecast.

To set the forecast remaining or ETC (Estimate to Complete) forecast, type a value into one of the
following cells within the forecasting data block:

Forecast Remaining Labor Cost/MHr

Forecast Remaining Labor Cost

Forecast Remaining Man-hours per Unit

Forecast Remaining Productivity Factor

Forecast Remaining Cost per Unit

This will set the unit cost and man hour factors. When applied to the remaining gty to deliver and
added to the existing actuals this will equal your total forecast amounts.

6.5.3.2 DETAILED ETC FC METHOD

The Detailed ETC (estimate to completion) method lets you modify the crew makeup and production
rates that drive the remaining forecast values (based on remaining quantities and hours).

For example, if you started your project and you used apprentices, and now you prefer to use
journeymen, you can swap out resources for your forecast resources and use journeymen instead of
apprentices.

In Control settings > Project Tracking, you can now enable forecast methods for terminal cost items
when the allow-as built is set to all or cost for Detailed ETC. When the Detailed ETC forecast method is
enabled, all existing Current Estimate Resources for that cost item are copied to the Forecast
Resources tab in the CBS > Cost Item Details slide-out panel.
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Terminal cost items A

When Allow as-built is set to Allor Cost
Enable the following Forecast methods for terminal cost items when Allow as-built is set to AVor Cost

Current estimate ) Manual (ETC) =)
Current budget %] Manual (EAC) %]
Average performance ) MNone ()
Committed cost ) Contract %]
Detailed ETC &

Default Forecast method for terminal cost items when Allow as-built is set to AV or Cost

Current estimate -

When Allow as-built is et to JQuantity
Enable the following Forecast methods for terminal cost items when Allow as-built is set to Quantity

Current estimate =) Manual (ETC) =)
Current budget ) Manual (EAC) ()
Average performance =) Mone )

Default Forecast method for terminal cost items when Allow as-built is set to Quantity

Current estimate -

When Allow as-built is set to None
Enable the following Forecast methods for terminal cost items when Allow as-built is set to Mone

Mone )
Default Forecast method for terminal cost items when Allow as-built is set to Nome

Mone

When the Detailed ETC setting is enabled, a new tab is available in Cost Item Details called Forecast
Resources. This new tab is almost identical to the Current Estimate Resources tab, with the major
difference being that the Forecast Resources tab contains forecast information. You can edit these
resources and values separately from the current estimate resources for a cost item.
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CBS ACS PAY TEMS CHANGE REGISTER AUDIT LOG

€W " | Unsaved (Forecasts) -

petions @ @& ® B2 O $ m I B = Q

L 4 X
Tasks 3 [ Task detaili
= Earthwork
7 CBS Description ‘WBS phase SPI CURRENT ESTIMATE
] position i) DETAILS ATTRIBUTES COST CATEGORIES RESOURCES FORECAST RESOURCES

1 Jab Overhead 1002
2 Earthwork 1069 Forecast details v
3 Concrete il

Resources v
Structural Steel 1073

a0 Erect Steel - Heavy 1074 Productivity and overall settings e

4 Erect Steel - Light 1005

43 Bolted Connections 1006 Bescourceldetalls e

Joooooleo
<
N

v & Materials 1084

6.6 FORECAST MANAGEMENT

Scenario

Imagine you are covering the concrete portion of the Steel Structure project, and you want to do
a “what if” forecast based on a potential change in the type of concrete to be used. This forecast
will affect many codes and you do not want it to affect the forecast information for everyone else
on the project. Also, your manager requested that you send him the new forecast so he can
review the data and compare it to the Live Forecast, which will help decide which path to take.

Depending on the size of your project, you may have multiple engineers involved in forecasting project
tasks. For example, a larger team may divide up responsibilities by discipline, with discipline-specific
field engineers putting together information for a project manager.

InEight Control accommodates multiple people doing the forecasting, by allowing users to create and
save their own forecasts, so they can forecast their items without affecting anyone else’s work. They
can then share their forecasts with others as needed, accessing all the shared forecasts from the drop-
down folder of the Forecast data block.

Forecast £ Created from Live fore.. ~ { o0e >
# Forecast # Forecast # Forecast # Forecast
total cost total MHr= total total

MHrefismit rrrsnefrere

6.6.1 SAVE FORECASTS

Once you have adjusted your forecast in the Forecast data block, you can save the forecast.
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SAVE FORECASTS

1. To save the forecast, click on the drop-down arrow in the center of the Forecast data block.

Forecast £ Created from Live fore..~

# Forecast £ Forecast # Forecast # Forecast
total cost total MHrs total total
EHr=/umit mrraluietierbe

2. Select Save as... from the menu drop-down list.

Forecast ¢ Created from Live fore.. ~

2z Z
t‘x_:ltaﬁ[::rg:taﬂ Forecast name GtaFlomaSt
MHrs/unit

42500 | Created from Live forecas

4000 ;
§ Sharing
51,5000

£ Private
$15162 —

$256 =y Open

5499

S 2008 D New from Live >
4

Save as

$1,7500

52500

$1.0008 send a copy
$5000

3. Inthe Forecast Name field, type InEight Control. In the Sharing field, keep the forecast as
private.
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Save as

Forecast name

InEight Control
Sharing
# Private forecast -
4. Click Save.

[l = The Forecast data block now displays the saved forecast. Any changes made within
this data block will be saved to that forecast. To get back to the Forecast data

block, select the Add data blocks button and insert the Forecast data block.

0 ml & B 1= Q

Alternatively, you can revert to the Forecasts saved view.

6.6.2 LOAD FORECASTS

You can load existing shared forecasts, as shown in the Step by Step below.

6.6.3 PROJECT LEVEL SHARED FORECASTS

You can create up to five forecasts that are automatically shared with members assigned to the
project. This lets you collaboratively work together with other team members to work on a forecast,
prior to getting pushed to the live forecast. Other members can also edit and push the live forecast.

Selecting the Shared link lets you manage between private and shared access. All team members that
share your forecast view can view and edit the forecast, and view any changes made update in real
time.
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SHARED FORECASTS

1. To share the forecast, click on the drop-down arrow in the center of the Forecast data block.

Forecast £ October202 |~

£ Forecast
total cost

S 250,000.00
5 400,000.00
51,500,000.00

51,516,282 48

£ Forecast

total MHrs

0.00

8,000.00

30,000.00

4999.10

2. Select Private from the drop-down list.
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£ Forecast
total
MHr=/unit

0.00

0.80

3.00

5.00

£ Forecast

total

productivity
0.00
0.00
0.00
0.00
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Forecast ¢ October2021~

# Forecast # Forecast
total cost Forecast name total
MHrs/unit
$2500 | October 2021 0u
4000 . 0.4
$ 400, Sharing
571,500,0 ) i i A
. Private forecast information
Z Private| .
$15162] — 15 only visible to you 5.0
$256 [ Open 0.1
2000 ) 200
3 ' D Mew from Live (3
5499 0.t
Save as
51,7500 lg o
§ 250,0 Refresh frc : 0u
1,000,40 o
$1.000, Send a copy

55000 0
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¢ The Shared forecast option automatically defaults in the drop-down selection

X

Manage access

Sharing

£2 Shared forecast -

¢ You can also send a copy of the forecast to one or more team members

X

Send a copy to

Enter one or more names to send a snapshot of this
forecast

Paul bennion)|

Paul bennion

¢ Select Cancel on the Send a copy to dialog box, and then select Save on the Manage access

dialog box
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X

Manage access

Sharing

£ Shared forecast -

{/) Send a copy Cancel

¢ Selecting Private access removes access for all team members

¢ Change the shared forecast name by clicking in the Forecast name field and typing in a
new name
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£2 Forecast 10/19/2021 8:24:6.. ~

2 Forecast
Forecast name

total
MHrs/unit
i1 M Forecast 10/19/2021 R L
040 . C
Sharing
01 z
co
62 & Shared ‘
56 [ Open C
0.0 . 2C
D New from Live »
99 L
& 5o
0. (£ saveas ;
040 C
040 C
Send a copy
01 [

e Selecting Refresh from live lets you restore forecast values from the live forecast
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Forecast 52 Forecast10/19/20218:246.. =

% Forecast % Forecast
total cost Forecast name total
MHrsfunit

$ 2500 Forecast 10/19/2021 8:2:
54000 .
Sharing
$1,500,0
E2  Shared
515162 ==

$256 [ Open

52000 )
Mew from Live 3

$ 499

g

Save as
51,7500

5250, Refrash from live

Q2

51,0000

o]

Send a copy
$ 5000

@ Push to Live forecast...

TIP You can send forecasts to multiple people at once, by searching for and adding
people to the list before clicking Send.

6.6.4 COMPARE FORECASTS

You can compare forecasts by inserting the Forecast Delta data block in your view and selecting two
forecasts from the data block title bar to compare.
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Foreca.. A [EZEEEIINRA — NN

Forecast Final Forecast Final Forecast Final Forecast Final PF Forecast Final Forecast

Cost MH Man Hour/Unit Unit Cost Remaining Cost
§0.00 0.00 0.00 0.00 50.00 50.00
5$50,000.00 0.00 0.00 0.00 $5.00 $50,000.00
50.00 0.00 0.00 0.00 50.00 50.00
(510,000.00) -1.00 0.00 0.00 (510.00) (510,000.00)

ennn nnn nnn nnn ennn on nn

You can use all columns in the Forecast Delta data block to compare the live and saved forecasts.
COMPARE FORECASTS
1. Select the Add data block button on the top right-hand corner of the Control Workspaces page.

View - | Forecasts -

O mlf & 0§ = Q

2. Inthe slide out panel on the left, select the Forecast Delta data block and drag it beside the
Forecast data block.
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(2 Steel Structure Job (105091) - Control ~ Workspaces ~
CBS ACS PAY ITEMS
Actions = @
Add data block Tasks i Wfrom Live forec.. ~ = <
CBS position Description recast Forecast F
Standard data blocks o ial MHrs final man f
hours/Unit [
o 1 Job Overhead 0.00 0.00
oAz Earthwork 8,320.00 083

8] 21 Earthwork Review 320.00 320.00

=) Earthwork 8,000.00 080
Cost category data blocks artmwer '

() 3 Concrete 30,000.00 3.00

[ | Structural Steel 37,000.00 37.00

|} 41 Erect Steel - Heavy 16,000.00 4571

3. Using the drop-down menus on the Forecast Delta data block, select both the first and second
forecasts in their respective drop-down's.

=0] (= AN Cctober Fo.. v MGad Live foreca.. v

# Forecast Fi.. Live forecast # Forecast Fi.. # Forecast Fi_. # Forecast R.. # Forecast R
October Forecast

0 o] 4] 4] 0

($798,640.68) ($3,240.00) ($3,240.00) (51.00) (521422868) ($3,240.00)

(511,379.83) (3109.00) ($109.00) 0.00961 (811,379.80) {$109.00)

(510,565.51) ($30.00) (380.00) (81.00) (52.449.51) {$80.00)

(5814.32) ($29.00) (57.25) 0.20311 5814.32) (529.00)

6.7 TIME PHASED FORECASTING

Projects are typically overwhelmed by escalating forecast values as the project progresses. What the
business thought they were going to spend doesn't end up being very accurate at the end of a project.

One way to mitigate this is to take the forecast and break it down into more consumable, estimate
related time blocks/periods, as shown in the screenshot below. This prompts the project engineers to
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think about what activities, bills, and costs are going to occur in smaller more mentally digestible time

periods.
CBS Description
Forecasted position
CBS item
Sep '19 cost Oct '19 cost Mov "19 cost Dec '19 cost Jan '20 cost Feb '20 cost
Time blocks
$1.166.65853658536 $1.129.02439024390 $1,166.09803008050 $112.90243902439 $ 300.00000000000 ® $ 500.00000000000 @

Projects need to spread their estimate by periods to verify forecast accuracy vs. the actuals spent
within that period. One of the key goals of time phased forecasting is to see when you are forecasting
to spend allocated budget. You can then determine how accurate your forecast was versus the actuals
spent within that period. Based on forecast accuracy, this gives you the opportunity to make manual
adjustments within the Time phased forecasting register. It also provides the ability to have the system
automatically distribute the forecast for you based upon certain criteria.

TPF gives you visibility into when you are going to spend dollars associated to a cost item in monthly
time periods. TPF also helps with cash flow, enabling customers to provide more insight into how much
money they need to pay employees and other bills.

After selecting a cost item from the CBS, TPF can be accessed from Control > Workspaces > Actions >
Time phased forecasting. This is only if the project settings for TPF is enabled under the Forecast
section.

CBS

Actions = @ BT ®

Global forecast method.. :
Task details
Set forecast method

Description Resource

Time phased forecasting

Claim multiple CBS quantities Financial Results A...

Budget move and contract adjustment P
9 g Basic Design Servi...

Unlock budget

Indirects
Sync 4

Contingency 1
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The table below shows the columns from the Time Phased Forecasting page.

Overview - Time phased forecast

- Resource Description

1 Auto Distribute This will automatically distribute remaining forecast based on the
remaining forecast cost curve being used, in addition to the Start and Finish dates.
based on cost
curve and start/end

dates
+] x|
=a

2 CBS position The CBS position identifier number.

3 Description The description of the CBS.

4 WBS Phase code = Work Breakdown Structure code number.

5 Start This is the scheduled start date for the cost item.

6 Finish This is the scheduled finish date for the cost item.

7 Cost Curve This is a graph/calculation of the costs of production as a function
of total quantity produced. Cost curves can be created, viewed
and maintained in Settings > Control > Schedule, in the Cost
Curves section on the page.

8 Forecast method Forecast methods include: Current Budget, Current Estimate,
Average Performance, Manual (EAC), None, and Rollup.

9 Forecastremaining This is the unsettled balance of forecast. Cost that is projected to

cost still be required to be paid out (varies depending on forecast
method).

10 Forecastfinal cost Total cost to date + Forecast remaining cost, cost item projected
total cost at completion.

11 Phased Forecast  This is the remaining forecasted cost that has not yet been
Remaining Cost allocated to a monthly period. It is the difference between the
Delta Forecast remaining cost and the sum of forecasted cost currently
represented in all remaining months on the TPF window.

12 Load more This will load additional month columns to view in the TPF
window.
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Overview - Time phased forecast (continued)

- Resource Description

13 <date> cost The forecasted cost projected to be incurred during that individual
month.

Start

Finish Cost Forecast t Forecast t Forecasf t Phased forecast Loadm. Jul "19 cost Aug '19 cost Aug'19
pae (@) (5) G ~ @ moes et final g cost (R) ® e e
code cost cost delta @

esults... | 1000 06/19/2019 | 12/31/2019  Linear Rollup $15038381.26 $15038381.26 ($15,038,381.26 $35544.88 $116944.26

11 Commercial Cost | 1025 06/19/2019 | 12/31/2019 | Linear Rollup $1.41050662  $1.410,506.62 ($1.410506.62 $984.78 $5507.29
111 G &AExpense (7... 1026 06/19/2019  06/19/2019  Linear Currentestimate ~ $1,090,208.12  $1,090,208.12 ($1,090,20812 $0.00 $0.00

112 P&PBond (0.40.. 1027 06/19/2019  06/19/2019  Linear Current estimate $67.828.91 $67.82891 ($67,828.91 $0.00 $0.00

TIP There is a Load More column that exists in the middle/top of the page. When selected,
additional monthly time buckets will be added to the page.

Forecast method Load more Jan '19 cost

Current estimate 50.00

6.7.1 TPF REGISTER

The Time phased forecasting register allows you to time phase auto spread forecast remaining costs,
which are based on cost curves, and start/end dates. You can also manually override specific months
and change the distribution costs.

For example: you have $250,000 to spend on a cost item (Forecast remaining cost). You can use Time
Phased Forecasting to spread your dollars into monthly allocation buckets. This can be done by
automatically spreading the $250,000 forecast, or by manually overriding the forecast and entering
your own values into the monthly buckets.
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CBS > TimePhased Foreca. _
Auto spread forecast Manual override
N\ N\
[ Descript WE Start Finist Cos Fo  Forecast Forecast Phase Sep 19 remaining Oct '19 cost Nov '19 cost Dec '19 cost. Jan ‘20
po phi curv me  remaining final cost remain cost
col cost delta

1 Job Overhead 1002 06/11/2019  11/25/2019  Linear Curr $ 250,000.00 $250,000.00 000.00 $0.00 $60,000.00 $25,000.00 ® $ 48,000.00

2 Earthwork 1069 11/26/2019  05/11/2020  Linear Curr $ 800,000.00 $800,000.00 $0.0 $0.00 $0.00 $0.00 $2857143

3 Concrete 1071 05/12/2020  10/26/2020  Linear Curr $3,000000.00  $3,000,000.00 $00 $0.00 $0.00 $0.00 $000

4 Structural Steel | 1073 10/27/2020  04/12/2021  Linear Roll $1,050,000.00 $1,050,000.00 $0.0i $0.00 $0.00 $0.00 $0.00

6.7.2 AUTO DISTRIBUTE

The Auto distribute icon allows you to have the system automatically allocate remaining forecast as

determined by your Actual Start date, Actual Finish date, and Cost Curve.

CBS > Time Phased Foreca..
a Auto distribute remaining forecast based on
28 cost curve and start/end dates

CBS ‘ﬁ"'\ Load m.. Jul'19cost Aug '19 cost

positio
T4 1.1 Basi..| 1001  03/. 09/. L Roll.. = 10,0 1,092,364,798.677 12,310,649,399.471
T4 1.1 Indi. 1002 | 03/. 09/. L Roll.. | 121 1,092,364,798.677 12,310,649,399.471
L4 111 Con 1003 07/ 09/ L Curr 126, 19,187,552.694 1,641,816.243

1.1.1.2 Job.. 1009 06/. 09/. F Curr... USD. USD 21,497,584.087  USD 11,845,050,361.155

1113 Desi.. 1006 07/ o7/ L Curr 6.5 (136,936.199) 3.116

1.1.1.4 Job .. | 1004 03/ 12/. B Roll.. = (21.. 961,605.565 (1,068,557.342)

1.1.1.41 Desi.. 1005 03/ 08/ L Curr.. 30,1 (86,894.355) (253,032.894)

Aug'19
remaining cost

12,567,815,504.198

12,567,815,504.198

102,472,320.000

USD 12,345,678,901.123

0.000

(1,535,622.827)

30,158.730

The Auto distribute icon allows you to automatically distribute dollars into monthly allocation buckets.
In this case, the allocating of dollars will begin on the Start date of May 2020 and stop allocating on

Finish date month of October of 2020.

Descript WBS Start Finisk Cos' Fo Forec Phased Sep '20 cost Oct '20 cost
phase cun me rema forecast
code cost remaining...
Concrete 1071 05/12/2020 10/26/2020 | Linear Curr..  $3.,000,00 $0.00 $ 55357143 $535714.29

6.7.3 MANUAL TIME PHASED FORECAST

Using the same example, it’s also possible to manually forecast the allotted $3,000 into your desired
monthly buckets. By manually entering in $400,000.00 into the Oct 2020 bucket, your Phased forecast
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remaining cost delta changes to $135,714.29. This represents the remaining amount of dollars to still
be forecasted.

Descript WBS Start Finisk Cos Fo Forec Phased Aug "20 cost Sep "20 cost Oct '20 cost
phase cury me rema forecast
code cost remaining...

Concrete 1071 05/12/2020 10/26/2020  Linear Curr. $3,000,00 ($135,714.29) 3535,714.29 $553571.43 $553571.43 $ 400,000.00

On the right side of the screen, a blue circle displays by the forecast quantity when a manual override
to the forecast quantity is performed. If you hover over the blue circle, it shows a description of the
manual override.

Sep '19 cost Oct '19 cost Mov '19 cost
$238,134.05 522191098 S 1,266,
$10,723.09 576,254.74 5$3
S 0.00 5 500.00 h
$0.00 Manual Override:
Changed by: paul trippi
$ 0.00 Change date: 08/05/2019 04:29 PM

Value before: S 0.00

On the left side of the screen, a manual override to the forecast amount shows a warning symbol by
the cost curve. Hovering over the warning sign shows that the cost item contains a manual change to
the time phased months, and thus, the cost curve is no longer accurate.
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CBS Description sk Cost Forec Fo
position curve meth rer
co
1 Financial Resulis... (31/2019 | Linear Rollup g
1.1 Commercial Cost (31/2019 | Linear Rollup 8
111 G & A Expense (7. 19/2019 Linear Current es_. g
[
lag’
1.1.2 P & PBond (0.40.. 1972 Costitem contains manual time

phased months

L e | Ol men! Tliale lee AN AN N I S e e o b e

6.7.3.1 PROPORTIONAL MAN HOURS AND QUANTITY

In addition to Cost, Man hours and Quantity displays on the Time phased forecast grid. If you manually
adjusted the cost for one of the months in the grid, a dialog box appears asking to proportionally
adjust Man hours and the Quantity.

X

Propartionally adjust MHrs and/or Qty ?

The man hours and quanfity can be modified proportionally for
this fscal pemod

Man hours

Ay
Quantity

Die s Tor all cost items and don shodw this message
again
This dmlog can be ne-enacded Trom e Sethngs men |} ) nihe

plo=1it ¢

Cancel Ok
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If for example you doubled your cost in the Time phased forecast, it would also proportionally double
your Man hours or Quantity. You can view the values that the man hours and quantity would
proportionally adjust to in the read only cells.

If you manually adjusted Man hours or Quantity in the Time phased forecast grid, a dialog box appears
asking to proportionally adjust cost and man hours .

X

Proportionally adjust Cost and/or MHrs ?
il if

The cost and man hours can be mi ed prapartionally for this
hscal pesiod
1] I
D A Tor & #1 items and | this meazage
agai
his dialog can be re-enatled from the Settings menu () m the

Both dialog boxes have the option to adjust proportionally without showing the message again. If you
selected this option and want to revert settings back to see the dialog again, in the Time phased
forecast grid, go to the Settings icon and select Enable dialogs.
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[=]

Ces
posi

Enable
1o shiow upo

I I R I

In the Time phase forecast grid, you can also select to export to Excel.

@] Publish
‘\‘_

Hovemiber 7020 December 2020 i
R
oty Cast Mhbrs Oty Cozt Mhirs 5
-0.14 {5 10000.00) » oo @ 100 & §2.542.37 0.00
0.00 5311330 aaz 0o 5532280 53218
.00 100000 - g = 0 = 50000 0.0
Q.0 S 0.00 LR (L] 5000 .00
Qi e SRA5a7 = B0 @ 013 = ST e
Selecting this exports everything that is in your view to an Excel spreadsheet.
A B | € D E | F 5 H I J K L M | N | O P a R 5
ZBS stili-_Desl:ripLia WBS phas Start Finish Forecast nCost curve Forecast r Forecast r Oty remai Phased fo Phased fo Phased fo March 20: March 20: March 20z April 2020 April 2020 April 20201
1L1.1.1.1 MAINTAIN 1348 HHHHEEER SRS Manual (E Linear 10000 100 1 -12627.1 100 1.262712 o 0 a o 0 a
1.1.1.1.2 FUEL AND 1017 SH8EEHEE saaEE Manual (E Bell Shape 10000 100 -99 0.001005 900 99 o 0 0 a
1.1.1.1.3 GAS&DIE 1018 HEHEEHEH #@EEEE Manual (E Front Loac 10000 100 -220 1000 -100 220 o 0 a o 0 a
11.1.1.4 FUELHOSI 1474 #uBBEHHH satwaiit Manual (E Back Load 10000 100 1 -1.7E-05 -100 0 o] 0 [ "] 0 ]
L1.1.1.5 Maintenal 1476 fHBHREHH #istaiie Manual (E Linear 10000 100 1 -535.826 -5.35826 0.01142 0 0 a o 0 a

6.7.4 STATIC MANUAL TIME PHASED FORECASTING
(TPF)

Static manual TPF lets you distribute a time phased forecast in the future without causing a
redistribution. All values entered in the TPF are constant, and any deltas based on current month
actuals that do not equal what was forecasted for that month, must be spread manually.

To enable the static manual forecast method, the Forecasting and Push time phased forecast to Live
forecast toggles must be set to On in Settings > Control > Forecast.
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— = 103961 Settings

» PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE
< 1
R -
d;'
Time phasing
@
Enable time phasing for the following:
®
Forecasting (i) @)
- Push Time phased forecast to Live forecast ©
@
commitments () e

The static manual forecast can be enabled on the Time phased forecasting page by first making a
change to any of the distribution fields. After you click the Publish button, the Push these values to the
Live forecast dialog box opens. When the Do not redistribute manual spread check box is selected, the
values entered in whole months remain as-entered and are not automatically redistributed when

actuals are incurred or months close.

Push these values to the Live forecast?
Please review the changes below. and then click "Yes” if you wish 1o push thes values to the live foreeast

Current live forecast values
ces Description Livaforeca o Forecast ramaining | Forecast remaining
remaining cost cost manhours

EAR) FWCEB/C $175.00 $22500

Do not redistribute manual spread (1)

The forecast method for the CBS record automatically changes to static manual TPF, and the forecast
remaining cost and forecast total cost changes based on the distribution amount adjusted in TPF.
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a

GBS Description © Forecast © Forecast © Forecast © Forecast D Forecast
position remaining cost total cost remaining remaining unit method
rs cost
3
O v 31 Misc. Rev External $2375.00 $245,042.96 75.00 5950000 Rollup
~
31 FINC B/C $225.00 $325.00 000 $45000 Static manual TPF_ ¢ Sratic Manual TPF (estimate
at completion)

“

If costs are claimed for the CBS item, the forecast total cost remains the same, but the forecast
remaining cost is reduced from the claimed actual quantity.

/ CLAIM ACTUALS ACTUALS HISTORY COMMITMENTS
Description CE total cost Actual cost (to date)
S100.00 510000

a w31 Misc. Rev External
31l FWC B/C Claimed cost Cost categary
) 50 333333 F 4
= w312 Vantage Dewaten
O 31.21 | CraftLabor

Posted date
O 3122  Equipment 04/21/2023

Tl Live forecast |E| & current live

- 3 Description & Forecast o Forecast

O pasition femanang cost total cost

0 w31 Misc. Rev External / $2325.00 524504296
31 FWC B/C / | $175.00 §32500 I

In TPF, the claimed amount now shows the phased forecast remaining cost, which represents the
remaining amount that still needs to be spread. The phased forecast remaining cost now must be
deducted somewhere from the TPF distribution.

GBS Description orecast Forecast Remaining gty Phased
(] position in... remaining forecast

MHrs remaining cost
O 31 FWC B/C 5175.00 0.00 0.50 | $ 50,00

6.7.5 TIME PHASED FORECAST SETTINGS

Time phased forecast can be turned on in Settings > Control > Project Settings, in the Forecast section
of the page.
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If the setting is turned off, you will not see the Time phased forecasting option in the Actions drop-
down, CBS tab, in the Control > Workspaces page.

6.7.5.2 ENABLE TIME PHASED FORECASTING

TI me phaS irl g Time phased forecasting provides the ahility to

spread forecast remaining values into the projects
fiscal periods. Mavigate to Project details to set the
Start and End dates which define the earliest and
Enable time phasing for the following: | latest project periods.

Forecasting (3) ®

Push Time phased forecast fo Live forecast &)

6.7.5.3 COST CURVES

Cost curves determine the proportion of money to be expended in a certain period of time. In the case
of Time phased forecasting, the type of cost curve being used determines how forecast will be spread
across the monthly forecasting buckets.

In addition, the fiscal calendar also influences how the forecast is spread.

Cost Curves are found in Settings > Control > Schedule, in the Cost Curves section of the page.

Cost curves

Customize cost curve tables

®
Description Data points
Linear 20
Front Loaded 2
Back Loaded 2
Bell Shaped 21

By selecting a Cost Curve and selecting the View icon, you can view its default distribution.
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® [®

Description

+ Linear

In this case, the Linear Cost Curve settings displays the cost curve durations and values.

Description Number of points
Linear 20
From duration % To duration % Value %
0.00% 5.00% 5.00%
5.00% 10.00% 5.00%
10.00% 15.00% 5.00%
15.00% 20.00% 5.00%
20.00% 25.00% 5.00%

Total 100.00%

For example, using a Linear Cost curve, with a Start Date of 05/12/2020, the Forecast Remaining cost is
$3,000,000.00, with a Phased forecast remaining cost delta of $O. This means that you are forecasting
to spend $3,000,000.00, and your Phased Forecast Remaining Delta is zero because your Time Phased
Forecast is now fully met (you have fully forecasted $3,000.000.00).

CE Descript WE Start Finish Cos' Fo Forecast Forecast Phased forecast

pc phi cury me¢ remainin final cost remaining cost
cot cost delta
3 Concrete 1071 05/12/2020 10/26/2020 Linear Curr.. | $3,000,000.00 $ 3,000,000.00 $0.00

Since your scheduled Start date is 05/12/2020, the system will start forecasting money on this cost
item in May. Based on the Linear Cost curve and the fiscal calendar it will stop forecasting money in
October 2020. This is based off your scheduled Finish date of 10/26/2020. Over the period of 6
months, your spend is totaling 3,000.000.00.

May '20 cost Jun "20 cost Jul '20 cost Aug '20 cost Sep '20 cost Oct '20 cost

$339,285.M1 $ 500,000.00 $ 500,000.00 $ 625,000.00 $ 500,000.00 $535714.29
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6.7.6 TIME PHASED FORECAST PREREQUISITES

There are certain requirements for a cost item to be eligible for time phased forecasting.
1. The Schedule data block must have a Start and Finish date.

2. The Schedule data block must have a Cost curve association.

6.7.7 TIME PHASED FORECAST VIEW

You may want to create a View in your Control Workspace similar to this one showing a Time Phased
Forecast in comparison with the Live forecast. This shows the hours you are forecasting to spend
money (TPF) vs. the Live forecast.

3 Descrif WBS Start Finish Cost Forecast Forecas Forecast Forecast Forecast Forecast Forecast final
poi phas curve remaining method final cost final man final MHrs final unit cost
code cost hours/Unit productiv...
1 JobOverh 1002 06/11/2019  11/25/2019  Linear $ 250,000.00 ($0.00) Current esti $250,000.00 0.00 0.00 000 $ 250,000.00
2 Earthwork 1069 11/26/2019  05/11/2020 Linear $ 800,000.00 ($0.00) Current esti $800,000.00 1.60 16,000.00 1.00 $80.00
3 Concrete 1071 05/12/2020  10/26/2020  Linear $3,000,000.00 $320,000.00 Current esti $3,000,000.00 6.00 60,000.00 1.00 $300.00
4 Structural 1073 10/27/2020  04/12/2021  Linear $1,050,000.00 ($1,050,000.00) Rollup $1,050,000.00 21.00 21,000.00 1.00 $1,050.00
Erect Steel.. 1074 Linear $ 800,000.00 ($800,000.00) Current esti $800,000.00 20.00 16,000.00 1.00 $1,000.00
Erect Steel.. 1005 Linear $ 200,000.00 ($200,000.00) Current esti $200,000.00 20.00 4,000.00 1.00 $1,000.00
Bolted Con 1006 Linear $50,000.00 ($50,000.00) Current esti $50,000.00 050 1,000.00 1.00 $25.00
5 Materials 1084 Linear $1,750,000.00 ($1,750,000.00) Rollup $1,750,000.00 0.00 0.00 0.00 $1,750,000.00
Earthwork 1085 Linear $ 250,000.00 ($250,000.00) Current esti $250,000.00 0.00 0.00 000 $25.00
Concrete - 1086 Linear $1,000,000.00 ($1.000,000.00) Current esti $1,000,000.00 0.00 0.00 0.00 $100.00
Structure 1087 Linear $500,000.00 ($500,000.00) Current esti $500,000.00 0.00 0.00 0.00 $500.00
Subtotals 11 $6,850,000.00 $6,850,000.00 97,000.00

The following steps walk you through how to plan Time phased forecasting.

TIME PHASED FORECAST PLANNING

1. To start time phased forecasting, on the CBS tab, select your pre-determined CBS items as
shown below.
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Tasks ¢ l Schedule
GBS position Description Scheduled Schedule ID E:cgdule plug Plug days
2 1 Job Overhead v HD.0000003 0.00
2 2 Earthwork v HD.0000019 90.91
2 3 Concrete v HD.0000044 375.00
2 4 Structural Steel v HD.0000046 v 262.50
2 41 Erect Steel - Heavy HD.0000064 200.00
2 4.2 Erect Steel - Light HD.0000105 50.00

2. Select Time phased forecasting from the Actions menu.

Actions w BT ®

Global forecast method.. . .
Fiscal calendar settings have beer

Set forecast method

Time phased forecasting |
Claim multiple CBS quantities R
Budget move and contract adjustment P

Job Overhead
Unlock budget

Earthwork
Sync »

- = Concrete

¢ This action opens the Time Phased Forecast window, where you can see the CBS on the
left side of the screen, and its associated forecasting monthly allocation cost buckets on
the right

CBS > Time Phased Foreca..

Publish
CE Descript Wi st Finish Cor Fo  Forecast Forecast Phased| Toadm . Jul'19cost Aug ‘19 cost Aug'19 Sep 19 cost Oct 19 cost
po ph cur me remaining final cost remain| remaining cost
co cost delta

1 Job Overhead | 1002 06/.. 11/25/2019  Lin curr. $250000.00 $250,000.00 $0.00 $18,000.00 $18,000.00 $62,000.00

2 Earthwork 1069 11/.  05/11/2020  Lin curr. $800,000.00 $800,000.00 $0.00 $0.00 $0.00 $0.00

3 Concrete 1071 05/ 10/26/2020  Lin. Curr..| $300000000  $3000,000.00 $0.00 soo0e $0.00

41 Erect Steel - . | 1074 Lin. curr. $800,000.00 $800,000.00 $ 0.0 $000 $0.00 $000

42 ErectSteel - . | 1005 Lin curr $200000.00 $200,000.00 $0.00 $0.00 $0.00 $0.00

4 Structural St.. | 1073 10/..  04/12/2021 | Lin. Roll. | $1.05000000  $1,050,000.00 $0.00 $000 $0.00 $0.00

3. For one of your cost items, type in $500 in one of the monthly bucket fields.
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Feb "20 cost Mar '20 cost Apr '20 cost
$0.00 $0.00 $0.00 $0.00
147,619.05 514761905 5138,095 V 5147,619.05
$0.00 $0.00 S50000 @ 50.00

S 0.00 S 0.00 S 0.00 S 0.00
S0C 5 0.0 5 0.0 5 0.0

» Notice how the field now has a blue circle next to the $500.00. If you hover over it, you see
the value before, after, and the date the change was made

$ 500 oq%

Manual Override:

£

I

Changed by: paul trippi
Change date: 08/06/2019 08:25 AM
Value before: § 0.00

Fes

&0 AN
2 0.00

¢ Because of the manual adjustment, a warning sign appears on the Cost curve for this cost
item. The cost curve is not being changed to manual, but the system records that this cost
item is no longer linear, because it has been overridden

CE Descript wi Sti Finish Cost

po ph curve
co

1 Job Overhead = 1002 06/ 11/25/2019  Linear

2 Earthwork 1068 11/ 05/11/2020  Linear

3 Concrete 1071 09/ 10/26/2020  Linear D
¢ The override made to this cost item is no longer needed, and you now decide you want to

revert to its original setting, and have the system Auto distribute the forecast

4. Make sure your cost item is checked, then select the Auto distribute icon.
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CBS > Time Phased Foreca..

Auto distribute remaining forecast based on
%lm cost curve and start/end dates
CE Descripr’

we stan s Cost
po ph: curve
col

< 3 Concrete 1071 05/12/2020 10/26/2020  Linear

¢ This action will revert the time phase values back to the same numbers as they were prior

to any manual adjustments, plus:
a. It will erase any manual adjustments

b. It will distribute the remaining forecast values based on cost curve and start/end
dates of that specific cost item, as determined by the fiscal calendar

¢ The result of selecting the Auto distribute icon starts its forecasting spread on the cost
item’s Start date of 05/12/20, and will Finish its schedule on 10/26/20

[-I]
=8 -

—
Descript WBS Start Finist Cos' Fo Forec Phased ig '20 cost Sep "20 cost Oct '20 cost
phase cury me rema forecast
code cost remaining...

Concrete 1071 05/12/2020  10/26/2020 Linear Curr $3,000.00. $0.00 $ 55357143 $553571.43 $535714.29

Wlegg= Itisimportant to remember the purpose of utilizing Time Phase Forecasting is to
see how you are forecasting to spend money over a period of time. The

expectation is to get the forecast adjusted to where it should be, and update costs

as needed.

6.7.8 TIME PHASED FORECAST MICROSOFT EXCEL
IMPORT

You can import a Microsoft Excel file to update the values in Time Phased Forecast by selecting Import
on the Time Phased Forecast page to download the time phased template. To import time phased
forecast values, you can download a template as shown in number 2 in the image below to use as a
guide to import your new time phased forecast values. The same format provided in the download
template is required for the import to be successful.
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CBS Time phased forecasting o
/ Nov 2023 - May 2024 - £3 G
CBS Description WES S “scember 2023 w
[ position phase — rars
= Remaining m... Qty RN Gty Cost
0O J o = 0.00 50
[
Import time phased values
L mpart from Excel (xlsx, xis) or Comma separated vahee [ csv)
0 0.00 50
0 ' 0.00 0

=1
2]

Downloa . I 2 only the cod and
L. Download time phased template e only the columns and

) ©

I Wi,
nn header names. Only
populated fields will be imported. Blanks will
be ignored and proportional adjustments will
not oocur

Cancel

INEIGHT @

The Excel file includes the cost items that are in your current Time Phased Forecast view. Columns in
orange are required, columns in yellow are optional to change, and columns in grey are ignored and
cannot be changed. When you are finished making your Excel changes, you can then import the Excel
file into Control to update the Time Phased Forecast with your new values. Column header names are
ignored if changed.

A A B C D E L L N o

Required /
Yellow | Optional
| Ignored

1

2

3

4

s 92 Phased forecast rema Phased forecast rema Novembe Novembe Noi
&

7

8

1 Financial Results Analysis 1000 Cu 1] -1 [} [
) Misc. Rev Internal 103 1/1/2024 3/31/2024 0 -0.000956353 0 0
2.3 Directs 001 1/1/2024 3/31/202 56 [ 9.1€-09 [} 0
9 23114 Type D Excavation LD/ PL/CP to Embankm 1007 LY 1] a 0 (1]
102.3.1.1.5 Road Subgrade Prep/PlacefFinish (1600 1008 Ci 0 o [ 0
11 2.3.1.18 Sump El(ah’a‘llnﬂ&EatkfIH‘CONDlTlONA'loll / o [1) o 0 1]

1

Updates are made when you select Publish. Excel imports are shown in the Import History Audit Log,
where you can download the Excel file to see a list of errors if the process fails.
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TIME PHASED FORECAST MICROSOFT EXCEL IMPORT

1. To start time phased forecasting, on the CBS tab, select your pre-determined CBS items as
shown below.

] -
Tasks N BEEGEES
= CBS Description Forecast (T/0) UoM Actual MHrs
position gty (to date)

1 Financial Results ... 100 PLS 0.00
v 2 Misc. Rev Internal 100 PLS 7,030.50
2.1 Misc. Rev Internal 100 PLS 0.00
v 23 Directs 100 PLS 3821.00
v 231 Direct Labour 100 PLS 3,067.00

2. Select Time phased forecasting from the Actions menu.

Actions = BT ®

Global forecast method.. . .
Fiscal calendar settings have beer

Set forecast method

Time phased forecasting |
Description

Claim multiple CBS quantities

Budget move and contract adjustment P

Job Overhead
Unlock budget
Earthwork
Sync »
- = Concrete
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3. Select the Import icon.

CBS *  Time phased forecasting

Dec 2023- Jun 2024~ £33 G

CBS( Description W;PS February 2024 «
[]  positien gﬂg:e Mhrs Qty Cost
5000 0.00 0.00 $0.
3000 0.00 0.00 S0

NN NN

4. Click Download time phased template.

Import time phased values
Import fram Excel ( xlsx, xls) or Comma separated value (_csv)

Browse

S}

Template will include only the columns and
rows currently in your view.

Do not change column header names. Only
populated fields will be imported. Blanks wi
be ignored and proportional adjustments will
not occur.

Cancel

J. Download time phased template

@

5. Adjustment any of the fields under the yellow columns. For example, for CBS position 2.3,
change the February 2024 Cost from 13.62637329 to 9, then save your changes.
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T1 - S
A B S | T u | \4 \ X Y

1 Required

2 Optional

3 Ignored

4

5 February 2024 Cost February 2024 Mhrs February 2024 Qty March 2024 Cost March 2024 Mhrs March 2024 Qty
6 1 Financial Results Analysis 0 0 0 0 0 0 1]
77’2 Misc. Rev Internal 0 13.62637329 10 0.000614656 12.74725243 10 0.000575001
8 2.1 Misc. Rev Internal 0 0 0 0 0 0 0
97 2.3 Directs 0.001413 13.62637329 10 0.001990392 12.74725243 10 0.00186198
107 231 Direct Labour 0 13.62p37329 10 0 12.74725243 10 0

Financial Results Analysis
Misc. Rev Internal

Misc. Rev Internal
Directs

Diract Labour

6. Select the Import icon again.

0.001413

0 13.62637329

@ | [T

Dec 2023 - Jun 2024 -

IF;

7. Select Browse, and then navigate to th

Import time phased values

Import from Excel (xsx, xis) or Comma separated value (csv)

Drag and drop the file here

L Download time phased template ©  Template willinclude only the columns and

fows currently in your view.

e Excel file you just saved, then select Open.

@® Do not change column header names. Only
populated fields will be imported. Blanks will
be ignored and proportional acjustments will
notoccur
Cancel
@ Open X
1 ¥ > ThisPC > Downloads v 0 O Search Downloads
Organize ~  New folder = m @
¥ Downloads ~  Name Date modified Type Size 1
b Music + Today @
= Pictures B Time phased templatexisx 1/23/2024 10:34 AM Microsoft Excel Work. 11K
8 videos £ receipt.paf 1/23/2024 821 AM Adobe Acrobat Docu 50 K8
v < >
File name: |Time phased templatexisx ~| A Fites ) v
[Com | o

8. Select Import.
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Import time phased values - Time phased template xIsx

Import from Excel (. xIsx, .xIs) or Comma separated value (.csv)

i Download time phased template

Drag and drop the file here

or browse

Browse

() Template will include only the columns and
rows currently in your view.

() Do not change column header names. Only
populated fields will be imported. Blanks will
be ignored and proportional adjustments will

not occur.

6.7.9 COLUMN CHOOSER

Cancel

Control User Guide

When you open the Time phase forecast, a column chooser has been added to the grid.

Column options

Available coduming

Account code

Aetwal Timish

Actiual start h
L

Al &g -hiil

As-built kock

CBS contrinste

quantity

CBS tag

CBS tag 10

GBS tag 11

CBS Lag 112

sefecied columng

3

=

WBS phase code

Coet curye

Farecas] remaiming cosl

FOrecaEt remairning man o

Oty rermnainireg

Cancael

X

After you choose which columns to show, the left side of the grid updates with your selection.
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On the right of the grid, you can also adjust your view for each month's Cost, Man hours, and Quantity.
This can be done using the drop down next to the month and deselecting the options you do not want
to see on your grid.

Nevensber 2020 .-1':"‘| December Z0Z0 -
[ M Cost Fhis Oty
s -0.26 § 254237 0.00
Fins 1AL SaddeHd L]
1AL g |
Wan hours o 0 ol
0.26 5 2 543 4
Ouantity o

Apply 1o &l migeths

ey g= If you select cost from past dates, the data is read only.

6.7.10 AUDIT LOG

All changes made within TPF are captured in the Audit log within Control Workspaces. The Audit log
captures changes based on any changes made to a forecasted CBS item.

In the example, it shows that a forecasting value was changed on 08/13/19 for Audit ID 232. The
forecasting value had been changed from 89.36 to 100.00 for the Aug '10 remaining cost time period.

Audit Data type Item Descripti WBS Attribute Change Changed Value Value
CBS ID type by date before after
ACS 232 | Time phased forecast | Cost item Job Overhead 1002 Paul trippi 08/13/2019 0. 89.36 100.00
Pay items 225 Current Estimate Estimate r. C01.04-Coner. Resource employed Paul trippi 08/13/2019 1. Resource e
Integration 224 Current Estimate Estimate r. E.01.05-Earth Resource employed Paul trippi 08/13/2019 1. Resource e
Import history 223 Current Estimate Estimate r.. C01.04-Coner. Resource employed Paul trippi 08/13/2019 1. Resource e

6.8 PUSH TO LIVE FORECASTS

As mentioned above, the Live Forecast is the official forecast used for financial reporting and shared
with all members of the project.

You can push forecasts entered in the Forecast data block to the Live Forecast either individually or by
selection. This allows you to send only the items that you choose from your forecast to the Live
Forecast.
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The Live Forecast can only be updated if the user is assigned the appropriate role with the associated
permissions. Project Admin or Power User can edit the Live Forecast directly.

Mo} =0 Forecast changes made in the Forecast data block WILL NOT be pushed to the Live
Forecast without an additional action detailed in the Step by Step below.

Changes made to your Forecast are only seen by you, unless you share them with
someone else (see topic 9.4 Forecast Management) or update them to the Live Forecast.

PUSH LIVE FORECAST BY SELECTION IN THE CBS TAB

1. From the CBS tab with the Forecast data block in the view, select a group of cost items, by
clicking the row header check boxes.

2. Click on the drop-down arrow in the center of the Forecast data block.

3. Select Push to Live Forecast.

J[eag= The Push to Live Forecast option is disabled until you select one or more cost items.

4. After review, select Yes and your forecast values will push to the Live Forecast.

6.8.1 TIME PHASED FORECAST PUSH TO LIVE

The time phased forecast feature lets you make edits in your time phased forecast. You are then able
to push those edits to your live forecast.

You can edit your total forecast remaining cost and forecast remaining hour values in the Time phased
forecast window. It would then override your forecast remaining cost and your forecast remaining man
hour if there is a change.

The Time phasing Forecasting option must be enabled first in order to have the Push Time phased
forecast to Live option available to be enabled. Enabling only the Forecasting option does not
automatically enable both.
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Time phasing

Enable time phasing for the following:

Py

Forecasting (i) [

©_ | Budget @ @
be

Push Time phased forecast to Live forecast

Forecast

% Complete value at which delta from straight line calculation utilizes
average performance

6

The Time phasing section can be located in the Project Settings of Control under the Project tracking
tab.

When you have enabled both options under the Time phasing section click save. Then go back to the
CBS tab.

Follow these step by steps to use a time phased forecast push to live.

TIME PHASED FORECAST PUSH TO LIVE FORECAST

1. Select cost items from the CBS tab with a Forecast remaining cost to use in the push to live
feature.

e = Make sure the cost items you selected have start and end dates. Otherwise you
cannot edit them in the Time phased forecasting window.

2. From Control's CBS tab, select the Actions tab. Then select the Time phased forecasting
option.

3. In the third data block where it has the Month and Year, scroll to the Remaining cost. Now move
the scroll bar over to January of 2021.
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CBS ’  Time phased forecasting
o
T Description Forecast Foracast Qty remaining Phased
)} [[pesitin: | S W LML N erre hes ey oy Remaming 7 Lol
m] $5,000.00 0.00 10,000.00
O §318.77 0.00 1.28
January 2021 w February
iining qty Cost Mhrs Qty Cost Mhrs
10,000.00 I 0 0.00 0.00 $0.00
1.28 $ 366.00 0.00 1.46 s 402.01

4. If you believe the line item could take up more time and money, you can adjust the Cost and

Man hours for the following month. These changes will then be added to the phased forecast
remaining columns once you push to live.

ng Phased Phased Phased

Ji 2021 Febi
forecast forecast forecast s T Mhanuary = a @ Mhe e
remaining remaining remaining gty ping oty = rs ty -0st rs
+ $1,00000 @ 10000 @ 000 @ $0.00
1.28 $366.00 0.00 1.46 $402.01

Je = Quantity will show as changed with a delta next to the column. Currently, you
cannot push quantity updates to live.

5. When you have made all the changes you need, select the cost items you want to push to live.
You can either select one or all.

cBs Time phased forecasting
Tl
. s D
cBs Description |ng Phased Phased Phased 5 February 2021 v
() | position p Torecast
Le T remaining remaining remaining qty aty Cost Mhrs aty Cost
) 10000 ® 000 ® $0.00 0.00 100 ®
0.00 1.46 $10201 ® 0.00 041 ®

6. Dialog appears asking if you want to push these values to the Live forecast. Select Yes to
continue. The Cost and Man hours difference shows in the orange columns.
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Push these values to the Live forecast?
Please review the changes below, and then click "Yes' if you wish to push these values to the live forecast.

ces Description Live forecast remaining Live forecast remaining Forecast remaining cost Forecast remaining Cost |
‘cost ‘manhours manhours dit

1.2 Fiber optic cable-1 §5,000.00 0.00 $6,000.00 100.00 §1,000.00 100.00

1.4 CCTV devices §1,500.00 0.00 $1,200.00 0.00 ($300.00) 0.00

7. When this is pushed to live, your Forecast remaining cost and Forecast remaining man hour
should update in the Live forecast. Your Forecast Method will then change to Manual ETC.
Manual ETC will have a green dot indicator that states it was pushed from Time phased forecast
when you hover over the item.

Live forecast < eosee >

© 12/09/2020 =

¥ Forecas % Forecast # Forecast # Forecas # Forecast % Forecas

$36,975.68 500.00 500.00 0.80 $36,975.68 | Rollup

$ 25,000.00 300.00 0.03 1.00 §2.50 | Current estimate
$6.000.00 100.00 0.01 0.0 Updated by push from Time phased forecast

$5,000.00 100.00 0m 1.00 §$0.25 | Current estimate
$975.68 ; 0.00 0.00 0.00 §162.61 | Manual (ETC) [ ]

The Forecast remaining cost and Forecast remaining man hour columns will have an orange
wedge indicator that shows you which values have been updated manually changed when you
hover over the indicator.

3 CBS position Deseription WBS phase Total

O code committed
cost ; i

[m} v Electrical devices 1000 500.00 §5,000.00 $36975.68 500.00 500.00 0.80 $3697568  Rollup =
[m} 1 Install conduit 1002 250.00 $150.00 $25,000.00 30000 003 1.00 $250  Current estimate
O 12 Fiber optic cable-1 10011 250.00 $150.00 $ 6,000, UJ:I wuo@ 0.01 0.00 $060  Manual (ETC) ] |
[m] 13 Most recent change to this item
m} 14
o 5 cBs Column Previous value New value Previous Forecastfina..  Forecast finalcostnew  Previous Forecast final..  New Forecast final MH..  Changed by Changed date
[} 6 1.2- Fiber optic cable-1  F 100 200 ) | $6000.00 $7.000.00 100.00 200.00 Danielle Shovel  12/9/2020
O v

6.9 FISCAL CALENDAR

InEight Control has built in settings that automatically set the actuals in the forecasting-related data
blocks to match your company’s month end calendar. This allows you to hold the actuals at a certain
cutoff date to allow for forecasting to be done based on month end actuals.
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@ Steel Structure Job (105091) - Settings ~ ®
PROJECT HOME PROJECT INFORMATION FISCAL CALENDAR FUEL TYPES CUSTOM LIST FIELDS
@ General

(%)) contral
&

\\U Plan + Week ending day + Financial year start month
@ Progress

@) 1 t
\\C}/] nspect

() Contract Period end
@ Design
+ Month end day Last weekday
+ Financial period closing day Month end plus days
+ Financial period closing time * Closing time zone
©2018 InEight Inc. Privacy and Temms | v 12.3 INEIGHT

These fiscal calendar settings include a suspended period for you to finalize your forecast numbers
without incurring any new actuals.

Period end

+ Month end day Last weekday

Last day of the month - Select one -
+ Financial period closing day = Month end plus days

Same as Month End Plus Days - 8
+ Financial period closing time * Closing time zone

23:30 G) (UTC-06-00) Central Time (US and Canada) -

During this suspended period, your numbers are “frozen”, allowing you to finish month end reporting
without worrying about the numbers changing. Any new actuals accumulated during the suspended
period will populate once the suspended period is over.

You will note that the Live forecast data block contains a label in its header called “This Month”.
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Forecast Final Forecast Final Forecast Final
Labor Total Cost Cost MH
$250,000.00 $250,000.00

S4nn nnn nn S4nn nnn nn ann

This label reminds you that the values in the live forecast data block are only for the current month, as
defined in the Organization Settings under Fiscal Calendar (see Lesson 3 — Project Setup).

VIEW FISCAL CALENDAR SETTINGS

1. From the Project home page of the your job, select Settings from the left side menu.

Design
Dashboard

Quantity tracking

Assigned equipment

Project home

Project details 4
Settings

Workflows

Assigned users

¢ You can also access settings from the first-level menu or by clicking on the View project
settings tile on the home page

2. On the resulting Project Settings page, click on the Fiscal Calendar tab.
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In this section, you can define the following fields (if you have the appropriate access):

Week endingday Determines which day of the week is the last day.

Financial year Allows the financial year-end to be different from the calendar year-
start month end.

Month end day Determines what the last day of the month is.

Last weekday Sets the day for the above setting.

Financial period Allows you to set the financial period to end on the same day or
closing day allow a period to close out the finances.

Month end plus Sets how many closing days.
days

Financial period Establishes the time when the Forecast data block actuals will be
closing time reset to the next period.

Closing time zone Sets the closing time zone.

6.9.1 FORECAST EQUATION UPDATES TO CURRENT

The actual numbers claimed are periodically synced. The date of actuals which apply to your forecast
can be seen in the Data Block Header.

Forecast | Created from Live forec.. ~ [= < o920 3
Forecast Forecast Forecast Forecast Forecast Forecast method
final cost final MHrs final man final final unit

hours/Unit productivit... cost

Melg= The fiscal settings in Platform determine when actuals for the period will be synced.

6.10 LIVE FORECAST SNAPSHOTS

When you sync your live forecast, Control creates a snapshot. After that sync has been completed,
everything in your live forecast is captured and saved in a snapshot for that month. As soon as the
month ends, the most recently synced items in the live forecast, is your snapshot for the month.
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In the live forecast column, select the drop-down menu to show the live forecast snapshots. The
snapshots saved are labeled with the month and year they were created.

i

I . i
<aill ..-'l\.lr__lI i |:|.|.

December 2020

= i H-I'\

Movember 2020

You can view the current live forecast for the month. For existing projects, cannot snapshot previous
months.

For example, if you select a previous snapshot such as January, it loads into your live forecast. You can
put in any columns you want to organize the view. If you do have a column in your view that is not a
live forecast type (such as open/remaining committed cost and total committed cost), those columns
show as blank and disabled. This occurs because the snapshots only capture the live forecast values.

Open Total Forecast
committed committed method
cost cost

Page 310 of 528 InEight Inc. | Release 25.7



Control User Guide 6.10 Live Forecast Snapshots

All columns from past live forecast snapshots are read-only. You cannot change anything that has been

calculated in the past snapshots. A warning icon with a tool tip also appears in the column header.
Hover over it to show the warnings.

et .. e PR
e | -

When you load an old snapshot, the CBS hierarchy does not rearrange to show how the live forecast
previously looked when that snapshot was taken.

The Forecast cost G/L change column shows you what has changed between last month and this
month for your gain loss values.

The Forecast cost change column calculates the difference between the Forecast final cost and the
previous month's Live Forecast final cost.

InEight Inc. | Release 25.7 Page 311 of 528



6.10 Live Forecast Snapshots Control User Guide

Formula description: Forecast
cost change = Current Live
Forecast final cost - Previous
manth Live Forecast final cost !
—

L] i w

£ 10,000 00000041 Rollu

§ 9.999.999999690 Rollu

Green coloring for the numbers indicates an increase in forecast cost change between the two months.
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EXERCISE 6.1 — FORECASTING

Now that you have covered all the functions of forecasting, it is time to perform your own forecasts.
Utilizing the forecasting methods you have learned, practice creating forecasts as indicated below.
You can use your own project (if available) or the training project used in this lesson.

1.

6.

From the Control main page, select the CBS tab.

Change to a view that contains the Forecasts data block.

Save a new forecast.

Update the forecasts of cost items of your choice to practice using each of the following
Forecast Methods:

e Current Budget
e Average Performance

e Manual EAC (based on costs or hours)

Send your forecast to a person.

Note the differences.

Congratulations, you have completed this exercise!
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REVIEW

1. How is the Current Budget Forecast Method calculated?
a. Forecast Total Cost = Current Budget

b. Forecast Total Cost = As-built Total Cost + (Current Budget Unit Rate * Current
Budget Remaining Qty)

C. Forecast Total Cost = As-built Total Cost + (Current Budget Unit Rate * Current
Estimate Remaining Quantity)

2. How does the Live Forecast receive updates?
a. They happen automatically
b. Push to live forecast from the Forecast data block title bar drop-down
C. Push to Live Forecast from the Actions drop-down menu

d. Viewed in the CBS change log

3. Who can a forecast be sent to?
a. Project Manager
b. Project Engineer
C. It automatically goes to everyone

d. Anyone you add to the list

4. Which data block do you use to compare forecasts?
a. Forecast
b. Forecast Delta
C. Forecast Comparison

d. Live Forecast

5. The fiscal calendar settings for Live Forecast are located under:
a. Organizational Breakdown Structure

b. Account code structure
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C. Operational resources

d. Project settings

SUMMARY

As a result of this lesson, you can:
o Differentiate and utilize InEight forecasting methods
¢ Manage forecasts

e Manage Time Phased Forecasting

Push to Live Forecast

View the Fiscal Calendar settings
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7.1 CHANGE MANAGEMENT
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7.2 INEIGHT CONTROL WORKFLOW - CHANGE
MANAGEMENT

Estimate

Historical Benchmarking

Control

Conform Estimate / WBS Structure

Progress .
Measurement Forecasting

Account Code

Management Final Hours and Costs

CBS Register

Forecast Method Budget/Forecasts
Setup Quantities

ACS Register Create & Manage

Cost ltems
Define Qty Account
Analyze Planned
Earned and Actual

Live
Forecasts
Farecast

WBS Structure / Budgeted
Quantities & Hours

roved changes
ﬁsgate Cu(rentgsudget Revenue Management

Billed Revenue

Change Management v |
Change Register Pay Item Register
Budget Move Create/Manage
Pay ltems

Budget
Plan Qty/MH Analyzed Planned & Forecast Revenue
Adjustment
Contract
Adjustment

Track Billed Revenue

7.3 CHANGE MANAGEMENT OVERVIEW

During any phase of a project there are multiple ways you can manage changes to items such as
guantities, design, schedule, and cost. Within Control, you can manage changes to quantities, man-
hours, and costs through a controlled approval process. You can make records of items such as budget
moves, quantity and man-hour adjustments, and change orders by filling out forms.

You can access these change management forms from the Actions menu.
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— fat  Steel Structure Training Job 2 105092 / Control / Workspaces

Actions  w ®

Global forecast mgthod.. .
H Task details { seee >

Set forecast method Resources Forecast (T/0) UoM
aty
Update Forecast (T/0) gtywith Plan compone...
1.00  Lum|
‘_:1 Claim multiple CBS guantities
- 00.00  CY
Budget move and contract adjustment »
Budget move
| Lock/unlock budget » poo-oo | cv
Budget quantity and man hour adjustment
syne » ) 00000  Ton
Contract adjustment
(] a ETECT STEeT = HEj 350.00 Ton

After you fill out and save the applicable changes, Control stores these changes in the Change Register
tab, where the project budget is managed.

< ACS PAY ITEMS CHANGE REGISTER AUDIT LOG
Actions  w s A 4 B D = Q
B WS S e S e [ R R e L
by cost MH price

220 Contingency Draw - Buildi CD-001 01/12/2023 AJ Waters 03/19/2023 % [ ] @ Approved $0.00 0.00 $000 Budgetm |
210 Fiber Office Connections 0220831 08/31/2022 13 AJ Waters 08/31/2022 % o @ CCO-Approved $ 55,000.00 0.00 $57,20000 Contract
20.0 New Cabinet Hardware CCO-0015 09/21/2020 9 Jordan Ca. 10/22/2020 % @ CCO-Approved $3500.00 0.00 $3500.00 Contract
19.0 Flooding and material was. CCO-004 02/10/2020 © Austin Wil... 03/10/2023 % @ CCO-Approved $0.00 0.00 $10,000.00 Contract
18.0 Extra Surveying 0019A 02/10/2020  19-1 Chris Hohl... 04/21/2021 % 2 Draft §15,000.00 0.00 $19,500.00  Contract
17.0 Increase in Scope 002 01/18/2020 002 Mike Paul 02/05/2020 % @ Approved $22,000.00 0.00 $50,000.00 Contract
16.0 Change in Scope col 01/18/2020 001 Paul Benni... 04/24/2020 % @ Approved $0.00 0.00 $0.00 BudgetQ
15.0 11/13/2019 John Upten 04/12/2022 % @ Approved $0.00 0.00 $000 Budgetm
14.0 traslado de dinero dentro 10/21/2019 oM Elia Burgu. 03/19/2023 % Cj Pending $0.00 50.00 $000 Budgetm
13.0 Traslado de dinero dentro 09/16/2019 013 Elia Burgu. 03/19/2023 % Cj Pending $0.00 0.00 $0.00 Budgetm
120 CCoo0002 09/15/2019 003 Mike Paul 03/19/2023 % Cj Pending $0.00 0.00 $0.00 Budgetm
11 Flood control on haul road CC0-0002 03/22/2021 4 Chris Hohl... 03/22/2021 % _Z CCO-Draft $9,000.00 0.00 $0.00 Contract

4 »

Subtotals $12,115,309. 64,222.00 $ 290,200.00

In the Change Register you can review each change individually and approve changes as needed. When
a change is approved, it updates the current budget values in the CBS and is given a status of Approved
in the Change Register. Otherwise, the change is only documented in the Change Register with a status
of Draft or Pending and has no effect on the current budget.

e = To manage changes, you must have applicable permissions.

The table below provides a brief description of the three types of changes you can record in Control.
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Budget move Reallocate costs from one area of the budget to another. When making a
budget move, the result must be net zero, neither adding nor removing costs
from the budget. The move can include reallocation of man-hours and
quantities as well.

Budget Make modifications to budgeted man-hours and/or quantities without making
quantity and changes to overall budgeted costs.

man hour

adjustment

Contract Make a change to the scope of your budget and contract, via the addition or

adjustment revision of cost items and pay items, which results in a change to the project’s
budgeted costs and pricing. Also commonly referred to as a change order.

Al = When you perform a budget move, contract adjustment, or budget quantity and man-
hour adjustment, you can select a maximum total of 250 cost items or 100 pay items.

When you exceed the maximum, the Budget move and contract adjustment option in the
Actions menu drop-down becomes unavailable. This improves the speed, reliability, and
performance of the change order.

7.3.1 MANAGING CHANGES USING THE INEIGHT SUITE

For a more holistic approach to managing changes within your organization, your company might
choose to follow a change management process that integrates with other InEight applications that
can include:

¢ InEight Change

¢ InEight Document
¢ InEight Schedule
¢ InEight Progress

For more information on how to use the InEight suite of applications to manage change orders, see
Change Order Management.

7.3.2 INEIGHT CHANGE INTEGRATION WITH CONTROL

The InEight Change application is designed to manage project changes through a detailed, organized
process, tracking changes from issue to executed change order. When executed in InEight Change,

Page 320 of 528 InEight Inc. | Release 25.7


https://learn.ineight.com/integrated_solutions/Content/Business-Processes/Change-Order-Management/Change-Order-Home.htm

Control User Guide 7.4 Associated Budget Move

change orders can automatically become contract adjustments within InEight Control via an
integration between the two applications. If your company is using both Change and Control for
managing change orders, consult the Contract Adjustment (with InEight Change) topic for more
information on this process.

Budget moves can also be initiated in InEight Change and integrate with InEight Control to show up in
the Control Change Register. For more information about managing budget moves using Change and
Control, see Budget Moves in InEight Change.

RELEVANT LINKS

Integrated Solutions - Approve contract adjustment
Integrated Solutions - Execute the change order
Integrated Solutions - Change order management
Video - Contract adjustment

Video - Assigning pay items to cost items

Link 5

7.4 ASSOCIATED BUDGET MOVE

During a project, you might need to move costs from one area of the budget to another to account for
project changes, without changing the total budget amount. In Control, you can manage budget moves
via a controlled approval process.

To launch a budget move in Control, from the CBS tab of the Workspaces module, select Actions >
Budget move & contract adjustment > Budget move. This opens a Budget move record with the option
to fill out the record following one of two workflows.

Change register > Budget Move
oDetai\s E

Choose your Budget move workflow

Associated ) ! N
© Define budget moves with a From and To process to provide ultimate traceability of budget moves

Non-Associated
Define budget moves freely to provide the most flexibility.

The following table provides information about each budget move workflow.
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Control User Guide

Budget move
workflow Description Cons

Links each
source cost item
to a target cost
item as a single
transfer
transaction.

Associated

Treats each
adjustment
(debit or credit)
as a standalone
action, without
explicitly linking
the source and
destination.

Non-
associated
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 Clear audit trail —
Shows both the
source and
destination of the
funds in a single
transaction,
improving
transparency.

 Traceability — Easily

see where the
budget came from
and where it went.

» Reporting clarity —
Helps financial and
project controls
teams track budget
changes as
purposeful
reallocations rather
than isolated
changes.

Flexibility — Can make
quick, one-sided
adjustments without
needing to define where
the funds are coming
from or going to.

Faster entry — Useful
when you're adjusting

budgets over time and the

counterbalance to the
move is handled later or
separately.
Auto-calculate — Only
non-associated budget

» More steps required —
Typically involves
selecting both a “from”
and “to” item, with extra
steps for assigning
amounts and adjusting
cost categories, which
can be more time-
consuming than a non-
associated move.

» Requires clear
planning — You must
know both ends of the
move when performing
it, which might not
always be the case.

Lack of traceability — Harder
to tell where money came
from or where it went, which
complicates reviews and
audits.

Potential for confusion —
Canlead to
misunderstanding or
misreporting of why certain
budget changes occurred.
Reduced accountability —
Without links, it's easier to
lose the rationale for the
budget changes, especially
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Budget move

workflow Description Cons

moves contain the feature over a long project timeline.
to automatically generate

CB budget adjustments

from CE values and CE

values from CB budget

adjustments.

The following are considerations when performing a budget move using the Associated workflow
option:

e Current Budget cost and man-hours are only maintained at the terminal level. You cannot move
cost to or from a parent cost item.

¢ You can move costs between multiple cost items at the same time.

¢ You can automatically update Current Estimate (CE) values from Current Budget (CB) values only

in a non-associated budget move or a contract adjustment.

PERFORM AN ASSOCIATED BUDGET MOVE

1. Select Actions > Budget move & contract adjustment > Budget move.

= far  Steel Structure Training Job 2| 105092 / Control / Workspaces

Actions = ®

Y

Global forecast

H Task details { soon >

| Set forecast method Resources Forecast (T/0) UoM
aty
Update Forecast (T/0) gtyNyith Plan compone...
1.00  Lum|
‘_:1 Claim multiple CBS quantities
B 1 00000  CY
Budget move and contract adjustment
Budget move
1 000.00 CY

7 Lock/unlock budget
Budget quantity and man hour adjustment

syne _ 000.00  Ton
Contract adjustment

= A TETECT STeel = Hei - ) 350.00 Ton
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The Budget Move wizard opens to the step 1, Details.

2. Select the Associatedoption and add budget move details as needed, and then click Next.

0 Details

Choose your Budget move workflow

Associated
@ Define budget moves with a From and To process to provide ultimate traceability of budget moves.

Non-Associated
Define budget moves freely to provide the most flexibility.

Budget move details

Description 453
Move budget from light steel erection to heavy.

cco 60

Issue # 57
056

Discipline 484

Structural Steel

The Budget move wizard opens step 2, Select from & to items.

3. From the From section on the left, select the cost items you need to move budget from and from
the To (for net zero moves) section on the right, select the cost items you need to move budget
to.

Page 324 of 528 InEight Inc. | Release 25.7



Control User Guide 7.4 Associated Budget Move

Changeregister > Budget Move

o Select from & to items =
From To (for net zero moves):
[  CBSposition Description WES phase code O GBS pusition Description WBS phase code
[m] 318 £ BuildingN&0 - Scrape.. 1099 a [m] 318 £ Building N&O - Scrape.. | 1099 a
O ~a £ Structural Steel 1073 0 -4 £ stuctural Steel 1073
a 41 ) ErectSteel - Heavy 1074 | 41 5 Erect Steel - Heavy 1074 |
42 £  ErectSteel - Light 1005 | [m] 12 £ FErectSteel - Light 1005
a 43 )  Bolted Connections 1006 | 43 5 Bolted Connections 1006 |
] 24 £ Labor 1088 O 44 i Labor 1088
] 45 £ Equipment 1089 O 45 £ Equipment 1089
] 16 £ adParty 1090 O 4% £ 3rdParty 1090
O s £ Materials 1084 0 »s i Materials 1084
a 51 ) Earthwork - Materials 1085 O 51 f;  Earthwork - Materials 1085
[m] 52 £ Concrete - Materials 1086 [m] 52 £ Concrete - Materials 1086
a 53 £} Structure Steel - Mate.. 1087 O 53 £y structure Steel - Mate.. 1087
v v
1 items selected 2 items selected

(] (] (]

4. Click Next. The Budget move wizard opens to step 3, Define relationships.
5. For each cost item listed under the From section, select Define to do one of the following:

¢ Select Cost category, Qty or MHr adjustment only to modify only the cost category,
guantity or man-hours of the cost item (not the cost item’s cost).

» Select the cost item or items to move budget to that includes costs. You can click Select All
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to select all the listed cost items.

From:

Control User Guide

o Define relationships

i 4.2 [1005] Erect Steel - Light

CB total cost Pending budget cost

$200,000.00 © $0.00

To:
| Define | ] 4.1 [1074] Erect Steel - Heavy
CB total MHrs CB total quantity 4.2[1008] x
4, [0 Cost category, Qty or MHr adjustment only

Budget move with Cost category, Qty or MHr
adjustment to

4.3 [1006] Bolted Connections
4.2[1005] x

@ 4.1 [1074] Erect Steel - Heavy
1 4.3 [1006] Bolted Connections

Select All m

[ Cancel ] [ Draft ] [ Back ]

6. Click OK to close the Define window. Now, for each cost item under the To section, it shows the

cost items you associate to it from the From section.

7. Click Next. The Budget move wizard opens to step 4, Assigh amounts.

8. In Assign amounts, you can move costs, quantities, and man-hours.

¢ You can move costs and man-hours by entering values in the CB total cost and CB total

MHrs fields under the To section. This automatically deducts the amounts from the
assigned cost items under the From section.
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o Assign amounts
From: To:
4.2 [1005] Erect Steel - Light 4.1 [1074] Erect Steel - Heavy
CB total cost Pending budget cost CB total MHrs CB total quantity CB total cost CB total MHrs CB total quantity
$ 200,000.00 $0.00 4,000.00 200.00 $ 800,000.00 16,000.00 800.00
$11,000,00 200,00 0.00 10000.00 200.00 0
= $189,000.00 3,800.00 200.00 = $ 810,000.00 16,200.00 800.00

4.3 [1006] Bolted Connections

CB total cost CB total MHrs CB total quantity

$50,000.00 1,000.00 2,000.00

1000.00 0 0 v

Advanced options Cancel Draft Back m

¢ You can enter CB Total Quantity values on the To section. They do not automatically
deduct from the From section because you could be moving between cost items with
differing units of measure.

¢ You may need to add more or fewer man-hours than you deduct. To allow this, select
Advanced options and switch the Adjust MHrs (not net zero) to On. The CB total MHrs of
your From cost items will no longer automatically deduct when you make adjustments to
your To cost items.

9. Click Next. The Budget move wizard opens to step 5, Adjust cost categories.

10. In Adjust cost categories, you can assign your pending budget changes to existing and new cost
categories of your cost item. For each cost item under the To section, click the Add cost category
button to reassign costs to different cost categories.

° Adjust cost categories
From To:

4.2 [1005] Erect Steel - Light Available. $0.00 4.1 [1074] Erect Steel - Heavy Available: $0.00

CB total cost Pending New total CB total cost Pending New total
Labor. $200,000.00 11,000.00 $189.000.00 Labor. $ 800.000.00 3 $808.000.00
Totals $200,000.00 $11,000.00 $189,000.00 Materials $0.00 : $2,000.00
= Totals $800,000.00 $10,000.00 $810,000.00

@ Add cost category

4.3 [1006] Bolted Connections Available: $0.00

CB total cost Pending New total
Labos $50000.00 1 $51.000.00
= Totals $50,000.00 $1,000.00 $51,000.00

@ Add cost category

11. On the Add cost categories window, select a cost category, then click OK.
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Add cost categories

Total :2 Selected

Labor

Construction Equipment
FOM Rented Equipment
Supplies

8000

Materials
Subcontract
Fees
Allowance

G&A

JO0O 000

I Indafinard

12. In the Pending fields, adjust the cost category amounts as needed.

To:
4.1 [1074] Erect Steel - Heavy Available:
CB total cost Pending
Labor: $ 800,000.00 8,000.00
Materials: $0.00 2,000.00
= Totals $ 800,000.00 $ 10,000.00

(¥ Add cost category

Control User Guide

>

L

$0.00

New total
$ 808,000.00
$ 2,000.00

$810,000.00

Weyp=0 After making your adjustments, the Available amount should equal $0.00.

13. Click Next. The Budget move wizard opens to step 4, Summary.

14. In Summary, review your proposed changes, and then click Submit to send the budget move for

approval.
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Change Register >  Budget Move

From:

4.2 Erect Steel - Light

CB total cost CB total MHrs CB total quantity

Before: $ 200,000.00 4,000.00 200.00
Pending: ($10,000.00) -100.00 -20.00
$ 190,000.00 3,900.00 180.00

7.4 Associated Budget Move

=]
° Summary
4.4 Modluel 01 - Erect Steel Heavy
CB total cost CB total MHrs CB total quantity
Before: $0.00 0.00 0.00
Pending $ 10,000.00 100.00 20.00
$10,000.00 100.00 20.00

[ Cancel } [ Draft } [ Back ]

ey g= Select Draft if the budget move is not ready to be submitted and needs to be saved

for later.

7.4.1 ASSOCIATED BUDGET MOVE - SINGLE COST

ITEM

At times, you might encounter changes that require you to make budget changes within the cost

categories of a single cost item. For example, you may find that some items that you estimated to be
self-performed work may be faster and cheaper if they were subcontracted out. Therefore, you can
perform a budget move for a single cost item to redistribute the budgeted cost between different cost

categories.
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PERFORM AN ASSOCIATED BUDGET MOVE WITHIN A SINGLE COST

ITEM

1. Select Actions > Budget move & contract adjustment > Budget move.

Steel Structure Training Job 2 | 105092 / Control / Workspaces

Actions  w ®

Y
Global forecast mgthod.. .
H Task details C sooe >
Set forecast method P = Forecast (T/0)
qty
Update Forecast (T/0) qtyNyith Plan compone...
1.00
‘_:1 Claim multiple CBS quantities
1 000.00
Budget move and contract adjustment
Budget move
| Lock/unlock budget » L pooco
Budget quantity and man hour adjustment
Sync ) 000.00
Contract adjustment
= a7 TTETECT STEET="He 350.00

The Budget Move wizard opens to the step 1, Details.

UoM

Lum

cY

CY

Ton

Ton

2. In Details, select the Associatedoption and add budget move details as needed, and then click

Next.
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° Details

Choose your Budget move workflow

Associated
© Define budget moves with a From and To process to provide ultimate traceability of budget moves.

Non-Associated
Define budget moves freely to provide the most flexibility.

Budget move details
Description 453

Move budget from light steel erection to heavy.

cco 60

Issue # 57
056

Discipline 484

Structural Steel

The Budget move wizard opens step 2, Select from & to items.

3. In Select from & to items, select the same cost item under both the From and To sections, and
then click Next.

Change Register >  Budget Move Q

o Select From & To Items

From: To (for net zero moves):

GBS position Description WBS phase code CBS position Description WBS phase code

1 Job Overhead 1002 1 Job Overhead 1002

2 Earthwork 1069 2 Earthwork 1069

3 Concrete 1071 3 Concrete 1071

4 Structural Steel 1073 4 Structural Steel 1073

41 Erect Steel - Heavy 1074 41 Erect Steel - Heavy 1074

4.2 Erect Steel - Light 1005 42 Erect Steel - Light 1005

v 43 Bolted Connections 1006 v 43 Bolted Connections 1006
44 Modluel 01 - Erect Steel Heavy 1087 44 Modluel 01 - Erect Steel Heavy 1087

5 Materials 1084 5 Materials 1084

5.1 Earthwork - Materials 1085 - 5.1 Earthwork - Materials 1085

1 items selected

1 items selected

(Ccancel | ot | [ mack |

The Budget Move wizard opens to the step 3, Define relationships.
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4. In Define relationships, click the Define button, and then select Cost category, Qty, or MHr
adjustment only.

Change Register >  Budget Move Q

o Define relationships

From To:

4.3 Bolted Connections Define ] 4.3 Bolted Connections

CB total cost Pending change | ¥ Cost category, Qty or MHr adjustment only

$50,000.00 0 $0.00 0

4.3 Adjustonly X

[\[eJga Selecting the Cost category, Qty, or MHr adjustment only option lets you move
budgeted cost category values within a single cost item.

5. Click OK to close the Define window, and then Next. The Budget move wizard opens to step 4,
Assign amounts.

6. In Assign amounts, click Next to skip the Assigh amounts step because we are not changing the
man-hours or quantities. The Budget move wizard opens to step 5, Adjust cost categories.

7. Click the Add cost category button to assign your pending budget changes to existing and new
cost categories of your cost item.

Change Register >  Budget Move Q

6 Adjust Cost Categories

From: To:
4.3 Bolted Connections Available $0.00
CB total cost Pending New total
Labor $50,000.00 000 $50,000.00
Totals $ 50,000.00 $0.00 $50,000.00

(¥ Add cost category

(ot ] (oon ) (o) (D
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7.4 Associated Budget Move

8. On the Add cost categories window, select the cost categories to include in the adjustment, and

then click OK.

Add cost categories

Total :2 Selected

¥ Subcontract

Fees

I‘. Cancel I

9. Make adjustments in the cost category Pending fields as needed.

¢ The values shown in the Available and New total fields will automatically adjust based on

the values entered in the To Pending fields

e The amount in the Available field must be $0.00 to proceed to the next step.

To:

4 3 Bolted Connections

CE total cost
Labor: $ 50,000.00
Subcontract: 50.00
= Totals 5 50,000.00

L0 T YO [ A Wp—

Available: $0.00
Pending New total
-50,000.00 5 0.00
0.000.0( $50,000.00
$0.00 5 50,000.00

10. Click Next. The Budget move wizard opens to step 4, Summary.

11. In Summary, review your proposed changes, then click Submit to send the budget move for

approval.

The budget move will now be listed in the project’s Change Register with a status of Pending.

RELEVANT LINKS

Non-associated budget move

Integrated Solutions - Change order management
Video - Associated budget move

Video - Non-associated budget move

Video - Contract adjustment

Link 5
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7.5 Non-Associated Budget Move

Control User Guide

7.5 NON-ASSOCIATED BUDGET MOVE

During a project, you might need to move costs from one area of the budget to another to account for

project changes, without changing the total budget amount. In Control, you can manage budget moves
via a controlled approval process.

To launch a budget move in Control, from the CBS tab of the Workspaces module, select Actions >

Budget move & contract adjustment > Budget move. This opens a Budget move record with the option

to fill out the record following one of two workflows.

Change register >  Budget Move

o Details

Choose your Budget move workflow

Associated

Define budget moves with a From and To process to provide ultimate traceability of budget moves

Non-Associated

Define budget moves freely to provide the most flexibility

The following table provides information about each budget move workflow.

Budget move

workflow

Associated

Page 334 of 528

Description

Links each
source cost item
to a target cost
item as a single
transfer
transaction.

¢ Clear audit trail —
Shows both the
source and
destination of the
funds in a single
transaction,
improving
transparency.

 Traceability — Easily
see where the
budget came from
and where it went.

» Reporting clarity —
Helps financial and
project controls

Cons

» More steps required —

Typically involves
selecting both a “from”
and “to” item, with extra
steps for assigning
amounts and adjusting
cost categories, which
can be more time-
consuming than a non-
associated move.
Requires clear
planning — You must
know both ends of the
move when performing
it, which might not
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Budget move
workflow Description Cons

teams track budget always be the case.
changes as

purposeful

reallocations rather

than isolated

changes.
Non- Treats each Flexibility — Can make Lack of traceability — Harder
associated adjustment quick, one-sided to tell where money came
(debit or credit) adjustments without from or where it went, which
as a standalone  needing to define where complicates reviews and
action, without the funds are coming audits.
explicitly linking ~ from or going to. Potential for confusion —
the source and Faster entry — Useful Canleadto
destination. when you're adjusting misunderstanding or
budgets over time and the misreporting of why certain
counterbalance to the budget changes occurred.
move is handled lateror =~ Reduced accountability —
separately. Without links, it's easier to
Auto-calculate — Only lose the rationale for the
non-associated budget budget changes, especially

moves contain the feature over a long project timeline.
to automatically generate

CB budget adjustments

from CE values and CE

values from CB budget

adjustments.

Performing a non-associated move makes cost adjustments at the total cost and cost category levels.
In addition to cost adjustments, adjustments to man-hours and quantities can also be made.

With the applicable permissions, you can approve budget moves. When you approve a budget move, a

message shows confirming the budget move is approved.

Change order # 1.0 approved. successfully.
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PERFORM A NON-ASSOCIATED BUDGET MOVE

1. Select Actions > Budget move & contract adjustment > Budget move.

far  Steel Structure Training Job 2| 105092 / Control / Workspaces

Actions = ®

Global forecast

H Task details { soon >

Set forecast method == Forecast (T/0) UoM
aty
Update Forecast (T/0) qtyNyith Plan compone...
1.00  Lum|
‘_:1 Claim multiple CBS quantities
1 00000  CY

Budget move and contract adjustment

1 Budget move

| Lock/unlock budget poooa | cv
Budget quantity and man hour adjustment
Sync 000.00  Ton
Contract adjustment
= a7 TTETECT STEeT="Hei - ) 35000  Ton

The Budget Move wizard opens to step 1, Details.

2. In Details, select the Non-Associated option and add budget move details as needed, and then
click Next.
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oDetalls

Choose your Budget move workflow

7.5 Non-Associated Budget Move

Associated

Define budget moves with a From and To process to provide ultimate traceability of budget moves

® Non-Associated

Define budget moves freely to provide the most flexibility.

Budget move details
Description

Move budget from light steel erection to heavy.

cco

Issue #

056

Discipline

Structural Steel

453

60

57

484

The Budget move wizard opens step 2, Select Assign amounts.

3. In Assign amounts, click the Add cost item icon to select the applicable cost items.

Change register > Budget Move

88 ° Assign amounts $ = o

CBS position Description WBS €8 total cost Adjusted CB
cost

Subtotals 0 $0.00

4. Select the cost items, and then click Add.

InEight Inc. | Release 25.7

CB total MHrs Adjusted €8 CB total Adjusted CB i
MHrs quantity aty
a
>w
sooo 000 000
Cancel Back
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Change register > BudgetMove >  Select costitems

i Search

0 CBS position Deseription :‘;Eaie

code
O 1 Job Overhead 1002
m] 2 Earthwork 1069
] 3 Concrete 1071
0O ~a4 Structural Steel 1073
41 Erect Steel - Heavy 1074
42 Erect Steel - Light 1005
43 Bolted Connections 1006
(m} A5 Materials 1084
0 51 Earthwork - Materials 1085

Subtotals 32 (3 items selected)

canca |

5. Enter adjustment amounts for each cost item. You can enter positive or negative adjustments
into any of the fields labeled Adjusted, including Adjusted CB cost, Adjusted CB MHrs, and
Adjusted CB qty. See the following adjustment examples:

¢ Moving from one cost item to another:

Change register > Budget Move

® - | ° Assign amounts S 1= ¥
—, CBSposition Description WBS CB total cost Adjusted CB CB total MHrs Adjusted CB CB total Adjusted CB
phase cost MHrs quantity qty
code
m] 41 Erect Steel - Heavy 4 $ 800,000.00 ($ 5,000.00) 16,000.00 20000 800.00 000 "
O a2 Erect Steel - Light 15 $ 200,000.00 $5,000.00 4,000.00 200.00 200.00 0.00
m} 43 Bolted Connections ) $50,000 00 $000 1,000.00 0.00 2,000.00 0.00
Subtotals 3 $1,050,000.00 $0.00 21,000.00 0.00

¢ Moving one cost item to multiple cost items:
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Change register >  Budget Move

® a3

CBS position

41
42

43

Subtotals 3

Approve

Description WBS
phase
code

Erect Steel - Heavy

Erect Steel - Light

Bolted Connections.

CB total cost

$ 800,000.00
$ 200,000.00

$50,000.00

$1,050,000.00

o Assign amounts

Adjusted CB
cost

($ 5,000.00)
$4,000.00

$1,000.00

$0.00

CB total MHrs

16,000.00

4,00000

1,000.00

21,000.00

7.5 Non-Associated Budget Move

$ © @
Adjusted CB CB total Adjusted CB
MHrs quantity qy
200.00 800.00 000 "
20000 200.00 0.00
0.00 2,000.00 0.00
0.00
Cancel Draft Back m

* Make cost adjustments at the CB cost category level using any of the Adjusted CB cost

category columns:

Description

Erect Steel - Heavy
Erect Steel - Light

Bolted Connections

CB labor total

phase cost
$800,000.00
$ 200,000.00

$50,000.00

o Assign amounts
ce

Adjusted CB Adjusted CB CB FOM rented Adjusted CB
labor cost construction i FOM rented
equipment to... equipment c... total cost equipmentc...
($ 4,000.00) $0.00 ($1,000.00) $0.00 ($500.00)
$3,000.00 $0.00 $1,000.00 $0.00 $500.00
$1,000.00 $0.00 $0.00 $0.00 $0.00

° The Adjusted CB total cost must equal zero to submit.

° The Adjusted CB cost will automatically calculate as the total of all cost category

values.

° Costs entered directly in the Adjusted CB cost field are automatically allocated to the

appropriate CB cost categories (for example, Adjusted CB labor cost, Adjusted CB

material cost) based on where costs were originally allocated on the cost item.

e Assign amounts at the cost category level by right-clicking on the cost item, and then
selecting Cost category.
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Change reqgister 2

® ® &8
0 CBS position
L 41
42
O 43

Budget Move

Control User Guide

Description WBS
phase
code

Erect Steel - Heavy 1074

-

Erect Steel - Ligh~

@ Cost category
Bolted Connectic

This gives you a view that makes it easy to see the pending adjustments of all your
categories in a slide-out register and how they contribute to the total.

After making adjustments, click the Close icon at the top right corner to close the Cost

category slide-out.

o Assign amounts

1005

4.2 Erect Steel - Light
CB total cost

. $200,000.00

Cost category

~ Total
™ Labor
v Construction Equipment
~ FOM Rented Equipment
“ Supplies
¥ Materials
¥ Subcontract
“ Fees
v Allowance

G&A

Il rdnfimad

Pending budget cost
($ 10,000.00)

CB total MHrs CB total quantity
4,000.00 200.00
CB total cost Pending
$200,000.00 ($1,000.00) ~
$200,000.00 $0.00
$0.00 $0.00
$0.00 $0.00
$0.00 $0.00
$0.00 ($1,000.00)
$0.00 $0.00
$0.00 $0.00
$0.00 $0.00
$0.00 $0.00
& nnn ennn ¥
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The Adjusted CB cost subtotal must equal zero to submit. In other words, the cost
adjustments must be net-zero to proceed.

6. Review your proposed changes, and then click Submit to send the budget move for approval.
Click Draft if the budget move is not ready to be submitted and needs to be saved for later.

MeJ= The hours and quantities subtotals do not need to equal zero to submit.

7.5.1 AUTO-CALCULATE BUDGET MOVE VALUES

Non-Associated budget moves include a time-saving feature that auto-calculates values when
performing the following tasks:

e Update CB from CE — Automatically generates CB adjustments in the non-associated budget
move record to match existing current estimate values of the cost items selected.

¢ Update CE from CB - When approved, automatically updates current estimate values in the CBS
based on adjustment values defined on the non-associated budget move.

7.5.1.1 UPDATE CURRENT BUDGET (CB) ADJUSTMENTS FROM
CURRENT ESTIMATE (CE)

Prior to generating a budget move record for approval, a common best practice to help you work
through project changes and have traceability should questions arise, is to make your budget move
adjustments directly in the CE fields of your cost items on the CBS tab.

When the time comes to get approval, you can create a non-associated budget move and use the
Auto-calculate feature to generate the CB adjustments on your budget move record automatically.

PERFORM A BUDGET MOVE USING AUTO-CALCULATE > UPDATE CB

FROM CE

ey = These steps assume budget move adjustments have already been made in the Current
Estimate.

1. Select Actions > Budget move & contract adjustment > Budget move. The Budget Move wizard
opens to step 1, Details.

2. In Details, select the Non-Associated option and add budget move details as needed, and then
click Next. The Budget Move wizard opens to step 2, Assign amounts.

InEight Inc. | Release 25.7 Page 341 of 528



7.5 Non-Associated Budget Move Control User Guide

3. In Assign amounts, click the Add button to select the cost items that are part of the budget
move.

4. Click the Auto-calculate icon, and then select Update CB from CE.

5. . Select the values to auto-calculate, and then click Apply.

® ® © ssionamouns s = B

CB total cost Adjusted CB ©B total MHrs Adjusted CB CBiotal Adjusted CB U. B
cost MHirs quantity aty <ot

$:800,000.00 5000 16,000.00 0.00 800.00 000 Ton

8 8 o

$200,000.00 5000 4,000.00 0.00 20000 000 cY

<]

$50000.00 $000 1,000.00 0.00 2,000.00 000 Lumps.

N

Auto calculate

Match current budget values with current estimate values
® selectall
@ Cost
& Quantity

© Man hours

4 CEE— > v

Subtotals 3 (3 rows selected) $1,050000.00 $000 21,000.00 0.00

[ Cancel ] [ Draft ] [ Back ]

6. Click Yes when prompted to confirm.

7. Click Submit to submit the budget move for approval. Click Draft if the budget move is not ready
to be submitted and needs to be saved for later.

7.5.1.2 UPDATE CURRENT ESTIMATE FROM ADJUSTED
CURRENT BUDGET

You can update your current estimate values based on the adjusted current budget values for contract
non-associated budget moves.

To view adjusted current budget values in relation to current estimate values, add the following
columns to your view:

* Cost source

¢ Update CE total cost

e Update CE total MHrs

e Update forecast (T/0O) qty
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e CE total cost

e CE total MHrs

e Forecast T/O qty

e New CE total cost

e New CE total MHrs

¢ New forecast (T/O) qty

To add these columns, initiate a non-associated budget move, go to the Assign Amounts step, click the
Column chooser icon, and then select your columns.

e Assign amounts s 1= D

CB total cost Adjusted CB CB total MHrs Adjusted CB CB total Adjusted CB u_ Cl
cost MHrs quantity qty

No results found CE total cost

CE total MHrs

Forecast T/0 gty

] CE labor total cost

[CJ CE construction equipment total cost
[C] CE rented equipment total cost
[CJ CE supplies total cost

[C] CE materials total cost

[ CE subcontract total cost

] CE fees total cost

[J CE contingency total cost

[J CE general and admin total cost

(] CE undefined total cost

(] New CB total cost

[C] New CB total MHrs

[J New CB total gty

Cost source

Update CE total cost
Update CE total MHrs
Update forecast (T/0) gty
New CE total cost

New CE total MHrs

New forecast (T/0) qty

4 G - ¥
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7.5.1.3 SELECT COST ITEMS TO UPDATE

The check boxes under the Update CE total cost, Update CE total MHrs, and Update forecast (T/O) qty
allows you to update the current estimate based on what is adjusted in the current budget after the
budget move is approved.

. CBS position Cost source Update CE Update CE Update
B total cost total MHrs forecast
(T/O) atv
# Unassigned cost items |
O 1117
O s | Plug
O 1119 Plug
O 11110 | Plug
.|

Subtotals 4 |

The Update CE total cost and Update CE total MHrs check boxes are active for plug cost source only.
The Update CE total cost and Update CE total MHrs check boxes cannot be edited for Detail cost items
because cost is driven by your associated resources.

For example, if the Update CE total cost box is checked, the Adjust CB cost is added to the CE total cost
after the contract adjustment is approved. You can preview the results in the New CE total cost, New
CE total MHrs, and New forecast (T/O) gty columns.

7.5.1.4 SELECT AUTOMATIC UPDATES FOR MULTIPLE COST
ITEMS

You can select automatic updates for multiple cost items to save you time from selecting check boxes
manually for each cost item.

The Auto-calculate tool automatically checks the adjustment boxes for all the cost items that you
select.

To use the Auto-calculate feature select the cost items you wish to update. Click the Auto-calculate
icon, and then select Update CE from CB. In the Auto calculate dialog box, select whether to update
Cost, Quanty, Man hours, or Select all for the selected cost items, and then click Apply.
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Change register >  Budget Move

® ® e Assign amounts

CBS positi Escripti WBS CB total cost Adjusted CB CE total MH Adjusted CB cl
positiol Update CB from GE scription e &l o cuét e to rs Ml!lrs e a

<]

a

41 Update CE from CB 1074 $800,000.00 $0.00 16,000.00 0.00

(<]

42 Building I1&J - Bridge C»_ 1005 $200,000.00 $0.00 4,000.00 0.00

<]

43 Goncrete - Building K&L $50,000.00 5000 1,000.00 000

RN

Auto calculate

Match current budget values with current estimate values
® Select all
M Cost
4 Quantity

4 Man hours

The applicable check boxes are now automatically selected to adjust your current estimate values for
the selected cost items.

7.5.1.5 SET SETTING FOR DEFAULT CURRENT ESTIMATE
UPDATE

You can have the current estimate cost, man-hours, and quantity check boxes selected by default to be
updated with adjusted current budget cost, man-hours, and quantity values when doing change
orders.

In Settings > Control > Project Tracking, you can switch the Default CE values to be updated from CB
values toggle to ON. When enabled, all applicable check boxes are selected by default. This is a quick
way to keep CE and CB values in sync without having to double enter values.
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> PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE SYNC INTEGRATIONS
-—

'y

| D Tasks

Maintain CBS Structure at a specific level? Level to Maintain CBS Structure at

Generate WBS phase code automatically?

o )
WBS Phase code generation method WBS Phase codes start value

Continue numbering from the last generated number hd

Enable manual snapshets (i) €] Default CE values to be updated from CB values (i) ©@

Allow syncs to replace manual snapshots ®

For more information, see the Default CE values to be updated from CB values section in Project
Tracking, Tasks settings.

RELEVANT LINKS

Associated budget move

Integrated Solutions - Change order management
Video - Associated budget move

Video - Non-associated budget move

Video - Contract adjustment

Link 5

7.6 BUDGET QUANTITY / MAN-HOUR
ADJUSTMENT

During the course of a project, it is typical to have scope modifications that warrant changes to
guantities or labor hours.

It is important to remember that changing man-hours or quantities will affect budgeted values of
MH/QTY, QTY/MH, and Unit-Costs, but will not change the overall dollar value of your budget.

Within InEight Control, you can perform budget quantity and man-hour adjustments using a controlled
approval process.
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PERFORM A BUDGET QUANTITY / MAN-HOUR ADJUSTMENT

1. Select Actions > Budget move & contract adjustment > Budget quantity and man hour
adjustment.

fat  Steel Structure Training Job 2 | 105092 / Control / Workspaces

=] o

Y
Global forecast method.. .
H Task details { woon >
Set forecast method Resources Forecast (T/0) UoM
| aty
Update Forecast (T/Q) gty with Plan compone...
1.00  Lum|

‘_:1 Claim multiple CBS guantities

000.00 CY
| Budget move and contract adjustment |
| Budget move
| Lock/unlock budget poooo | cv
| Budget quantity and man hour adjustment
sync 000.00  Ton
Contract adjustment
(] a7 ETECT STee="Hej 350.00  Ton
The budget adjustment wizard opens to step 1, Details.
2. In Details, add details as needed, and then click Next.
Change Register >  Budget quantity and ...
o Details
Issue # cco -
002XX 002XX
Description 21
Tonnage increase due to material changﬁ
Discipline 500
Change Management tag 1 Change Management tag 2 Change Management tag 3

The budget adjustment wizard opens to step 2, Select Items.
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3. In Select Items, select a cost item from the list.

Change Register > Budget quantity and _

oSE\EDI Items

©BS position Description WBS phase code
3 Conerete 107
Structural Steel 1073
Erect Steel - Heavy 1074
Erect Steel - Light 1005

4.3 Bolted Connections 1006

| v 44 Module 01 - Erect Steel Heavy 1087 |

e =0 You can select more than one cost item to adjust; however, these changes will be
grouped as a single line item in the Change Register.

4. Click Next. The budget adjustment wizard opens to step 3, Assign amounts.

5. In Assign Amounts, enter the change to the man-hours or quantities into the applicable field, and
then click Next.

Change Register >  Budget quantity and ...

o Assign Amounts
4.4 Module 01 - Erect Steel Heavy
MHrs Quantity
Original: 0.00 0.00
Pending 5,000.00
New total: 0.00 5,000.00

The budget adjustment wizard opens to step 4, Summary.

6. In Summary, review your proposed changes, and then click Submit to send the budget move for
approval.
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Change Register >  Budget quantity and ...

o Summary

4.4 Module 01 - Erect Steel Heavy
MHrs Quantity
Before: 0.00 0.00
Pending 0.00 5,000.00

After: No change 5,000.00

E el -

You can select Draft if the budget move is not ready to be submitted and needs to be saved for
later. With applicable permissions, you can select Approve to approve the budget move.

RELEVANT LINKS

Integrated Solutions - Approve contract adjustment
Integrated Solutions - Execute the change order
Integrated Solutions - Change order management
Video - Contract adjustment

Video - Associated budget move

Video - Non-associated budget move

Link 5

7.7 CONTRACT ADJUSTMENT FROM INEIGHT
CHANGE OVERVIEW

A contract adjustment, often referred to as a change order, represents a change to the scope of the
contract that results in a change to the project’s budgeted costs, man-hours, and contract price. These
adjustments typically involve adding or revising cost and pay items to accurately estimate the financial
and labor impacts of the change.

When you integrate InEight Change with InEight Control, you can track project changes using a more
robust, transparent, and auditable process than using just the Control application.

RELEVANT LINKS

InEight Inc. | Release 25.7 Page 349 of 528


1-Tasks.htm
https://learn.ineight.com/integrated_solutions/Content/Business-Processes/Change-Order-Management/execute-contract-changes/execute-the-change-order.htm
https://learn.ineight.com/integrated_solutions/Content/Business-Processes/Change-Order-Management/Change-Order-Home.htm
https://learn.ineight.com/Control/Content/Categories/VideoStartPage.htm?wchannelid=65osol8gf1&wmediaid=s7agdmkq91
https://learn.ineight.com/Control/Content/Categories/VideoStartPage.htm?wchannelid=65osol8gf1&wmediaid=u5cujj5gdj
https://learn.ineight.com/Control/Content/Categories/VideoStartPage.htm?wchannelid=65osol8gf1&wmediaid=r2umbbsko9
https://university.ineight.com/learn/course/362/model-set-up-user-management?generated_by=13065&hash=2660b13637786b6739d9c9096a7afc003ea2f20a

7.8 Change Approval Process Control User Guide

Integrated Solutions - Approve contract adjustment
Integrated Solutions - Execute the change order
Integrated Solutions - Change order management
Video - Contract adjustment

Video - Assigning pay items to cost items

Link 5

7.8 CHANGE APPROVAL PROCESS

After budget moves are submitted, they must be reviewed and approved before their values are added
to the current budget. The Change Register allows users with applicable permissions to review the
details of contract adjustments, budget moves, and quantity or man-hour adjustments. They can
revise, reject, or approve the changes.

To access the Change Register in Control Workspaces, select the Change Register tab.

{2  Steel Structure Training Job 2| 1.. / Control / Workspaces

cBs ACS PAY ITEMS CHANGE REGISTER AUDIT LOG
Actions = R 4 B B = Q
0] Description cco Crea... Issue Last Last Notes Status Total budget Total budget Total contract Type
date # cha... changed cost MH price
by on
80 Concrete issue CCO0-003 07/01/2025 2 Paul benni.. 07/01/2025 e (" cco-Pending $ 259,000.00 3000.00 $284900.00  Contract adjustmen
70 Cracked weld 06/26/2025 3 Paul benni 07/01/2025 =) 2 Issue-Draft $0.00 0.00 $000  Budget move
60 Steel alignment issue €C0-002 06/26/2025 1 Paul benni 06/30/2025 2@ 2 cconat $11,000.00 20.00 $100000  Contract adjustmen
kR Additional Steel Work €COo-001 07/01/2025 079 Paul benni.. 07/03/2025 =) 2 Draft § 225,000.00 2900.00 $250900.00  Contract adjustmen
30 Additional Steel Work 06/25/2025 079 Paul benni.. 07/01/2025 & ? Revised § 225.000.00 2900.00 $250900.00  Contract adjustmen
20 Structural steel budget move 06/19/2025 Paul benni 07/01/2025 =) (@) Approved $0.00 0.00 $000  Budget move
10 Erect steel budget move 06/18/2025 Paul benni 07/03/2025 =) (JPending $0.00 0.00 $000  Budget move

The Change Register includes the following columns:

Column

name Description

ID Auto-assigned by the system to uniquely identify each change entry. When a
submitted change is revised, a duplicate record is created with the ID
indicating a new version of the original. For example, if the original change has
an ID of 2.0, the new revision entry will have an ID of 2.1.

Description The description entered on the Detail step of the change’s record.

CCO Text field for entering a change order number. Contract adjustments
generated from InEight Change will automatically have this filled with the
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Column
name Description

number defined in the executed CCO. This is only editable within the CCO in

Change.

Creation The date the change record was created in the Change Register.

date

Issue # Text field for entering the issue number. Change records generated in InEight
Change will automatically contain the number as defined on the
issue/PPO/CCO in Change. This is only editable within the CCO in Change.

Last Indicates the user who last made a change to the record.

changed by

Last changed Indicates the date when the last change was made.

on

Notes Clicking on the icon in this field opens a slide out panel where notes can be
entered and reviewed in a “text feed” format.

Status Indicates the state of the change record (for example draft, pending,
approved). More information about statuses is covered in a separate table
below.

Total budget Indicates the total amount of adjusted cost estimated on the change record.

cost
adjustment

Total budget Indicates the total adjusted man-hours estimated on the change record.
MH

adjustment

Total Indicates the total contracted price adjustment estimated on the change
contract record.

price

adjustment

Type Indicates whether the change record is a Budget move, Budget Qty & MH

adjustment, or Contract adjustment.
Entries in the Change Register will have different statuses depending on what step of the process they

are in and where the change was created (for example, Change or Control). The following table lists the
possible statuses and what they indicate.
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T T

Draft A change record that is not yet submitted. This allows a change record to be
started and saved for later, until it is ready to submit. A change record that came
from Change is indicated as Issue-Draft for budget moves or CCO-Draft for
executed change orders.

Pending A change record that has been submitted but not yet approved. A change record
that came from Change is indicated as Issue-Pending for budget moves or CCO-
Pending for executed change orders.

Approved A change record that has been approved by someone with the appropriate
permissions. An approved change makes the proposed budget cost and contract
price adjustments final, updating the Current Budget accordingly. An approved
change record that came from Change is indicated as Issue-Approved for budget
moves or CCO-Approved for executed change orders.

Rejected A change record that has been rejected by someone with the appropriate
permissions. Rejecting a change ends the change process and prevents the
proposed changes from updating cost items and pay items in the Current
Budget. A rejected change record that came from Change is indicated as Issue-
Rejected for budget moves or CCO-Rejected for executed change orders.

Revised An approved change record that has been revised. Revising an approved record
results in a new version of the change record with a new version number. For
example, if an original change record has an ID of 2.0 and has its status changed
to Revised, it results in a new change record being created automatically with an
ID of 2.1 and a status of Draft. A revised change record that originally came from
Change is indicated as Issue-Revised for budget moves or CCO-Revised for
executed change orders.

7.8.1 MANAGING CHANGES IN THE CHANGE REGISTER

With the applicable permissions, you can review project changes as they are recorded as entries in the
Change Register and either approve, reject, or revise them as needed. The Change Register includes

both change records that are in progress (status of Draft) and changes that have been submitted
(status of Pending).

To review a change record, click within the row representing the change. A slide-out panel opens that
summarizes the details of the change. The options available on the slide-out panel depend on the
change record’s status.
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7.8.1.1 DRAFT CHANGES REVIEW

On the slide-out panel for Draft changes, you can select Review, Delete, or Revise.

ACS PAY ITEMS CHANGE REGISTER AUDIT LOG
= -
$ v C = Q
3. & x
Additional Steel Work
Type Status Originated on Originated by
Contract adjustment (Cost ite 2 Draft 07/01/2025 Paul bennion
Last changed on Last changed by Approved on Approved by Approval probability
07/02/2025 Paul bennion N/A N/A N/A
a
Pay item details
Pay item Description Current billing Adjusted Adjusted Adjusted Locked date
number method current price current unit current pay qty
price
003 Steel - Labor & Material Unit price $164,500.00 $0.00 0.09 =
4 6 Additional steel work Unit price $ 86,400.00 $800.00 108.00
< > v
$ 250,900.00 $ 800.00
Cost item details
CBS position Description WBS Adjusted CB Adjusted CB Adjusted CB Locked date
pha... cost MHrs atvy -

(o ) (o | (D

¢ Review - Opens the change record in a read-only state. All the steps of the change can be
reviewed, but no changes can be made. This may be a helpful option to give users permission to
review changes without having the access to approve or reject them.

¢ Delete - Permanently deletes the draft. When clicking Delete, a prompt comes up to make sure
you want to delete the record.

¢ Revise - Opens the change record with full functionality to edit the record. After editing, if the
record is ready for approval, on the Summary step you can click Submit. If the record is still not
ready, you can select Draft to save it for future editing.

7.8.1.2 PENDING CHANGES REVIEW

On the slide-out panel for changes with a Pending status, you can select Review, Reject, Revise, or
Approve.
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ACS PAY ITEMS CHANGE REGISTER
1.0
Erect steel budget move
Type Status
Budget move (Associated) C_j Pending
Last changed on Last changed by
07/03/2025 Paul bennion
From/To CBS position Description W..
ph...
co...
From 42 Erect Steel - Light 1005
To 41 Erect Steel - Heavy 1074
From 4.2 Erect Steel - Light 1005
To 43 Bolted Connections 1006

AUDIT LOG

Originated on

06/

18/2025

Approved on

n/a

Adjusted CB
cost

($ 10,000.00)
$10,000.00
($ 1,000.00)

$1,000.00

Control User Guide

S v G
Originated by
Paul bennion
Approved by
n/a
Adjusted CB

Hrs

-200.00

+200.00

0.00

0.00

Adjusted CB
qty

0.00
0.00
0.00

0.00

$0.00

= Q

Locked

[ Review } [ Reject ] [ Revise }

¢ Reject - Changes the status of the change record to Rejected, ending the change process and

preventing the proposed change from updating cost items or pay items. From that point on, the

change record is read-only. Once rejected, the change cannot be revised.

e Approve - Changes the status of the change to Approved, making the proposed changes final
and updating the Current Budget and contract price with the changes. Once approved, you can

review or revise the change.

¢ Revise - Opens the change record with full functionality to edit the record. If you revise a

Pending record, you can resubmit maintaining the Pending status, or select Draft to save with a

status of Draft.

If you revise an approved record, the status of the record will change to Revised and become

read only, and a new draft of the record will be created with a new version number.

21 Cracked foundations

20 Cracked foundations
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07/03/2025

07/01/2025

Paul benni...

Paul benni...

07/03/2025 =

07/03/2025 S}

ﬁ Draft

Revised
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Revising an approved record will back out all approved budget, quantity, man-hour,

NOTE

and pay item amounts from the Current Budget. A revising warning message shows
to confirm that you want to proceed.

X

Revising will back out previously approved

amounts from current budget.
All approved budgets, quantities, man hours and pay items will be
reverted back to it's original, pre-approved state. Are you sure you

want to continue?

7.8.2 GROUP BY OPTION

You can activate the Group by icon to show certain change columns in groups of like information. Like
the CBS, you can activate the Group By icon to categorize certain columns in the Change Register.

CBS ACS PAY ITEMS CHANGE REGISTER AUDIT LOG
pctions v R 4 G =
D Description cco Crea.. Issue Last Last Notes Status Total budget Total budget Total contract Type
date & cha.. changed cost MH price
by on ji

20 Concrete issue €CO-003 07/01/2025 2 Paul benni 07/01/2025 B 5 cco-Pending $259,000.00 3,000.00 $284900.00  Contract adjustment
7.0 Cracked weld 06/26/2025 3 Paul benni.. 07/01/2025 @ z Issue-Draft $§0.00 0.00 $0.00 Budget move

6.0 Steel alignment issue CCO-002 06/26/2025 1 Paul benni. 06/30/2025 % £ CCO-Draft $11,000.00 20.00 $1.,000.00 Contract adjustment
31 Additional Steel Work CCO-001 07/01/2025 079 Paul benni. 07/03/2025 % 2 Draft $225,000.00 2,900.00 $250900.00 Contract adjustment
30 Additional Steel Work 06/25/2025 079 Paul benni 07/01/2025 =) ? Revised 22500000 2:900.00 $25090000  Contract adjusiment
20 Structural steel budget move 06/19/2025 Paul benni 07/01/2025 ] @ Approved $0.00 0.00 $0.00  Budgetmove

10 Erect steel budget move 06/18/2025 Paul benni 07/03/2025 =) (© Rejected $000 000 $000 Budget move

Select a column header, drag it into the gray section above the column headers, and then drop it.
Multiple column headers can be placed in the Group By field.
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CBS

cco

CC0-003

CC0-002

CCO-001

Crea...
date

07/01/2025
06/26/2025
06/26/2025
07/01/2025
06/25/2025
06/19/2025

06/18/2025

ACS

Issue
#

2
3
1
079

079

PAY ITEMS

Drag a column header and drop it here to gr{

Last Last

cha... changed

by on

Paul benni... 07/01/2025

Paul benni. 07/01/2025

Paul benni... 06/30/2025

Paul benni... 07/03/2025

Paul benni. 07/01/2025

Paul benni. 07/01/2025

Paul benni... 07/03/2025

CHANGE REGISTER

Notes

g gn g g g

Status

(" cCo-Pending
ﬁ Issue-Draft
£ CCO-Draft
ﬁ Draft

ﬁ Revised
@Approved

@ Rejected

AUDIT LOG

Total budget
cost
adjustment

$259,000.00
$0.00
$11,000.00
$225,000.00
$225,000.00
$0.00

$0.00

Total budget
MH

adjustment

Control User Guide

3,000.00

0.00

20.00

2,900.00

2900.00

0.00

0.00

Total contract
price
adjustment

$284,900.00
$0.00
$1,000.00
$250,900.00
$250,900.00
$0.00

$0.00

After the Group by icon is activated, and one or more columns are grouped, such as the Status column,
you can see all the change records in their respective groupings. You can also see a subtotal for each of
the groupings (if applicable).

< PAY ITEMS CHANGE REGISTER AUDIT LOG
Actions $ h 4 % 1= Q
EE

1D Description cco C:t::tiun Issue I(;ﬁ:f_ Iégi- g;ayt Stat... Notes ﬁ-gi-_ I(_I‘:_'I;ﬁ.-
by on cha.. tag 1 tag 2

80 09/23/2021 Paul trippi 09/23/2021 0.00  ( Pend 5]

7.0 09/23/2021 Paul trippi 09/23/2021 1000000 | ( JPend.. =3}

6.0 09/23/2021 Paul trippi 09/23/2021 000 (jPend. &

5.0 09/23/2021 Paul trippi 09/23/2021 0.00 ( jPend. =)

4.0 09/23/2021 Paul trippi 09/23/2021 000  ( jPend. =3}

21 3 3 09/23/2021 | 3 Paul trippi 09/23/2021 0.00  ( Pend 5]

Count:6

30 07/26/2021 | § Paul trippi 07/26/2021 10000 ¢ Draft 5]

Count:1

2.0 3 3 01/19/2021 3 Paul trippi 09/23/2021 0.00 ? Revis... =)

Count:1

RELEVANT LINKS

Integrated Solutions - Approve contract adjustment

Integrated Solutions - Change order management

Video - Change approval process

Link 5
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EXERCISE 7.1 - CHANGE MANAGEMENT

Now that you have covered the key tasks related to change management, you can practice making
changes on your own. You can use your own project (if available) or the training project used in this
lesson.

1. Review the project and determine a scenario that would require a contract change.
2. Perform a Contract Adjustment per your scenario, including the creation of a pay item.

3. Once completed, approve the Contract Adjustment.

Congratulations, you have completed this exercise!
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REVIEW

1. Where can you review the details of your contract adjustment or budget move and

2. When creating a budget move, what is recommended?

choose to either revise, reject, or approve the change?

a. Change Register

b. Approval Screen

C. CBSlLog

d. Contract Change Log

a. Issue number
b. Description

C. Dollar amount
d

. All of the above

SUMMARY

As a result of this lesson, you can:

Explain the change management process
Complete a cost budget move

Complete a quantity budget move
Complete a man-hour adjustment
Create an adjustment to the contract

Describe the change order approval process
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8.1 REVENUE MANAGEMENT
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8.2 INEIGHT CONTROL WORKFLOW -
REVENUE MANAGEMENT

Estimate

Historical Benchmarking

Control

Conform Estimate / WBS Structure

Progress . .
orecastin
Account Code Measurement g

Final Hours and Costs
ELEEE CBS Register

ACS Register Create & Manage Forecast Method Budget/Forecasts
Cost ltems Setup Quantities
Define Qty Account
Contribution Codes
Live

Analyze Planned EeraEsis
Earned and Actual Forecast

WBS Structure / Budgeted
Quantities & Hours

Approved changes
update Current Budget Revenue Management

I
1
Billed Revenue

Change Management r |
Change Register Pay Item Register

Create/Manage
Pay ltems
Budget
Qty/MH Analyzed Planned & Forecast Revenue
Adjustment
Contract
Adjustment Track Billed Revenue

8.3 PAY ITEMS

VIDEO | Pay Item Details

Pay items distribute the cost calculated in the Cost Breakdown Structure along with all markups, fees
and contingencies calculated in the pay items. You can manage pay items on the Pay Items tab. For
more information, see Pay Items section in Workspaces.

8.4 BULK IMPORT PAY ITEMS

You can import pay items in mass directly into the Pay Item and Proposal register, similar to how cost
items can be imported directly into the CBS.

You can access the Excel import feature by clicking on the Import icon on the far right toolbar of
Control > Workspaces > Pay Items.
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8.4 Bulk Import Pay ltems

Billed date: 06/21/20.. to 02020 (4 Y &1 (1 = Q
Pay Pay Pay Pay Pay Pay Pay
rtem 1hem item item ihem Ttem Tteam
tag 8 tag 9 tag 10 user user user user

When you click on the Import icon within the Pay Items tab of the Workspaces page, the Import Pay
ltems window is shown.

Overview - Import Pay ltems window

1 Import from
Excel

2 Import Type

3 Information
message

You can either drag and drop or browse to the file to import. Microsoft
Excel files (.xlIsx,, .xIs) and Comma Separated Value (.csv) files can
be imported.

You can add new pay items into the Pay Item and Proposal register.

Explains that once an import file is specified, the next step will allow
you to match the columns in your spreadsheet to the appropriate
columns in Control.

InEight Inc. | Release 25.7 Page 361 of 528



8.4 Bulk Import Pay Items Control User Guide

Import Pay items 0

Import from Excel ( xlsx, xls) or Comma separated value (_.csv)

Drag and drop the file here

or browse

Browse

Options

2] 3,

* Import type @ The import file is read and field mapping can
be specified. Mapping uses row 1 headers
from the source document

Pay ltems

@® New import

Cancel

Clicking Next brings you to the Map columns window, where you can map your Excel columns to the
applicable column in Control.

Overview - Map Columns Window

1 Template  After you map the import file columns to the Pay Item columns in Control,
you can save your settings as a template for future use. This is helpful when
you need to make scope changes or updates on a regular basis.

2 Control The names of the column headers in Control that you can map your data to.
field

3 Mapped A green checkmark indicates the column in your import file is mapped
correctly to the Pay Item's column. The Green key indicates the matching
code you specified is locked.
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Overview - Map Columns Window (continued)

4 File The names of the column headers in your import file that you can map to the
columns pay item columns in Control.

Import Pay items - payltems.csv

Map columns o
Template | Unsaved template v BT
Control field e Mapped e File columns o
Pay items .

Current billing method Elank-do not import

Current forecast t/o qty v Current forecast (T/0) gty

Current pay qty Blank-de not import

Current price v Current price

Current unit price Blank-do not import

Description v Description

Line number Blank-do not import

* Pay item number 9* Pay item number

Pay item tag 1 Blank-do not import

4

+ Required fields

(o) (o) (D

8.4.1 SPREADSHEET RULES

For the import to work correctly, the items in your Excel spreadsheet need to be formatted in a certain
way so that Control can recognize them. The following table indicates important spreadsheet rules to

follow to make sure your data imports successfully:

Import Reads the first worksheet within the referenced workbook.
function Stops the import process when a blank row is encountered, so consolidating
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e | e

the data to be imported is required.

Firstrowof  This is the header row of the data.
data This becomes the titles that are referenced during the mapping process.
During import, headers are not read if a blank header cell is encountered.

Numbers Need to be the actual number, not the summation of cells.
Cannot contain the $ or other currency symbol.

Secondrow This is the first row of data import.
of data

ey =0 If you make changes in the spreadsheet, you must save the spreadsheet before
importing. Only saved data are imported.

After clicking the Next button, the system reads your Excel file and attempts to import pay items. A
successful import shows a message stating the number of files to be imported.

Document contains no errors
1 record(s) ready for import

Select next to continue with import steps.

If the import is not successful, a message is shown stating that errors exist. An error file is provided for
you to download, review, make corrections to your Excel file, then eventually continue with the pay
item import again.
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1 of 1 records contain errors

No Pay ltems were imported. Multiple errors found in pay item import.

Download the error file to review and resolve errors.
Once all errors have been resolved, reattempt import.

Download Error File

The import error download file shows exactly where the error(s) exist within the Excel file.

PayItem from External System
File Import attempted on: 8/20/2021 7:43:46 PM

The following errors were detected while attempting to import pay item
values into control.

Review the errors below, once all the errors have been resolved,
reattempt the import to Control.

Error 1: Current unit price must be a numeric value for pay item number
5. (this error has 1/1 total rows affected)

Pay Item Number: 5
Row: 1

8.5 EARNING RULES

On the Cost Items tab the Update earning rules icon updates the earning rules for all associated cost
items. For each cost item associated to a pay item, you can adjust the earning rules by Earning % and
Earnings Timing. The Earnings timing indicates when you can earn revenue for a specific cost item
associated to a pay item. You can select from the following earnings timing options:
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¢ Percent complete — You will earn revenue based on the % complete of the cost item
e Start —You will earn all the revenue when the work of the cost item is started (e.g., Mobilization)

¢ Finish — You will not earn any revenue for the cost item until all the work is completed (e.g., QC

item)
Pay item ID Description Total Price
002 Concrete - Labor & Material $2,919,020.71
CBS Position Description Earning % Earning Amount Earnings Timing 'WES Phase Code
{Forecast)
52 Concrete - Materials 2500 % $729755.18 | Percentcomplete | 1086
\ .
3 Concrete 75.00 % $ 2,189,265.53 | Q 1071
Percent complete
100.00 % 919,020.71
R Start
Finish
[#| Default Earning Rules

Cancel

In this case for your Structural Steel Project, cost item 3 has an earning rule that equals 75% of the

Earning Amount (Forecast) of the pay item’s final revenue. Respectively, cost item 5.2 has an earning
rule of 25% of the Earning Amount (Forecast).

Since the Total Price of this pay item is $2,919,020.71, it is expected that cost item 3 will earn 75% of
this amount, and cost item 5.2 will earn 25%.

Pay item ID

Description Total Price
002 Concrete - Labor & Material $2919,020 71
CBS Pasition Description Earning % Earning Amount Eamings Timing WBS Phase Code
(Forecast)
52 Concrete - Materials 25.00 % $729755.1 plete ¥ 1086
3 Concrete 75.00% $2,189,265.53 Percent complete 107
100.00% $2,919020.71

[#) Default Earning Rules

Cancel
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J[e3g = Billing method of Cost plus

When the billing method of the pay item is set to Cost Plus, then the Update earnings
rules option will be disabled. Therefore, the associated cost items of the pay item will
earn revenue based on the assigned estimate resources’ billing rates and the % complete
of the cost item.

ADJUSTING PAY ITEM EARNING RULES

On the Pay Items tab, select a pay item.

Hover over to the right of the Description and click on the three black dots.

Select Pay item details.

Select the Cost Items tab.

Click the Update earning rules icon.

Change the Earning % percentages for each associated cost item so the total will equal 100%..

Click Save.

N o g bk~ w b=

8.6 BILLED REVENUE

You can track revenue for your cost items in the Billed revenue details panel. The timing and basis for
billing revenue varies depending on your contractual agreement. Options include billing by a time
period or milestone, or based on a schedule.

The Billed revenue details slide-out panel records and tracks billed revenue.
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002
Concrete - Labor & Material
BILLED RETENTION BILLED HISTORY
Pending hillable gty Pending billable revenue Retainage %
01e $ 530,386.06 0.00 %
Billed revenue Cost category
0 Undefined
Billed quantity + Billed date
m| 07/08/2025

Cost item
Change order

Notes

@ Add billed

Cancel

In the Billed revenue details slide-out panel you can navigate to the following tabs:

¢ Billed
e Retention

¢ Billed History

250

Control User Guide

To open the Billed revenue details slide-out panel, from the Pay Items register, click the ellipses next
to the pay item description, and then select Billed revenue details. The Billed revenue details slide-out

panel opens, where you can record and track what you bill to the client.
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@ Steel Structure Training Job2 | 1050 / Control / Workspaces

cas Acs PAY ITEMS CHANGE REGISTER AUDIT LOG Unsaved (Revenue) -
sons » @ @ & e v b o = Q

Revenue snapshot: Currentrevenue forecast ~  Billed date: 10/01/2005 to o7/08/2025 [

v Pay Pay Description Forecast Forecast Revenve Current Is Billed Billed Revenue Quantity Pending Pending Net
item item total revenue revenue forecast billng billed revenue aty carmed corned billable billable aty billed
position umber unit €0t method method revenve reven.

Unspproved revenue $93159.69
o0 Earthwork - Labor & Material 75988701 75988701  Defaut unit price ] $000 000 S217.44437 029 §7748437 029 $000
2 002 Concrete - Labor & Material E S29 $291902071  Default Unit price. (m] $0.00 000  $530386.06 018 $53038606 018 $000
Insert pay item
3 003 Steel - Labor & Material @ Insertpay 100228 Defaut Uit price 0 000 000 sa:neze o8 smLE0N 018 000
() Delete payitem(s)
[@ Paritem deais
2 Billed revenus i
B Billed revenve details
Subtotals 3 (1 pay items selected) §5599159.69 $000 $1069013.45 $1069.01345 5000

The Billed Revenue Details slide-out panel opens by default to the Billed tab.

RELEVANT LINKS

Control Revenue settings

Control Sync integration settings
Integrated Solutions - Tracking Revenue
Video - Billed revenue

Video - Billings integration to Control

8.7 REVENUE FORECAST PROBABILITY

Revenue can come from Control or Change. Only Contract Adjustments have revenue. You can also
adjust your pay item values in a Contract Adjustment. For example a drop down field called Approval
Probability is a drop down of all your revenue categories and their associated probability. This drop
down field displays the Approval probability by percentage and associated name.
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Change register  *  Contract adjustment

Mect Budget change  Net Quantity change  Met Man hour change Madup  Foe Met Contract change  Approwal probability
0.00 Na 0.00 50,00 50,00 5 0u00 -

D0% - queen =
Qo .

Choose your Contract adjustment workflow

E Start with Cost items
W Enter matk ap and fees on cost items t

-

Start with Pay items
Adjust pay iem prece before adjusting cost item budgets

Contract adjustment details
Issue # coo

Follow the steps below to select an approval probability.

APPROVAL PROBABILITY

Select the Actions drop down menu.

Hover over Budget move and contract adjustment, then click Contract Adjustment.
In the Approval probability drop down, select the percentage and associated name.
In step 3, select the add icon to add either new or existing pay items.

Enter a value into the Adjusted total price text box.

o a bk~ 0w DN =

Either save as Draft or select the Submit button. Now it shows the selected approval probability

in the Change Register. It also displays in the line item slideout. This updates automatically based
on status changes.

If your line item is approved, it has a 100.00% in the Approval Probability column.
8. If a Contract Adjustment has been revised or rejected, then the line item has a 0.00% in the

Approval Probability column.

JeJ= That Contract Adjustment's revenue is never going to be earned or added to the
pay items because a new Contract Adjustment has been created.
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8.7 Revenue Forecast Probability

9. Ifyour line item is in a Draft or Pending state, the Approval Probability column displays the

approval probability you selected for that line item.

NOTE

blank.

If you don't select an approval probability, the Approval Probability column is

Your Approval Probability drives the price you include in your Forecast Final Revenue. For this next
example, we are going to include the Unapproved Revenue into the Forecast Final Revenue. In the Pay
Iltems Register, the Unapproved Revenue column calculates all the Contract Adjustments. The column
adds up all Contract Adjustments that include the pay item and the adjusted price that has note yet
been approved. The Unapproved Revenue column calculates anything that is in a Draft or Pending

state.

RS - PAY ITEMS

% v, ov...
Mar.. L qua fare. eam,

§3m0.00 10000 §124.00

100 Default §000

In Pay Item Details, the Change Orders, you can view the following details:

» Total price change

Total unit price change

Total pay quantity change

Approval probability

Adjusted forecast final revenue
Status

InEight Inc. | Release 25.7

Billed date: paneama  to 1000172020

364 5
0.0 $1,000.00 -1.00 ]

Page 371 of 528



8.7 Revenue Forecast Probability Control User Guide

12345
12345
Total Price Pay Ouantity Unit Price
4 300000 (1n] & 3 000,60
DETAILS ATTRIBUTES CHANGE ORDERS COET ITEMS
Issue ¥ Total price Total unid price Total pay gty Appraval Adjusted Sladus
changa changa changs prohability forecast final
TRV
£ 1.000 00 50,00 0.x3 M 1.00 % 1000 i Dalt
5 0000 S 3000.00) 0.0 B0000 % §000 3 Pending
R L) S 3000.00) 0,00 000 3 5 000 Rpwispd
5 3.000.00 5 3.000.00 1.00 100,00 % 5 3.000.00 'f«-_%_l Approaed

The Forecast Final Revenue is the sum of all the Adjusted Forecast final revenue. Calculating the
Unapproved Revenue with the Forecast Final Revenue provides you with a more accurate look at the
revenue you will see when the Contract Adjustment is approved. Nothing is added into the Total Pay
Iltem Price until it is approved.

Approval Probability drop down is only available in the Contract Adjustment. Everywhere else it is read
only. To manually adjust the Contract Adjustment, go to the Change Register. Then right click the line
item you want to change and select Revise. The Contract Adjustment can also automatically change
based on status changes.

The Revenue Category Name and probability percentage drives the Approval Probability. The Revenue
Category Name draws from the Revenue Categories in the Master Data libraries.

Master data libraries - Revenue categaries ™

English Espaiiol ES-MX

Revenue calegory nama Revainia changs SIatus name Frobability percentags Stata (i) Reveaus category name Revenue change sialus nama

Englishas 0| Active Hew Dema STZEN

The Revenue Categories show the Revenue category name and probability percentage for only active
revenue.
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8.8 TIME PHASED BUDGET

Time phased budget lets you plan out where to spend money in the months of the active fiscal
calendar for the project.

The point of being able to time phase your budget is so that you can plan out your budget cost per cost
item. You are spreading out your budget over the course of the project for each cost item.

8.8.1 BUDGET ORGANIZATION SETTING

The time phased budget feature includes an organization setting located in the Project tracking tab of
the Control settings. The organization setting sets the default for all the projects within that
organization.

You can also change the budget setting at the project level. If you are starting new projects in your
organization, you need to have Time phasing budget switched on.

By default all the projects that are created under that organization also have the time phased budget
enabled. This is the same for when budget is disabled.

Time phasing

Enable time phasing for the following:

Budget (i) (©) Edit past Time phased budget values (&)

8.8.2 EDIT PAST TIME PHASED BUDGET VALUES

The Edit past Time phased budget values toggle lets you edit past fiscal period time phased budget
values.

Time phasing

Enable time phasing for the following:

Budget (3) (®) Edit past Time phased budget values ()
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When this setting is enabled, you can edit your past time phased budget values via a budget move or a
contract adjustment in the time phased budget step, with the proper permissions.

Change register Contract adjustment

Net budget change  Net quantity change  Net man hour change
§0.00 No 000

Markup  Fee
$000 5000

o Time phased budget

Net contract change  Approval probability
$0.00

CcBS Description wes Start Finish Cc January 2022 February 2022
s i b
L1} {poxstin &,ﬂie Cost Adjusted cost Cost Adjusted cost

m (521239 @ §21233 .

[ $0.00 $0.00

Selecting the new Rebaseline icon resets the cost item's time phased budget distribution based on the
Start and Finish dates against that cost item. Rebaselining lets you amend your time phased budget
distribution costs for a cost item.

You can also edit any of the Adjusted cost values manually for past months.

g8 TR
CBS Descrniption Start Finish April 2022 May 2022
[]  position - -
- Adjusted cost Cost Adjusted cost
O 50.00 50.00
5471.92 $5975.31

At the project level, the time phased budget inherits the organization settings, but still lets you switch
the budget setting On or Off at the project level. For example, you can have time phased budget
turned on at the organization level and you can turn it off at the project level.

8.8.3 SWITCHING OFF TIME PHASING BUDGET

If the Time phasing budget is switched on, that means there is time phasing budget data in the
database. If you turn it off time phasing budget at the project level, it gives you the following warning
message:
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X

Are you sure you want to delete Time phased budget? %
Turning off time phased budget will delete all existing time phased budget
data for the project.

| By selecting this checkbox and accepting these conditions, |
understand that all time phased budget data will be deleted for this
project.

MeJg=m All of your time phased budget data is going to be deleted if you switch time phased
budget off. You must select the check box in the warning dialog acknowledging that you

understand and accept these conditions.

If you still want to turn off the time phasing budget, you can select Yes and then click Save. This will
delete the time phasing budget data from the database.

8.8.4 SWITCHING ON THE TIME PHASING BUDGET

If you want to turn on time phased budget, the following dialog box appears if there are any missing

start or end dates:
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Cost items are missing start and end dates.
How would you like to populate the missing cost item start and end dates?

® Default all budget to current fiscal period
(O Default to project start and end dates

(O Go back and populate the missing dates

Every cost item in your project needs the start and finish date entered to use that data in the time
phase budget.

When time phased budget data is calculated, the calculation is based off of the data in the current
budget and total cost for the cost item. Then, the cost is distributed to the cost items start date, finish
date, and cost curve.

Time phased budget <o)

CB total cost Start Finish Cost curve Pending
budget cost
$48,790.00 01/01/2020 03/31/2022 Linear $150.00
$25,020.00 01/01/2020 07/30/2021 Back Loaded (5 5,060.00)
§5,050.00 12/30/2020 12/31/2020 Front Loaded $ 4,640.00
$5120.00 01/01/2021 05/31/2021 Linear $540.00
$1,600.00  12/01/2020 03/31/2021 Custom curve 1 $10.00
$1,000.00  12/01/2020 05/15/2021 Bell Shaped $10.00
$11,000.00 12/01/2020 03/31/2022 Custom curve 2 $10.00

8.8.4.1 DEFAULT ALL BUDGET TO CURRENT FISCAL PERIOD

The first option you have is to default all of the budget to the current fiscal period. Then, all cost items
that don't have defined start and finish dates have the current budget going to the current fiscal
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period.

For example, if you look at WBS phase code 1007, you would have $100,000 put into December 2020.

Tasks £ | Time phased budget <e> H
3 CBS position Description WBS phase CB total cost Start Finish Cost curve Pending

a code budget cost
a v Electrical devices 1000 §48,790.00 01/01/2020 03/31/2022 Linear $150.00
a 1.1 Install conduit 1002 $25,020.00 01/01/2020 07/30/2021 Back Loaded ($5,060.00)
O 12 Fiber optic cable-1 10011 $5050.00 12/30/2020 12/31/2020 Front Loaded $ 4640.00
O 13 Pull cable 1003 $5120.00 01/01/2021 05/31/2021 Linear $540.00
a 1.4 CCTV devices 1004 $1,600.00 12/01/2020 03/31/2021 Custom curve 1 $10.00
( 15 Terminations 1005 $1,000.00 12/01/2020 05/15/2021 Bell Shaped $10.00
O 16 Light poles 1006 $11,000.00 12/01/2020 03/31/2022 Custom curve 2 $10.00
a v 2 Indirects 1008 $ 305,000.00 Linear $000
( v 21 Staff 1010 $ 305,000.00 Linear $0.00
(] 211 PM 1007 $ 100,000 ng: Linear $0.00
O 21.2 PE 1009 $ 85,000.00 Linear $0.00
O 213 Super 101 $120,000.00 Linear $0.00
O 3 Staff training 1012 $5.500.00 Linear $0.00
a 4 Craft training 02 §17,500.00 Linear $0.00
(]} 5 ST&S 1014 $45,000.00 Linear $0.00

Subtotals 64 $431,790.00 $150.00

8.8.4.2 DEFAULT TO PROJECT START AND END DATES

The next option is to default to the start and end dates. On the project details page you define all the
project start and end dates. After those are defined, then we can default all of those missing start and
end dates to just the project start and end dates.

8.8.4.3 POPULATE MISSING DATES MANUALLY

You can also return to the Time phased budget step and manually populate the missing dates. If you
choose this option, the budget setting turns off again (if it wasn't already turned off and on again in
previous sections). You then have to go into the CBS and manually enter all the start and finish dates.
Then, you could turn the budget setting back on and it should distribute the budget.

Med= Time phased budget data currently can only be seen in the CBS contract adjustment.

For more information about settings for time phasing budget, see Time-phasing.

8.8.5 TIME PHASED BUDGET IN CONTRACT
ADJUSTMENT

From the CBS, select cost items to adjust in the contract adjustment.
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LOB8880 0

% CBS position Description WBS phase CB total cost Start Finish Cost curve Pending

code budget cost
v Electrical devices 1000 $48790.00 01/01/2020 03/31/2022 Linear $150.00
1.1 Install conduit 1002 $25,02000 01/01/2020 07/30/2021 Back Loaded ($ 5.060.00)
1.2 Fiber optic cable-1 10011 $5,050.00 12/30/2020 12/31/2020 Front Loaded $4,640.00
13 Pull cable 1003 $5,12000 01/01/2021 05/31/2021 Linear $540.00
1.4 CCTV devices 1004 $1,60000 12/01/2020 03/31/2021 Custom curve 1 $10.00

Then select the Actions drop-down, hover over the budget move and contract adjustment and then

select Contract adjustment.

r

Actions ¥ E ®

) forecast method
Set torecast method Descﬁptiﬂn WEBES phase
code
Time phased forecasting
Electrical devices 1000
Claim multiple CBS quantities Install conduit 1002

Budget move and contract adjustment b
Budget move

Unlock budget
Budget quantity and man hour adjustment

Sync b _
Contract adjustment @

In the contract adjustment, there is an area called Change order attributes. This area lets you set your

change orders/contract adjustment to the following:

e Start date
¢ Finish date

e Costcurve
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o Details

Choose your Contract adjustment workflow

Enter markup and fees on cost items to generate pay item price

‘ @ Start with Cost items

Start with Pay items
Adjust pay item price before adjusting cost item budgets

Change order attributes
Start date Finish date Cost curve

2020 - December ¥ 2020 - December ¥ Linear v

Contract adjustment details
Issue # cco

Cost Curve can be adjusted in many ways. If you select Bell Shaped the cost adjustments increase
during the summer months and then decreases in the winter months.
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Cost curve
Linear v
Linear -

Front Loaded

Back Loaded

Bell Shaped @

Custom curve 1

Custom curve 2
ﬁ
In step 3 of the contract adjustment, the Time phased budget step can be used for both Start with Cost

items work flow and the Start with Pay items work flow. You can adjust your time phased budget in
either contract adjustment work flow.

Jleg= The only time your time phased budget should change is when you get change orders and
you have to change your overall budget amount.

For the Start dates, you cannot put budget in the past. If you try to select a month that has already
passed, you will get an error stating Start date must be in an open fiscal period.

Change order attributes

Start date Finish date Cost curve

2020 A 2021 v December ¥ Linear v

Start date must be in an open fiscal period
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Finish date has to be greater than your start date otherwise you get the following error.

Finish date Cost curve

2020 - December w Linear b

Finish date cannot be earlier than start date

Move onto step 2 Cost Items. You can add Adjusted CB total cost. In this example we are adding $100
to each cost item.

o Cost items

@ ® Assign costto ¥

= CBS position Description WBS CB total cost Adjusted CB Markup
l phase total cost %
code

Z\ Unassigned cost items

O 12 $100.00
0O stall conduit $ 25,020.0C $1

O 13 Pull cable $100.00
0O 14 $100.00
0O 15 Terminations 1005 $100.00
16 Light poles 1006 $11,000.00 $100.00

In the Time phased budget step, the 100 dollars now has to be distributed. Scroll over to the
Distribution type column.

MeJg=n In step 3, only TERMINAL cost items will be brought into that grid. Non-terminal cost
items do not show on the Cost items grid of the contract adjustment.

e Time phased budget

_ cBS Description Start Finish Cost [Distribution | CB total November 2020 December 2020

[ L] - type (e Cost Cost Adjusted cost

O $0.00
O $0.00
O $0.00
O $0.00
C 5000
O I $0.00

There are three different Distribution types:
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e Change order (default setting)
e Costltem

¢ Manual

When Distribution type is set to Change order, it means it is pulling in the start date, finish date, and
cost curve from the details step of your change order.

The changes to the Adjusted total cost column are then distributed throughout the start and finish
date and shows in the Adjusted Cost column.

If your cost curve was set to linear, roughly the same amount of cost goes into the same fiscal period.
Since some months are longer than others, they will have additional cost.

a Time phased budget =

$0.00 Dec 2020 - Dec 2021 ~ View Cost column @)

cBS Description WBS Start Finish Cost Distribution October 2021 November 2021 December 2021
hase

CEve tps Cost Adjusted cost Cost Adjusted cost Cost Adjusted cost

[

( $9562
[ $9562
O $9.62
[ §9.62
( $962
[ I $9562

w o o v o o
B
3

8.8.6 TIME PHASED BUDGET AT THE BUDGET MOVE

Time phased budget is included for both the non-associated and associated budget move.

The total adjusted CB total cost must be zero before you can move budget. This shows as a net zero
budget adjustment when you are moving budget from cost items to other cost items. You can also
move the time phased budget.

You can set the start date, finish date, and cost curve for the budget move change orders.

Page 382 of 528 InEight Inc. | Release 25.7



Control User Guide 8.8 Time phased budget

o Details

Choose your Budget move workflow

Associated

Define budget moves with a From and To process to provide ultimate traceability of budget moves

Non-Associated

'-!, Define budget moves freely 1o provide the most flexibility

Change order attributes
Start date Finish date ost curve

oy
FilFy |

Budget move details

Issue & CCO

The Time phased budget step is similar to the Time phased budget step for Contract adjustment. The
distribution type on this step is where you can select to distribute by the change order attributes or the
cost item attributes. You can also manually adjust your cost.

Change register Budget Move
o Time phased budget =
g8 $0.00 Feb2021 - Aug2021 =  View Cost column @)
CBS‘ Ny Description WeS Stant Finish Cost curve Distril February 2021 March 2021 April 2021
Pt g " Com Cost Adjusted cost Cost Adjusted cost Cost
$000 $000
@ $000
%
» >

Cancel Draft Back | m

InEight Inc. | Release 25.7 Page 383 of 528



8.8 Time phased budget Control User Guide

When you adjust the budgeted cost either through a contract adjustment or a budget move, you can
adjust the cost over the different fiscal periods and decide where to place the adjusted cost.

8.8.7 TIME PHASED BUDGET GRIDS

In the left side gird, you have many of the cost item details in columns. This includes the following

columns:

CBS position
Description

WBS phase code
Start

Finish

Cost curve
Distribution type

CB total cost
Adjusted CB total cost

Pending budget cost: any outstanding budget cost that has not yet been approved. For
example, if you have another pending contract adjustment, it adds those values in this
column.

Phased budget cost delta

CBS Description B total Adjusted CB Pending — Phased budget
position bst total cost budget cost _y cost delta
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You can adjust the amount of columns you see using the slider to move between the left side grid and
the right side grid.

The right side grid shows your cost and adjusted cost columns. Your cost columns show current cost
that has been approved.

For example, in the CB total cost column, if you have $1,000 approved, the cost columns for each
month distributes that cost throughout each month.

e Time phased budget =

&8 $0.00 Dec 2020 - Dec 2021 View Cost column (@)
. cBS Deseription CB total Adjusted CB December 2020 January 2021 February 2021 March 2021
b o otal oot Cost Adjusted cost Cost Adjusted cost Cost Adjusted cost Cost Adjusted cost
5$0.00 5962 $7.69
$0.00 $962 $T769
$0.00 $9.62 $7.69
O $0.00 $9.62 $7.69
$0.00 $962 $T69
O I $0.00 $962 $769

8.8.8 CHANGING DISTRIBUTION TYPE TO COST ITEM

You can change the auto distribute type to Cost item if you want your adjusted budget to use
attributes from the CBS.

To do this, you can select one, many, or all of your cost items in the left side grid, and then click on the
auto distribute icon. Then select Cost item.

[x) Auto distribute adjusted budget based on
@ cost curve and start/end dates

Change order escnpuon Start

Cost item

(< J < < I < I < I < T <.

Your Distribution type has changed to cost item. You are now distributing your adjusted budget based
on the cost item attributes that are pulling in from the CBS.
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CE
- CBS Description Finish Cost Distribution CE total
| position curve type cost

This also changes how the Cost curve distributes the adjusted cost. As you can see from the screenshot
above, some cost curves have been adjusted.

8.8.9 MANUAL DISTRIBUTION OF COST ADJUSTMENT

You can change a specific cost item's cost adjustment to zero and then manually redistribute that
zeroed cost to other months. If you do not distribute the cost to other months, the following missing
amount for the adjustment cost is highlighted in orange.

$40.00 Dec 2020 - Dec 2021 ~ View Cost column @)
December 2020 January 2021 February 2021
Cost Adjusted cost Cost Adjusted cost Cost Adjusted cost Cost
$10.00 o $50.00 T q
$0.00 $100.00 $0.00
$0.00 $19.87 $18.54
$20.46 §27.55 §22.04
§$1.44 $18.80 $38.78
$5.35 §7.20 $5.76

After redistribution, there are some manual indicators showing what the value was before the change.

Start Finish Cost Distribution December 2020

January 2021 February 2021
curve type

Cost Adjusted cost Cost Adjusted cost Cost Adjusted cost Cost
I:l $1000 @ $50.00 ® Value before: $0.00 >
$0.00 $100.00 §0.00
$0.00 $19.87 $1854
$20.46 $27.55 $22.04
$1.44 $18.80 $3878
$5.35 §7.20 §5.76
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The warning indicator on the cost curve column lets you know that your cost item contains manual
time phased months and is not technically back loaded anymore.

Finish Cost Distribution
curve type

N

Cost item contains manual time phased months

8.8.10 DELTAS IN A ADJUSTED COST COLUMNS

Deltas appear on a contract adjustment when the adjusted cost for a cost item does not match the
current budget total cost.

\[e) = You are not allowed to submit or approve a cost item adjustment that has a delta.

That is where the phased budget cost delta column displays any missing or over budgeted costs for
any one cost item.

This column sums up all of your adjusted cost in the right side grid and compares it to the Adjust CB
total cost.

For example, if you have $10 not distributed, you need to add it to the adjusted cost in that same cost
item before moving onto the next step. If the current budget total cost has $100, you must spread that
total cost amount throughout your months.

$10.00 Dec 2020 - Dec 2021 + View Cost column

Adjulsled ce :e:‘\ding Phaﬁsdlhudgﬂ December 2020 January 2021 February 2021
[EA S ORLCoes SR Cost Adjusted cost Cost Adjusted cost Cost Adjusted cost

I} 5000 e $5000 @ 54000 @
$0.00 $100.00 $0.00

Hovering over the delta warning in the right side grid shows where the error in cost is occurring. If you
have multiple deltas in different cost items, the delta cost would then sum up all delta costs.
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3]?-0'3 Dec 2020 - Dec 2021

-

= brua
Phased budget cost delta.

Budget must be allocated before the change order

can be submitted or approved.

@ TUwUy

If you attempt to submit or approve the contract adjustment with deltas and you return to the Time
phased budget step, the Phased budget cost delta column shows which cost items have a delta. You
need to resolve the deltas and redistribute the costs in the Adjusted cost columns in the right side grid
before moving forward.

$20.00

CBS Description Adjusted CB Pending Phased budget December 2020 January 2021
position total cost budget cost cost delta Cost Adjusted cost Cost Adjusted cost

$10.00 S000 e $50.00 @
n.00 $1000 @ $100.00

Undistributed budget remaining $0.00 $19.87

$20.46 $27.55

You can also adjust your delta costs using the same Auto distribution button from earlier and selecting
Change order. Change order always distributes without a delta.

]
=14

_. Change order

Cost item
[ |

Now you can submit and approve your contract adjustment. All those values are going to be
committed into your time phased budget.

Page 388 of 528 InEight Inc. | Release 25.7



Control User Guide

8.8 Time phased budget

For example, if you sync into your ERP, you can receive all changes made in the contract adjustment

right after those changes have been approved.

8.8.11 VIEW COST COLUMNS

If you want to view just your adjusted cost columns, select the View Cost column slider to turn off your

cost columns. Only the adjusted cost columns shows. These columns show what you are adjusting in

the active project months for the contract adjustment.

December 2020
Adjusted cost

$0.00
$0.00
$0.00
$0.00
$0.00
I $0.00

January 2021

Adjusted cost

$962
$962
$962
5962
$962
$962

February 2021

Adjusted cost

$769
$7.69
$769
$7.69
$769
$769

March 2021

Adjusted cost

$7.69
$7.69
$769
§7.69
$769
§$769

8.8.12 DATE RANGE FILTER

April 2021

Adjusted cost

$7.69
$769
$769
$7.69
$769
$769

$0.00

May 2021

Adjusted cost

Dec 2020 - Dec 2021 ~

$9.62
$9.62
$962
$9.62
$962
$9.62

June 2021

Adjusted cost

View Cost column (@)

July 2021
Adjusted cost

$7.69
$769
$769
$7.69
$769
$7.69

w o W B B »

The date range filter lets you filter the right side grid to show only the months you want to see. You

can view the project months based on the following options:

» This month (current fiscal month you are in)

Next 3 months
Next 6 months

Next 12 months

InEight Inc. | Release 25.7
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$0.00 Dec 2020 - Dec 2021 - View Cost column (@)
t  Timeframe
This month Next 6 months hrough project finish date
O
Show months
From December 2020 * To December 2027 b

You can also manually select the months you want to view using the Show months drop-down lists.

8.8.13 APPROVING BUDGET WARNINGS

You can't approve budget set in the past. If you have any adjusted cost set for the current month
(December) and the contract adjustment is approved in the next month (January), the approver
receives a warning stating you have budget in past or closed periods.

The contract adjustment can still be approved, but the adjusted cost from the closed month moves to
the following month.

The other option the approver has is to revise the adjusted cost. When revising, the adjusted cost from
December has already moved into the adjust cost column for January. If you do not want all of the
previous month added into a single month, you can manually move the additional adjusted cost from
January into the other open fiscal period months.
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REVIEW

1. Revenue columns can only be populated for a cost item that has an assigned ?

a.
b.
C.
d.

uom
Unit price
Pay item

Cost curve

2. What are the four tabs within the Pay Item slide out?

a.

b
C.
d

Details, Attributes, Revenue, Cost Items
Revenue, Cost Curves, Change Orders, Cost Items
Details, Cost Curves, Change Orders, Cost Items

Details, Attributes, Change Orders, Cost Items

3. In the Pay item details slide out panel, which tab contains the Update earning rules

option?
a. Details
b. Cost Items
C. Attributes
d. Change Orders
4. The slide out panel is where you can record what you bill to the client
a. Billed revenue details
b. Payitem details
C. Forecast revenue details
d. Cost curve details

SUMMARY

As a result of this lesson, you can:
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Forecast revenue and determine profit

Manage pay item details

Adjust pay item earning rules

Bill customers per pay item or in mass

Track billed revenue
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9.1 SCHEDULING
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9.2 SCHEDULING OVERVIEW

Inside of the Control application exists the functionality to track schedule dates at a CBS level. The
ability to easily add and modify this information allows you to accurately track your operations planned
and completed dates.

The schedule data can either be mass imported through an Excel upload, created and modified directly
within the CBS, or by way of Primavera schedule integration through and XER file import. This lesson
will cover all options.

9.3 SCHEDULE DATA BLOCK

The schedule data block is where all information regarding schedule dates is contained. Some of the
key fields inside this data block are:

e Schedule ID

e Planned Start Date
e Planned Finish Date
e Early Start Date

e Early Finish Date

e Late Start Date

¢ Late Finish Date

e Actual Start Date

e Actual Finish Date

You can add and edit this information directly inside the Schedule data block. However, this will only
allow you to modify one CBS line item at a time.

The following Step by Step shows you how to add the Schedule data block, save a Scheduling view, and
add various dates for a specific CBS item.
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SCHEDULE DATA BLOCK

1. From the Workspaces page of the Steel Structure Job, remove each data block from the page,
except for the Tasks and Task Details data blocks, by right clicking on the context menu.

Current budget { eoe >

CB total CB total MHrs CB total cost CB MHrs/Unit

CB Unit/MHr CB unit cost
quantity

1.00 0.00 $ 250,000.00 0.00 0.00 $ 250,000.00

L e LTS LRELLY.] o an nonn 1 An A oan o

2. For each data block you plan to remove, select Remove Data Block

Choose columns
Filter

Save data block as...

Remove data block

3. Once the data blocks are removed, click the Add Data Block button.

E 9 m B B 1= Q
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4. Dragand drop the Schedule Data Block to the right of Task Details.

@) steel Structure Job (105091) - Control ¥ Workspaces ¥

CBS ACS PAY ITEMS CHAMNGE REGISTER

Actions = @

X

.
H
H
CBS position Description Resource Forecast UoM

Standard data blocks

Earth | 1000000  CY

Earthwork Review E'I 100 | Each

Schedule
4
T E T A s 22 Earthwork Is 1000000 CY
_ Structural Steel 100000 Ten
41 Erect Steel - Heavy : 5 350.00 Ton
42 Erect Steel - Light is 20000 Ten

5. Select Module [your initials] — [description.]

CBS position Description Resource Forecast UoM Scheduled Rall up Schedule WBS Schedule ID Schedule piug Plug days
(T/0) schedule days
quantity
'
42 Erect Steel - Light Is 20000 Ton H HD.0000105 50.00
43 Bolted Connections Is 200000  Ea ! HD.0000106 1250
1
i

D 44 Module 01 - Erect Steel Heavy 13 80000  Ton

6. In the schedule data block, type your Initials.01234 in the Schedule ID field.

Schedule

Scheduled Roll up Schedule WBS Schedule ID
schedula
E SH.01234
1
1

7. Click the right arrow to move to next set of columns in the schedule data block.
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Schedule < ona )

Scheduled Roll up Schedule WBS Schedule ID
schedule

8. Double click into each field and enter the following:
 Start=10/05/2020
« Finish = 10/15/2020
e Early Start =10/01/2020
 Early Finish =10/15/2020
¢ Late Start =10/07/2020
e Late Finish =10/15/2020

Schedule
Start Finish Early start Early finish Late start Late finish
10/05/2020 10/15/2020 10/01/2020 10/15/2020 10/07/2020 10/15/2020

¢ Entering dates on any terminal CBS item will auto-populate the parent’s dates. If there are
multiple terminal items under one parent, any start dates will take the earliest and any
finish dates will take the latest

¢ Once all the initial schedule dates are entered, the schedule data block also allows for the
project to track actual dates

9. Click the Right Arrow to move to next set of columns in the schedule data block.

¢ You will leave these columns blank for this Step by Step

Schedule {sse

Actual start Actual finish
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9.4 SCHEDULE EXCEL IMPORT

The Control application allows for an Excel import to import data into the Schedule data block. This is
especially useful when bringing in large sets of data for multiple CBS items.

Excel imports can sometimes 'hang' while attempting to import CBS data. If this happens, it's possible
to cancel an Excel import while the system continues the attempt to import the data.

The following Step by Step covers downloading this Excel sheet, entering the necessary data, and
importing it back it into Control.

EXCEL IMPORT

1. From the Workspaces page, using the Schedule view on the CBS tab, click the Export button,
then CBS as CSV.

E 9O m B || I Q

Export:
ot ceta A
CBS as CSV

final Forecas ial Forec
MHr=s I|.:'|r||:|~|:lu

ik
Schedule as XER —

0.00 0.00

e This creates a CBSDataBlock folder in your Downloads folder

2. Open the CBSDataBlock.csv file.

Subtotals 44

i) 2018 InEight Inc. Privacy and Terms | v 18.3

85 cesDataBlock (3).csv = A
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3. Inside the Excel spreadsheet, delete all rows except for Module [your initials] — [description].

bl - - —
('x“ Eut Calibri 111 -~ A A - == '?/" %Wrap Text General - =;e
ER) Copy - '
Paste ' Format Painter B I U- #H.- d-A-=== &= Merge & Center = | $ ~ % * | %5 &% FCDI"IdItI-Dr
K4 ormattin
Clipboard ra Font ra Alignment ra Mumber ra
B11 A f
A B C D E F G H
1 |CBS position Description Resource Forecast (T/0) quantity UoM Change status Allow as-bt
2] 4.4 Module 01 - Erect Steel Heavy | 3 800 Ton All

3

= 5

4. Enter the following:
e Actual Start =10/03/2020
e Actual Finish =10/12/2020

AR AC AD AE
Late finish JActual start Actual finish | Cost curve
1I:I',-lr 1-’-1,-|r 2020 1I:I',-lr D3,-" 2020 1I'_'I-,-lr 12,-lr 2020 JLinear

5. Save the file to your computer (as .xlsx, .xls, or .csv).

6. From the Control > Workspaces page, click the Import button for Cost ltems.
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O i = Q

Import:
O 10/21/2019
inal Fore Cost rtems Forecast
rems method

Actuals
»,504,089.00 .00 Current estimate

Schedule
SD S 669.03 ——— 00 Current estimate

7. Click Browse to select your Excel file.

Import CBS data

Import from Excel (_xlsx, .x1s) or Comma separated value (.csv)

Drag and drop the file here or browse

Browse__.

8. Select Cost Items and cost item attributes, Update Existing Items and CBS position.

Page 400 of 528 InEight Inc. | Release 25.7



Control User Guide 9.4 Schedule Excel Import

Options

*Impaort type

ID::st items and cost item attributes - I
| ® Update existing and new items |

Cost item matching criteria

| CBS position - |

Update existing items

Mew Items

9. Click Next.

)

10. Next, you will map which columns from the Excel sheet get imported to which columns in
Control. Click on CBS Columns to sort A-Z.
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Map columns

Order Data type

Control User Guide

Template | Actual Start/Finish

CBS columns Mapped

File columns

11.  Under File Columns, match Actual Finish and Actual Start to the CBS columns description.

CBS columns Mapped

Actual finish

Actual start

12. Do the same for WBS Phase Code.

CBS columns Mapped

User defined &

User defined 7

User defined &

WES client code 1

WRS client code 2

WES phase code a,

13. Click Next.
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File columns

Actual finish

Actual start

File columns

Blank-do not import

Blank-do not import

Blank-do not import

Blank-do not import

Blank-do not import

WES phase code
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Cancel

¢ The actual dates you specified import into the Schedule data block

CBS ACS PAY ITEMS CHANGE REGISTER AUDIT LOC
Actions = ® [ ®

CBS Description Resource Forecast UoM Actual start Actual finish Cost c

[l position o)
quantity

U 1 Job Qverhead 100 Lump Sum
=] 2 Earthwork 5 1000000 CY
a 3 Concrete 5 1000000 CY
5] . Structural Steel 100000 Ton 10/03/2020 10/12/2020
=] a0 Erect Steel - Heavy 6 800.00 Ton Linear
(=] a2 Erect Steel - Light 5 20000 Ton Bell Shap
5] 43 Bolted Connections 5 200000 Ea
(4] 44 Module 01 - Erect Steel Heavy 35000 Ton 10/03/2020 10/12/2020

TIP The Excel import can only be accomplished if the Control > Settings > Schedule

setting is set to Manual Entry.

PROJECT TRACKING ESTIMATE RESOURCES SCHEDULE

Define project schedule

Schedule data source:

Manual entry -

Manual entry

XER file type

R B L U T S U D S ST T U GO T T S e T U e GO T ST
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9.5 PRIMAVERA SCHEDULE INTEGRATION

The XER (file extension used by Primavera containing project file related data) import functionality
allows the milestones and schedule dates (baseline and current) to be integrated into planning
activities. Schedule IDs in Control are used to map Primavera Activity IDs to import and export the
project information. The status of construction activities and progress are then integrated back into
the InEight scheduling tools.

The Primavera schedule integration not only allows for XER file import of schedule dates but is also
capable of a cost item bi-directional push and pull between Control and Primavera. XER imports
integrate critical milestones and schedule dates into planning activities in the InEight cloud platform.

It’s also possible for you to map the existing Control 25 CBS tag fields, and also the existing 15 user
defined fields to P6. Conversely, you can create new fields in P6 based on tagging scheme. This allows
you to filter Primavera and Control in similar ways, with the same sets of dates within both
applications.

You also can push (Physical) % complete to P6. As you are progressing in Plan or Progress, and as
guantities drive the percent complete in Control, it’s possible to push the percent complete back to the
associate activity in P6.

9.5.1 PRIMAVERA SCHEDULE INTEGRATION SETTINGS

The setting to change the schedule data source to Manual entry or an XER file type is in Settings >
Control > Schedule > Define project schedule.

Under the Schedule data source, it’s possible to manually enter schedule dates, or you can utilize the
XER file type.
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Define project schedule

Schedule data source:

XER file type b

Manual entry ——p» Option 1
XER file type =——3» Option 2

After selecting your Schedule data source, you will have the option of making sure that your schedule
IDs are similar across your baseline and current schedule.

Duplicate field values for Baseline and Current schedule columns:
#| Schedule ID and Baseline schedule 1D
#| Scheduled and Baseline Scheduled
¢ Schedule WBS and Baseline schedule WBS

#| Roll up schedule and Baseline roll up schedule

If you uncheck one of these options, and then check it back, you will be given the option to copy
existing Schedule ID column values to Baseline schedule ID column, and vice versa. This is a way to
ensure that data consistencies remain in check for both baseline and current monthly schedule.

X

Select one:

# Copy existing Schedule 1D column values to Baseline schedule 1D column

Copy existing Baseline schedule ID column values to Schedule ID column

o)
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Under Percent complete, you can either update the XER file with physical percent complete from

Control, or not.

Under the second dropdown for Update XER activities, you have the option to update XER with tags
and user defined fields from Control, or not to.

Update XER activities with cost item tags and user defined fields from

Percent complete: Control:
Do not update percent complete A Do not update tags or user defined fields hd
Update XER with physical percent complete from Control Update XER with tags and user defined fields from Control
Do not update percent complete Do not update tags or user defined fields

If you choose to update XER with tags and user defined fields, the Define tags and user defined export
rules table appears. The 3 options to choose from are to match using Control field name, match using

external system field name, or do not export.

If you choose to map to an external system field (as shown below using Tag 15 for the second record),
you will need to manually type in the name of the field first. Because this is not an API, the system is
not aware the existing fields within P6. Therefore, you need to self-determine which Control values

you want to populate in P6.
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Percent complete:

Do not update percent complete

Define XER tags and user defined export rules:

9.5 Primavera Schedule Integration

Update XER activities with cost item tags and user defined fields from

Cantrol:

v Update XER with tags and user defined fields from Control b

Column names in external scheduling system must be an exact match. If the specified name does not have a match with the external system, then a new
column will be added at the project level.

Match using External system field name ¥

Match using Control field name
Match using External system field name

Do not export

"] EN_CBS tag 8(CBS tag 8)

"] | EN_CBS tag 17(CBS tag 17)

] EN_CBS tag 19(CBS tag 19)

"] | EN_CBS tag 25(CBS tag 25)

0 EN_CBS user defined 6(CBS user defined 6)

O EN_CBS user defined 12(CBS user defined 12)

"] EN_CBS tag 4(CBS tag 4)

"] EN_CBS tag 10(CBS tag 10)

"] | EN_CBS tag 15(CBS tag 15)

* Required fields

Export Rule

Do not export

Match using External system field name

Match using Control field name

Do not export

Do not export

Do not export

Do not export

Do not export

Do not export

Do not export

*External system field

Tag 15

EN_CES tag 17(CBS tag 17)

9.5.1.1 PRIMAVERA XER SCHEDULE INTEGRATION
PREREQUISITES

1. XER file type or manual entry must be selected in Settings > Control > Schedule, in the Schedule

data source section.
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PROJECT TRACKING ESTIMATE RESOURCES SCHEDULE OTHERS

Define project schedule

Schedule data source:

XER file type v

Manual entry

XER file type

2. On the Schedule data block, the Scheduled column must be checked prior to importing a

schedule.
Schedule Ceoe >
Scheduled Schedule Plug days Start Finish
ID plug
days
4 PS1 v 21,682.50 07/18/2019 07/18/2019
L4 Ps.2 L4 0.00 07/18/2019 07/18/2019
L4 XYZ L 0.00 07/18/2019 07/18/2019

3. The Schedule ID in Control must match the Activity ID in the XER file.

Schedule TR
Scheduled Schedule Sched Plug days Start Finish
ID plug
days
4 PS1 v 2168250 07/18/2019 07/18/2019
s PS.2 v 0.00 07/18/2019 07/18/2019
4 XYZ 000 07/18/2019 07/18/2019

The following steps walk you through how to import a Primavera .XER file into Control.
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9.5 Primavera Schedule Integration

SCHEDULE INTEGRATION IMPORT

1. From the CBS tab of the Control Workspaces page, select the Import icon on the top right menu
bar, then click Schedule.

Sy o |B] B 1= Q

Import:
oo >
lle WBS Schedulel Costitems 5chedule plug Plug
lays

Actuals/ -
v

Schedule
v
v

2. A warning message appears asking if the XER Activity Ids and Control IDs match. Click Yes if both
IDs match before continuing.

X

Do XER Activity IDs and Control Schedule IDs match?

xer activity IDs must match a Control schedule ID in order to map a
schedule activity to a cost item.

Do not show this warning again Close Yes

3. In the Import schedule data window, click on the Browse icon in the Drag and drop file portion
of the screen.
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Import schedule data

Import from schedule (.xer)

Drag and drop the file here

Browse

Maximum upload file size: 50 MB

Options

Baseline schedule
A fixed project schedule that is the standard by which project performance is measured. and a reflection of all formally authorized scope and schedule
changes. After importing a baseline, you can import a current schedule and derive some key performance indicators (KPI's).

® Current schedule
A schedule update, which reflects progress to date, plus forecast progress going forward and is used for monitoring. Schedule data can be mapped to
domain data such as Control cost items to derive cost based schedules, and time phasing, for example.

4. In the Import schedule data window, click on the Browse icon in the Drag and drop file portion
of the screen.

5. Select the desired .XER file that was generated in Primavera.

» Once the .XER file is uploaded, the Browse box turns green

Import schedule data - Activity ID file xer

Import from schedule (xer)

Drag and drop the file here

Browse

Maximum upload file size: 50 MB

6. In Options, select either the Baseline schedule or Current schedule for the schedule type that
you want to import.

|Option5 |

Baﬁe\ine schedule
A fized project schedule that is the standard by which project performance is measured. and a reflection of all formally authorized scope and schedule
changes. After importing a baseline, you can import a current schedule and derive some key performance indicators (KPI's).

® Current schedule
A schedule update, which reflects progress to date, plus forecast progress going forward and is used for monitoring. Schedule data can be mapped to
domain data such as Control cost items to derive cost based schedules, and time phasing, for example.

7. Select Next.

8. Select Import after reviewing the Schedule summary.
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Import schedule data - Activity ID file.xer

Schedule summary

Schedule name

WSFN Shoreline Protection

Total schedule records
Schedule WBS

Schedule activities

(0

9.5 Primavera Schedule Integration

Schedule type

Current schedule

107

306

i) Import may take some time. You may continue to make changes to your project while the import is processing

¢ The Importing data process screen displays the current status for each step of the .XER

data import.

Processing schedule data import - Activity ID file.xer ("3058™ OPG WSFN Shoreline Protection-A00131-1)

Importing data

Step

Step 1: Preparing data to be sent

Step 2: Placing data in queue

Step 3: Writing data to master library

Step 4: Sending data to project

Step b: Mapping master data to project data

Step 6: Inserting data to project tables

)

Status update is also avaliable in the Import history

Status

° Complete

O Processing - 1mins

O This may take some time. You may continue to make changes to your project while the import is processing.

e If there are errors in any of the steps, you can click on the Pending unmapped items found

link to make the corrections
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Importing data

Step Status

Step 1: Preparing data to be sent o Complete

Step 2: Placing data in queue @ complete

Step 2: Writing data to master library o Complete

Step 4: Sending data to project o Complete

Step 5. Mapping master data to project data | Pending, unmapped items found

Step 6: Inserting data to project tables

¢ You can also navigate to Audit Log > Import history to view the import status, which
includes the Total line items imported

File name Status Processing TotalTine Errors Total Added Added pay Created by Created
Details items imported estimate items dat
resources
NEWPROJ.xer (D... @ Complete All steps 18 0 19 0 0 Asmita Ray 08/02/2019 100

9. If there are corrections to be made, once completed, you can select Import to re-import the
data.

Auditiog > Importhistory > Activity ID file.xer ("

Status details Schedule details Cost item details
Map status XER activity ID Control schedule ID Description CBS position Description WBS phase ‘Scheduled
code
No match found HD.0000003 1 Job Overhead 1002
No match found HD.0000019 2 Earthwork 1069
No match found HD.0000044 3 Concrete on

10. When the import is successful, select the Close button.
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Processing schedule data import - NEWPROJ .xer (Duplicate-NEWPROJ)

Importing data

Step Status

Step 1: Preparing data to be sent o Complete
Step 2: Placing data in queue 0 Complete
Step 3: Writing data to master library Q Complete
Step 4: Sending data to project 0 Complete
Step 5: Mapping master data to project data o Complete
Step 6: Inserting data to project tables ° Complete

This may take some time. You may continue to make changes to your project while the import is
processing

Status update is also avaliable in the Import history

x Job ended successfully.

e Check the Control: Schedule block for newly imported scheduled dates

e This is a quick audit to make sure that the desired Primavera dates imported successfully

.
Tasks : @ Schedule
CBS position Description Scheduled Schedule ID gchedule plug Plug days Start Finish
[ jays
~1 Financial Results A_ 4 PSS ¥4 2168250 | 07/18/2019 07/18/2019
AT 10 - Commercial C. 4 Ps2 ¥4 0.00 | 07/18/2019 07/18/2019

1.1 Dependent G&A 4 XYz 0.00

07/18/2019 07/18/2019

The following steps walk you through how to export a Primavera .XER file from Control.

PRIMAVERA SCHEDULE INTEGRATION EXPORT

1. From the CBS tab of the Control Workspaces page, select the Export icon on the top right menu

bar, then click Schedule as XER.
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2. Assuming you have Percent Complete and User defined Fields and tags turned on in your
settings, click Export.

e Depending on what you’d like to export, you can always uncheck undesired options

X

Export with the following fields:

¥| Percent complete

# User defined fields and tags

e After selecting Export, an XER file will generate and be placed within your C:/Downloads
folder. The file will be named <job name>(Schedule).xer

e

) 103442(5chedule).xer -

¢ At this point you are ready to import the XER file into Primavera

9.5.2 PERCENT COMPLETE COLUMN UPDATES IN CBS

If you are progressing your schedule in P6, it's possible to import this progress data directly into
Control using the Schedule Integration Import process. The % Complete column records within the CBS
can receive updates from the P6 XER file. The XER file can originate from Primavera or InEight
Schedule. As long as the % Complete data is captured within the XER file, it will update the CBS with
this new schedule information.
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Tasks : B Actuals [EEESEN to REEEED O
% CBS position Description WBS phase Schedule ID % Complete Qty complete
code (to date)
1 Financial Results An.. | 1000 PS.001 0.45% 0.00 10/01/2019 08/25/2020
1.1 INDIRECTS & UNASS.. 1001 PS.002 0.76 % 0.01 10/01/2019 08/25/2020
1.1 Commercial Cost 1002 PS.003 230% 0.00 10/01/2019 10/15/2019
1111 Direct Pickup 1016 PsS.013 100.00 % 3050 10/01/2019 11/29/2019

By not using this feature, the % Complete column updates from P6 will not populate the % Complete
column within Control. You would need to update the CBS with the % Complete or claimed quantity via
other methods for completing progress measurement which are addressed in the Progress
Measurement & Forecasting User Guide.

This feature allows for the Schedule Import process to align the P6's schedule % complete with the cost
item's % Complete.

After running the Schedule Integration Import process, you can check the CBS and verify the progress
results in the % Complete column.
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REVIEW

1. Where can you enter schedule dates for your cost items?
a. Cost item details
b. Task details data block
C. Schedule data block
d. On the Schedule tab

€. On the Schedule slide out panel

2. Using the Control Import feature, you can import which of the following types of data?
a. Tasks
b. Current Estimate
C. Schedule
d. Cost Categories

€. All of the above

3. When importing a Primavera schedule, the Schedule ID in Control must match the
in the XER file.

Import ID
Current Estimate ID

Task Details ID

a o T o

Activity ID

€. Start Date ID

4. When using the Define project schedule: Schedule data source feature, which option
allows you to export a Primavera formatted file to eventually be used to import directly
into Primavera?

a. Manual entry file
b. XER file type
C. Activity ID file type
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d. Task Details file type
€. Schedule file type

SUMMARY

As a result of this lesson, you can:
* Navigate to the Schedule data block
e Edit schedule data inside the CBS
e Edit schedule data using Excel import
¢ Integrate planning activities

¢ Schedule using Primavera
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10.1 ACCOUNT CODE STRUCTURE (ACS)
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10.2 INEIGHT CONTROL WORKFLOW
ACCOUNT CODE STRUCTURE

Estimate

Historical Benchmarking

Control

Conform Estimate / WBS Structure

Progress - .
orecastin
Account Code Measurement g

Final Hours and Costs
Management CBS Register

ACS Register Create & Manage Forecast Method Budget/Forecasts

Cost Items Setup Quantities
Define Qty Account
Contribution Codes
Live

Analyze Planned FerssEss
Earned and Actual

Forecast

WBS Structure / Budgeted
Quantities & Hours

Approved changes
update Current Budget

Revenue Management

1
1
Billed Revenue
Change Management -
Change Register Pay Item Register
Budget Move Create/Manage
Pay Items
Budget
Qty/MH Analyzed Planned & Forecast Revenue
Adjustment

Contract
Adjustment Track Billed Revenue

10.3 WHAT IS AN ACCOUNT CODE?

Account Codes serve as a standardized coding system to track like operations across a company, for
the purpose of global reporting and benchmarking. Account Codes typically follow a hierarchical
structure which allows for summary level reporting rolled up to company standards, but can also be a
flat list.

Account Codes are assigned to cost items similar to a tag on a cost item. Once an account code has
been assigned to all terminal cost items you can view many project and organization reports organized
by the account code structure, rather than individual project cost break down structure which often
differs from project to project. Account Codes can also tie back to InEight Estimate where estimators
can assign the same standard set of account codes to estimate items, and compare them to active or
completed projects for historical benchmarking.
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10.4 ACCOUNT CODE SETUP

The master set of account codes is created and stored under Master data libraries > Account Codes.

Steel Structure Training Job (105091) Project home «

Favorite projects & organizations Master data libraries

C-XYZ b
Account codes Units of measure
Cost centers Vendors
Currencies

Custom labels

Disciplines and commodities

Manage favorites
Field attributes

All projects & organizations
Operational resources

(@) Report >
Qualifications
(%) Explore P
Revenue categories
Master data libraries >
Unions
Suite administration >

10.4.1 STAGING VS. PUBLISHED ACCOUNT CODES

The Account Codes master data library contains four tabs: Published, Staging, Audit Log, and Import
Log.

@ Master data libraries = Accountcodes ¥
PUBLISHED sTacinG D AUDITLOG IMPORT LOG
Account code Description ‘ UoM primary Currency
(ORI overhead PLs US Dollar
00.00000000 00000000 DES-1 PLS US Dollar
00.00000000_MRTER 0 MRTER 0 PLS US Dollar
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¢ The Published tab lists all account codes that have been created and published under the Staging

tab.

¢ Under the Staging tab, you create and edit account codes, and then publish them for use.

Account codes are not available for use in projects until they are published

e The Audit Log tracks changes made to the Account Code Structure, including the value before

and after, the changed date, and who made the change

¢ Under the Import Log tab, you can track the status of all the account code import processes.

e When you hover over the Failed with errors imports, a pop-up will provide a brief import

status, along with next steps

e Under the pop-up, there is a down facing blue arrow where you can download a detailed
error log

Failed with errors

1 &= 0of1  JothiT 07/15/2019 2:15:43 )

Failed with erro

Failed with erro

Failed with erro

Failed with erro

Complete

O 0 00 0 0 0

Failed with erro

_| AccountcodeErrorLog07302019085118 - Notepad -
File Edit Format View Help

Import account codes ACS data: AccountCode_87152819891354.x1sx
File import attempted on: 87/15/19 2:15 AM

The following errors were detected while attempting to import account code
values.
Review the errors below. Once all errors have been resolved, reattempt the
import.

Row 2 Column "Currency”: has issue
Error: has invalid datg

[m]

X

Account codes are typically maintained at an organization administration level to ensure that

categories and

codes remain consistent with company standards.

The account codes within the Account Code Structure are arranged into a hierarchy of parent-child

relationships that can contain varying levels of detail, indicated by color, for each level of the hierarchy.

You can assign account codes to cost items anywhere, from the highest level to the lowest level. The

lower the level assigned, the higher the level of detail associated to the account code.

The example below shows a level 3 account code (50.03.04) acting as a parent to two subordinate

account codes

(50.03.04.002 and 50.03.04.004).
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Account code
50.03.02.004.02
50.03.02.004.04

50.03.04

50.03.06

50.03.06.002.02

50.03.00.002.04

10.4 Account Code Setup

Description

Break - Concrete Paving Removal

Load out - Concrete Paving Removal

Paving Milling and Scarification

Paving Milling and Scarification - Asphalt
Paving Milling and Scarification - Concrete
Litility Line Removals - Underground

Itility Line Removals - Underground (<4° Depth)
|Hility Line Remaoval (<4' Depth)

Storm Sewer Removal (=4' Depth)

The following Step by Step walks you through how to create a new account code.

CREATE AN ACCOUNT CODE

1. From the Project home page, select the 1st Level drop-down menu.

2. Select Master Data Libraries.

3. Select Account Codes.
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Steel Structure Training Job (105091) - Project home

Favorite projects & organizations Master data libraries

C-XYZ >
Account codes Units of measure
Cost centers Vendors
Currencies

Custom labels

Disciplines and commodities

Manage favorites
Field attributes
All projects & organizations

Operational resources

&) Report >
Qualifications
(%) Explore >
Revenue categories
Master data libraries >
Unions
Suite administration >

¢ All the account codes appear on your screen in a hierarchy format

4. Select the Staging tab.

@ Master data libraries - Account codes. ¥
PUBLISHED | STAGING |
Account code Description | UoM primary Currency UoM secondary Auto gty |
_ Overhead - Edit - publish666_edited PLS US Dollar on
00.002 002-Edit_Test-publish PLS US Dollar off

5. Click the check box next to any of the existing account codes.

PUBLISHED STAGING
® B @
Accourtcode Description UoM primary Currency UoM secondary Auto gty primary
T ot #ssemty -t st Ton us otar o 520300004
62030400402 Module Assembly - ErectStee - Erect Seel - Light (0-19 /L) Ton Us Dollor o
62030400404 Moduie Assembly - Erect Steel - Erect Steel - Mecium (20-33 I/LF) | Ton US Dolar o o ot
[ - 62.03.04.00406 Module Assembly - Erect Steel - Erect Steel - Heavy (40-79 Ib/LF) Ton US Dollar on on o ]
B 2030400408 Wodule Assembly - Erect Steel - Erect Sl - Extra Heavy (0-118 /L) Ton TGS Dollr o o Torr

6. Click the Add Account Code button.
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®

E

Account code

62.03.04.004.02

62.03.04.004.04

62.03.04.004.06

10.4 Account Code Setup
Description Uel
Erect Steel Tt
Module Azsembly - Erect Steel - Erect Steel - Light (0-19 Ib/LF) Tor
Module Azsembly - Erect Steel - Erect Steel - Medium (20-39 |b/LF) Tor
Module Assembly - Erect Steel - Erect Steel - Heavy (40-79 |b/LF) Tar

¢ This creates a new account code with the code you selected as the parent

¢ In the Account code details slide out panel, the following can be assigned:

I T S

InEight Inc. |

Parent Account
Code

Account Code
Description
Currency

UoM Primary
UoM Secondary

Auto Quantity
Primary/Secondary

Parent Roll Up
Behavior

Account Code
Tag 1-20

User Defined Field
1-10

Release 25.7

Account Code with lower level “child” account codes below
it.

The alpha numeric sequence assigned as the code.
Description detailing the account code’s scope.

The currency assigned to the account code.

The primary unit of measure for the account code.
The secondary unit of measure for the account code.

Automatically roll up cost item quantities if the cost items and
this account code have the same primary/secondary UoMs.
It can also be set on a project specific basis.

Controls whether primary or secondary quantities of
account code roll up to the parent account code’s primary or
secondary quantity.

Tags that can be associated to account codes to enable
them to be categorized.

Optional open-text fields you can use to add information
related to the account code.
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Meyg= The asterisk (*) at the beginning of a tile indicates it is a required field and it must
be populated before the code will be created.

7. Fill in the information below:

e Account code: Your Initials (Since a parent was selected when creating this new account
code, numbering prior to ‘—Your Initials’ will be the parent’s)

e Description: Your Initials — Account Code
e Currency: US Dollar
e UoM primary: Ton

* Leave all other defaults/blanks

Account code details

+Parent account code +Account code

62.03.04.004.06 - Module Assembly - Erect Steel - .. 62... -User #

I Description + Currency

Your Initials -~ Account Code USD - US Dollar -

UoM primary UoM secondary

Ton - -

Associated entity roll up behavior

Auto quantity primary Auto quantity secondary

8. When you have filled out all the information, click Stage to send the new account code to staging
area.

¢ The new account code now exists in the Account Code Structure on the Staging tab

¢ The new account code will not be available for use within projects until it is published
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9. If you have the permissions to publish account codes, check the box for the account code you
created..

10. Click the Publish button in the top-right corner of the page.

You can also edit existing account codes within the Account Code Structure, as indicted in the steps
below.

EDIT ACCOUNT CODE DETAILS

1. From the Account Code — Staging tab, select the account code you created.

2. Click the Edit Account Code button.

PUBLISHED STAGING
®

Account code Description UoM primary Currency UoM secont

Module Assembly - Erect Steel Ton US Dollar

62.03.04.004.02 Module Assembly - Erect Steel - Erect Steel - Light (0-19 1b/LF) Ton US Dollar

62.03.04.004.04 Module Assembly - Erect Steel - Erect Steel - Medium (20-39 Ib/LF) Ton US Dollar

62.03.04.004.06 Module Assembly - Erect Steel - Erect Steel - Heavy (40-79 Ib/LF) Ton US Dollar
ﬁ Your Initials = Account Code Ton US Dollar ]

o 62.03.04.004.08 Module Assembly - Erect Steel - Erect Steel - Extra Heavy (80-119 Ib/LF)| Ton | US Dollar |

¢ The edit account code page opens where changes can be made

TIP Note that only the description, auto quantity primary, auto quantity secondary,
parent roll up behavior, and account code tags can be edited after an account code
has been created. All other items are greyed out and read only.

3. Once you are done editing the account code, click Stage to update the account code.
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Account code details

= Parent account cede = Account code

62

+ Description * Currency

*our Initials ~ Account Code -

* UoM primary UoM secondary

Associated entity roll up behavior

Auto quantity primary Auto quantity secondary

BE [ [ o

Parent roll up behavior

Contribute primary to primary Contribute primary to secondary

ot | [ ] on |

Contribute secondary to secondary

__‘ o |

10.4.2 ACCOUNT CODE PERMISSIONS

If you have the required permissions, you can delete, replace, or rename account codes.

MeJ= The account administrator does not have permissions automatically assigned to approve
account codes. Your account administrator must add the permission to approve account

codes in the Master data libraries to the administrative account.

10.4.2.1 DELETING ACCOUNT CODES

Follow the step-by-step to delete an account code.

ey g= If you are deleting a parent account code, all children under the parent are also deleted.
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DELETING ACCOUNT CODES

1. Go to the Master data libraries and then select Account codes.
2. From the Staging tab, select an account code you want to delete.

3. Select the Edit icon in the upper-left corner.

Q Master data libraries - Account codes ¥
PUBLISHED STAGING AUDITLOG IMPORT LOG
© g
Staged account code changes and requests may differ from current published codes, refer to Published tab for current information.
Account code Description UoM primary Currency UoM secondary
T | oo Aere US Dollar
O oo DES WD A2k Hour CFA Franc BCEAO Hour
(] 100.00000000000001 desrption updated_1324 Test1920- Copy US Dollar TestSep13
(] 00.00000000000001 MRTER 0 DES_P PLS US Dollar
0 [IOGG0000000G00IMRTERDIGolEE) = DES_POU TestSep13 US Dollar TestSep13
(] 00.00000000000001 nandy kendo nandy TestSep13 Unidad de Fomento TestSep13
(] 00.00000000000001 Nandy test ACS Nandy Test Acs TestSep13 US Dollar TestSep13
(] 00.00000000000001.New nandy May2... New nandy May20th TestSep13 US Dollar TestSep13
@] 00.00000000000001_.NR_05082019 00.00000000.NR_05082019_DESC Acre US Dollar
m} 00.00000000000001.NR1_05082019 00.00000000.NR1_05082019_DESC Acre US Dollar 098765
O [ooG0EeG000000TNRI0s080IeM = NR1_09082019_DESC Acte US Dollar
(] 00.00000000000001.PK -Oct-2019 PK -0ct-2019-descrption Test01 30-05-2019 US Dollar TestSep13

4. On the Edit account code page, select Delete account code, and then click Next.
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Delete account code Cancel

Delete account code

Replacement account code (optional)

Belect one

Moy g= In the Replacement account code optional text box, you can enter in an existing
account code to replace the account code you are deleting.

5. On the Delete account code confirmation page, select Delete in the lower-right corner.
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Delete account code Cancel

Delete account code

Confirm deletion

Are you sure you want to delete this account code? This
action cannot be undone.

6. Click the Stage button.
» This takes you back to the Staging page.
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F 0 ® Q

X
Approve account codes

Are you sure J;u want to approve all pending account codes? This
action cannot be undone

Staging notes
Staging notes entered here will be applied to all account codes
being approved

500

7. From the Staging page, select Approve all, and then select Approve.

e You can view your current items and deleted items in the Published tab.

The deleted account code shows the following error code in the Cost Item Details and in the CBS tab.
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Task details { so0e )

Account code Hide in plan Is terminal
and progress

#REF! (] 0
00

% I:I

10.4.2.2 REPLACING DELETED ACCOUNT CODES

To remove the #REF! error in the cost item details slide-out panel and grid, select the error to open the
Assign Account Code dialog box. Select another account code from the list, and then click Assign. The
error on both the CBS tab and the Cost Item Details slide-out panel is replaced with the account code
you selected.
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Sel... Utilized Account code Description UoM
® 00 Overhead PLS
D 00 DES WD A2k Hour

) 00.00000000.Core Functi.. DES - DUTCH Test123456Test123456Te .

00.00000000000001

desrption updated_1324

Test1920- Copy

) 00.00000000000001.MRT..  DES_P PLS
@) 00.00000000000001. MRT..  DES_PDU TestSep13
O 00.00000000000001.nan... nandy TestSepl3
O 00.000000000000017.Nan... Nandy Test Acs TestSepi3
B 00.00000000000007 New ... New nandy MayZ20th TestSepi3

O 00.00000000000001.NR_ 00.00000000.NR_050820 Acre

(o) (o ) (M

10.4.2.3 RENAMING ACCOUNT CODES

If you have the required permissions, you can rename account codes. Follow the step by step to
rename an account code.

RENAMING ACCOUNT CODES

1. Go to the Master data libraries, and then select Account codes.
2. From the Staging tab, select an account code you want to rename.

3. Select the Edit icon in the upper-left corner.
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Q Master data libraries - Account codes ¥
PUBLISHED STAGING AUDITLOG IMPORT LOG
© [
Staged account code changes and requests may differ from current published codes, refer to Published tab for current information.

Account code Description UoM primary Currency UoM secondary
S | o Acre US Dollar
a ‘ L] DES WD A2k Hour CFA Franc BCEAO Hour
O 100.00000000000001 desrption updated_1324 Test1920- Copy US Dollar TestSep13
O 00.00000000000001.MRTER 0 DES_P PLS US Dollar
0 [IOO000G0000000TMRTERDIGoIEHM) = DES_FDU TestSep13 US Dollar TestSep13
O 00.00000000000001.nandy kendo nandy TestSep13 Unidad de Fomento TestSep13
(] 00.00000000000001.Nandy test ACS Nandy Test Acs TestSep13 US Dollar TestSep13
(] 00.00000000000001 New nandy May2... New nandy May20th TestSep13 US Dollar TestSep13
@] 00.00000000000001.NR_05082019 00.00000000.NR_05082019_DESC Acre US Dollar
0 00.00000000000001 NR1_05082019 00.00000000.NR1_05082019_DESC Acre US Dollar 098765
O [ OoG00000000000TINFIN0S0820010 = NR1.09082019_DESC Acre US Dollar
(] 00.00000000000001.PK -Oct-2019 PK -Oct-2019-descrption Test01 30-05-2019 US Dollar TestSep13

4. On the Edit account code page, enter a new name for your selected account code in the
Description text box. Then enter a new name for your selected account code.

Account code details

* Parent account code * Account code

None - None # No. 001 Ed
Sta g the code or descrip footing
* Description * Currency

__001 USD - US Dollar £
* UoM primary UoM secondary

Acre 4 ]

5. Click the Stage button.
» This takes you back to the Staging page.
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F 0 ® Q

X
Approve account codes

Are you sure Iu want to approve all pending account codes? This
action cannot be undone.

Staging notes
Staging notes entered here will be applied to all account codes
being approved.

500

6. From the Staging page, select Approve all, and then select Approve.

* You can view your current items and renamed items in the Published tab.
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e =0 Your renamed account code is viewable through the Account code column, Cost
Item Detail tab, and the ACS tab.

10.5 ACCOUNT CODE ASSIGNMENT

e =0 Account codes can only be assigned to terminal items. Parents cannot have an account
code.

ASSIGN ACCOUNT CODES TO COST ITEMS

1. From within the Control Workspaces page of a project, select the CBS tab to view your Cost
Breakdown Structure.

2. From the View menu, select the Project Controls view by first selecting View more, if not already
displayed.
3. Within the Task Details data block, click on the right arrow to progress to the Account Code

column.

4. For a cost item you wish to have an Account Code assigned, double click in the Account Code cell

for that cost item.

5. Use the search box to find the account code to assign, then click Select, and then click Assign.

10.6 AUDIT LOG

The Audit Log tab within the CBS register is used to capture changes that were made within InEight
Control and is broken down into five sub-tabs located on a left sidebar menu. Each log is designed to
capture the changes that happened within each of the different registers and during syncronization.

All five audit logs can be access by selecting Audit log tab menu bar, then selecting each individual

audit log on the far left.
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Actions ¥

cBS

ACS

Pay items

Integration

Import history

10.6.1 CBS

You can access the CBS audit log by selecting CBS from the left side menu.

Audit
D

4871359
4871358
4871357

4871356

Item
type

Cost Item

Cost Item

Cost Item

Cost Item

Desc wBS

Concrete 1071

Earthwork 1069

Job Overh.. 1002

Structural.. 1073

Attrit

Schedule

Schedule

Schedule

Scheduled

Chan
by

Michael M
Michael M
Michael M

Michael M

PAY ITEMS

Chan
date

07/23/20.

07/23/20.

07/23/20.

07/23/20.

CHANGE REGISTER "AUDIT LOG

Forec Forec
total total
co...

Value
befor

False

False

False

False

Value Actuz
after comp

True

True

True

True

Control User Guide

The CBS audit Log captures changes in the CBS register and utilizes an attribute field to identify what

type of change was made. Other columns include:

¢ Changed By (who made the change)

e Change Date (the date and time the change was made)

¢ The attribute value before and after

e Forecast cost before and after

¢ Forecast man-hours before and after

¢ Posting date before and after

Pay items

Integration

Import history

10.6.2 ACS

You can access the ACS Audit Log by selecting ACS from the left side menu.

Audit
D

4871359
4871358
4871357

4871356

Data
type

CBS

CBS

Item
type

Cost Item

Cost Item

Cost Item

Cost Item

Desci WBS

Concrete 1071

Earthwork 1069

Job Overh 1002

Structural 1073

Attrik

Schedule ...

Schedule ...

Schedule

Scheduled

Chan
by

Michael M.

Michael M.

Michael M

Michael M

Chan
date

07/23/20..

07/23/20..

07/23/20

07/23/20

Value
befor

False

False

False

False

Value
after

True

True

True

True

The ACS Audit Log functions similarly to the CBS Audit Log, but contains the changes that were made
within the ACS (Account Code Structure) tab. The fields utilized to capture what changes were made

are:

¢ Change attribute

e Changed By (who made the change)
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¢ Changed Date (the date and time the change was made)

e Attribute value before and after

10.6.2.1 PAY ITEMS

You can access the Pay Item Audit Log by selecting Pay Items from the left side menu.

Audit ID

4873330

> o
5 @
2 &

Pay items. 4872029
Integration 4872028
Import history 4872027

Data type

Pay Item

Pay Item

Pay Item

Pay Item

Item type

Pay Item

Pay Item

Pay Item

Pay Item

Description

Pay Item 1

Pay item
No.

001

1

1

1

Attribute

Billing Method

Pay item tag 8

Pay item tag 6

Pay item tag 4

Changed
by

Renee Japp
Renee Japp
Renee Japp

Renee Japp

Changed Value
date before

07/26/2019 01 Cost Plus
07/24/2019 02:
07/24/2019 02

07/24/2019 02

Value after

Fixed Final Price

10.6 Audit Log

The Pay Item Log again functions similarly but contains changes that were made to the pay items. The
fields utilized to capture what changes were made are:

e Attribute

Audit ID Description

1333638 Testing 07/31

1333637 Testing 07/31

Attribute

Description

Sales Order

Total price before and after

Value before and Value after

Changed By (who made the change)

Changed Date (the date and time the change was made)

Changed Changed Value Value after Total price

by date before before

paul trippi 07/31/2019 08 Test Testing 07/31 $1040.0000000...
paul trippi 07/31/2019 08: S1 $40.000000000

10.6.3 INTEGRATION

You can access the Integration/Sync Audit Log by selecting Integration from the left side menu.
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Audit ID Interface Status Processing details Start Finish User name Log Handle
cBS

ACS 65639 ActualQty Succeeded 4ofa 07/29/2019 03:23 PM 07/29/2019 03:24 PM pavithra baskaran1 4a229816-€aa6-431b-811

Pay items 65638 LiveForecast Succeeded 4ofa 07/29/2019 03:23 PM 07/29/2019 03:24 PM pavithra baskaran1 e90c8df-1916-4a50-847

Integration 65637 Budget Succeeded 4ofa 07/29/2019 03:23 PM 07/29/2019 03:24 PM pavithra baskaran1 43b8dc1c-6825-413a-9¢

Import history 65636 cBS Succeeded 4ofa 07/29/2019 03:23 PM 07/29/2019 03:24 PM pavithra baskaran1 0985605a-745¢-4127-88

The Sync Audit Log is different from the other three. This log is used to capture:

¢ Whether the syncronization process between InEight Control and the ERP system was completed
successfully

¢ How long the sync process took to complete and who requested the sync

It keeps track of the following functions, as seen under the Actions > Sync menu:

e Push CBS Structure

Push CBS Structure and Budget

Push CBS Structure and Live Forecast

Push CBS Structure and Actual Qty

Get Plan Quantities
Get Actual Cost and MH

The syncing relationships and process will be discussed further in Lesson 12 - Interfaces.

M= The status field will automatically update and change from Queued to Succeeded.
Queued status items can be cancelled if there is an error or if the sync is no longer
necessary by clicking the Cancel a Queued Sync button in the top right-hand corner of the
sync log.

To help troubleshoot sync issues, you can click on the Processing details link to get more information
on which steps succeeded, are suspended, or failed.
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@ Last updated: 08/29/2018 01:03 PM
Use shortcut key F5 to refresh status

Completed details - - Plan quantities pull- 31570

Step Status
Step 1: Recieving data Complete

Step 2: Populating data Complete

© 2018 InEight Inc. Privacy and Terms | v 18.3 INEIGHT

If a sync error should occur, you can click on the Log Handle link to obtain troubleshooting information.

Log Handle

4a2298fb-eaab-431b-81f1...

ce90c8df-1916-4a50-847...

This brings you into the InEight Suite App Logs screen, where you can see information relating to the
error including Level, Time, Domain, Area, Exception Message, Exception Type and Correlation Id,
which can help you determine the cause of the sync error.

10.6.4 IMPORT HISTORY

You can access the Import history audit log by selecting Importhistory from the left side menu.

The Import history log contains status information for all imports coming into InEight Product Portfolio.
For example: cost item and actuals import processes can both be viewed in the Import history log for
status, then you can eventually make corrections and reprocess.
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File name Status Processi Total Errors Total Added Adde
cBS Details line imported estimate pay
i ite

B
FE

Last
ed edited
date

3<ga
=
89
o3

23y

ACS Market_St_9_8_17_GMP_Baseline.xer (Mark. ° Failed Step3 1842 0 0 0 0 Renee Japp 07/24/20191..  Renee Japp 07/24/20191
Pay items Market_St_9_8_17_GMP_Baseline.xer (Mark... € Failed Step3 1842 i 0 0 0 Renee Japp 07/23/20191... Renee Japp 07/23/20191

Integration Bookl xlsx Pe. HQ 2 2 0 0 0 Renee Japp 07/12/20190... paul trippi 07/30/2019 0.

Import history Market_St_9_8_17_GMP_Baseline xer (Mark Cancelled  Step5 i i 0 0 0 Renee Japp 07/10/20190.. Renee Japp 07/23/20191

The Import history audit log allows you to take action on import and sync failures, based on error
messages. Error messages are contained within the Error File Here for those imports that have failed
import.

You can view progress in sync longs, view error messages, and then resolve issues in effort to continue

with your import.

Control - Audit Log
| seton | Deion
1 File name The name of the actual import file being used to import data.

2 Status The current status of the import file. There are six import status that
can define the current state of an import process.

3 Processing This column describes the processing state in which the file is being
Details processed. This column is not applicable for all statuses.

4 Total line This is the total line items that are included within the Excel import file.
items

5 Errors This is a count of the number of errors during import.

6 Total import This is the total amount of records that were successfully imported

from the Excel import file.

7 Added This is the total amount of added estimate resources that were added in
estimate the CBS.
resources

8 Added pay This is the total amount of pay items successfully imported from the
items Excel import file.

9 Created by This is user responsible for importing the Excel upload file.

10 Created date  This is the actual date the Excel upload file was imported.

11 Last edited by This is the last user to edit the Excel upload file.
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Control - Audit Log (continued)

| e

12 Last edited This is the last date the Excel upload file was edited.

File name Status Processing Total line Errors Total Added Added pay Created by Created Last Last
Details items imported estimate items date edited by edited
(2) ® (4) @ resources @) (8) ® =
NEWPROJxer (D. Pend. M @ Steps 18 0 0 0 0 paul trippi 08/02/201912:1... paul trippi 08/02/2019 12:1
NEWPROUer (.. (/) Cancelled  Step’ 0 0 0 0 0 paul tippi 08/02/2019 12:1... paul trippi 08/02/201 12:1..
NEWPRO.ser (D. Cancelled  Steps 0 0 0 0 0 paul trippi 08/02/2019 12:0... paultrippi 08/02/2019 12:1
NEWPROJxer (D. Cancelled  Steps 0 0 0 0 0 paul trippi 08/02/2019 12:0... paultrippi 08/02/2019 120

If you hover over one of these Status symbols below, it provides you with a brief explanation of the
selected status.

Here are some examples:

Database update failed 9 Failed C

Import Cancelled
0 of 0 items contains errors Cancelled
d the import
Import complete ® Complete
842 items imported successfully L}
Pending Pend.. @

0 of 111 line items contain errors Pend. W@
PP Continue Import
@ cancel Q Complete

There are six possible import statuses listed below.

InEight Inc. | Release 25.7 Page 443 of 528



10.6 Audit Log Control User Guide

Status
Icon Definition
Failed @ o Import failed due to a duplicate row within the Excel file.
Failed with ~ e=<+ L1 |mport failed with an attachment to download with further information.
errors
Pending =+ »e  The Excel import file is pending, further action is needed. The double

blue arrows will open a new window where you can correct and re-
process the Excel import file. The blue circle with the line through it will
cancel the import completely.

Cancelled The Excel import file has been cancelled.

O Processing

Processing The Excel import is still processing. Once this is complete, the status

will move into one of the other five statuses.

Complete 9 conpie Processing of the Excel import files is complete.

10.6.5 PENDING STATUS

When an import is in a Pending status, this means that further action is needed to complete the Excel
file import.

Pending M) @
There are two options:
Option 1

1. By selecting the double blue errors, you will be taken to another window to continue processing
the faulty records.

File name Status

CBS Import.csv Pending »l@

As an example, in the below screenshot, there are 3 existing errors. If you hover over one of the errors,
it will tell you what needs to be corrected.

In this case, there is an issue with the account code assignment, as the pop-up hover suggests.
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Auditlog > Import history

>

CBS Import.csv

Status Details (& wBs phase code)

Import status.

Pending

Pending

Pending

Pending

Pending

Pending

Pending

Pending

Error

Error

Error

CB

€ £ R K < < < < < X

S match status

101002 [1] [Job Overhead]

t0 1069 [2] [Earthwork]

101071 [3] [Concrete]

to 1073 [4] [Structural Steel]

01074 [4.1] [Erect Steel - H.

01005 [4.2] [Erect Steel - Li

t0 1006 [4.3] [Bolted Connec.

101084 [5] [Materials]

t0 1085 [5.1] [Earthwork - M.

01086 [5.2] [Concrete - Mat.

t0 1087 [4.4] [Module 01 - Er.

|3 errors remaini | [ Find next error ]

Import Columns A

Import method

CBS position

Update existing items 0. 1

Update existing items 0. 2

Update existing items 0. 3

Update existing items 0. 4

Update existing items 0.~ 4.1

Update existing items o... 4.2

Update existing items .. 4.3

Update existing items 0. 5

Update existing items 0. 5.1

Update existing items o... 5.2

Update existing items .. 4.4

Description

Job Overhead

Earthwork

Concrete

Structural Steel

Erect Steel - Heavy

Erect Steel - Light

Bolted Connections

Materials

Earthwork - Materials

Concrete - Materials

Module 01 - Erect Steel

WBS phase code

1002

1069

107

1073

1074

1005

1006

1084

1085

1086

1087

Account code

20

51

61

62.03.02.004.06

62.03.02.004.02

10.6 Audit Log

62.03.02.006
1112233

1112234 (<}
1112235 Value must match an existing account code €
1112236 [<]

2. When you double click into one of the 3 errors, it will take you directly into an account code

From here you can select an account code and click on Assign.

assignment screen where you can make the correction.

Assign account code

Engineering (Pr.

Research & Qu

Prepare Estima

Review (Pre-Bid)

Post Bid

Management

Sear

Select Account code Description
00 Overhead.6233 EDIT
0003 OH - Get Work
0003.02 OH - Estimating

5 00.03.02.002 OH - Estimating -

00.03.02.006 OH - Estimating -
00.03.02.008 OH - Estimating -
00.03.02.010 OH - Estimating -
00.03.02.014 OH - Estimating -
00.03.02.016 OH - Estimating -
00.03.02.018 OH - Estimating -

2nd Estimates

MWk

MWk

MWk

MWk

MWk

MWk

MWk

Cancel m

3. After all corrections have been made to the existing errors, you can select the Import button on

the top right on the screen.

Description

Job Overhead

Earthwork

Concrete

Structural Steel

WBS phase code Account code
1002 20

1069 51

107 61

1073

4. A warning message appears stating that changes will be made, and this project will be disabled

until completion.
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Importing cost items will update the CBS for all connected users. Notify all
users that changes need to be saved prior to continuing with import. Upon
commitment of import, this project will be disabled until completion.
Flease note this may take several mins.

Active Users :
Super Nintendo Chalmers
bridgette quintero

5. Once processing has finished, you will receive an Import complete message.

X

Import complete
The project has updated and is now enabled.

Close

6. The Import history page now shows that the imported file is now successfully imported and
updates the Last edited date.

Total Added Added pay Created by Created date Last edited Last edited
imported estimate items by date

resources
CBS Import.csv @ complete n 0 0 0 0 Keith Anderson 06/19/201906:30 ... paul trippi 07/31/201910:32

File name Status Total line Errors
items.

Option 2

1. Selecting cancel, the blue circle with the line through it, will cancel the import completely.

File name Status

CBS Import.csv Pending )E

10.6.6 FAILED WITH ERRORS STATUS

When an import is in a Failed with errors status, the system will generate a Word error report. The
document displays detected errors while attempting to import the Excel file values. Errors will need to

be reviewed within the Word document
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e Failed with errors 4

10.7 Quantity Contribution

An example of the Failed with errors Word error file provides direction on how to proceed with
correcting the Excel import errors, and a course of action to run the import again

Import actuals CBS data: CI
Fil empted on:

BS import.xls
7/31/2019 3:45:03 BM

detected while attempting to import actual

resolved,

i (this error
imported WBS/CBS items

The only option with a Failed with errors status is to review the errors, resolve them within the initial
Excel file import, and then re-import the file.

10.7 QUANTITY CONTRIBUTION

At the project level, you can manage account codes under the ACS tab from the Control Workspaces
page. On the ACS tab, you can see the account codes assigned to your cost items, along with the
related parent account codes, with account code details and quantity contributors.

Other budget information is automatically pulled into the ACS Details data block including, Total Cost,
Unit Cost, Unit Rates, Primary and Secondary Quantity Ratios, Quantities Complete, and Account Code
Tags. To access this information, click the right arrow to view the second, third and fourth panels of the

data block.

Actions =

ACS

% Account code

&

~ 9
~ 9909
~ 99.00.02
99.09.02.002
~ 990904
99.09.04.002
A 99.09.06

99.09.06 002

Descri...

Change Order
Back charges
Back charges
Back charges
Back charges

Back charges

Back charges .

Back charges

ACS details
Primary Qty
1.00000000000
0.00000000000
1.00000000000
1.00000000000
0.00000000000
1.00000000000
0.00000000000

1.00000000000

InEight Inc. | Release 25.7

Primary UoM

PAY ITEMS

Auto-quanti
(Primary) &

O 0o oo o oo

GHANGE REGISTER

{ ove >

Notes.

LA A T . T T

Forecast total cost

$187,829,311.97999998927

$187,829,311.97999998927

$209,963,377.59999999404

$209,963,377.59999999404

($22,134,065 62000000104)

$200.00000000000

50.00000000000

$0.00000000000

AUDIT LOG View

Unsaved (Quantity Managem...

omE E = Q

ACS qty contributors

Forecast total MHrs Contribute Contribute
Primary Primary to
Primary Sccondary

3,535,755.04678499978

3,535,755.04678499978

3,535,755.04678499978

3,535,755.04678499978

0.00000000000

0.00000000000

0.00000000000

0O 0o oo oo

0.00000000000
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10.7.1 ACS NAVIGATION

The ACS tree lets you easily navigate up and down your ACS structure and also provides a way to filter
down to a subset in the structure. Open the ACS tree slide-out panel by clicking on the ACS tree icon on
the side toolbar.

< ACS PAY ITEMS CHANGE REGISTER > View : Unsaved (Project Controls) hd
hctions = O o B 1= Q
Y acst =
ree c
l ACS § l ACS details
v Expandall % Collapse all * Account code Description Primary Qty

70.b elted Overesd I b Felsted Overhead

51 Grading
[ 100

61 Concrete
- et [ 1000900
-~ 62.03 Structural Steel and Connections _ Metals 0.00

- .
62.03.02 Structural Steel Industrial St(...) % GRAT Structural Steel and Connactions 000
“* 62.03.02.004 Structural Steel Industria(.)
~ 62.03.02 Structural Steel Industrial Structures 600.00
62.03.02.004.02 Structural Steel Indust(..)

62.03.02.004.06 Structural Steel Indust(..) TSGR  structural Steel Industrial - Erect Steel coo.oo
62.03.02.006 Structural Steel Industria(.) 62.03.02.004.02 Structural Steel Industrial - Erect Steel - Li. 200.00
62.03.02.004.06 Structural Steel Industrial - Erect Steel - H 400.00
_ Structural Steel Industrial - Bolted Connec... 2,000.00

Similar to the CBS color coded hierarchy, the ACS gives you the option to differentiate your account
codes by color. Click on the ACS data block ellipsis to select this option to help you identify which level
of the hierarchy a specific account code is located.

CBS ACS PAY [TEMS > View : | Unsaved (Project Controls) -
Actions  w 0 DlT E 1= Q
Y - - -
ACS = B ACS details [T H 10/01/2021
32 Account code Description Filter M Auto-guantity Forecast total Fi
‘-:‘ (Primary) MHrs ct
I | Job Related Overhead S incenied column & ISR
ST crading P 0 8,000.00
T | Concrete |"CO‘°“°"Ed sceount code positon I 2000000
R .- o0 Ton 0 499910
~ 6203 Structural Steel and Connections 0.00 Ton 4899.10
~ 62.03.02 Structural Steel Industrial Structures 600.00 Ton (] 489910
AR  structural Steel Industrial - Erect Steel 600.00 Ton O 4,000.00
62.03.02.004.02 Structural Steel Industrial - Erect Steel - Li... 200.00 Ton 4,000.00
62.03.02.004.06 Structural Steel Industrial - Erect Steel - H 400.00 Ton (] 0.00
Structural Steel Industrial - Bolted Connec... 2,000.00 Ea 999.10

10.7.2 ACCOUNT CODE QUANTITY

There are two methods for defining primary and secondary quantities for your account codes:
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e Manual entry in the Primary Qty and Secondary Qty fields

¢ Using the auto-quantity feature to have them automatically inherit the quantities of any cost
items that have the same unit of measure as the assigned account code

DEFINE ACCOUNT CODE QUANTITY

1. From the Workspaces page of the Steel Structure Job, select the CE + CB viewset from the View
drop-down list.

2. In the Current Estimate data block, double click in the Secondary UoM field for a cost item you
assigned an account code to.

Select a Secondary UoM from the drop-down list different than the cost item's primary UoM.
Click the side arrow to navigate to the Secondary Qty column.
Double click in the Secondary Qty field for your cost item and enter a value.

Select the ACS tab.

S A

In the Primary Qty field for the account code assigned to the cost item you just changed and type
in a quantity value.

o

For your account code, check the Auto-quantity (Primary) check box.

9. To view what cost items are assigned to the account code, right click on your account code and
select ACS item details.

If you have the account code slideout open and want to open a different account code's item details,
you can select a different account code. The details slideout updates to the current account code's
details. You no longer have to exit out of one ACS item only to right click and select ACS details slide
out to open another.

10.7.3 QUANTITY CONTRIBUTORS

Within your project, you can specify how primary and secondary quantities contribute to your account
codes. Specifically, you can indicate how:

e Cost item primary and secondary quantities contribute to assigned account code primary and
secondary quantities

¢ Child account code primary and secondary quantities contribute to parent account code primary
and secondary quantities

For both cost item and account code contributions you can have quantities roll up:
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e Primary quantity to primary quantity

¢ Primary quantity to secondary quantity

* Secondary quantity to secondary quantity

Control User Guide

a3 = Account codes will only automatically inherit quantities from cost items/account codes
using the same unit of measure.

10.7.3.1 CONTRIBUTION OPTIONS - COST ITEM TO ACCOUNT

CODE

From the ACS item details slide out panel, you can specify how cost item quantities roll up to the

account code that is assigned to it, by selecting the appropriate checkbox. The total of the contributing

cost item(s)’s quantities will roll up to become the account code quantity.

ACS item details

position phase
code code
42 Erect Steel - Light 1005

Description

WBS

Ton

(T/0...
200.00

final
MHrs

4000

CE
total
cost

200,000.00

- Structural Steel Industrial - Erect Steel - Light (0-19 Ib/LF)

10.7.3.2 CONTRIBUTION OPTIONS - CHILD ACCOUNT CODE TO

PARENT ACCOUNT CODE

On the ACS page, in the ACS gty contributors data block, you can specify how child account code

guantities will roll up to their parent account codes by selecting the appropriate checkbox.

ACS
Account code
20
51
61
62
62.03
62.03.02
62.03.02.004
62.03.02..

62.03.02
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Description

Job Related Overhead
Grading
Concrete

Metals

Structural Steel and Connectio...

Structural Steel Industrial Stru...

Structural Steel Industrial - Ere...

Structural Steel Industrial - Ere...

Structural Steel Industrial - Ere._

ACS details < oo2 >
Primary Primary
Qty UaM
0.000000000.. MWk

1.000000000..

10000.00000..

0.000000000.

0.000000000..

0.000000000..

1000.000000.

200.0000000...

800.0000000.

PLS

cY

Ton

Ton

Ten

Ton

Ton

Ton

Auto-
quantity
(Primary)

154

ACS qty contributors

Contribute Contribute

Primary to Primary to

Primary Gty Secondary ...
(] (]
(0] (]
(] (]
|| O
¥ (]

Contribute
Secondary to
secondary Qty
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10.7.4 ACS UNIT OF MEASURE TOGGLE

In the ACS register, you can toggle different Unit of Measures. The Unit of Measure toggle has three
different options:

» As entered Unit of Measure
e English (Imperial Unit of Measure)

¢ Metric
Frapect Controls -
2 o ¥ = Q

Sysiem of measure

3 As-enbered urel ol measre

.:%J-"'] P ey
- Primarny
Ll — .JI
0 Metnc

If you want to display and edit in liters instead of gallons for example, you would select the ruler icon
in the top right corner of the ACS register, and then select Metric. The quantity amount converts in the
browser and displays in the alternate unit of measure.

10.7.5 ACCOUNT CODE QUANTITY CONVERSIONS

Cost items that are tracked in one unit of measure can be tracked in another UoM. For example, cost

items that are tracked in a metric UoM can contribute to account codes tracked in imperial UoM. This
saves time in maintaining account code quantities, as project team members do not have to perform

guantity conversions manually. Data accuracy is also ensured since any manual errors are eliminated

from the conversion process.

InEight Inc. | Release 25.7 Page 451 of 528



10.7 Quantity Contribution Control User Guide

In this example, CBS item Asphalt Paving and Break Removal contains a Forecast quantity of 3,000 with
a UoM of Square Meter.

Tasks Task details

% CBS position Description Resource Forecast (T/0)
quantity
~ 1112 Removals and De... 100 | PLS
1.7.1.2.1 Excavate Native .. 3 4200000 m3
1.1.1.22 Asphalt Paving Br... 3 3,000.00 | Square Meter
~ 11123 Concrete Removal 1.00 | PLS

In the ACS, you can display the Primary UoM Alternate System column to see what UoM is needed to
track cost items in, so they contribute to your account codes. The Auto-quantity column is set up so
that quantities are summing up the CBS. The Primary Qty of 3,587.97 is automatically populated. There
is no further action to allow this value to roll up to the account code.

[ ] . -
ACS : W ACS details Cooe> [ i
% Account code Description Primary Qty Primary UoM Auto-guantity Primary UoM
(Primary) alternate
system of...
~ 50.03.02.002 Paving Removal - ... 3587.97 Square Yard L4 Square Meter
50.03.02.002.02 Break - Asphalt P.. 322410 Square Meter rd Square Meter
50.03.02.004 Paving Removal - . 0.00 Square Meter Ld Square Meter
A~ 500312 Concrete Removal 0.00 Cubic Meter L Cubic Meter
~ 50.03.12.002 Concrete Removal... 0.00 Cubic Meter L Cubic Meter
50.03.12.002.05 Concrete Removal.. 290.82 Cubic Meter td Cubic Meter

The system will automatically take the Forecast Qty in the CBS, and convert that number to the value
shown in the Primary Qty field displayed in the ACS. In the above example, the CBS Forecast Qty of
3,000 in square meters is being converted to the 3,587.97 square yards, as shown in the ACS.
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3000

Square meter

1k

10.7.6 NOTES COLUMN

3587.97

Square yard

L

10.7 Quantity Contribution

A Notes column is available for you to add to a new or existing data block. The Notes column lets you
add commentary to any of the ACS records.

Actions  w

ACS

v Account code

i

~ 9
~ 99.09
~ 99.00.02
99.09.02.002
~ 99.00.04
99.00.04.002
A 99.00.06

99.09.06.002

Description

Change Orders, Contract Allowan

Back charges
Back charges
Back charges
Back charges
Back charges
Back charges

Back charges

- Incoming

- Incoming - Labor
- Outgoing Internal
- Qutgoing Internal
- Outgoing External

- Outgoing Extemna.

ACS details

Primary Qty

1.00000000000

0.00000000000

1.00000000000

1.00000000000

0.00000000000

1.00000000000

0.00000000000

1.00000000000

Primary UoM

PAY ITEMS

Auto-quanti
(Primary) +/

0O oo oo o oo

CHANCE REGISTER

M T T T

AUDIT LOG
ACS qty contributors
Contribute Contribute
Primary to Primary to
i Secondary
0
]
O
0
[m]
O
0

0

ew

g

Unsaved (Quantity Managem... ¥

B B = Q
X

Project account code notes

463

0n hold until spec docs are received.

After notes are added to a record, the Notes column populates with the number of comments that are

currently added to each record.
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ACS PAY ITEMS CHANGE REGISTER AUDIT LOG VIEW | Unsaved (Quantity Managem

o m B B = Q

X
E ACS details C oon > ¢ | ACS gty contributors Project account code notes
Primary Qty Primary UoM Auto-quantity Notes Contribute Contribute " -
(Primary) Primary to s On h_old until spec docs are
Primary Secondary received.
1.00000000000 PLS |:| % 3
Primary UOM needs to be
0.00000000000 PLS N
O = \ verified.
1.00000000000 PLS O % O
Change tax rate to 7%
1.00000000000 PLS O & [ 4 .
0.00000000000 PLS ] B [} 500
1.00000000000 PLS O =3 O
0.00000000000 PLS (] @J (]
1.00000000000 PLS O & O m

10.8 MEASUREMENT TYPES

In master data libraries units of measure, there are two sections. The sections are Units of measure,
and Measurement types. Using any two Units of measure that share the same Measurement type
(such as area), you are able to do a measurement type conversion in the ACS.

If you have a cost item with a different unit of measure assigned to an account code, but with the same
measurement type, that cost item can contribute to the same account code.

o Master data libraries - Units of measure *
Units of measure
Name Description Measurement type
Ol L #NAME?- Copy AE ae BACKLOGS Area
#NAME?- Copy B DESC Area
#NAME?d DESC Area
-0098765- Copy- Copy1- Copy Area
-0098765- Copy- Copy1- Copy -D098765- Copy- Copy1- Copy Area

You can have a cost item with a measurement type of acre contribute its values to its assigned account
code if the account code has a measurement type of square foot. This is Because acre and square foot
are both a measurement type of Area.
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The column Primary to Primary lets you choose the cost item that contributes quantities of the account

code.
Sy N DETAILS COST CATEGORIES
24601999 SF - . Primary to Primary
ACS item details
CBS Desc.. WBS Forec... UoM CE CE Prim... Prim...
positi... phase (T/0) final total 10 to
code code quan.... MHrs cost PQ] Seco..
Permits 1004_ 450.00000 Acre 232300000 99.9999950
o fou 64.00000  0.00000000
Excavate fo 1253 95.00000 cY 57.00000 0.00000000
JEH Stee 1254 2 64600 Ton 529200 0.00000000

0.00000000

0.00000000

4,032.9767

The items without a check mark, such as Cubic Yards, have a measurement type that is not considered
an area, so you cannot select Primary to Primary for Cubic Yards, Ton, and Each.

10.9 COST CATEGORY LABEL
CUSTOMIZATIONS

In Master data libraries > Cost categories, there is a Enable custom labels toggle. If this toggle is turned
on, all of your cost category field names come from the custom columns depending on your language
preference in Control. Language preference is located in user settings.

|Enah|e custom labels @ Q

Custom label - EN Custom label - ES-MX Custom label - FR-CA Custom label - PT-BR

You can overwrite the custom labels if you have the applicable permissions. Depending on where you
have cost categories shown in the product, the overwritten labels show with the new custom labels.

MeJ = These labels can be viewed at the organization level. Every project within that
organization can see these labels.

If the organization prefers a different field name, it can be renamed using the cost category custom
labels.

‘o) = Dimmed custom labels cannot be overwritten. For example, the Field name Total.
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Field name Is terminal Custom label - EN

Total

Labor ( £ 234

Labor Base I L-Base [

If the custom label for the field name is blank, then the custom label column will use the default name
for the field name column.
One way of finding these custom labels in the project is by going to the CBS register. From there, open

the Cost Categories slide-out panel. Under the Cost category column, find your custom label. For
example, the Labor Base field name can be customized and renamed L-Base.

O
-

4
-
I
o=
m
» ol
m
™
0

1004_
TA ATTRIBUT T CAT R
% Complete Latest actuals in forecast
values
E EEEER .'-I' 1 L} -
Total
Cost category Current budget Total cost (lo date) Currenmt estimate
ATotal = = 2 1099994845000 9 <30SSG 6000000 9 ¢ 4949 944449 J Quyay
~ | § 14 )

) DOI 3
L'E-I‘}E’ L-Base 00000 S 0000000000 S 183.093332000

e} g= These changes can take a few minutes to fully generate because custom categories span
the entire project.

If the Enable custom labels toggle has been shut off, then the category names come from the Field
names in the Master data libraries only.
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REVIEW

1. Account codes are created inside which of the following:
a. ACS register page
b. Library

C. Project settings

2. Which of the following are account codes used to track?

a. Quantity

=

Budget

Account Code Tags
Unit Costs
a,b,andd

All of the above

-~ ® a2 o

3. Which of the following is not tracked in the CBS Audit Log?
a. Change Attribute
b. Changed By
C. Change Date
d. PayItem Value

€. Forecast Cost Before and After

SUMMARY

As a result of this lesson, you can:
e Define what an account code is
e Set up account codes within the library
¢ Assign account codes to cost items
¢ Define the quantity contribution for each account code

e Review and analyze the audit log

InEight Inc. | Release 25.7 Page 457 of 528



Summary Control User Guide

This page intentionally left blank.

Page 458 of 528 InEight Inc. | Release 25.7



Control User Guide 11.1 InEight Control Interfaces

11.1 INEIGHT CONTROL INTERFACES
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11.2 INTERFACES OVERVIEW

The InEight cloud platform has several options for synchronizing information from one platform to
another. This gives you multiple options to utilize data efficiently between various programs, saving

you time and resources.

The table below shows you the high-level functions of multiple platforms to help you better

understand how these tools interrelate.

Overview - Interfaces

Estimate

Contract

Control

Plan

Progress

ERP
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Create CBS/ ACS / WBS structures
Create cost estimates

Analyze contractor/supplier quotes
Prepare bid proposals

Benchmark estimate values

Create and manage bid packages
Set up and manage contracts
Create and manage issues and change orders

Edit CBS / ACS / WBS structures

Manage budgets and contracts

Manage forecasts

Record actuals (manual entry, or import from Plan and ERP)
Calculate job costs / variances, earned values, contract earnings

Associate planning components with CBS / ACS / WBS structures
Create work plans and packages

Create work plans and daily plans
Record progress and timesheets (as-builts)
Approve executed daily plans

Budget, Payroll, Forecasts, AP/AR, Final Costs

Control User Guide
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For this lesson, you will focus on the programs that integrate directly with Control (after the initial
import from Estimate) and will go over how to perform the basic “Push” and “Get” actions to move
data between systems.

The workflow diagram below shows the connections between the programs, and details on what data
passes between the various InEight products:

Estimating Contract Administration Project Control Field Execution

Structure with

estimated quantities,

costs and resources
-

E

Structure, budget, and resources

[ 1

i Quantity Tracking
& Esimate I
Budget changes Approved

i i uantities Daily plan from
Cost Estimating ‘ Progress Measurement q

work package
Quote Management i
g A Change Forecasting onored ”
wes Change Management e & Progress

Bid Preparation Codes quantities
Issue Management -« ——

Work Packaging

I

Account Code Management Daily Planning
Change Management Weekly Timeshest

Budgets, As-built costs,

Jforecasts hours
(@ Contract

!

@ Compliance

Bid Packages Accounts - ERP
Contract Management Form Creation
. Budget le Form Execution
d
> Payroll Approve
Purchase Order details Y hours Events Management
APIAR
T Compliance forms Form results
v

Structure Q Compliance (Mobile)

I

Form Execution

11.3 PUSH AND GET ACTIONS

Control Integrations typically have one direction that specific information travels. As data is generated
or modified in one product, it does not automatically change in other connected products
downstream; you must perform a sync action, referred to as “Push” or “Get”.

e A Push sync occurs when you are in a program and you would like to send information to a
different program

e A Get sync occurs when you are in a program and you would like to retrieve information from a
different program

You can view the various integration options by clicking on the Actions menu from the Control main
page and hovering over the Sync option. The image and table below give a description of the sync type
functions:

InEight Inc. | Release 25.7 Page 461 of 528



11.3 Push and Get Actions

1
2

10

11

Push CBS Structure

Push CBS Structure
and Budget

Push CBS Structure
and Live Forecast

Push CBS Structure
and Actual Quantities

Push CBS Structure,
Budget, Live Forecast,
and Actual QTY

Push Pay ltem
Push Billed Revenue

Push Forecast
Revenue

Get Quantities
(Through Previous Pay
Period or Job To Date

Get Actual Cost and
MH

Get Billed Revenue
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Control User Guide

Overview - Sync Options

Syncs the Control CBS Structure to the ERP system.

Syncs the Control CBS Structure, budgeted quantities, man-
hours, and costs to the ERP system.

Syncs the Control CBS Structure and Live Forecasted
quantities, man-hours, and costs to the ERP system.

Syncs the Control CBS Structure and job-to-date actual
quantities to the ERP system.

Simultaneously performs all the syncing functions listed above
(1-4).

Syncs the Pay item list and data to the ERP system.
Syncs job to date billed amounts to the ERP system.

Sync pay item revenue values (billed revenue, earned
revenue, forecast revenue).

Retrieves the claimed quantities from InEight Plan and
incorporates the information to Actual QTY within Control.

Retrieves actual project costs and man-hours from the ERP
system and incorporates the information to Actual Costs and
Actual Man-hours within Control.

Retrieves billed amounts from the ERP system and
incorporates the information to Billed revenue within Control
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Actions  w @
Global forecast method.. .
Task details
Set forecast method ription WES phase SPI CBE planned Re
code value (to date)
Claim multiple CBS guantities -
lization 10009 0.00 5000 @3
| Budget move and contract adjustment » ing & Grubbi... 10010 0.00 5000 9
Lock/unlock budget > issified Exca.. 10011 0.00 50.00
, - - o 0.00 $000 11
| Push CBS structure
I 4 0.00 $000 8
|_| v 4 9 Push CBS structure and Budget 0.00 $0.00
O 41 Furni - psh cBS structure and Live forecast 6 0.00 5000 3
O 42 0.00 $000 6
Push CBS structure and Actual quantities
O v o473 . r 0.00 50.00
O 431 Place Push CBS structure, Budget, Live forecast, and A... 6 0.00 5000 @
O 432 @ Push Pay Item a.0o 000 |2
0 v 5 . 0.00 $0.00
- Push Billed revenue
O 51 i 0.00 S000 3
O 59 e Push Forecast revenue 0.00 5000 |6
O v o6 K1l quantities @ y | Through previous pay period
O 6.1 2
Get Actual cost and MHrs Job to date
0 6.2
O 63 Insta Get Billed revenue m 0.00
[l Fmaldall EO Fine M Ann—T ™ nnn & nnn ]
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SYNC OPTIONS

1. From the Control main page, click the Actions menu.

@ Steel Structure Training Job (105091) Control

Actions = @

w2 CBS position Description WEBS

;:1 phase
code

— I . e

2. Select Sync from the Actions drop-down.

Actions - @

Claim multiple CBS quantities
Budget move and contract adjustment  #

Unlock budget

Sync ]

3. Select Push CBS Structure from the Sync drop-down.
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Actions - @

- Task details < eeee >

Description Resource Forecast
. . . (T/0)
Claim multiple CBS quantities S
Budget move and contract adjustment »  Earthwork 10,000.00
Unlock budget _ i
Earthwork Review il 1.00

Sync
Push CBS structure

Lnan.nn

Push CBS structure and Budget

3
Push CBS structure and Live forecast

o Push CBS structure and Actual quantities 000.00

] 41 Push CBS structure, Budget, Live forecast, and Act... 350.00
Get Plan quantities L

ol 4.2 200.00
Get Actual cost and MHrs

@ 43 . , 1000.00

* A toast message appears at the top of the screen showing the process initiated

@ Steel Structure Job (105091) - Control Workspaces v CBS structure syn initiated

CBS ACS PAY ITEMS CHANGE REGISTER

¢ You follow the same steps for selecting the other synchronization options

e For the Get Plan Quantities option, you will need to select the Through Previous Pay
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Period option

52 Insta Push Forecast revenue 0.00 5000 6

o6 36 In Through previous pay period

Get quantities »

6.1 Furni
Get Actual cost and MHrs Jab to date

2
;

6.3 Insta Get Billed revenue 0.00 50.00

1000 00o

Oomalefill OAT M TAnnT nonn & nonn A

11.4 AUDIT LOG INTEGRATION

As you utilize the sync option, you have the option to go back and audit the status of the actions taken.
The Audit Log Integration displays any synchronization process that has been initiated and its status. It
is used to capture whether the synchronization process between InEight Control and the ERP system
was completed successfully. The log can also tell you how long the sync process took to complete and
who requested the sync.

SYNC AUDIT LOG

1. From the Control Workspaces page, click on the Audit Log tab.

@ Steel Structure Training Job (105091) - Control « Workspaces

< ACS PAY ITEMS CHANGE REGISTER AUDIT LOG View Forecasts -

Actions  w @ 9 DlT m IE Q

2. On the left side bar menu, click on Integration.
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g

@)  Steel Structure Job (105091) v

I )

Actions
CBS audit log
e Audit Data Item
D type type
ACS
264307 CBS Cost Item
Pay items
264306 CBS Cost Item
264305 CBS Cost item
Import history
264304 CBS Cost Item

¢ The log displays the current sync status

11.5 SCHEDULED SYNCS

Scheduled syncs let you set a time and date for the type of information you want updated from either

push or get data.

You can set up recurring syncs or a one-time sync to get up-to-date costs on man-hours. Scheduled
syncs occur at the point and time you scheduled them for.

To start scheduling syncs, the tab Sync integrations has been added to the Control Project settings.

If no syncs are scheduled, you can add a sync by selecting the Add sync schedule button.

PROJECT TRACKING ESTIMATE RESOURCES SCHEDULE SYNC INTEGRATIONS

<) General

&% | capital

«-| Control .

: Sync Integrations schedule
(<4:) Plan

3% | Progress (® Add sync schedule

There are five required fields you must fill out in order to schedule a sync.

Sync type

Time zone

Start date

Time to run sync

Repeat
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Sync types lists all available push and get syncs.

The Time zone is where you select which region's time zone you are in.

Start date functions similarly to selecting a start date for a project. You cannot select to start a sync
from a day in the past. The scheduled sync starts at the current day by default unless you select
otherwise.
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(e g= You can only select start times in 30 minute increments.

The Repeat section is where you select how often a scheduled sync repeats. You can choose to have
the sync repeat daily, weekly, monthly, or never depending on your preference. You can end the
schedule syncs on a certain date or end after a number of occurrences.

For daily syncs, select how often you want to repeat the sync or when you want the reoccurring syncs
to end.

For weekly syncs, select which days the sync repeats on as well as when you want the sync to end.
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Repea End
'
[ ¥ 8 Af [ .
m I ; o =
i e
Repeaton A lone
5 M T W T 5

;"t'ljl‘.l'. Repeat on
Never Daily Weekly Monthly Day =
® First - Sunday -
— .
d
® After 4 ence Second
On = .

Last

After you click Add, the sync appears in the synch integrations tab.
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Sync Integrations schedule

L
(+) Add sync schedule
Scheduled syncs [
Push Billed revenue
Sync type: Push Billed revenue Start date: 02/01/2021 |’. X
Time to run sync: 12:00 PM CST Repeat on: Fni
Repeat Weekly End: 12/31/2021
Get Plan quantities
Sync type: Get Plan quantities - Job to date Start date: 02/08/2021 |¢" (%)
Time to run sync: 1:00 PM CST Repeat on: Last - Saturday
Repeat: Monthly End: 12/31/2021

You can edit syncs or delete them using the edit and delete buttons on the far right of the sync data

box.

Jleg= You can schedule all your syncs for the project at one time. If you already have syncs
configured for currently existing projects, you don’t need to reconfigure your setup for

this feature.

For any new projects that do notyet have scheduled syncs set up, you need to go to the Application
integrations section of Control. Follow the Step by Step to navigate to the Application integrations

page.

NAVIGATING TO APPLICATION INTEGRATION

1. From the header bar, select the projects drop-down.

2. Hover over Suite administration. That is where you would set up all of your sync configurations.

3. Select Application integrations.
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REVIEW

1. How can you know a sync process initiated?
a. Viewing the CBS Audit log
b. Appearance of a toast message

C. There is no way to tell

2. Where can you view the status of a sync process?
a. Inthe Change Register
b. On the CBS tab, in the Forecast data block
C. On the Pay Items tab, under the sync status column

d. Inthe Sync Audit Log

SUMMARY

As a result of this lesson, you can:

e Explain the InEight cloud platform Functional Flow diagram
e Explain the different InEight Control Push interfaces and use cases
¢ Explain the different InEight Control Get interfaces and use cases

¢ |dentify where to go to audit sync transactions
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12.1 CONTROL SETTINGS

As an administrator, you can configure settings at the organization and project level in Control. The
correct setting details must be added to manage projects successfully.

¢ Organizational settings — Settings configured at the organizational level are inherited when
creating associated child organizations and new projects within the organization. You can
configure organizational settings in Main menu > <organization> > Settings > Control.

* Project settings — At the project level, you can refine the default inherited organizational
settings to customize how they are applied in each project. You can configure project settings in
<project> > Settings > Control.

Organizational settings are applied as default settings for new projects. As an administrator, you can
configure the default project settings to how they will apply to your individual project.

12.1.1 CONSIDERATIONS

You must have Level 3 — Account Admin permissions in InEight Platform, or an assignment to the root
organization based on permission configuration.
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Every new project launch has its own particularities, and the setup and initialization of these projects
depends on multiple factors, such as:

¢ Project organizational structure

Staff and resources assigned

Location of the project

Units of measurement

Currencies

Financial reporting period

This lesson covers how to set up these project options.

e =0 Establishing roles and permissions is an administrative function. As such, access to these
settings may not be available to you, as the setup of these settings may not be within the
scope of your daily tasks.

12.1.2 USER MANAGEMENT

The User Management page provides a list of users inside your organization. You can view any user’s
project access, roles, and permissions within your organization. Users with required administrative
permissions can edit and grant permissions to other users, up to the equivalent level of access they
have been granted.

VIEW THE ROLE AND PERMISSIONS OF A USER

1. From any InEight application, click on the First Level Menu in the upper left corner of your
screen, and from the drop-down menu, select Suite Administration, then User Management.
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@ 105091 (Steel Training Job) Project home

Favorite projects & organizations Suite administration

5100000 - PKS Incs >

User management —

Roles and permissions

- Application integrations

i File storage
Application
2 Model Configure notifications
Manage favorites ackages
t) Docuq Enterprise organization structures
) Sched All projects & organizations
2 Estimy () Report >
Repor _- Explore >
RepOr  Master data libraries >
ﬂ Suite administration >
Dashh

APl documentation

<1 Control Contracts

2. Scroll down the list or use the Search field to find and select a user.
3. To view the record, right click on the name, and select Show Info.

¢ You can also click on the Show Info button located on the upper-right register menu bar
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TIP You can use the Search located in the upper right corner of the page to search for a
keyword in any column in the User Management database.

."'d-!-\.
L,

X

[search...

» Once you click on the Show Info option, a slide out panel appears on the right. From
this panel, you can view the contact information, as well as the role and project
access of that specific user.

Q

Paul Smith X

Email address paul smith@example...
Employee ID

Status Active

Start date 12/31/2016

End date 12/31/9999

e} g= Note that once your organization implements the InEight cloud platform, you will
be able to link your contacts’ address book to your user information.

12.1.3 ORGANIZATIONAL BREAKDOWN STRUCTURE

The Organizational Breakdown Structure represents the way your company is structured and divided,
such as departments, districts, sectors, etc. Roles and permissions can be added at different levels in
your OBS, so users with a district level access would have access to all the projects under that district’s

umbrella.

12.1.4 ROLES AND PERMISSIONS

A role is defined as the function that a user occupies inside an organization or project. A role in
Platform contains a set of predetermined authorizations and permissions. When a role is assigned to a
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user, they acquire all the permissions of that role in the project or organization that you can assign to
users or project staff. With sufficient rights and permissions, you can add or remove a role and all
access it provides from the user. The Roles and Permissions section is where you can view what
permissions each different role has. Refer to Platform topic for information about adding, deleting,
modifying, and assigning roles.

Control ~

B selectall

Select all View sets Selectall Budgets Selectall

®

Tasks and cost
@ View personal view sets

VIch
®

Send personal views to all users n a project 2} Edit current estimate

Select all Actuals Selectall Forecasting selectall

@ Create change orders 22} Edit equip-hours ® View foreca:

Integrations Selectall Pay items Selectall Account codes Select all

 View integrations @ View pay items © Viewacs

[} EditAcs

orecast @ Delete pay tems

Push CBS structure, budget,ive forecast, and actual gty

MeJ = The administrator levels range from 0-3 and give you a predetermined set of permissions,
with the lowest level giving read only access, and higher levels having more abilities to

adjust settings and edit fields within the InEight portfolio of products.

InEight Control has many permissions that control important functions within the program.

12.2 PROJECT SETTINGS

To manage a project successfully in Control, the correct project details must be added before project
initiation. To view project details, go back to the All projects & organizations page of the InEight cloud
platform.

12.2.1 ORGANIZATIONS PAGE

The Organizational Breakdown Structure (OBS) represents the hierarchical company structure. It can
have regions, such as Eastern and Western, and within those regions, the company can have also
divisions, such as Electrical, Paving, and Masonry. The organization can continue to be more refined to
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the level such as states, cities, districts. Projects are the lowest level of the structure but they do not
show in the OBS.

The OBS controls your access. Where you are assigned in the organization determines what access you
inherit and the visibility you have to other areas of the OBS. The higher the level a user is placed on the
OBS, the more actions they can perform, and the more organizations and projects they can view. A
user assigned at only the project level has no visibility to any other projects or administrative pages.

To access the OBS, go to All projects & organizations > Organization.

= fr  All projects & organizations

PROJECTS ORGANIZATIONS

®
@
o)

Organization Description Greated by Greated on Last modified on i

M1 5100000 PKSTnc PKS Inc InEight Service Account 01/26/201794811 AM 01/26/2017 94811 AM

O | S100000-PKS nc: AA AAUID Viaya LakshmiDa-PTR@Ineight | 12/07/2022 2:15:54 AM 12/07/2022 21554 AM

1 $100000- PKS nc  Concentrix Concentrix Desc Kullai Reddy 09/15/20221151:58PM 09/15/2022 11:51:58 PM

) | $100000- PKS Inc: Core Test Org 102 Core_Test 0rg 102 core ga 07/08/20221235:26 PM 07/08/20221235:26 PM

a $100000 - PKS Inc : Core_Test_0Org_1118 Core_Test_Org_1118 Core ga 07/27/2022 5:14:32 AM 07/27/2022 5:14:32 AM

a $100000 - PKS Inc : Core_Test_0Org_1169 Core_Test_0rg_1169 Core ga 08/02/2022 4:13:08 AM 08/02/2022 4:13:08 AM

a $100000 - PKS Inc : Core_Test_0Org_2014 Core_Test_Org_2014 Core ga’ 08/04/202212:38:29 PM 08/04/2022 12:38:29 PM

a $100000 - PKS Inc : Core_Test_0rg_2150 Core_Test_0rg_2150 Core ga 07/25/202210:10:38 PM 07/25/2022 10:10:38 PM

) | S100000- PKS inc : Core Test 0rg 2244 Core_Test. Allprojects & organizations > Edit organization Cancel
O] S100000- PKS Inc - Core Test Org 2335 Core_Test 4
O] S100000- PKS Inc - Core Test Org_2362 Core_Test  Parent organization

) | 5100000- PKS Inc: Core Test Org 242 Core_Test.

) | 5100000- PKS Inc: Core Test Org 2436 Core_Test.

[ $100000- PKS Inc - Core Test Org_2458 Core_Test. *Name * Description

[ $100000- PKS nc - Core Test Org_2482 Core_Test. $100000 - PKS Ind PrSIne

* External arganization D

Roatorgl

Configurations

* Default base currency * Account code delimiter

Budget code

Using unique budget code? | (3

* Unique budget code

Segment 1

Project - ®

12.2.1.1 UNIQUE BUDGET CODE SEGMENTS

You can populate budget segments in Workspaces to show a unique code label. Unique budget code
segments contain additional options to identify a cost item using four independent fields that are

separated by periods. Budget codes can be configured at the organization level and are primarily used
with Time Center.
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@ Al projects & organizations

All projects & organizations > Edit organization

The segments are combined to create a single

Bud get code  uniaue budget code separated by periods. They

cannot be changed once a project has been added

Using unique budget code? @

* Unique budget code
Segment 1 Segment 2 Segment 3 Segment 4

Project v Cost center v Other (String) v Phase code

S

12.2 Project Settings

3/ CBS
position

Other (String) Cost Code

Subtotals 163

Tasks H
R Please specify name _

Description

Financial I Results

Misc. Rev Internal

Misc. Rev Internal

Escalation/Contin

General Project Ri.

Budget
Segment 1

Budget
Segment 2

Budget
Segment 3

‘E‘ C 0318203 §

Budget 2 Forecast
Segment 4 method

103961

103961

103961

103961

103961

103961

1000

1103

1104

1101

1102

1001

Average performan

Rollup

Manual (EAC)

Rollup

Current estimate

Rollup

When the edit WBS phase codes and budget segments permission is assigned to a role in Suite
administration > Roles and permissions > Control, users are allowed to populate the WBS phase codes
and budget segments in the CBS workspace. This permission only applies based on configurations set
for the WBS phase code and the budget segments. The edit WBS phase codes and budget segments
permission must be selected to allow users to edit WBS phase codes and budget segments.

fa  Suite administration / Roles and permissions

Roles and permissions >  Edit role

Tasks and cost items

Move cost items up/down
Indent/outdent cost items
[=*} Edit closed projects

(¥) Add whbs phase code and budget segments

[=* Edit wbs phase code and budget segments

Take manual snapshots

Select all

When only the Add wbs phase code and budget segments permission is assigned, users are only
allowed to import WBS phase code and budget segments, and not to edit them.
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When importing, users who have only been assigned the Add wbs phase code and budget segments
permission must use the New items option in the Import CBS data dialog box.

Import CBS data

Import from Excel (.xlsx, xls) or Comma separated value (.csv)

Drag and drop the file here

nnnnnn a

Browse

Options
* Impaort type (i) Theimport file is read and field mapping can
. ) ) be specified. Mapping uses row 1 headers
Cost items and cost item attributes - from the source document
(O Update existing and new items For new cost items, if the CBS position field is
mapped then the position specified is where
() Update existing items the cost item will be placed in the hierarchy. If
the CBS position field is not mapped then the
(@ Mew items new cost item will be inserted at the bottom of
the CBS hierarchy.

. Costcategories list

Cancel
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OPEN PROJECT DETAILS

1. From the All projects & organizations page, right-click on your job.

2. Select Edit Project, or click the Edit icon.

12.2.2 PROJECT PAGE

The Edit Project page is where general project setup information is edited and stored, including the
following settings:

¢ Project Details
e Location

¢ Project Dates
e Prime Contact

e Currency and Markets
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All projects & organizations > | Edit project DETAILS INFORMATION ATTRIBUTES
Project settings
Project details
* Project ID * Extemal project ID @ Notes
0020029472| 0020029472

X

Add project image
Cx 2500 James River WWTP and AWT Facility Active

* Name *Status

* Organization

5100000 - PKS Inc : SA1000 - Kiewit Corporation : SB3000 - SC3002 - entral : SD3003 - Central (SVP Level) : SE6. -
Location
Country / Region Address 1 Address 2 city
State Postal / Zip code Latitude Longitude *Time zone
(UTC-06:00) Central Time (US & Canada) -
Project dates
Project start date Project end date Forecast start date Duration (D) Forecast completion date ()
02/01/2020 ] 02/14/2020 =] ® e
Forecast extensions/reductions Forecast revised duration Forecast revised completion date
Prime contract
Company legal name Original contract amount Contract number Contract date
Contract start date Duration () Contract completion date () Certificate of substantial completion(expected) Certificate of substantial completion(awarded)
Contract extensions/reductions: Contract revised duration Contract revised completion date Certificate of final completion(expected) Certificate of final completion(awarded)
Currency Project contacts
*Base currency Owner Designer
Contact 1 Contact 2
® Add another currency
Contact 3 contact &

Markets

Market

© Add another market

12.2.3 PROJECT SETTINGS

You access Project settings from the Project home landing page. From the Project home page, you can
either:

¢ Select Settings from the side menu

¢ Select Manage settings on the Settings tile
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& Welcome Paul

INEIGHTS)

12.2 Project Settings

Pt) Paul
< Back
el Structure Training Job *
Model
Document

Schedule

Quantify
&) control

@) Plan

@) Progress
Contract

Change

PROJECT SETTINGS
Project home

Project details

Settings

Workflows

Assigned users
Assigned contacts
Assigned vendors

Billing classes

Operational rate codes

® 2 ® @®
Contractor (Default) - Y @
& My links © Map Y C 6] Image
5
y +
Al —
i I
|
Add links s [ -‘u{??” Addimage
Aurora T
® - ] ) @
—A Lakewood } i 4
| 5
l PR T
i " Ei\g/\'ewoaa T # o83 |
Lusass 7 . :
} ““'f"“" & OpenSireethlap contrbutors
«] Time phased distribution Y
Add URL to display
You must select a project to view this data
Please select a project
Y %1 IWP by status v
W Approved W Construction complete
M Constructionstarted M Draft
M In review M Ready for review

The Project settings page contains setup information for all the InEight products, including Control. A
list of tabs on the left allow you to navigate to the appropriate settings for each application.

Steel Structure Training Job | 105091 / Settings

SETES &  GLOBALOPTIONS HOME PAGE FISCAL FUEL TYPES CUSTOM LISTS MENU OPTIONS
CALENDAR
| Design
Master data libraries
«] Control
2] Plan © Validate equipment to project currency.
Toggling this to ‘Off will turn off equipment validation
(%) Progress
. Cost item integration behavior
g Capital
"|-._ Contract @ Control with confirmation
) Control with confirmation: Use this option if you use Control and an ERP. Ta sync cost items between Control and other applications, you
must confirm using the tions in the Actions menu in Control
%) Change
() Control without confirmation
Compliance Control without confirmation: Use this option if you use Control but not an ERP. Cost items sync automatically between Control and other
applications.

The settings that pertain to Control are located under two of the tabs, as listed below:
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e General

Home Page

Global Options
Fiscal Calendar
Document Types
Custom Lists
Attribute Definitions

Menu Options

e Control

Project Tracking (Organization, Project)
Forecast (Organization, Project)

Estimate Resources (Organization, Project)
Schedule (Organization, Project)

Revenue (Project)

Sync Integrations (Project)

Others (Organization, Project)

12.2.4 HOME PAGE

Control User Guide

The Home Page tab lets you create URL links to be placed directly on the Project home page at both
the Organization and Project levels.
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Custom links

* Link name *URL
@ Enter link name Enter URL
O InEight University university.ineight.com ®
O Learn.Ineight www. learn_ineight.com ®

103961 / Project home

l_()+| & Links =z

AdMygroject image Organization

KVK

dds

LaunchPad

Print PO
Document

Project
@ Schedule )
InEight University
€3] Desion
- Learn.Ineight
Quantity forecasting

12.2.5 GLOBAL OPTIONS

The Global Options tab controls the master data libraries, cost item integration behavior, advanced
work and scheduling features, and the template library. The three cost item integration behaviors
provide flexibility in how to configure Control with and without a direct tie to an ERP system. There is
also an option to pass cost items directly from other sources to applications.
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Master data libraries

© Validate equipment to project currency.
Toggling this to ‘Off" will turn off equipment validation.

Cost item integration behavior

@ Control with confirmation
Control with confirmation: Use this option if you use Control and an ERP. To sync cost items between Control and other applications, you
must confirm using the sync options in the Actions menu in Control.

(") Caontral without confirmation
Control without confirmation: Use this option if you use Control but not an ERP. Cost items sync automatically between Control and other
applications

(") Without control without confirmation
Without control without confirmation: Use this option if you do not use Control. Cost items pass directly from other sources to
applications

Advanced work and scheduling features

o Enables data sharing between Model, Schedule, and Plan applications for use with advanced work and
scheduling features

Template library

(©)  Enables project to be listed as an available template library project

12.2.6 FISCAL CALENDAR

The settings in the Fiscal Calendar can be set at the organization and project levels. These settings
specify the start and end dates for fiscal years and financial periods, such as month-end dates. It is
important to know the different cut-off dates, especially when you pull the current period actual
guantities to compare them to prior periods, or when you synchronize your quantities with the other
applications.

Changes to a project level fiscal calendar only impact the project, while changes to the organization
level fiscal calendar impact all projects that do not have fiscal calendar modifications. If there are no
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changes at the project level, and the project matches the organization fiscal calendar settings, the

project inherits the organization-level settings.

Any changes to the project fiscal calendar impact read-only snapshots, which are captured at the

closure of month-end plus days, for the period month being closed. Changes also influence the

monthly time buckets in time phase forecasting and budgeting and to the time periods in which claims

can or cannot be posted.

* Week ending day

* Financial year start month

Cancel

Saturday v Apr v
Period end
« Month end day Last weekday
Last day of the month v
* Financial peried closing day * Month end plus days
Same as Month End Plus Days A 17
« Financial period closing time « Closing time zone
09:30 ® (UTC-05:00) Eastern Time {US and Canada) A

12.2.7 DOCUMENT TYPES

You can assign a document type to InEight applications. This lets you filter the payload of Document

Types for visibility and use in the assigned application.

(@) English

Name Description
Diagram Diagram
O | Photo Photo
%) [ | Design Design
[ Executed contract Executed contract
[0 Executed change order Executed change order
O | Permit Permit
0 | Transmittal Transmittal
[0 Request for information Request for information
0 | Submitta Submitt
0 | Other Other
[ | Checkist Checklist
0O | Comespondk Correspondence

InEight Inc. | Release 25.7

Model, Document, Estimate, Cantral, Pla.
Model, Document, Estimate, Control, Pla.
Model, Document, Estimate, Control, Pla.
Model, Document, Estimate, Control, Pla.
Model, Document, Estimate, Control, Pla.
Model, Document, Estimate, Control, Pla.
Model, Document, Estimate, Control, Pla.

Model, Document, Estimate, Control, Pla.

Espariol
System managed Nam Descript

Yes Diagram: Diagram,

ves Imagen Imagen

Yes Design Design

Yes Contrato ejecutado Contrato ejecutado

ves Orden de cambio ejecutada Orden de cambio ejecutada
Yes Permisa Permiso

Yes Transmision Transmision

ves Solicitud de informacion Solicitud de informacién
Yes Envio Envio

Yes Otros Otros

Yes L verificaci Li ifi

Ves pondenci o

ESMX  v|
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12.2.8 CUSTOM LISTS

Like the tag feature in InEight Estimate, you can enter your tags and their values to use later for
categorizing your cost items as you manage your project in Control.

Many of the tag fields are validated fields, meaning you can choose from options in a drop-down list.
You define both the names of the tags and their drop-down values here.

The field names associated with Cost breakdown structure and Account codes, are tags defined and
editable at the organizational level; you cannot edit them at the project level, as indicated by the
statement “Inherited from parent organization”.

GLOBAL OPTIONS HOME PAGE PROJECT INFORMATION FISCAL CALENDAR  FUEL TYPES CUSTOM LISTS >
List name Label name Associated entity Field values Inherited from parent org . X
ACS tag 3 field values
ACStag 1 ACStag 1 Account code Multiple ves 1
ACS tag 2 ACS tag 2 Account code Multiple ves 1 « Deseription
v/ AcCStag3d ACStag 3 Account code M ves T
dm Account Code Revision Sept 2015
ACS1tag 4 ACStag4 Account code one ves 1
ACS1ag 5 ACStags Account code None ves 1 Account Code Revision July 2017
ACS1tag 6 ACS tag 6 Account code Nene ves 1 Account Code Revision Mar 10 2015
ACStagT ACStag T Account code None Yes 1
Change man: Change management . | Change management one No
Inherited from parent organization 4
Change man: Change management . | Change management one No
change management Change management Change management None No
cBStag1 CBStag1 Cost breakdown structure one No m
CBStag 11 CBStag 11 Cost breakdown siructure None Yes 1

12.2.8.2 CBS URL COLUMNS

You can create direct links to URL addresses outside of Project Suite under Custom Lists. In the URL
Field values you can define a URL with associated criteria to be used as an attribute for a cost item in
the CBS.

In the URL Builder enter a URL that you want associated with your list name, along with any other
dynamic attributes such as Project ID and CBS position code. Paste your URL and highlight the section
you want to reference with another field. First highlight an attribute in the URL string, and then click
the [T] reference icon to select which field to connect with.

f  Steel Structure Training Job | 105091 / Settings

FISCAL
s ! 1 s s M
GLOBAL OPTIONS HOME PAGE CALENDAR FUEL TYPES CUSTOM LISTS MENU OPTIONS
List name Label name Associated entity Field values Inherited from parent arg . x
— = = URL builder
F [  cestag2s CBStag 25 Cost breakdown structure None Mo
CBSURL 1 CBSURL1 Cost breakdown structure URL No Editable url @ I
[] CBSURL2 CBS URL 2 Cost breakdown structure URL No = www.google f|Project ID)/[CBS positi Project ID
Control CBS
[J CBSURL3 CBSURL3 Cost breakdown structure URL Mo ontro
WBS phase code
%) [0  casuRL4 CBS URL 4 Cost breakdown structure URL Mo )
CBS position
O | CBSURLS CBSURLS Cost breakdown structure URL No Account code
D Es:\ma:ing resources .. Es:ima:ing resources .. Estimating resources None No
[} ~ Abimn i s e Entimantiom ramnnirnnn Crtimatinm ranmtiraan NAma [N

Page 488 of 528 InEight Inc. | Release 25.7



Control User Guide 12.2 Project Settings

These quick links are accessible in the CBS and can contain detailed information pertaining to the cost
item and project, which can also link to external reports.

In the CBS cost item details attributes slide-out panel, the URL is concatenated to include the attributes
defined. A link is included on a cost item that opens a new tab.

028

Fiscal calendar settin
Miscellaneous Revenue Internal

DETAILS ATTRIBUTES COST CATEGORIES RESOURCES
Tasks H]
__ cun3 cuDd CuDs
%/ CBS Description
position
1 Fi | Results ...
o nenciafiesdts cuDe cup? cups
~v 2 Miscellaneous Re...
(] 21 Craft Cost cup9 CcuD10 cub1l
] 2.2 B/C To Parent 103
O 23 Intercompany Aut cupiz cup13 cupie
O ~v 3 Miscellaneous Re.
CuD15 CBSURL1_EN CBSURLZ_EN
O 31 Miscellanecus Re... & n &
O w4 Financial Result E
CBSURL3_EN ESTRTEE
O 41 Notin Use & & .
O 4.2 Not in Use

The links can also be accessed in the CBS register. Up to five CBS URL columns can be viewed in a data
block in the CBS, per project.

]

%/ CBS Description WBS phase CBS URL 1 CBS URL 2 CBS URL 3 CBS URL 4 CBS URL 5 ? Forecast
position code total cost

O 1 Job Overhead 1002 & $ 250,000.00
2 Earthwork 1069 = $400,000.00
(] 3 Concrete 1071 & $1,500,000.00
] o Structural Steel 1073 & 4 & & & $1,516,282.48
a 41 Erect Steel - Heavy 1074 & & & & & $ 25,666.00
(] 42 Erect Steel - Light 1005 & & & & & $ 200,000.00
(] 43 Bolted Connections 1006 & & & & & $ 4995500
] v 5 Materials 1084 & & & é & $1,750,000.00
(] 51 Earthwork - Mater 1085 & é é @ @ §250,000.00
(] 52 Concrete - Materi 1086 & & & & & $1,000,000.00
(m} 53 Structure Steel - 1087 & & & & & $ 500,000.00
0 6 1088 & & & & &

Subtotals 12 (1 rows selected) $4175621.00

At the organization level, CBS URL columns 6, 7, and 8 have been added to the CBS register. When you
define a CBS URL, it is then applied to each of the organization’s projects.
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b GLOBAL OPTIONS HOME PAGE C.:Il_SEEI'E:R
r\é: List name Label name Associated entity Field values Inherited from parent org
SR U ———— oy e T — o -
\- [ | CBStag24 CBS tag 24 Cost breakdown structure None No
o [ | CBStag2s CBS tag 25 Cost breakdown structure MNone Mo
O CBSURL1 CBSURL1 Cost breakdown structure URL Mo
O CBSURL 2 CBSURL2 Cost breakdown structure URL Mo
1 O CBSURL 3 CBSURL 3 Cost breakdown structure URL Mo
T-'- O CBSURL4 CBSURL 4 Cost breakdown structure URL Mo
[J | CBSURLS CBSURLS Cost breakdown structure URL No
&) CBSURL 6 CBSURL 6 Cost breakdown structure URL Yes 1
CBSURL7 CBSURL7 Cost breakdown structure URL ves 1
CBSURL 8 CBS URL Cost breakdown structure URL ves 1

Creating organization-level CBS URL links lets you associate shared documentation, such as external
standard reports that are used across the organization. Instead of setting up links for every project, you
can create a CBS URL link in Settings > Custom Lists.

12.2.9 ATTRIBUTE DEFINITIONS

Attribute Definitions are used to define project attributes which can be of the types text/date/number
or can have source values from Organization, Project, and Market master data. These definitions are
inherited to all projects in the organization.
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*Fuel type *Cost per UoM *Currency *UoM Account code
Gasoline $1.00000  ySD - US Dollar Gallon 71.06.32.016.02 - Turbine Enclosure - Install En... ®

12.2.10 MENU OPTIONS

The below URL addresses specific to InEight products are updated when licenses are purchased or
activated. The URLs are customer specific. The ability to maintain the URLs are intended for users with
account admin only (root Org Setting) permissions. If no other products are purchased or activated, the
URL opens an InEight related page to learn more about the products.

Menu links

Configure the URL addresses for your InEight Products

Product = URL * Target
Mode https://fineight.com/solutions/virtual-design-constr.. | New tab
Document https:/fineight.com/solutions/collaborative-docum... Mew tab
Basis http://my.basisplanning.com Mew tab

12.2.11 PROJECT TRACKING (ORGANIZATION &
PROJECT LEVEL)

Under the Control tab, Project Tracking settings configure how your project tracks progress and

percent complete in Control.

These settings include the following options:
¢ What level to lock down your CBS structure to
¢ What value to base percent complete off

* |f percent complete are capped at or allowed to exceed 100%

12.2.11.3 TASKS

The first option in the Tasks Section lets you maintain your CBS structure at a specific level. Selecting
yes, lets you determine your own CBS structure level.
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Tasks

Maintain CBS Structure at a specific level? Level to Maintain CBS Structure at

Generate WBS phase code automatically?

- 0

WES Phase code generation method WES Phase codes start value
Continue numbering from the last generated number -
Ty -
Enable manual snapshots (i) @)
Allow syncs to replace manual snapshots @ @]

The second option is WBS Phase Code. Select Yes or No under the Generate WBS phase code
automatically?

¢ Yes indicates phase codes for newly created cost items to be automatically generated

¢ The WBS Phase code generation method regenerates all values beginning from the specified
start value

¢ The value entered in the WBS Phase code start value is the phase code for the first cost item
created. When automatic phase code generation is activated, the proceeding new cost items is
automatically created based on the phase code generation method selected.

¢ No indicates phase codes for newly created cost items must be manually entered

ENABLE MANUAL SNAPSHOTS

You can create a manual snapshot of Control project data in the CBS and Pay Items registers.

If you have the Enable manual snapshots setting enabled, you can create a snapshot at any point in
time, separately from any of the above-mentioned syncs.
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lasks

WES Phase code generation  Snapshots will be captured when a user with Phase codes start value
permission selects to take the monthly snapshot. If

this setting is disabled, snapshots will be captured
only when Push Live forecast and Push Forecast
revenue syncs are run.

Continue numbering from th
I

Enable manual snapshots (i) ©

Allow syncs to replace manual snapshots (3 (&)

When the Enable Snapshots settings is enabled, you can select the Take Live Snapshot option from the
Current Live Forecast drop-down menu in the CBS to capture current values in the Live Forecast,
Current Budget and Current Estimate.

103561 | Ten bile Side - Phase 2 {Camying) /

cae acs PAY ITEMAS CHANGE RECISTER AT LOE

n Live forecast @3 Cumentlive forecast = Conen

Snapshots can also be taken from the Actions menu.
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CBS
Actions w @
Y Global forecast method.. .
Task details § soee
. Set forecast method Resources Forecast (T/0) UoM
4 qty
Update Forecast gty with Pla e
° 100  PLS
;:_ Claim multiple CBS quantities
i
al 100  PLS
+ Budget move and cantract adjustment b
A
l 1 Lock/unlock budget b Bl 100 | ALS
Add required cost items in_ 1.00 Each
Sync » Ri. 5245 | K§
Take snapshots 100  PLS
| Snapshots will capture current values in Live forecast, Current budget, Current estimate, and Revenue |
O ~ 231 DWETT LauouT TOU T TS

You can view the draft snapshot by selecting the View draft snapshot from the Current live forecast
drop-down menu. This lets you know that the draft snapshot is not yet finalized for the current month.

Live forecast | @& Current live forecast ~

& Forecast P Y - recast © Forecast
total cost &2 Current live forecast total
=y = ¥

=4

TakeLive Snapshot | ) ot | jve snapshot : 7/12/2023, o1,

12:28:01 PM The draft snapshot is
not yet finalized for the current

© June 2023 month.

$ 4,599 637,039.68..
2 View draft snapshc*

5209224 9771109... B4

2344212919300 ® may 2023 N

466 0000020 | © April 2023 37

When you select View draft snapshot, the snapshot values load into the CBS in a read-only status.
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Live forec.. | & Viewdraftsnapshot ~ | /A ¢ esss )

Forecast Forecast Forecast Forecast Forecast
total cost total MHrs total total

MHr=/ unit productivity

=) Forecast
total unit cost method

When you select the Take Live Snapshot meu-option, consecutively, a message lets you know that an
existing snapshot already exists and a choice to override the previous snapshot.

Live forecast &P Current live forecast =

&3 Forecast £ o rrerd lvs frranagt fecast
total cost < Current live forecast
it
Take Live Snapshot
$000 a i
2 View draft snapshot \. X
$2401,829.02 T

Take Live Snapshot
An existing snapshot for 6/26/2023,12:23:46 PM already exists. Do you want to override the previous snapshot?
Last Live snapshot taken: 6/26/2023, 12:23:46 PM by Paul (via Manual snapshot)

- IR

The same snapshot functionality now exists in Pay Items, with the exact same option.

Pay ITEMS CHANGE REGISTER AUDIT LG Tice -
ctions. ® a2 / v B B & Q
Revenue snapshol:  Curent revenue forecast Billed date:  MAXINE o 06262023 G
o ard b by that- Casrent revenie forecast
o il : Last revenue snapshot: Tue Jun 06 2003 S:47:00
Take revenue snapsho’. P,
o . . : Snapshat will capture current Revenue values
= < Pay item position Fay item Lot Cumrent Price back Change gl Griginal 6
number billing stotus oader papoe wnitpa MIYI0Z3 sy —
[T10) gty method
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ALLOW SYNCS TO REPLACE SNAPSHOTS

When the Enable manual snapshots and the Allow syncs to replace manual snapshots toggle is turned
to On, the manual snapshot is replaced when the Push Live Forecast and/or Push Forecast revenue is
synced. If this setting is disabled, syncs are replaced with manual snapshots.

Tasks

WES Phase code generation method WBS Phase codes start value
Continue numbering from the last generated number -

Enable manual snapshots () @

Allow syncs to replace manual snapshots (3) S

If this setting is enabled, a manual snapshot will be
replaced when Push Live forecast and/or Push
Forecast revenue is synced. If this setting is
disabled, syncs will not replace manual snapshots.

12.2.11.4 ACTUALS

The image and table below give a brief explanation of Project Tracking: Actuals settings.

Overview - Project Tracking: Actuals

1 Calculate % Calculate percent complete for individual cost items as a percentage
complete of:
» Forecast (T/O) Quantity
o Current Budget Quantity

2 % complete Cap any cost item percent complete at 100%
cap
3 Calculating Calculate percent complete for roll-ups, such as superior cost items
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Overview - Project Tracking: Actuals (continued)

I
roll-up method and account codes by Cost or Manhours

4 Roll-up % Roll-up percent complete weighted by

complete « Current Budget
e Current Estimate

5 Calculate man Calculate man-hours earned for roll-up items by summing the man-
hours earned  hours earned of the contributing items (regardless of roll-up items
at the parent percent complete).
level by... Option 1: The summation of man hours earned from direct child items
Option 2: The total man hours multiplied by percent complete

6 Get actual When turned on, the subcontract actual cost is received from
cost from Contracts. Actual costs from Contract can consist of a goods receipt,
Contract an accrual, or an invoice receipt/payment form. If a goods receipt and

an invoice receipt come in at the same time for a record, the higher
cost is recognized and not duplicated.

7 Drive When turned on, the committed costs is driven from Contracts. When
committed cost turned off, committed costs are derived from the ERP.
values from
Contract

8a Update % Quantities that are claimed in Contract for SOV items updates the
complete from percent complete in Control when the Update % complete from
Contract Contract switch is enabled. Updating the percent complete provides

you with another way to claim quantities against schedule of value
items in Contract.

When quantities are claimed against a schedule of values item in
Contract and the Get quantities sync is executed in Control, the cost
items actuals quantity completed gets updated with a percentage
claimed toward the contract's schedule value total cost.
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Overview - Project Tracking: Actuals (continued)

1006
23113 Clear & Grub Bench B & West Laydown

o . Fancial Posting date Eﬁ Actuals type Actuals completed Cost category Changed by Notes
0| v Misc. B & rzvzaszns | contimed cos s217.14) Undefined Labor Change - [Service Account]
@] 21 Misc. R O 121772018
(m] v 22 Escalati O 1211512018
(m] 221 Generalp | (0 12/08/2018
0 v 23 et 0O 12/012018
= 0 1172412018 o, ’
8b Calculate Calculate the percent complete for individual cost items as a
percent percentage of
complete for « Current estimate total cost
individual cost « Committed total cost
ltems as a « Forecast total cost
percentage of « Current estimate total cost
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Calculate percent complete for individual cost items as a percentage of
Forecast (T/0) gty hd

Calculate percent complete for roll-up items such as superior cost items and
account code by:

3] .

Calculate man hours earned at the parent level by @ @

Cost

(@ The summation of man hours earned from direct child items

(O The total man hours multiplied by percent complete

Get actual cost from Contract @ @ @

Drive committed cost values from Contract (i) 0 @

12.2.11.5 ESTIMATED ACTUALS

Cap percent complete at 100%

Yes .‘

Roll-up percent complete weighted by 0

Current Budget -

Update % complete from Contract (J @ G_/)

Calculate percent complete for individual cost items as a percentage of

Ao -

Current estimate total cost
Current budget total cost
Committed total cost
Forecast total cost

Current estimate total cost

This feature allows estimated actuals to be accrued to a cost item, then used to contribute to the

forecast. This results in the forecast being more accurate. The estimated actuals are calculated based

on the cost category values associated to the cost items.

When Turn on estimate actuals is enabled, you can choose to turn on or off estimated actuals based

on the cost category. You can enable estimated actuals in both Control and InEight Progress.

When any one of the following cost categories are enabled, the Claim Actuals tab shows the option
when claiming quantity to accrue estimated cost based on the amount claimed.
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Estimated actuals

Turn on estimated actuals: ©

Enable estimated actuals for:
Actual type

Control Progress
Laber cost ) &)
Labor man hours &)
Construction Equipment cost &)
Construction equipment hours &)

FOM Rented Equipment cost

Supplies cost

Materials cost

Subcontract cost

Fees cost

Allowance cost

G & A cost

QOO0 00 e I 0 ®

Undefined cost

You access the Claim actuals tab from the Control > Workspaces page by right-clicking the cost item on
the CBS tab and selecting Actuals details. The Actuals details slide-out panel is then shown where you
can select the estimated actuals option.
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CLAIM ACTUALS ACTUALS HISTORY
QUANTITIES
Forecast (T/0) gty Qty complete (to date)
200.00 0.00
MAN HOURS
EQUIPMENT HOURS
Claimed quantity ¥ Estimated actual cost to be added on claiming:
COST o R -
Claimed quantity supplies $0.00
P . Materials 50.00
10/17/2019 =1 Subcontract $0.00 B
Notes 4000
@ Add claimed quantity @ Claim guantities for multiple cost items

On the CBS tab, the estimated actuals are shown as columns. These values can be added to the
Confirmed actuals (actuals that were imported into Control or manually entered in Control) to get all
the actuals for the project that are available. This helps you more accurately forecast your project.

CBS ACS FAY ITEMS

Live forecast o

Actuals RAKENE] to RUMARZUIED E

Confirmed Confirmed
actual cost actual gty

Current estimate 5 0.00 0.00

O 10/17/2019 &

v

12.2.11.6 ENABLING ACTUALS FOR PROGRESS

Using an example for Progress, if you have labor cost and man hours enabled for Progress and there is
an approved daily plan in Progress, those man-hours go over to Control automatically as estimated
man-hours. Then, those man-hours generate an estimated cost based on the operational rates for that
resource. In this case, it would be using the Straight time rate, the Double time rate, and the Over time
rate.
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The same process can happen for construction equipment and equipment hours. For example, if you
claim equipment hours in Progress and they are in an approved daily plan, then those hours go over to
Control as estimated equipment hours. The operational and equipment resources also have a unit cost.
Those hours times for that unit cost can then be used to generate an estimated construction
equipment cost.

12.2.11.7 ENABLING ACTUALS FOR CONTROL

If man-hours and equipment hours are enabled, then you claim a quantity, it can generate estimated
man-hours and equipment hours if there are CE amounts on those hours. For example, CE man hours
per unit and CE equipment hours per unit can be estimated. If those are nonzero and you claim
guantity, then the estimated man hours and equipment hours are generated.

3 CBS position Description WBS phase AHrs (to date) Equipment Estimated Estimated Estimated CE Mhrs/Unit CE equipment-
code hours (1o date) actual cost actual man acwal  Hrs/Unit
hour

equipment

a4 Costitem 4 04 0.00 0.00 $0.00 0.00 0.00 0.00 0.00

If you do not have estimated actuals enabled in the project settings, you do not see any of the
Estimated actuals columns, and you also cannot add them to your view. Some of these columns are a
direct correlation with Progress.

Some of these columns are also from Control. The columns from Progress generate actual man-hours
and equipment hours from claimed quantity in Control. These columns come over directly from
Control and they affect your forecasts. Any estimated man-hours are included in your man-hours to
date and then the estimated actual cost is included in your total cost to date.

Your forecast equations look for total cost to date, man-hours to date, and equipment hours to date to
generate forecasts.

12.2.11.8 ESTIMATED ACTUALS PROCESS OVERVIEW

When you have synced everything from Progress, it is now in your ERP system. You can then bring in
the man-hours and equipment hours through the sync.
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Estimated Estimated Estimated CE Mhrs/Unit CE equipment- Last estimated Last estimated Issue
actual cost actual man actual Hrs/Unit actual man actual equip
hours equipment hours reversal hours reversal
0 $0.00 000 0.00 0.00 0.00

0 $000 0.00 0.00 0.00 0.00

0 $1.25000 110.00 20,00 10,00 1.00) 03/29/2021 3.07:2 03/29/2021 3.08:7

0 $000 0.00 0.00 0.00 0.00

After the sync is completed, you can reverse the estimated actuals as they have been accounted for as
confirmed actuals by bringing the actuals through the sync.

The Estimated columns are only general estimates. They are not confirmed hours until synced with an
ERP or an external payroll system. With an ERP you can make changes to where you can have taxes
added on which would raise the price for the estimated actuals. Estimated actuals that go into Control
from Progress are not guaranteed to be 100% correct. Your ERP is what confirms the final cost.

12.2.11.9 REVERSING ESTIMATES

When you bring in values from your ERP system, you can reverse your estimates with the actual values

as the replacement.

NOTE

If you keep the estimated values without reversing after syncing with ERP system, those

values are detected as double values.

REVERSING ESTIMATED ACTUALS

1. From the CBS, select the cost items you want to revert actuals.

2. Select the Actions drop-down menu.

3. Hover over Reverse estimated actuals. Then, select Reverse estimated actual eqiup hrs and
const....
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CBS ACS PAY ITEMS

Actions  w @ E ®

. _ _

Set forecast method Description WES phase Estimated Estimated
code actual man
hours

Time phased forecasting

Cost item 1 01 0 5$000 000
Claim multiple CBS quantities Cost item 2 02 0 $0.00 0.00

1 "

Budget move and contract adjustment » Costitem 3 03 0 §1.250.00 110.00

Costitem 4 04 0 $0.00 0.00

Unlock budget
Syne 13

Reverse estimated actuals »
Reverse estimated actual cost

Reverse estimated actual MHrs and labor cost

Reverse estimated actual equip hrs and const

4. Click Yes to confirm reversal.

You can also select Reverse estimated actual cost or Reverse estimated actual MHrs and labor
cost.

5. Inthe CBS, look for the Last estimated actual man hours reversal or Last estimated actual
equipment hours reversal columns.

Estimated CE Mhrs/Unit CE equipment-
actual Hrs/Unit
equipment

Last estimated Last estimated
actual man actual equip
hours reversal hours reversal

0 $0.00
0 $000
0 $1.250.00 110.00 2000 10.00 1.00
0 $0.00 0.00 000 0.00 0.00

03/29/2021 3.07:2 03/29/2021 3.08.7

Those columns show the date of the last time you reversed the amount.

In the actual history, the reversal shows as negative entries when you have successfully reversed
the estimated actuals.

Page 504 of 528 InEight Inc. | Release 25.7



Control User Guide 12.2 Project Settings

12.2.11.10 TIME PHASING BUDGET

Time phasing your forecast lets you take your forecast and break it down into more consumable,
estimate related time blocks/periods. This gives you more visibility into what activities and costs are
going to occur in smaller time periods. Time Phasing is explained further within the Forecasting lesson,

under Time Phased Forecasting.

Time phasing the budget lets you plan out where to spend money in the months of the active fiscal
calendar for your project. Time Phased Budget is explained further within the Revenue lesson, under

Time Phased Budget.

Time phasing

Enable time phasing for the following:

Budget (§) (&) Edit past Time phased budget values ©

12.2.12 FORECAST (ORGANIZATION & PROJECT
LEVEL)

12.2.12.11 TIME PHASING

Time phasing your forecast lets you take your forecast and break it down into more consumable,
estimate related time blocks/periods. This gives you more visibility into what activities and costs are
going to occur in smaller time periods. Time Phasing is explained further within the Forecasting lesson,

under Time Phased Forecasting.

Time phasing

Enable time phasing for the following:

Forecasting (i) ©
Push Time phased forecast to Live forecast ©
commitments (i) (&)
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12.2.12.12 FORECAST

The image and table below give a brief explanation of Project Tracking: Forecast.

Overview - Project Tracking: Forecast

e [

1 % % complete threshold for delta from straight-line calculation:
complete
for delta By configuring the value of % Complete threshold, you can determine the
from equation used for the Delta from Straight-Line column depending on if
straight- those cost items have their % complete greater than or less than the value
line set in configurations.

Changing the threshold and impacting the formula is necessary because
when a cost item has not been sufficiently completed, the actuals data is
not yet reliable enough to predict the final anticipated cost (forecast cost) of
that scope of work, so a different equation should be used until that cost
item has been sufficiently completed.

For example, if the threshold is 3% complete, and a cost item is less than
3%, then delta from straight line = Forecast total cost - CB total cost. Once
the cost item has reached 3% complete, then the calc switches to Forecast
total cost - Average performance total cost

You can set manual forecast notes to be mandatory when switching to a manual forecast type. When
the Mandatory notes for manual Forecasts switch is set to On, entering forecast notes is mandatory for
Manual (EAC) and Manual (ETC) forecasts.

Forecast
% complete value at which delta from straight line calculation utilizes Mandatory notes for Manual forecasts @
average performance

5 ©

When manually forecasting, notes are required to be entered in the Forecast Notes dialog box. Once
confirmed, the notes are captured, and the forecast method automatically changes to Manual.
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This feature helps to keep track of manually entered forecasts. You can use the notes to explain the
forecast. For example, you can enter a rationale for why a manual forecast is being used.

CBS ACS PAY ITEMS CHANGE REGISTER

Actions  w ® 4 (]

A 4
Tasks TS i @ Forecast 2 Created from Live fore.. = C oo
H H
% CBS Description it & UoM Z Forecast £ Forecast £ Latest forecast note Z Forecast
position total cost notes method

1 Financial Results . 100 PLS o $3048.24 @ % 2 Changed forecast total cost to $3,048.24 Manual (EAC)
O vz Mizc. Rev Internal 100  PLs $2,453%Q0.03 & Rollup f
]} 2.1 Misc. Rev Internal 100  PLS 50 x
(] v 22 Escalation/Contin. 100  Each $52,000.0 Forecast notes are required

Please enter a note to update your forecast.

*Notes 500

Changed forecast total cost to $3,048.24

Cance' m

12.2.12.13 CUSTOM FORECAST METHOD CALCULATIONS

You can create custom forecast methods at both the project and organization levels by configuring
your own calculations.

PROJECT TRACKING FORLCAST ESTRLATE RESOURCETS T Ravivaaf SYNG INTECRATIONS

* complese vabue #l wisch deita from strasghl e calculabon uidspes Msdassny notes for Maresl Foretaits (1)
Frrtige periormance

o Custom forecast method calculations

() Add custom lorecast meshod

Custom forecast methods L

~  Sputheast i b4
=~  ORG_CALC double check ()]
= West ] X
~  BODMAS ++ + (]
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To create a custom Forecast Method, click Add custom forecast method, and then enter the Forecast
Method Name, Forecast Total Cost and Forecast Total Mhrs calculations. You can create a maximum of
10 custom organization and project level forecast methods each at one time.

Select the Formula icon to choose fields to include in your forecast formula.

p

(#) Add custom forecast method

New custom forecast method

o Define calculations

* Farecast method name

Midwest Forecast

+ Forecast total cost (3)

| 1000-4000+6000+3000+10 |

* Forecast total MHis (§)

| [Actual egp hrs (fo date 1 | —

% complete

Actual cost (to date)

Custom forecast methods

- Midwraet Cararact

Cancel | ﬁ..c_ua eqp hrs (to date)

Actual labor cost (to date)
Actual labor cost/MHT (to dat
Actual labor unit cost (to dati

Actual MHrs (to date

In the CBS you can set the Custom Forecast Method for a cost item at the organization or project level,
which updates the Forecast Total Cost and Forecast Total Mhrs based on the calculations created in

Settings.
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= s Steel Structure Tramang Job | 105081 § Contral / Workspaces

CBS ACS PAY ITEMS

Actions ® [ ()

T

< CBS Descrphion WES phase * CB fovecast ? Delta from * Forecast ? Forecssi
(0 position code total MHr &1 straight line notes method
C | Job Overhead 1002 0.00 250,000.00 11" Current estimate
A ( 3 Earthwork 1069 -8,000.00 400,000,00 e} Current estimate
[ 3 Coancrete 1071 - 30,0000 1500000000 ?_: Current estimate
[ v 4 Struciural Stesl 1073 4399.10 1516,282.48 = Ruallup
41 Erect Steel - Heawy 1074 0.00 1,266,327 48 (= Canada West Regio «
n a7 Erect Steel - Light 1005 -4,000.00 200,000.00 &
= O
O 43 Bolted Connections 1006 -339.10 49.955,00 = -
I v g Materials 1084 0.00 .00 _E:_ Committed cost .
C 51 Earthwork - Mater 1085 0.00 000 &= Midwest Forecast
[ 53 Concrete - Materi... 1086 000 o.00 = Mortheast Forecas
C 53 Structure Steel - 1087 0.00 0.00 =
— _— B7BJHRA Forecast
O 6 1088 0.00 000 e
Canada West Regic"_

12.2.12.14 ENABLE FORECAST METHODS BASED ON ALLOW
AS-BUILT SELECTIONS

Select which forecast methods can be used based on the allow as- built settings, for both terminal and
non terminal cost items.

There are multiple forecast allow as-built options to choose from to help you configure your forecasted
cost items, in addition to the existing available Control forecasting methods. When an option is
disabled, that method is not available to select for cost items with the allow as-built selected.
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Enable Forecast methods based on Allow as-built selections

Non-terminal cost items ~

When Allow as-built is set to Aifor Cost
Enable the following Forecast methods for non-terminal cost items when Allow as-huilt is set to Aifor Cost

Current estimate @ Manual (ETC) @
. Terminal cost items A
Current budget @ Manual (EAC) @
Average performance @ None @ When Allow as-built is set to Allor Cost )
Enable the following Forecast methods for terminal cost items when Allow as-built is set to Allor Cost
Committed cost & Contract & Current estimate @ Manual (ETC) @]
Default Forecast method for non-terminal cost items when Allow as-builtis set to Alfor Cost Current budget @ Manual (EAC) @]
e it estimats -
et estimate Average performance @ Hone ®
Committed cost @ Contract [©
When Allaw as-built is set to Quantity
Enable the following Forecast methads for non-terminal cost items when Allow as-built is set to Quantity Detailed ETC ©
Conent estimate © Manual €TC) © Dt Forecast method forteminl cost tems when Allow as-built s setto Allr Cost
Current budget © Manual (EAC) @ Current estimate -
Average performance © None ©@
B When Allow as-built is set to Quantity
Default Fi t method -t | cost items when Allow as-built is set to Quantity .
vl forecast menio for non-termina; est tems when Allow ss-bultis set o tuanfty Enable the following Farecast methods for terminal cost items when Allow as-built is set to Quantity
Current estimate v M
Current estimate @ Manual (ETC) ©]
Current budgat @ Manual (EAC) ]
When Allow as-built is set to None
Enable the following Forecast methods for non-terminal cost items when Allow as-built is set to None Average performance © None @
Foll @ N ® . p
ollap @ one @ Default Forecast methad for teminal cost items when Allow as-bult s set to Quantity
Manual (ETC) © Manual (EAC) [©] Current estimate -
Default Forecast method for non-terminal cost items when Allow as-built s set to Mone
Rollup. When Allow as-built is sét to None

Enable the following Forecast methads for terminal cost items when Allow as-built s set to Mone
None @
Default Forecast method for terminal cost items when Allow as-built is set to None

None

12.2.13 ESTIMATE RESOURCES (ORGANIZATION &
PROJECT LEVEL)

The Wage rate composition determines what percentage of each labor hour will be calculated at the
scale 1, scale 2, or scale 3 rate.

Wage rate composition

Scale 1 Scale 2
a0 10
Scale 3

10
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12.2.14 SCHEDULE (ORGANIZATION & PROJECT

LEVEL)

Under the Schedule sub-tab, you can define the data source for your project's schedule using manual
entry or import using and XER type file. You can also create custom cost curves to apply to your
progressed work, based on actual costs and schedule. Plug day calculations and Schedule ID's are also

maintained in the Schedule tab.

Define project schedule

Schedule data source:

Manual entry

Duplicate field values for Baseline and Current schedule columns:

Schedule ID and Baseline schedule ID Cost curves

Scheduled and Baseline Scheduled
Schedule WBS and Baseline schedule WBS  customize cost curve tables

Roll up schedule and Baseline roll up schedule

O Deseription

(J  Back Loaded

O  Linear )
Plug Day Calculation

O  Employed!

() FrontLoad Plug days default rollup calculation

O BellShape -ongestchild
Schedule ID

Schedule ID settings will only affect newly created cost items

Schedule ID prefix

Ps

Define the delineator

Period

InEight Inc. | Release 25.7
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12.2.15 REVENUE (PROJECT LEVEL)

12.2.15.15 REVENUE AND COST TIMING

Revenue and Cost Timing

Category

Labor cost

Construction Equipment cost

FOM Rented Equipment cost

Supplies cost

Materials cost

Subcontract cost

Subcontract Retention released

Clent Retention eleased

Average calendar days elapsed from billng o colletion

o

Retention Tax

000%
0.00%
000%
0.00%
0.00%
000%

Payment timing

Same month

Same month

Paymenttiming  Next__months

0.00%  Same month

0.00%  Same month

0.00% | Same month

0.00% | Same month

000% | Same month

000%  Same month

Next__ months

auamaane | BilliNg Mmethod default earnings rules

Project end date

Default cost item earnings amounts @

Fixed final price
Earnings amounts based on:

O Forecast (T/0) gty
® CE total cost

Unit price
Earnings amounts based on:

@® Forecast (T/0) aty

O CEtotal cost

Pay item to Cost item Forecast (T/0) gty relationship

Enable pay item Forecast (T/0) gty rollups Enable pay item Forecast (T/0) qty roll down @

Control User Guide

e © Markup

Ibefault markup percent

0.00%

Cost categories

Labor 0.00% Labor 000%
Construction Equipment 0.00% Construction equipment 000%
FOM Rented Equipment 0.00% Rented construction equipment 000%
Supplies 0.00% Installed material 000%
Materials 0.00% Installed equipment 000%
Subcontract 0.00% Supplies 000%
Fees 0.00%

Allowance 0.00% z

You can change the Retention percentage, Tax rate, and Payment Timing at the cost category level.
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Revenue and Cost Timing

Category Retention Tax Payment timing Next __ months
Labor cost 5.00% 0.00% | Same month
Construction Equipment cost 2.00 % 0.00% | Same month
FOM Rented Equipment cost 0.00 % 0.00% | Same month

You can set the average calendar days elapsed from the billing collection, in addition to setting the end
of project date to any of the options available in the drop-down menu.

You can also enter a default retainage percent that is held back from each bill on the pay items. Pay
item retainage creates an incentive for contractors to complete contracted work on a project.
Typically, contractors do not get paid the total amount of money until all work or a set milestone is
completed. With pay item retention, an agreed upon retainage percentage is held back by the owner
for each bill by the client until the owner agrees to release the retention.

When changing the Default retainage percent setting you can choose to either update all existing items
on a project, update matching existing pay items, or only apply to pay items created in the future.

Average calendar days elapsed from billing to collection End of project date
34 Project end date v
Project end date
Default retainage percent Forecast completion date
5.00 % Contract completion date

Certificate of substantial completion (expected)

Certificate of final completion (expected)

When it is time to bill for a pay item, the retainage percentage is used to automatically withhold the
percentage of the bill specified in the Billed Revenue details slide-out panel. You can also see your
adjusted net bill which excludes the retention withheld amount.
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BILLED

RETENTION

Pending billable gty

144.00

Billed revenue

$100.00

Pending billable revenue

$13,300.00

Cost category

Control User Guide

BILLED HISTORY

Retainage %

10.00 %

Undefined v
On the Pay Items page, the Net billed revenue shows $90.00, while $10.00 is being withheld.
+ Pay tem Payitem Description Billed revenue Retention released Retention withheld Net billed Retainage % Billed Reven.
O position number revenue aty earned
=] 1 001 Earthwark - Labor & Material 5500000 5000 5000 $500000 000% 10000 5000
2 002 Concrete - Labor & Material $100.00 sooo | s1000 || 59000 || 10.00% | 000 s000
O 3 003 Steel - Labor & Material $000 $0.00 $0.00 $0.00 0.00% 0.00 $32.28

You can also release and track your full or partial retention amounts in both Billed Revenue Details and

Bill Multiple Pay Items, set a retention release date, then view the results in the Pay Item register.

BILLED RETENTION BILLED HISTORY

Retention withheld Retention released (to date)
$0.00 $0.00
Retention released *= Retention released date

$10.00 = 02/28/2022 i)
MNotes 250

=2
[]

Billed revenue Retention released

5 5,000.00

:

Retention withheld

$0.00

$100.00 |

$10.00 |

S0.00

50.00

Net billed revenue

50.00
50.00
50.00

Retainage %
$ 5,000.00 0.00 %
$90.00 10.00 %
50.00 0.00%

When approving contract adjustments from Change to Control, pay item amounts are not required to

equal the amount received from Change if the Enforce change order price values to match between
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Control and Change is turned off. In Settings > Control > Revenue, disabling the switch to theOff
position is ideal when pay items are not being used in a contract adjustment.

The example below shows a CCO agreed price of $101.00 and an Adjusted current price of $22.00.
When advancing to the Summary page, you can now approve the contract adjustment without the
CCO agreed price and Adjusted current price matching.

PROJECT TRACKING FORECAST ESTIMATE RESOURCES SCHEDULE REVENUE

When switch is on, Net contract change for pay items

. must equal Current price from the received change order.
Enforce change order price values to match between Control and Change @ a P 9

When switch is off, these values do not have to match to
@ approve contract adjustments from Change.

Change register > 370.1 - Contract adj... l @ /

CCO total budget  CCO unassigned budget  Net budget change | Net contract change [ CCO agreed price ©CO unassigned price  Approval probability
$101.00 $0.00 §101.00 Ny $22.00 $101.00 §79.00 100.00% - Executed Change Order =
/ ° Pay items

® ® @ (
as
Pay item Description Adjusted Current price Adjuste. urrent pay Current UoM Current billing Sales order
[J  number current price current un._ - forecast (T/0) method
price aty
BP08-003.01 UAV Survey and Aerial Phot.. 52200 ® $216947.00 @ 1.010 0.000 | PLS Unit price

When the Enforce change switch is enabled, the error message below stating that the contract
adjustment cannot be approved shows when the Adjusted current price does not equal the CCO price.

Unable to approve contract adjustment

Het contract change must egqual CCD prce
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12.2.15.16 BILLING METHOD DEFAULT EARNINGS RULES

You can also manage the settings for billing method default earning rules, pay item forecast quantity
rollups, and the markups. You can select the default earnings amounts based on forecast takeoff
guantity. The default earnings are calculated using the forecast takeoff quantity of the cost item and
comparing it to the total forecast takeoff quantities of all of the cost items assigned to that pay item to
generate the percentage.

The Fixed final price and Unit price settings let you select a default way to calculate those earnings
amounts based on takeoff forecast quantity or CE final cost. After the settings are saved, all of your
fixed final price pay items that normally calculate based on CE final cost and unit price then calculate
forecast takeoff quantity or any of the other options you select. You can still modify this selection at
the pay item level.

12.2.15.17 PAY ITEM FORECAST TAKEOFF QUANTITY
ROLLUPS

In the Revenue tab, you can manage settings for Pay ltem Forecast takeoff quantity rollups. This setting
is used for pay item unit price only.

Unit price pay item Forecast (T/0) quantities will

. rollup based on contributing cost items' Forecast . .
Pay item to Cos (T/0) quantities ationship
Enable pay item Forecast (T/0) gty rollups (i) Enable pay item Forecast (T/0) gty roll down ()
@ ©

The toggle is only applicable to unit price pay items. It lets you enable the pay item forecast take-off
guantity to be calculated based on the sum of all the assigned cost items forecast takeoff quantities.

When enabled, you can no longer edit your pay item forecast takeoff quantity in the Pay item register.
If you click a field, you can no longer edit that field.

The Fixed final price and Cost plus values can be edited. The calculation is the sum of all the
contributing cost item’s forecast takeoff quantities. It can contribute to the pay item forecast if it has
the same unit of measure.

For example, you cannot add unlike units of measure. Only cost items that have the same unit of
measure as the pay item can contribute to that pay item’s forecast takeoff quantity.
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Actions = ®» ® Reves

nue snapshot Current revenue forecast » | Billed date: 09/0672017 to 04/06/2021 [ 7 1= Q
Pay item - demo ><

Pay Quantity Unit Price Billing method

cBS Position Description orecast (T/0) qty UoM CE final cost

In the image above, the two cost items have different units of measure.

Cost item 1 has a unit of measure of box, which also has the pay item contribute quantity box checked.
Cost item 2 has a unit of measure of bag with the pay item contribute quantity box unchecked. When
you go into the update earning rules editor, you cannot check the pay item contribute quantity box for
cost item 2 because the unit of measure does not match with cost item 1.

Pay item 1D Description Total Price
Pay item - deny

Calculate earning amounts by:

CBS Position Descript... Pay item Eaming % Eaming Eamings WBS Phas
contrib. Amount Timing
quantity (Forecast)

If you deselect the pay item contribute quantity box for cost item 1, the cost item’s quantity does not
contribute to the pay item’s quantity. Then, the pay item quantity is zero. If it is checked, cost item 1
with the unit of measure of box has a forecast takeoff quantity of 150. This means the pay item also
has a forecast takeoff quantity of 150.

In the CBS, you can change the Unit of Measure from bag to box, and then forecast take off quantity
updates.
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By default they both now have the pay item contribute quantity checked and the pay item forecast
take off quantity is the sum of any cost items that have pay item contribute quantity checked.

Actions - l:i‘_—} L" {):(;-
Y - - -
Tasks : LEE 0 EES ¢ neee ) s
% CBS position Description WBS phase Resource Forecast (T/0) UoM
code quantity
A Cost item 1 o
& 42 Cost item 2 02 10000 Bag p -
am
43 Cost item 3 03 " PL )
Ad Cost item 4 04 1 PLS

For example, with cost item 2 updated, the forecast takeoff quantity from of 100 is added to the
forecast takeoff quantity of cost item 1. The total forecast takeoff quantity is now 250. It includes both
of them since they now both have a matching unit of measure.

Also, this affects you earnings percent as well if you have forecast takeoff quantity selected. The pay
item contribute quantity for both cost items drives your earnings percent if the forecast takeoff
guantity radio button is selected. It also decides which cost items are going to contribute to the pay

item’s forecast takeoff quantity.

MeJg= When you turn on the pay item forecast quantity rollups, the Pay item contribute
quantity column does not show by default. To add it, go into the columns chooser, and

then select that column. After it is brought into your view, it remains there until you
deselect it from the columns chooser.
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Pay item - demo
Total Price Pay Quantity Unit Price Billing method
7 Unit price
B H RDERS A A
Eamings amounts based on: Forecast (T juantity E fina Fay item Minbute quantity # Update eamning rules
CBS Position Description Pay item Earning % Earning Amount
contribute (Forecast)
qu.‘lntﬂ_}l1
r\. .’.
4 ]
100.00 % $25,000.00

When you are in the Update earnings rule dialog box, the Pay item contribute quantity column is a
default column in that view because it column is editable in the Update earning rule dialog box. That
column is not editable in the main table. You can only select to add it to your main table view in the
pay item slide-out panel for informational purposes.

The Pay item contribute quantity column is not available if the setting is off or if you are looking at a
unit price pay item. If the setting was turned on and a user brought in the column and then decided to
turn that setting off, then those columns would disappear.

12.2.15.18 PAY ITEM FORECAST TAKEOFF QUANTITY ROLL
DOWN

When the amount of contract deliverables changes on unit price contracts, manually updating all the
guantities for every associated cost item can be time consuming. Pay item forecast take off quantity
allocations can be proportionally rolled down to the assigned cost items by setting the Enable pay item
Forecast (T/0) gty roll down switch to On in Settings > Control > Revenue.

Unit price pay item Forecast (T/0) quantities will
roll down to the contributing cost items’ Forecast

Pay item to Cost item Forecast (T/0) gty relationship (7/0) quantities
Enable pay item Forecast (T/0) gty rollups () | Enable pay item Forecast (T/0) gty roll downl@
e @

The unit price pay item Forecast (T/O) quantities proportionally rolls down to the contributing cost
items’ Forecast (T/O) quantities. Pay item to cost item roll down changes also show in the CBS Audit

log.
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CBS ACS PAY [TEMS
: @
Actions = ® o
3 Pay item Pay item Description Gurrent Current Current UoM Current
[ position number unit price pay qty forecast billing
(T/0) gty method
O 3 BP Office $124,730.58 1.000 8.000  PLS Cost plus
|l LY

Carrying Job | ./ Control / Workspaces

CBS
Actions  w @-
Y
Tasks H RERGEEE
% CBS position Description Resources Fordgast (T/0)
aty
D ¥ 2111 Site .. 1.000
O 21111 Site .. 6 7R181.000
O 21112 Temp... 9 £.000

The Allow as-built setting must be set to All or Quantity for the selected cost items.

12.2.15.19 MARKUP

For more information, see Markup.

In Revenue tab, you can configure a default markup percent that applies the markup to the entire

project. The Markup percent table adds a markup per cost category and per resource type on all of the
cost categories in resources in the project.
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PROJECT TRACKING ESTIMATE RESOURCES SCHEDULE REVENUE OTHERS

(_f General
&[®) Capital
.:. Control
(4] Plan
(32) Progress Markup

L] Compliance

efault markup perce

¥ | Contract I

% | Change

-J) Design
Cost categories Markup percent Resources Markup percent

For example, if you added 10% to Labor resources, then any labor resources automatically have a 10%
markup added to it and that affects the resources charge rate. Then that charge rate affects the
amount of revenue that cost items can bill for and earn.

After you set labor at 10% and click Save, you are prompted with this dialog box confirming that you
are making a change to an existing markup.

X

You are making a change to an existing cost
category/resource markup on this project

From this dialog box, you can choose to update all existing cost categories. For this example, it adds
10% resource markup percent for all labor resources.
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The option to update matching existing cost categories selection changes the current charge rates for
cost items that were modified. Anything that has not been modified such as a labor resource that has
not been manually modified, this option overrides it with 10%.

You can also specify whether to only apply cost items and resources created in the future. When
selected, no changes are made to existing resources. Any newly created resources, in this example
labor resources, have a 10% markup added to them.

Cost categories are applicable in plug cost items that do not have resources or are not resource-driven.
The cost categories have only a blanket cost category markup that helps drive the total revenue
amount on the cost item.

You can view this information from Markup columns such as Billing rate markup amount, CE billable
amount, Markup amount, and CE revenue amount.

% CBS position Description WBS phase Resource
code

i

o Current budget Total cost (todate)  Current estimate

Subtotals 4 (1 rows selected)

The column Markup amount uses the following formula:

* Markup percent x your current estimate = markup amount.

The Billing rate markup amount, for plug cost items is always set to zero because you can only have a
billing rate on resources. So if this is a detailed cost item, this is just showing your billing rate markup
amount for all of those resources.

The column CE billable amount uses the following formula:

e The Current estimate amount + your Billing rate markup amount = CE billable amount.

The column CE revenue amount uses the following formula:

¢ The CE billable amount + your Markup amount = CE revenue amount.
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The CE revenue amount is how much revenue a cost item can have. This is only applicable for cost plus
pay items. You can apply markups on cost items and they do not affect the revenue on those cost

items. The markups affect the revenue for cost plus pay items and any cost items that are assigned to
cost plus pay items.

12.2.16 SYNC INTEGRATIONS (PROJECT LEVEL)

Schedule sync integrations to run at specific times such as Pushing the CBS structure or Pushing Billed
Revenue.

Push CBS stiueiure Time 5 Fun syne

A5 structure anc Fasdget 120040

5 SiT e o

ture znd Achual quantities

tc e, By, Live fonscas! snd Actsal gusmities

Sync Integrations schedule
Push Bille revenue
Pugh Forecasl ievenue
Gat quantties
@ Add sync schedule Gat Actual cost and MHS
Gat Ealled neroenue
= Sync type / = Time zone
Select one - (UTC-07:00) Mountain Time (US & Canada) v
* Start Date = Time to run sync
03/03/2022 | 12:00 AM O
* Repeat

m Daily Weekly Monthly

Cancel

Scheduled syncs
Push CBS structure
Sync type: Push CBS structure Start date: 03/08/2022 B ®
Time to run sync: 12:00 AM MST Repeat on:
Repeat: Never End: After 1 occurrence(s)
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12.2.17 OTHERS (PROJECT LEVEL)

12.2.17.20 REQUIRED COST ITEMS

You can prevent the project from syncing when required cost items are not included by setting the
Prevent project from syncing if required cost items are not added toggle to Yes.

Required cost items

Prevent project from syncing if required cost items are not added | (%)

12.2.17.21 DECIMAL PRECISION

The image and table below summarize the different decimal precision options:

Overview - Decimal Precision

I T R

1 Currency Number of decimal places for currencies. Any field that includes currency
data will be affected by this setting.

2 Cost Number of decimal places for total cost information both at the terminal
Summary and non-terminal level.

3 Unit Cost Number of decimal places for any unit cost displayed.

4 Quantities Number of decimal places for any quantities displayed.

5 Percentages Percent complete calculations at both the terminal and non-terminal
level.

Numeric fields can be configured to omit decimals for currency, unit cost, percentages, cost summary

and quantities.
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Required cost items

Decimal precision

12.2.18 OTHERS (ORG LEVEL)

12.2.18.22 REQUIRED COST ITEMS

12.2 Project Settings

A Prevent project from syncing if required cost items are not added toggle has been added to prevent
the project from syncing if required cost items are not added. The Required cost items feature lets you
create standardized or most commonly used cost items at the organization level and then add them at

the project CBS level.
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Required cost items @

Prevent project from syncing if required cost items are not added )
O Description r';?ii phase UoM Account code Allow as-built
] RC1 44446666 Acre 99.99 Quantities
O RC2 44445555 Cubic Meter Quantities
(] RC3 44447777 Barrel 00.03.01.010 Quantities

12.2.18.23 CHANGE ORDER DETAILS

Change Order fields can be configured as validated drop-down list fields at the organization level.

After the toggle is set to On, the Discipline, Issue #, and CCO fields are validated in the drop-down list
values. When the toggle is set to Off, these fields are free text fields with no validations.

In the example below, six validated issues have been selected to be associated with this change order
after it is submitted.

Page 526 of 528 InEight Inc. | Release 25.7



Control User Guide 12.2 Project Settings

PROJECT TRACKING FORECAST ESTIMATE RESCURCES SCHEDULE OTHERS
Required cost items @
Pravent project from syncing if required cost items are not added | &2
L Descrigtion e Uah Account code Al as-built
N Associated lssues
(] RCLY BABBIE Bag A
O oz 58000 | cmi L
a RequiredTest] 231434 3E34343 Acre 00.03.01.004 5thr_.. None (]
L
O Aooo s67ag | Barel Al s
[m] ROCIL1Z 7788990 Bag 000301004 None - :
+ I
' ]
a
[a] Crnche somerete
i o Broioan uabe
Change order details 5
o Soepe esease
/— o Feed mesor on il maifunchion, procers M
Make fiekds valideted dropdawns (1) @ |

15 5

0 testinsue

7= Fraped cae
8- Schede delay

Discpine

Change maragement tag | Charge management tag 2 Crange management o9 3

[change managemen user detned 1 Change management wver defined 2 Crange management user defiosd 3
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REVIEW

1. How many administrative levels are there when you create a new role?

a.

A W N

b
C.
d

2. There are several options when setting up project tracking. What setting is NOT included
in these options?

a. How import of your CBS structure will be configured

b. How percent complete for individual cost items will be calculated
C. Configuring and naming tags
d

. Capping percent complete at 100%

SUMMARY

As a result of this lesson, you can:

¢ Create and manage InEight Control roles and permissions

* Navigate and define the different type of InEight Control project settings
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